Copyright Warning

The GASWorkS software and User’s Manual are protected under United States and international copyright laws and treaties. Making unauthorized copies of either the software or the associated documentation is a violation of United States and international law. Don’t be a criminal, don’t copy.

About This Guide

The GASWorkS Help Guide is intended as a supplement to the GASWorkS User’s Manual. This guide provides examples and how-to instructions for using the GASWorkS software. For more detailed descriptions of the functions and features, including technical information, please refer to the User’s Manual.

Words that are in italicized font are used throughout this guide to indicate the name of a menu item, menu list, command button, data item, keyboard key, or other option or setting that can be selected. Words that are in bold font are used throughout this guide to indicate entered or selected values. Key words and their definitions can be found in the Glossary section of this guide.

A copy of the Help Guide in Portable Document Format (pdf) is contained with the GASWorkS installation file. With some versions of GASWorkS, the Help Guide and other documentation are installed and viewable using the Help menu. Additional information and documentation may be found on our website www.b3pe.com.
## Table Of Contents

Copyright Warning ............................................................................................................. 1
About This Guide .................................................................................................................. 1

### IMPORT & MERGE ROUTINES

<table>
<thead>
<tr>
<th>Import</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Import &amp; Merge Information</td>
<td>3</td>
</tr>
<tr>
<td>Import A CSV File - Customer</td>
<td>5</td>
</tr>
<tr>
<td>Import A DXF File</td>
<td>7</td>
</tr>
<tr>
<td>Import A GASWorkS 7.0, 8.0, 9.0 Model</td>
<td>9</td>
</tr>
<tr>
<td>Import A KML File</td>
<td>11</td>
</tr>
<tr>
<td>Import A SHP File - Customer</td>
<td>13</td>
</tr>
<tr>
<td>Import A SHP File - Pipe</td>
<td>15</td>
</tr>
<tr>
<td>Import A Stoner PD/XY File</td>
<td>17</td>
</tr>
<tr>
<td>Merge A SHP File - Service</td>
<td>18</td>
</tr>
<tr>
<td>Merge A SHP File - Valve</td>
<td>20</td>
</tr>
</tbody>
</table>

### EXPORT ROUTINES

<table>
<thead>
<tr>
<th>Export</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Export Information</td>
<td>23</td>
</tr>
<tr>
<td>Export A CSV File - Customer, Node, Or Pipe</td>
<td>25</td>
</tr>
<tr>
<td>Export A DBF File - Customer, Node, Or Pipe</td>
<td>27</td>
</tr>
<tr>
<td>Export A DXF File</td>
<td>28</td>
</tr>
<tr>
<td>Export A GASWorkS 9.0 Model</td>
<td>30</td>
</tr>
<tr>
<td>Export A KML File</td>
<td>31</td>
</tr>
<tr>
<td>Export A SHP File - Customer, Node, Or Pipe</td>
<td>32</td>
</tr>
<tr>
<td>Export A Stoner PD/XY File</td>
<td>33</td>
</tr>
<tr>
<td>Export A XLS File - Customer, Node, Or Pipe</td>
<td>35</td>
</tr>
</tbody>
</table>

### GDI COMMANDS

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add A 2-Point Pipe</td>
<td>37</td>
</tr>
<tr>
<td>Add An Arc Pipe</td>
<td>39</td>
</tr>
<tr>
<td>Add A Branch Customer</td>
<td>41</td>
</tr>
<tr>
<td>Add A Compressor</td>
<td>44</td>
</tr>
<tr>
<td>Add A Customer</td>
<td>46</td>
</tr>
<tr>
<td>Add A Customer &amp; Automatically Assign The Main</td>
<td>49</td>
</tr>
<tr>
<td>Add A Customer With A Tap Location</td>
<td>51</td>
</tr>
<tr>
<td>Add A Duplicate Customer</td>
<td>53</td>
</tr>
<tr>
<td>Add A Feature To A Group</td>
<td>55</td>
</tr>
<tr>
<td>Add A Fitting</td>
<td>57</td>
</tr>
<tr>
<td>Add Multiple Customers</td>
<td>59</td>
</tr>
<tr>
<td>Add Multiple Customers &amp; Automatically Assign The Main</td>
<td>61</td>
</tr>
<tr>
<td>Add A Polyline Pipe</td>
<td>63</td>
</tr>
<tr>
<td>Add A Polyline Pipe Vertex</td>
<td>65</td>
</tr>
<tr>
<td>Add A Polyline Service Customer</td>
<td>68</td>
</tr>
<tr>
<td>Add A Regulator</td>
<td>70</td>
</tr>
</tbody>
</table>
Table Of Contents

Add A Service Line Vertex ....................................................... 75
Add An Unassigned Customer .................................................. 77
Add A User Graphic Image ........................................................ 79
Add A User Graphic Line .......................................................... 81
Add A User Graphic Symbol .................................................... 84
Add User Text ........................................................................... 86
Add User Text Associated With A Feature ................................. 88
Add User Text With A Leader Line ............................................ 91
Add A Valve ............................................................................. 94
Add A Valve Node ..................................................................... 97
Add A Well ................................................................................ 99
Adjust An Arc Pipe .................................................................... 102
Assign The Customer Service Lines .......................................... 104
Break Flagged Intersections ...................................................... 106
Calculate Delta P (Linear) ......................................................... 108
Calculate Delta P (Squared) ....................................................... 109
Calculate The Design Factor ..................................................... 110
Calculate The Flow Efficiency ................................................ 112
Cancel The Current GDI Command ........................................... 115
Clear All Customer Flags ......................................................... 117
Clear All Flags ........................................................................ 118
Clear All Node Flags ................................................................ 119
Clear All Pipe Flags ................................................................ 120
Clear The Change Log ............................................................... 121
Clear The Customer Find Flag ................................................ 122
Clear A Customer Flag ............................................................... 123
Clear Customer Item Flags ....................................................... 124
Clear The DXF Find Flag ........................................................ 125
Clear Error Flags ..................................................................... 126
Clear The GeoFind Flag ............................................................ 127
Clear The Node Find Flag ........................................................ 128
Clear A Node Flag ................................................................. 129
Clear Node Item Flags .............................................................. 130
Clear The Pipe Find Flag ........................................................ 131
Clear A Pipe Flag ................................................................. 132
Clear Pipe Item Flags .............................................................. 133
Clear The Supply Flags ............................................................ 134
Clear Unbroken Intersection Flags .......................................... 135
Clear The User Text Find Flag ................................................ 136
Close The GDI Window ............................................................ 137
Color Display Settings ............................................................. 139
Combine Pipes ......................................................................... 141
Compare Two Models ............................................................... 143
Connect Pipe Ends ................................................................. 144
Convert All Arc Pipes To Polyline Pipes ................................. 146
<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert An Arc Pipe To A Polyline Pipe</td>
<td>147</td>
</tr>
<tr>
<td>Convert Color Legend To User Text</td>
<td>148</td>
</tr>
<tr>
<td>Convert Service Lines To Customers</td>
<td>150</td>
</tr>
<tr>
<td>Copy A Customer</td>
<td>151</td>
</tr>
<tr>
<td>Copy A Customer &amp; Service</td>
<td>153</td>
</tr>
<tr>
<td>Copy A Group</td>
<td>155</td>
</tr>
<tr>
<td>Copy A Pipe</td>
<td>157</td>
</tr>
<tr>
<td>Copy Saved Views From Model</td>
<td>159</td>
</tr>
<tr>
<td>Copy A User Graphic Image</td>
<td>160</td>
</tr>
<tr>
<td>Copy A User Graphic Line</td>
<td>162</td>
</tr>
<tr>
<td>Copy A User Graphic Symbol</td>
<td>164</td>
</tr>
<tr>
<td>Copy The User Graphics From A Model</td>
<td>166</td>
</tr>
<tr>
<td>Copy A User Table</td>
<td>167</td>
</tr>
<tr>
<td>Copy User Text</td>
<td>169</td>
</tr>
<tr>
<td>Copy The User Text From A Model</td>
<td>171</td>
</tr>
<tr>
<td>Create A Branch Customer Tap</td>
<td>172</td>
</tr>
<tr>
<td>Create A Group</td>
<td>174</td>
</tr>
<tr>
<td>Create A Symbol Legend</td>
<td>176</td>
</tr>
<tr>
<td>Create A User Table</td>
<td>178</td>
</tr>
<tr>
<td>Delete The Color Legend Text</td>
<td>180</td>
</tr>
<tr>
<td>Delete A Customer</td>
<td>181</td>
</tr>
<tr>
<td>Delete All Customers</td>
<td>182</td>
</tr>
<tr>
<td>Delete A Group</td>
<td>183</td>
</tr>
<tr>
<td>Delete A Marked View</td>
<td>184</td>
</tr>
<tr>
<td>Delete All Marked Views</td>
<td>185</td>
</tr>
<tr>
<td>Delete A Node</td>
<td>186</td>
</tr>
<tr>
<td>Delete A Pipe</td>
<td>188</td>
</tr>
<tr>
<td>Delete A Polyline Pipe Vertex</td>
<td>190</td>
</tr>
<tr>
<td>Delete A Saved View</td>
<td>192</td>
</tr>
<tr>
<td>Delete A Service Line Vertex</td>
<td>193</td>
</tr>
<tr>
<td>Delete A User Graphic Image</td>
<td>195</td>
</tr>
<tr>
<td>Delete A User Graphic Line</td>
<td>196</td>
</tr>
<tr>
<td>Delete A User Graphic Symbol</td>
<td>197</td>
</tr>
<tr>
<td>Delete All User Graphics</td>
<td>198</td>
</tr>
<tr>
<td>Delete A User Table</td>
<td>200</td>
</tr>
<tr>
<td>Delete User Text</td>
<td>201</td>
</tr>
<tr>
<td>Delete All User Text</td>
<td>202</td>
</tr>
<tr>
<td>Delete A Valve Node</td>
<td>203</td>
</tr>
<tr>
<td>Delete All Valve Nodes</td>
<td>204</td>
</tr>
<tr>
<td>Delete Zero Length Pipes</td>
<td>205</td>
</tr>
<tr>
<td>Display A Background Image</td>
<td>206</td>
</tr>
<tr>
<td>Display The Color Legend</td>
<td>207</td>
</tr>
<tr>
<td>Display The Crosshairs</td>
<td>208</td>
</tr>
<tr>
<td>Display The Customer Symbols</td>
<td>209</td>
</tr>
<tr>
<td>Display The Flow Arrows</td>
<td>210</td>
</tr>
</tbody>
</table>
# Table Of Contents

- Display In Isometric View ........................................... 212
- Display The Node Symbols ........................................... 213
- Display The Pipe Symbols ........................................... 214
- Display In Plan View ................................................ 215
- Display The Tool Palette ........................................... 216
- Display The User Graphics .......................................... 217
- Display The User Text .............................................. 218
- Dissolve The Features In A Group .................................. 219
- Dissolve All Groups .................................................. 221
- DXF Layer Identification ........................................... 223
- Edit Customer Data ................................................... 224
- Edit Customer Data By Pipe Selection .............................. 226
- Edit Multiple Customers ............................................ 228
- Edit Multiple Nodes .................................................. 230
- Edit Multiple Pipes ................................................... 232
- Edit Multiple User Graphic Images .................................. 234
- Edit Multiple User Graphic Lines ................................... 236
- Edit Multiple User Graphic Symbols ................................. 238
- Edit Multiple User Text ............................................... 240
- Edit Node Data .......................................................... 242
- Edit A Node’s External Load ......................................... 244
- Edit A Node’s Fixed External Load ................................... 246
- Edit Pipe Data ............................................................ 248
- Edit A Pipe’s Customer Count ....................................... 250
- Edit A Polyline Pipe Vertex ......................................... 251
- Edit A User Graphic Image ........................................... 253
- Edit A User Graphic Line ............................................. 254
- Edit A User Graphic Symbol ......................................... 255
- Edit A User Table ........................................................ 256
- Edit User Text ............................................................ 258
- Export User Text ........................................................ 259
- Feature Snap ............................................................. 260
- Find Any Feature ......................................................... 261
- Find A Customer ......................................................... 263
- Find A Customer By Address ......................................... 265
- Find A Customer By Attribute ....................................... 267
- Find A Customer By Internal ID Number ............................ 269
- Find A Customer By Link ID Number ................................. 270
- Find A Customer By Record Number ................................ 272
- Find DXF Text ............................................................. 273
- Find A Geographic Location ........................................... 275
- Find A Node ............................................................... 277
- Find A Node By Name ................................................... 279
- Find A Node By Record Number ...................................... 281
- Find A Pipe ............................................................... 282
<table>
<thead>
<tr>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find A Pipe By Address</td>
<td>284</td>
</tr>
<tr>
<td>Find A Pipe By Attribute</td>
<td>286</td>
</tr>
<tr>
<td>Find A Pipe By Internal ID Number</td>
<td>288</td>
</tr>
<tr>
<td>Find A Pipe By Link ID Number</td>
<td>289</td>
</tr>
<tr>
<td>Find A Pipe By Record Number</td>
<td>291</td>
</tr>
<tr>
<td>Find User Text</td>
<td>292</td>
</tr>
<tr>
<td>Flag A Customer</td>
<td>294</td>
</tr>
<tr>
<td>Flag Customers By Item Value</td>
<td>295</td>
</tr>
<tr>
<td>Flag Customers With Invalid Link ID Numbers</td>
<td>297</td>
</tr>
<tr>
<td>Flag Customers With Redundant Link ID Numbers</td>
<td>298</td>
</tr>
<tr>
<td>Flag A Node</td>
<td>299</td>
</tr>
<tr>
<td>Flag Nodes By Item Value</td>
<td>300</td>
</tr>
<tr>
<td>Flag A Pipe</td>
<td>302</td>
</tr>
<tr>
<td>Flag Pipes By Item Value</td>
<td>303</td>
</tr>
<tr>
<td>Flag The Supply Node</td>
<td>305</td>
</tr>
<tr>
<td>Flag Unassigned Customers</td>
<td>306</td>
</tr>
<tr>
<td>Flag Unbroken Intersections</td>
<td>307</td>
</tr>
<tr>
<td>Get A Group ID</td>
<td>309</td>
</tr>
<tr>
<td>Go To An XY Coordinate Location</td>
<td>310</td>
</tr>
<tr>
<td>Highlight A Group</td>
<td>311</td>
</tr>
<tr>
<td>Highlight A Pipe</td>
<td>312</td>
</tr>
<tr>
<td>Insert A Compressor</td>
<td>313</td>
</tr>
<tr>
<td>Insert A Regulator</td>
<td>316</td>
</tr>
<tr>
<td>Insert A Valve</td>
<td>319</td>
</tr>
<tr>
<td>Join Adjacent Pipe Segments</td>
<td>322</td>
</tr>
<tr>
<td>Mark The Current View</td>
<td>324</td>
</tr>
<tr>
<td>Match The Customer Graphic Properties</td>
<td>325</td>
</tr>
<tr>
<td>Match The Customer Hydraulic Properties</td>
<td>327</td>
</tr>
<tr>
<td>Match All Of The Customer Properties</td>
<td>329</td>
</tr>
<tr>
<td>Match The Node Graphic Properties</td>
<td>331</td>
</tr>
<tr>
<td>Match The Node Hydraulic Properties</td>
<td>333</td>
</tr>
<tr>
<td>Match All Of The Node Properties</td>
<td>335</td>
</tr>
<tr>
<td>Match The Pipe Facility</td>
<td>337</td>
</tr>
<tr>
<td>Match The Pipe Graphic Properties</td>
<td>339</td>
</tr>
<tr>
<td>Match The Pipe Hydraulic Properties</td>
<td>341</td>
</tr>
<tr>
<td>Match All Of The Pipe Properties</td>
<td>343</td>
</tr>
<tr>
<td>Match The User Graphic Line Properties</td>
<td>345</td>
</tr>
<tr>
<td>Match The User Graphic Symbol Properties</td>
<td>347</td>
</tr>
<tr>
<td>Match The User Text Properties</td>
<td>349</td>
</tr>
<tr>
<td>Maximize The GDI Window</td>
<td>351</td>
</tr>
<tr>
<td>Measure An Angle</td>
<td>352</td>
</tr>
<tr>
<td>Measure A Distance</td>
<td>353</td>
</tr>
<tr>
<td>Measure An X-Axis Isometric Distance</td>
<td>355</td>
</tr>
<tr>
<td>Measure A Y-Axis Isometric Distance</td>
<td>356</td>
</tr>
<tr>
<td>Measure A Z-Axis Isometric Distance</td>
<td>357</td>
</tr>
<tr>
<td>Command</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Move A Background Image</td>
<td>358</td>
</tr>
<tr>
<td>Move A Branch Service Tap</td>
<td>360</td>
</tr>
<tr>
<td>Move The Color Legend Text</td>
<td>362</td>
</tr>
<tr>
<td>Move A Customer</td>
<td>363</td>
</tr>
<tr>
<td>Move A Customer &amp; Reassign The Supply Main</td>
<td>365</td>
</tr>
<tr>
<td>Move Customer Text</td>
<td>367</td>
</tr>
<tr>
<td>Move A Group</td>
<td>369</td>
</tr>
<tr>
<td>Move A Node</td>
<td>371</td>
</tr>
<tr>
<td>Move Node Text</td>
<td>373</td>
</tr>
<tr>
<td>Move Node Text For Multiple Nodes</td>
<td>375</td>
</tr>
<tr>
<td>Move A Pipe</td>
<td>377</td>
</tr>
<tr>
<td>Move A Pipe End</td>
<td>379</td>
</tr>
<tr>
<td>Move Pipe Text</td>
<td>381</td>
</tr>
<tr>
<td>Move Pipe Text For Multiple Pipes</td>
<td>383</td>
</tr>
<tr>
<td>Move A Polyline Pipe Vertex</td>
<td>385</td>
</tr>
<tr>
<td>Move A Service Line Vertex</td>
<td>387</td>
</tr>
<tr>
<td>Move A Service Tap</td>
<td>389</td>
</tr>
<tr>
<td>Move A User Graphic Image</td>
<td>391</td>
</tr>
<tr>
<td>Move A User Graphic Line</td>
<td>392</td>
</tr>
<tr>
<td>Move A User Graphic Line End</td>
<td>394</td>
</tr>
<tr>
<td>Move A User Graphic Symbol</td>
<td>396</td>
</tr>
<tr>
<td>Move A User Table</td>
<td>397</td>
</tr>
<tr>
<td>Move User Text</td>
<td>398</td>
</tr>
<tr>
<td>Multiply Customer Loads</td>
<td>399</td>
</tr>
<tr>
<td>Multiply Node Loads</td>
<td>400</td>
</tr>
<tr>
<td>Pan The GDI Image</td>
<td>402</td>
</tr>
<tr>
<td>Plot The GDI Image</td>
<td>403</td>
</tr>
<tr>
<td>Project To Plane Coordinates</td>
<td>406</td>
</tr>
<tr>
<td>Prorate Customer Loads</td>
<td>408</td>
</tr>
<tr>
<td>Purge Customers</td>
<td>409</td>
</tr>
<tr>
<td>Purge User Text</td>
<td>411</td>
</tr>
<tr>
<td>Quick Size</td>
<td>412</td>
</tr>
<tr>
<td>Quick Solve A Model</td>
<td>413</td>
</tr>
<tr>
<td>Quick Trace</td>
<td>414</td>
</tr>
<tr>
<td>Quick User Text</td>
<td>415</td>
</tr>
<tr>
<td>Reassign A Customer’s Supply Main</td>
<td>416</td>
</tr>
<tr>
<td>Reassign The Customer’s Supply Main Numbers</td>
<td>418</td>
</tr>
<tr>
<td>Redo The Last Data Or Graphic Change</td>
<td>419</td>
</tr>
<tr>
<td>Reduce Nodes</td>
<td>420</td>
</tr>
<tr>
<td>Regenerate The Model Data</td>
<td>422</td>
</tr>
<tr>
<td>Remove Attached Fittings</td>
<td>423</td>
</tr>
<tr>
<td>Remove A Feature From A Group</td>
<td>424</td>
</tr>
<tr>
<td>Renumber The Nodes</td>
<td>426</td>
</tr>
<tr>
<td>Repaint The GDI Image</td>
<td>427</td>
</tr>
<tr>
<td>Report Customers With Invalid Coordinates</td>
<td>428</td>
</tr>
</tbody>
</table>
Table Of Contents

Reset The Customer Symbol Colors ............................................................ 429
Reset The Feature Colors ............................................................................. 430
Reset The Node Symbol Colors ..................................................................... 431
Reset The Pipe Colors .................................................................................. 432
Reset The Tool Palette .................................................................................. 434
Resize The GDI Window ................................................................................ 435
Save The Current View .................................................................................. 436
Save The Feature Colors ............................................................................... 437
Scale A Background Image ........................................................................... 439
Segment A Pipe ............................................................................................... 441
Set To Flat Isometric Coordinates ............................................................... 443
Set An Intersection Flag .............................................................................. 444
Set The Orthogonal Coordinates .................................................................. 446
Set The Orthogonal Plus Coordinates .......................................................... 447
Set The User Graphic Line Size For All Features ....................................... 448
Set The User Graphic Symbol Size For All Features .................................... 449
Set The User Text Size For All Features ...................................................... 451
Set A Valve Node ........................................................................................... 452
Shift The Model Coordinates ...................................................................... 453
Show The Route Profile ................................................................................ 455
Snap To A Grid Intersection ......................................................................... 457
Snap Loose Pipe Ends .................................................................................. 458
Solve The Model ............................................................................................ 460
Straighten A Polyline Pipe ........................................................................... 462
Swap A Pipe’s Ends (The From Node & To Node) ......................................... 464
Tap A Pipe .................................................................................................... 465
Text Display Settings .................................................................................... 467
Trace ............................................................................................................ 469
Trace & Update The Data ............................................................................. 471
Turn A Background Image Display Off ....................................................... 473
Turn The Change Log Off ............................................................................. 474
Turn The Change Log On ............................................................................... 475
Turn A DXF Layer Off .................................................................................. 477
Turn The GeoMap Functions On ................................................................. 478
Undo The Last Data Or Graphic Change .................................................... 479
Unhighlight A Group .................................................................................... 480
Unset An Intersection Flag .......................................................................... 481
Unset A Valve Node ...................................................................................... 482
Update The Pipe Customer Count ............................................................... 483
View The Change Log ................................................................................... 484
View A CSV Table ......................................................................................... 486
View The Trace Results ................................................................................ 487
Zoom The GDI Image .................................................................................... 488
# GASWorkS™ 10.0

## Table Of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>GDI WINDOW EXAMPLES</td>
<td>493</td>
</tr>
<tr>
<td>Add A BMP Background Image</td>
<td>495</td>
</tr>
<tr>
<td>Add A DXF Background Image</td>
<td>500</td>
</tr>
<tr>
<td>Add A SHP Background Image</td>
<td>504</td>
</tr>
<tr>
<td>Attach A Fitting To A Pipe</td>
<td>507</td>
</tr>
<tr>
<td>Automatically Pan &amp; Zoom GDI Display</td>
<td>509</td>
</tr>
<tr>
<td>Color Code By Query</td>
<td>511</td>
</tr>
<tr>
<td>Color Code By Range</td>
<td>513</td>
</tr>
<tr>
<td>Determine An Appropriate Display Limit</td>
<td>516</td>
</tr>
<tr>
<td>Display The GDI Command List</td>
<td>518</td>
</tr>
<tr>
<td>Enter GDI Coordinates</td>
<td>519</td>
</tr>
<tr>
<td>Execute A GDI Command</td>
<td>522</td>
</tr>
<tr>
<td>Graphically View A Model</td>
<td>524</td>
</tr>
<tr>
<td>Grips</td>
<td>525</td>
</tr>
<tr>
<td>Import A DXF File (Example)</td>
<td>528</td>
</tr>
<tr>
<td>Import A GASWorkS 9.0 Property Table</td>
<td>536</td>
</tr>
<tr>
<td>Increase The GDI Image Display Speed</td>
<td>537</td>
</tr>
<tr>
<td>Move The GDI Image</td>
<td>539</td>
</tr>
<tr>
<td>Project A Model</td>
<td>540</td>
</tr>
<tr>
<td>Query Specifications Screen</td>
<td>543</td>
</tr>
<tr>
<td>Repeat A GDI Command</td>
<td>545</td>
</tr>
<tr>
<td>Save The GDI Image As A BMP File</td>
<td>546</td>
</tr>
<tr>
<td>Select A Feature</td>
<td>547</td>
</tr>
<tr>
<td>Set A Feature’s Dimensions</td>
<td>549</td>
</tr>
<tr>
<td>Set A Feature’s Location</td>
<td>551</td>
</tr>
<tr>
<td>Set The GDI Coordinate Units</td>
<td>553</td>
</tr>
<tr>
<td>Use The Data Panel</td>
<td>555</td>
</tr>
<tr>
<td>Use The Mass Update Routine</td>
<td>557</td>
</tr>
<tr>
<td>Use The Tool Palette</td>
<td>560</td>
</tr>
<tr>
<td>Working With Shapefiles (SHP)</td>
<td>563</td>
</tr>
<tr>
<td>GEOMAP EXAMPLES</td>
<td>565</td>
</tr>
<tr>
<td>General GeoMapping Information</td>
<td>567</td>
</tr>
<tr>
<td>Attach A GeoMap Background To An Existing Model</td>
<td>568</td>
</tr>
<tr>
<td>Build A New Model Using A GeoMap Background</td>
<td>572</td>
</tr>
<tr>
<td>GLOSSARY</td>
<td>575</td>
</tr>
<tr>
<td>INDEX</td>
<td>583</td>
</tr>
</tbody>
</table>
IMPORT & MERGE ROUTINES
General Import & Merge Information

The GASWorkS Import routines provide a means of creating a model from data contained in an outside application.

There are two routines provided with similar functions: the Import routine and the Merge routine. The Import routine creates an entirely new model from outside data. The Merge routine combines outside data with an existing model. Merge is useful for adding new feature types to an existing model - for example, adding customers to a pipe - only model, or updating customer information from a spreadsheet.

In addition to using the standard Import and Merge routines, models from older versions of GASWorkS can be imported by opening the model using the Open item from the File menu list.

Ensure that all data values and dimensional units contained in the source file are compatible with the values supported by GASWorkS. The source file does not need to include all of the data supported by GASWorkS. Items not included in the source file will be set to specified default values, and may be revised after the Import or Merge routine is complete using the Mass Update routine or any of the data edit routines. The default data values can be set using the Set Defaults item from the Utilities menu list.

The following table lists the Import and Merge file types supported by GASWorkS.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Import</th>
<th>Merge</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSV (Comma Separated Values) File - Customer</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>CSV (Comma Separated Values) File - Node</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>CSV (Comma Separated Values) File - Pipe</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>DXF (Drawing Exchange Format) File</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>GASWorkS 7.0, 8.0, 9.0</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>KML (Keyhole Markup Language) File</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>SHP (ESRI Shapefile) File - Customer</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>SHP (ESRI Shapefile) File - Junction</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>SHP (ESRI Shapefile) File - Node</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>SHP (ESRI Shapefile) File - Pipe</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>SHP (ESRI Shapefile) File - Service</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>SHP (ESRI Shapefile) File - Valve</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>File Type</td>
<td>Import</td>
<td>Merge</td>
</tr>
<tr>
<td>------------------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>Stoner PD/XY File</td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>
Import A CSV File - Customer

Summary

GASWorkS can import customer data from a CSV file to create a new model, or merge customer data from a CSV file with an existing model.

Example

Before importing a CSV file, it is a good idea to review the information contained in the Notes & Considerations section of the Import/Merge CSV (Comma Separated Values) Files topic in the User’s Manual, as well as the following Notes & Considerations section.

The example assumes that GASWorkS has been started.

- From the Utilities menu list, select the Import item.
  - The Model Selection screen is displayed. Enter a name for the new GASWorkS 10 model. Click the Continue command button. Note - If using an existing model, a message may be displayed asking whether to overwrite the model. Respond appropriately to return to the Model Selection screen.
  - The Import screen is displayed. Select the CSV (Comma Separated Values) File - Customer item from the File Type list. Click the Import command button.
    - The File Selection screen is displayed. Select a “.csv” file. Click the Continue command button.
    - The Customer Import Specifications screen is displayed. Assign the appropriate CSV Column Assignment to the related GASWorkS Data Item. To reset the Data Field Assignments, click the Clear Data Field Assignments command button. Review the remaining settings. When finished, click the Continue command button.
  - The Import screen is displayed again. The Import Log will update the status of the Import routine. When the routine is complete, click the Close command button to return to the GDI Window.

Notes & Considerations

- Customer data without specified X,Y coordinates will not be imported. A message may be displayed if no customers with coordinate data are found.
When importing or merging customer data, GASWorkS will ask whether or not to assign the supply main connections. If the Yes command button is clicked, GASWorkS will draw service connections between customers and the nearest main. It is possible that some of the assignments will be incorrect. If this occurs, use the Reassign Customer Supply Main command to make the correct assignments.

The Merge routine searches the existing model for matches between the data from the source file and the existing features using the specified Fuzzy Tolerance. If an existing pipe, node, or customer is found within the Fuzzy Tolerance of the feature being processed, GASWorkS assumes the two features to be the same, and the new feature will not be added to the model. If no existing feature is found within the Fuzzy Tolerance, the current feature will be added to the model. This can lead to some unusual processing where customers or nodes are “stacked” when the Merge routine is used. It is recommended that the User validates the results of the Merge routine before continuing with the model. The Fuzzy Tolerance value is expressed in terms of the Coordinate units.

See Also

General Import & Merge Information
Reassign A Customer’s Supply Main
GASWorkS™ 10.0 Import & Merge Routines

Table Of Contents

Import A DXF File

Summary

GASWorkS can import data from a DXF file to enter a name for the new model, or merge data from a DXF file with an existing model.

Example

Before importing a DXF file, it is a good idea to review the information contained in the Notes & Considerations section of the Import/Merge DXF (Drawing Exchange Format) Files topic in the GASWorkS User’s Manual, as well as the following Notes & Considerations section.

The example assumes that GASWorkS has been started.

● From the Utilities menu list, select the Import item.

   ● The Model Selection screen is displayed. Enter a name for the new GASWorkS 10 model. Click the Continue command button. Note - If using an existing model, a message may be displayed asking whether to overwrite the model. Respond appropriately to return to the Model Selection screen.

   ● The Import screen is displayed. Select the DXF (Drawing Exchange Format) File item from the File Type list. Click the Import command button.

      ● The File Selection screen is displayed. Select a “.dxf” file. Click the Continue command button.

      ● The Import Specifications screen is displayed. Assign the appropriate Layer Assignment to the related Pipe Size. To reset the Pipe Layers, click the Clear Pipe Layer Assignments command button. Review the remaining settings. When finished, click the Continue command button.

      ● The Import screen is displayed again. The Import Log will update the status of the Import routine. When the routine is complete, click the Close command button to return to the GDI Window.

Notes & Considerations

● The file is expected to be in a standard DXF format as specified by the Autodesk DXF Reference. This format can be created by a variety of CAD, GIS, and graphics packages.
Use the Zoom To Fit command to display the imported model after it is first opened.

The Merge routine searches the existing model for matches between the data from the source file and the existing features using the specified Fuzzy Tolerance. If an existing pipe, node, or customer is found within the Fuzzy Tolerance of the feature being processed, GASWorkS assumes the two features to be the same, and the new feature will not be added to the model. If no existing feature is found within the Fuzzy Tolerance, the current feature will be added to the model. This can lead to some unusual processing where customers or nodes are “stacked” when the Merge routine is used. It is recommended that the User validates the results of the Merge routine before continuing with the model. The Fuzzy Tolerance value is expressed in terms of the Coordinate units.

A layer that is not assigned as a Pipe Layer, Valve Node Layer, Customer Layer, or Service Layer will not be imported.

GASWorkS supports the following entity types for pipe line work - arc, line, polyline, lwpolyline, or spline.

The first and last coordinates of each pipe segment are converted into nodes. If either coordinate matches the location of an existing node, the new pipe segment will be connected to the existing node.

If valve nodes are included, they should be represented by a block type entity.

If customers are included, they should be represented by a block or text type entity. If a text value is used, the value should represent a unique identifier for the customer. Customer entities can be “stacked” (one on top of the other) in the source file.

Customer data without specified X,Y coordinates will not be imported. A message may be displayed if no customers with coordinate data are found.

If service lines are included, they should be represented by a supported entity type for pipe line work. Service lines can only be imported as part of a DXF file that also contains pipes and customers, or merged with a model that contains existing pipes and customers.

When importing or merging customer data, GASWorkS will ask whether or not to assign the supply main connections during Import. If the Yes command button is clicked, GASWorkS will draw service connections between customers and the nearest main. It is possible that some of the assignments will be incorrect. If this occurs, use the Reassign Customer Supply Main command to make the correct assignments.

See Also

General Import & Merge Information
Import A DXF File (Example)
Reassign A Customer’s Supply Main
Zoom The GDI Image
Import A GASWorkS 7.0, 8.0, 9.0 Model

Summary

- A GASWorkS 7.0, 8.0, or 9.0 model may be imported to enter a name for the new GASWorkS 10.0 model.
- Opening a GASWorkS 7.0, 8.0, or 9.0 model in GASWorkS 10.0 will execute the Import routine.

Example

The example assumes that GASWorkS has been started.

**Import A GASWorkS 9.0 Model -**

- From the *Utilities* menu list, select the *Import* item.

  - The Model Selection screen is displayed. Enter a name for the new GASWorkS 10 model. Click the *Continue* command button. *Note* - If using an existing model, a message may be displayed asking whether to overwrite the model. Respond appropriately to return to the Model Selection screen.

  - The Import screen is displayed. Select the *GASWorkS 9.0* item from the *File Type* list. Click the *Import* command button.

    - The File Selection screen is displayed. Select a GASWorkS 9.0 model. Click the *Continue* command button.

    - The Import screen is displayed. The Import Log will update the status of the Import routine. When the routine is complete, click the *Close* command button to return to the GDI Window.

**Open A GASWorkS 9.0 Model -**

- From the *File* menu list, select the *Open* item.

  - The Model Selection screen is displayed. Select a GASWorkS 9.0 model. Click the *Continue* command button.

    - A message will be displayed identifying the file as a GASWorkS 9.0 model and ask whether to import the file now. Click the *Yes* command button to continue.
A separate (converted) set of models will be created with the same name as the original file followed by a “_10” suffix.

Notes & Considerations

- The procedure for opening or importing a GASWorkS 7.0 or 8.0 file is the same as for a GASWorkS 9.0 file.

- Models created using older versions of GASWorkS must first be imported before they can be used in GASWorkS 10.0.

- If a model created in a GASWorkS version older than 7.0 needs to be processed, contact us for additional information.

- Use the Zoom To Fit command to display the imported model after it is first opened.

- A GASWorkS 10.0 model can be exported to a GASWorkS 9.0 format. When going back to an older version, remember that the older version does not support all of the features of the newer version - some attribute data will be lost.

- There is no Merge routine for older GASWorkS files.

See Also

Export A GASWorkS 9.0 Model
General Import & Merge Information
Zoom The GDI Image
Import A KML File

Summary

GASWorkS can import data from a KML file to enter a name for the new model, or merge data from a KML file with an existing model.

Example

The example assumes that GASWorkS has been started.

- From the Utilities menu list, select the Import item.
  - The Model Selection screen is displayed. Enter a name for the new GASWorkS 10 model. Click the Continue command button. Note - If using an existing model, a message may be displayed asking whether to overwrite the model. Respond appropriately to return to the Model Selection screen.
  - The Import screen is displayed. Select the KML (Keyhole Markup Language) File item from the File Type list. Click the Import command button.
    - The File Selection screen is displayed. Select a “.kml” file. Click the Continue command button.
    - The Import Specifications screen is displayed. Assign the appropriate Folder Assignment to the related Pipe Size. To reset the Pipe Folders, click the Clear Pipe Folder Assignments command button. Review the remaining settings. When finished, click the Continue command button.
  - The Import screen is displayed again. The Import Log will update the status of the Import routine. When the routine is complete, click the Close command button to return to the GDI Window.

Notes & Considerations

- A KML file can contain several feature styles. GASWorkS 10.0 is set up to read in only “Point” or “LineString” features. A KML file must follow the official KML schema for GASWorkS to import it.

- Use the Zoom To Fit command to display the imported model after it is first opened.
KML coordinates are stored in latitude and longitude. It is recommended to use a zero (0) Fuzzy Tolerance when importing KML files, as distances between points in latitude and longitude are typically very small. Because of the latitude and longitude coordinate system, it is also recommended to specify the Node Symbol Size in “% Of Display Width”. Otherwise, node symbols will appear to be very large and may block the appearance of other model features.

When importing or merging customer data, GASWorkS will ask whether or not to assign the supply main connections during Import. If the Yes command button is clicked, GASWorkS will draw service connections between customers and the nearest main. It is possible that some of the assignments will be incorrect. If this occurs, use the Reassign Customer Supply Main command to make the correct assignments.

The Merge routine searches the existing model for matches between the data from the source file and the existing features using the specified Fuzzy Tolerance. If an existing pipe, node, or customer is found within the Fuzzy Tolerance of the feature being processed, GASWorkS assumes the two features to be the same, and the new feature will not be added to the model. If no existing feature is found within the Fuzzy Tolerance, the current feature will be added to the model. This can lead to some unusual processing where customers or nodes are “stacked” when the Merge routine is used. It is recommended that the User validates the results of the Merge routine before continuing with the model. The Fuzzy Tolerance value is expressed in terms of the Coordinate units.

Merging a KML file with a model in projected coordinates is not recommended, as it will not be possible to project the merged data from the KML file. Instead, import the KML file into its own model, project the model, and then append the two models together by selecting the Append item from the File menu list. See the Append topic in the User’s Manual for more details.

See Also

- General Import & Merge Information
- Reassign A Customer’s Supply Main
- Zoom The GDI Image
Import A SHP File - Customer

Summary

GASWorkS can import customer data from a SHP file to enter a name for the new model, or merge customer data from a SHP file with an existing model.

Example

The example assumes that GASWorkS has been started.

- From the Utilities menu list, select the Import item.

  - The Model Selection screen is displayed. Enter a name for the new GASWorkS 10 model. Click the Continue command button. Note - If using an existing model, a message may be displayed asking whether to overwrite the model. Respond appropriately to return to the Model Selection screen.

  - The Import screen is displayed. Select the SHP (ESRI Shapefile) File - Customer item from the File Type list. Click the Import command button.

    - The File Selection screen is displayed. Select a “.shp” file. Click the Continue command button.

    - The Customer Import Specifications screen is displayed. Assign the appropriate Database Field Assignment to the related GASWorkS Data Item. To reset the Data Field Assignments, click the Clear Data Field Assignments command button. Review the remaining settings. When finished, click the Continue command button.

  - The Import screen is displayed again. The Import Log will update the status of the Import routine. When the routine is complete, click the Close command button to return to the GDI Window.

Notes & Considerations

- The Import routine for customer features does not use the Fuzzy Tolerance. This allows the import of “stacked” customers.

- A shapefile actually consists of several files - one ending in a “.shp” extension which contains the spatial or geographic data, and another ending in a “.dbf” extension which contains the attribute data associated with the graphical features. A shapefile can only contain one feature style - points or lines - but not both.

- Use the Zoom To Fit command to display the imported model after it is first opened.
Customer data must be contained in a point style shapefile.

The Merge routine searches the existing model for matches between the data from the source file and the existing features using the specified Fuzzy Tolerance. If an existing pipe, node, or customer is found within the Fuzzy Tolerance of the feature being processed, GASWorkS assumes the two features to be the same, and the new feature will not be added to the model. If no existing feature is found within the Fuzzy Tolerance, the current feature will be added to the model. This can lead to some unusual processing where customers or nodes are “stacked” when the Merge routine is used. It is recommended that the User validates the results of the Merge routine before continuing with the model. The Fuzzy Tolerance value is expressed in terms of the Coordinate units.

Not every GASWorkS Data Item needs to be assigned to import customer data from a shapefile. It is a good idea to at least assign the Link ID Number.

The customer Link ID Number should represent a unique identification number for the associated customer. This allows GASWorkS customer features to be linked to an original attribute data file (.dbf) or to an outside data source like a billing or Customer Information System file. In cases where linked attribute data is not available, the Link ID Number can contain an arbitrary number, or any alphanumeric value that is useful to the User - perhaps a customer rate class type, address, name, or other identification.

When importing or merging customer data, GASWorkS will ask whether or not to assign the supply main connections during Import. If the Yes command button is clicked, GASWorkS will draw service connections between customers and the nearest main. It is possible that some of the assignments will be incorrect. If this occurs, use the Reassign Customer Supply Main command to make the correct assignments.

If a load item was included in the attribute data, the customer loads will be automatically assigned to the appropriate nodes when the service lines are assigned (or reassigned). If the loads were not included in the attribute file, the load for each customer will need to be manually or automatically assigned. Use one of the Edit Customer Data commands to manually assign or change the load value for each customer. Use the Mass Update routine or Edit Multiple Customers command to change the load values in mass. The Customer Data Attribute File feature can be used to “link” the customer features to an attribute database that can be used to automatically assign the load values.

See Also

* Edit Customer Data
* Edit Multiple Customers
* General Import & Merge Information
* Reassign A Customer’s Supply Main
* Use The Mass Update Routine
* Working With Shapefiles (SHP)
* Zoom The GDI Image
Import A SHP File - Pipe

Summary

GASWorkS can import pipe data from a SHP file to enter a name for the new model, or merge pipe data from a SHP file with an existing model.

Example

The example assumes that GASWorkS has been started.

- From the Utilities menu list, select the Import item.

  - The Model Selection screen is displayed. Enter a name for the new GASWorkS 10 model. Click the Continue command button. Note - If using an existing model, a message may be displayed asking whether to overwrite the model. Respond appropriately to return to the Model Selection screen.

  - The Import screen is displayed. Select the SHP (ESRI Shapefile) File - Pipe item from the File Type list. Click the Import command button.

    - The File Selection screen is displayed. Select a “.shp” file. Click the Continue command button.

    - The Pipe Import Specifications screen is displayed. Assign the appropriate Database Field Item to the related GASWorkS Data Item. To reset the Data Field Assignments, click the Clear Data Field Assignments command button. Review the remaining settings. When finished, click the Continue command button.

- The Import screen is displayed again. The Import Log will update the status of the Import routine. When the routine is complete, click the Close command button to return to the GDI Window.

Notes & Considerations

- The recommended procedure is to import pipe data first, then Merge any customer, regulator, or valve data.

- A shapefile actually consists of several files - one ending in a “.shp” extension which contains the spatial or geographic data, and another ending in a “.dbf” extension which contains the attribute data associated with the graphical features. A shapefile can only contain one feature style - points or lines - but not both.

- Use the Zoom To Fit command to display the imported model after it is first opened.
Pipe data must be contained in a line style shapefile.

The Merge routine searches the existing model for matches between the data from the source file and the existing features using the specified Fuzzy Tolerance. If an existing pipe, node, or customer is found within the Fuzzy Tolerance of the feature being processed, GASWorkS assumes the two features to be the same, and the new feature will not be added to the model. If no existing feature is found within the Fuzzy Tolerance, the current feature will be added to the model. This can lead to some unusual processing where customers or nodes are “stacked” when the Merge routine is used. It is recommended that the User validates the results of the Merge routine before continuing with the model. The Fuzzy Tolerance value is expressed in terms of the Coordinate units.

If a node file exists, use the Import routine on the node file first, then use the Merge routine for the pipe file. It is not necessary to import a node file; if one does not already exist, one will be created when the pipe file is imported.

Support for non-model attribute data can be accommodated using the Pipe Data Attribute File feature.

The pipe Link ID Number should represent a unique identification number for the associated pipe. This allows GASWorkS pipe features to be linked to an original attribute data file (.dbf) or to an outside data source. In cases where linked attribute data is not available, the Link ID Number can contain an arbitrary number, or any alphanumeric value that is useful to the User.

A shapefile package may include a projection file (.prj) to convert the data from latitude/longitude coordinates to plane coordinates. When the shapefile is imported, if a projection file is present, GASWorkS will create a copy of the projection file under the same name and in the same folder as the model.

**See Also**

- General Import & Merge Information
- Merge A SHP File - Service
- Merge A SHP File - Valve
- Working With Shapefiles (SHP)
- Zoom The GDI Image
Import A Stoner PD/XY File

Summary

The PD/XY files were originally supported by Stoner Software’s GASSS program. GASWorkS can import data from a PD file to enter a name for the new model.

Example

The example assumes that GASWorkS has been started.

- From the Utilities menu list, select the Import item.
  - The Model Selection screen is displayed. Enter a name for the new GASWorkS 10 model. Click the Continue command button. Note - If using an existing model, a message may be displayed asking whether to overwrite the model. Respond appropriately to return to the Model Selection screen.
  - The Import screen is displayed. Select the Stoner PD/XY File item from the File Type list. Click the Import command button.
    - The File Selection screen is displayed. Select a “.pd” file. Click the Continue command button.
    - The Import screen is displayed again. The Import Log will update the status of the Import routine. When the routine is complete, click the Close command button to return to the GDI Window.

Notes & Considerations

- An XY file is not required to import a PD file. If one is detected, the graphical data contained in the XY file will be assigned to the pipes and nodes imported from the PD file.

- Use the Zoom To Fit command to display the imported model after it is first opened.

- There is no Merge routine for PD/XY files.

See Also

General Import & Merge Information
Zoom The GDI Image
GASWorkS™ 10.0  Import & Merge Routines

Merge A SHP File - Service

Summary

GASWorkS can merge service data from a SHP file with an existing model.

Example

Note - Service data must be merged with an existing model that contains both pipe and customer data.

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- From the Utilities menu list, select the Merge item.
  - The Merge screen is displayed. Select the SHP (ESRI Shapefile) File - Service item from the File Type list. Click the Merge command button.
    - The File Selection screen is displayed. Select a “.shp” file. Click the Continue command button.
    - A message may be displayed asking whether to merge the data in the file with the existing model. Click the Yes command button to proceed.
    - The Service Merge Specifications screen is displayed. Assign the appropriate Database Field Item to the related GASWorkS Data Item. To reset the Data Field Assignments, click the Clear Data Field Assignments command button. Review the remaining settings. When finished, click the Continue command button.
    - The Merge screen is displayed. The Merge Log will update the status of the Merge routine. When the routine is complete, click the Close command button to return to the GDI Window.

Notes & Considerations

- Service data must be contained in a line style shapefile.
- There is no Import routine for SHP service files.
- A shapefile actually consists of several files - one ending in a “.shp” extension which contains the spatial or geographic data, and another ending in a “.dbf” extension which contains the attribute data associated with the graphical features. A shapefile can only contain one feature style - points or lines - but not both.
The Merge routine for services checks the coordinates of each service line for a match with an existing customer using the Fuzzy Tolerance. A customer has to be located at either the first or last set of coordinates within the service line for a match to be found. When the Merge routine is complete, GASWorkS will notify the User if any services were unable to be matched with customers.

After matching a service to a customer, GASWorkS looks for a service tap at the other end of the service line. If a pipe exists within the specified Fuzzy Tolerance of the coordinates, a match is found, and a service tap is created. When the Merge routine is complete, GASWorkS will notify the User if any services were unable to be matched with pipes for service taps.

Once the customer and service tap are assigned, any remaining coordinate sets contained in the service line data are imported as vertices.

The Fuzzy Tolerance value is expressed in terms of the Coordinate units. The lower the Fuzzy Tolerance, the smaller the area GASWorkS will search for existing features. As a general rule, the higher the precision of the existing data, the lower the Fuzzy Tolerance, and vice versa. It may take several attempts to determine the appropriate value for a data set.

See Also

General Import & Merge Information
Working With Shapefiles (SHP)
Merge A SHP File - Valve

Summary

GASWorkS can merge valve data from a SHP file with an existing model.

Example

Note - Valve data must be merged with an existing model.

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

● From the Utilities menu list, select the Merge item.

   ● The Merge screen is displayed. Select the SHP (ESRI Shapefile) File - Valve item from the File Type list. Click the Merge command button.

   ● The File Selection screen is displayed. Select a “.shp” file. Click the Continue command button.

   ● A message may be displayed asking whether to merge the data in the file with the existing model. Click the Yes command button to proceed.

   ● The Valve Merge Specifications screen is displayed. Assign the appropriate Database Field Item to the related GASWorkS Data Item. To reset the Data Field Assignments, click the Clear Data Field Assignments command button. Review the remaining settings. When finished, click the Continue command button.

   ● The Merge screen is displayed. The Merge Log will update the status of the Merge routine. When the routine is complete, click the Close command button to return to the GDI Window.

Notes & Considerations

● A shapefile actually consists of several files - one ending in a “.shp” extension which contains the spatial or geographic data, and another ending in a “.dbf” extension which contains the attribute data associated with the graphical features. A shapefile can only contain one feature style - points or lines - but not both.

● There is no Import routine for SHP valve files.

● Valve data must be contained in a point style shapefile.
The Merge routine searches the existing model for matches between the data from the source file and the existing features using the specified Fuzzy Tolerance. If an existing pipe, node, or customer is found within the Fuzzy Tolerance of the feature being processed, GASWorkS assumes the two features to be the same, and the new feature will not be added to the model. If no existing feature is found within the Fuzzy Tolerance, the current feature will be added to the model. This can lead to some unusual processing where customers or nodes are “stacked” when the Merge routine is used. It is recommended that the User validates the results of the Merge routine before continuing with the model. The Fuzzy Tolerance value is expressed in terms of the Coordinate units.

See Also

- General Import & Merge Information
- Working With Shapefiles (SHP)
Table Of Contents
EXPORT ROUTINES
GASWorkS™ 10.0

Export Routines

Table Of Contents

General Export Information

GASWorkS provides two methods for exporting data for use with other applications - the Export routine found in the Utilities menu, and the Quick Export routines found in the File menu. The following table lists the available methods for each supported data type.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Supported By</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Export</td>
</tr>
<tr>
<td>CSV (Comma Separated Values) File - Customer</td>
<td>✓</td>
</tr>
<tr>
<td>CSV (Comma Separated Values) File - Node</td>
<td>✓</td>
</tr>
<tr>
<td>CSV (Comma Separated Values) File - Pipe</td>
<td>✓</td>
</tr>
<tr>
<td>CSV File Set</td>
<td></td>
</tr>
<tr>
<td>DBF (dBase Format) File - Customer</td>
<td>✓</td>
</tr>
<tr>
<td>DBF (dBase Format) File - Node</td>
<td>✓</td>
</tr>
<tr>
<td>DBF (dBase Format) File - Pipe</td>
<td>✓</td>
</tr>
<tr>
<td>DBF 3.0 File Set</td>
<td></td>
</tr>
<tr>
<td>DXF (Drawing Exchange Format) File</td>
<td>✓</td>
</tr>
<tr>
<td>GASWorkS 9.0 Model</td>
<td>✓</td>
</tr>
<tr>
<td>KML (Keyhole Markup Language) File</td>
<td>✓</td>
</tr>
<tr>
<td>SHP (ESRI Shapefile) File - Customer</td>
<td>✓</td>
</tr>
<tr>
<td>SHP (ESRI Shapefile) File - Node</td>
<td>✓</td>
</tr>
<tr>
<td>SHP (ESRI Shapefile) File - Pipe</td>
<td>✓</td>
</tr>
<tr>
<td>SHP File Set</td>
<td></td>
</tr>
<tr>
<td>Stoner PD/XY File</td>
<td>✓</td>
</tr>
<tr>
<td>XLS 8.0 Workbook</td>
<td></td>
</tr>
<tr>
<td>XLS (Excel) 8.0 &amp; 97 Workbook - Customer, Node, Pipe</td>
<td>✓</td>
</tr>
<tr>
<td>XLS (Excel) 8.0 &amp; 97 Worksheet - Customer</td>
<td>✓</td>
</tr>
<tr>
<td>XLS (Excel) 8.0 &amp; 97 Worksheet - Node</td>
<td>✓</td>
</tr>
</tbody>
</table>
See the GASWorkS User’s Manual for additional information on each specific Export routine.
Export A CSV File - Customer, Node, Or Pipe

Summary

Customer, node, or pipe data from GASWorkS can be exported to a CSV file.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- From the Utilities menu list, select the Export item.

  - The Export screen is displayed. Select one of the CSV (Comma Separated Values) File items from the File Type list. Click the Export command button.

    - The File Selection screen is displayed with a default Filename and location in the data field. Either accept the default Filename and location or to change the Filename and location. Click the Continue command button. Note - The default naming convention assigns the first letter of the chosen feature to the end of the model name. For example, a pipe CSV file would end in “_p.csv”. Note - If using an existing file, a message may be displayed asking whether to overwrite the file - respond appropriately.

    - The Export screen is displayed again. The Export Log section will display the status of the Export routine. When the routine is complete, click the Close command button.

Notes & Considerations

- CSV files can be used to create spreadsheets in programs such as Microsoft Excel.

- The Quick Export routine can be used to create a spreadsheet from the model data. Select the CSV File Set item from the Quick Export submenu from the File menu list. See the Quick Export topic in the User’s Manual for more information.

See Also

General Export Information
Export A DBF File - Customer, Node, Or Pipe

Summary

Customer, node, or pipe data from GASWorkS can be exported to a DBF file.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- From the Utilities menu list, select the Export item.
  - The Export screen is displayed. Select one of the DBF (dBase Format) File items from the File Type list. Click the Export command button.
    - The File Selection screen is displayed with a default Filename and location in the data field. Either accept the default Filename and location or to change the Filename and location. Click the Continue command button. Note - The default naming convention assigns the first letter of the chosen feature to the end of the model name. For example, a pipe DBF file would end in “_p.dbf”. Note - If using an existing file, a message will be displayed asking whether to overwrite the file - respond appropriately.
    - The Export screen is displayed again. The Export Log section will display the status of the Export routine. When the routine is complete, click the Close command button.

Notes & Considerations

- The DBF Export routine creates a dBase III format (DBF) file with a “.dbf” extension using the customer, node, or pipe data. Once created, the DBF file can be imported or opened by a variety of programs, including spreadsheet programs like Microsoft Excel.

- The Quick Export routine can be used to create a dBase III, IV, or V format file from the model data. Select the DBF 3.0 File Set item from the Quick Export submenu from the File menu list. See the Quick Export topic in the User’s Manual for more information.

- DBF files are created during the Export SHP routine.

- GASWorkS uses dBase IV format files as attribute files for linking customer, node, and pipe data to a database. See the Attribute Data section of the User’s Manual for more information.
See Also

Export A SHP File - Customer, Node, Or Pipe
General Export Information
Export A DXF File

Summary

Model data from GASWorkS can be exported to a DXF file.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- From the Utilities menu list, select the Export item.
  - The Export screen is displayed. Select the DXF (Drawing Exchange Format) File item from the File Type list. Click the Export command button.
    - The File Selection screen is displayed with a default Filename and location in the data field. Either accept the default Filename and location or to change the Filename and location. Click the Continue command button. Note - If using an existing file, a message will be displayed asking whether to overwrite the file - respond appropriately.
    - The DXF Export Setting screen is displayed. Review the settings. When finished, click the Continue command button.
    - The Export screen is displayed again. The Export Log section will display the status of the Export routine. When the routine is complete, click the Close command button.

Notes & Considerations

- The DXF Export routine creates a drawing exchange format (DXF) file. Once created, the DXF file can be imported or opened by CAD and graphics packages such as AutoCAD and Microstation.

- On the General data tab of the DXF Export Settings screen is a Use Template File option. GASWorkS provides a default template file in the “GASWorkS 10\Support\cad” directory. It is recommended to use this template file when exporting a DXF file to be used in a CAD program such as AutoCAD. However, a DXF file exported with this template cannot be imported back into GASWorkS.

See Also

General Export Information
Export A GASWorkS 9.0 Model

Summary

GASWorkS 10.0 model data may be exported to a GASWorkS 9.0 model.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- From the Utilities menu list, select the Export item.

- The Export screen is displayed. Select the GASWorkS 9.0 Model item from the File Type list. Click the Export command button.

- The File Selection screen is displayed with a default Filename and location in the data field. Either accept the default Filename and location or to change the Filename and location. Click the Continue command button. Note - If using an existing file, a message will be displayed asking whether to overwrite the file - respond appropriately.

- The Export screen is displayed again. The Export Log section will display the status of the Export routine. When the routine is complete, click the Close command button.

Notes & Considerations

- The Export routine creates a complete GASWorkS 9.0 file set, which can be opened by a program that supports GASWorkS 9.0 model data.

- The Quick Export routine can be used to create a GASWorkS 9.0 model from the GASWorkS 10.0 model data. Select the GASWorkS 9.0 item from the Quick Export submenu from the File menu list. See the Quick Export topic in the User’s Manual for more information.

- When exporting a model to a previous version of GASWorkS, remember that older versions do not support all of the features of GASWorkS 10.0 - some attribute data may be lost.

See Also

General Export Information
Export A KML File

Summary

Model data from GASWorkS can be exported to a KML file.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

● From the Utilities menu list, select the Export item.
  
  ● The Export screen is displayed. Select the KML (Keyhole Markup Language) File item from the File Type list. Click the Export command button.
  
  ● The File Selection screen is displayed with a default Filename and location in the data field. Either accept the default Filename and location or to change the Filename and location. Click the Continue command button. Note - If using an existing file, a message will be displayed asking whether to overwrite the file - respond appropriately.
  
  ● The KML Export Setting screen is displayed. Review the settings. When finished, click the Continue command button.
  
  ● The Export screen is displayed again. The Export Log section will display the status of the Export routine. When the routine is complete, click the Close command button.

Notes & Considerations

● The KML Export routine creates a Keyhole Markup Language (KML) file. Once created, the KML file can be imported or opened by mapping programs such as Google Earth.

● To export to a KML file, the model needs to be in longitude and latitude coordinates. If the model is not in the proper coordinates a message will be displayed asking to project the coordinates. Respond appropriately.

See Also

General Export Information
Project A Model
Export A SHP File - Customer, Node, Or Pipe

Summary

Customer, node, or pipe data from GASWorkS can be exported to a SHP file.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- From the Utilities menu list, select the Export item.
  - The Export screen is displayed. Select one of the SHP (ESRI Shapefile) File items from the File Type list. Click the Export command button.
    - The File Selection screen is displayed with a default Filename and location in the data field. Either accept the default Filename and location or to change the Filename and location. Click the Continue command button. Note - If using an existing file, a message will be displayed asking whether to overwrite the file - respond appropriately.
    - The Projection Specification screen is displayed. Select the projection file to be used. Click the Continue command button. Note - If exporting customer data, a message may be displayed asking whether to export the services. Either click the Yes command button to export the services to a line style SHP file; the filename will end in “_s.shp”, or click the No command button to export the customers only.
    - The Export screen is displayed again. The Export Log section will display the status of the Export routine. When the routine is complete, click the Close command button.

Notes & Considerations

- A shapefile actually consists of several files. The essential files are a “shape” format file ending in a “.shp” extension which contains the spatial or geographic data, and an “attribute” format file ending in a “.dbf” extension which contains the attribute data associated with the graphical features. A shapefile can only contain one feature style. That is, a shapefile can only contain point or line features, but not both. Exporting pipe or service data creates an arc (line) style file. Exporting customer or node data creates a point file.

- The default naming convention assigns the first letter of the chosen feature to the end of the model name. For example, a pipe SHP file would end in “_p.shp”.
The Quick Export routine can be used to create a shapefile from the model data. Select the SHP File Set item from the Quick Export submenu from the File menu list. See the Quick Export topic in the User’s Manual for more information.

Shapefiles can be imported or opened by graphical information system (GIS) and CAD programs. The shapefile is the standard file format used by ESRI ArcGIS software.

See Also

General Export Information
Working With Shapefiles (SHP)
Export A Stoner PD/XY File

Summary

Node or pipe data from GASWorkS can be exported to PD/XY files. The PD/XY files were originally supported by Stoner Software’s GASSS program.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- From the Utilities menu list, select the Export item.
  - The Export screen is displayed. Select the Stoner PD/XY File item from the File Type list. Click the Export command button.
    - The File Selection screen is displayed with a default Filename and location in the data field. Either accept the default Filename and location or to change the Filename and location. Click the Continue command button. Note - If using an existing file, a message will be displayed asking whether to overwrite the file - respond appropriately.
    - The Export screen is displayed again. The Export Log section will display the status of the Export routine. When the routine is complete, click the Close command button.

Notes & Considerations

None

See Also

General Export Information
Export A XLS File - Customer, Node, Or Pipe

Summary

Customer, node, or pipe data from GASWorkS can be exported to an XLS file.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- From the Utilities menu list, select the Export item.
  - The Export screen is displayed. Select one of the XLS (Excel) 8.0 & 97 items from the File Type list. Click the Export command button.
    - The File Selection screen is displayed with a default Filename and location in the data field. Either accept the default Filename and location or to change the Filename and location. Click the Continue command button. Note - If using an existing file, a message will be displayed asking whether to overwrite the file - respond appropriately.
    - If exporting customer data, a message may be displayed asking whether to export the services. Either click the Yes command button to export the services to a line style SHP file; the filename will end in “_s.shp”, or click the No command button to export the customers only.
  - The Export screen is displayed again. The Export Log section will display the status of the Export routine. When the routine is complete, click the Close command button.

Notes & Considerations

- The default naming convention assigns the first letter of the chosen feature to the end of the model name. For example, a pipe XLS file would end in “.p.xls”.

See Also

General Export Information
GDI COMMANDS
Add A 2-Point Pipe

Summary

Adds a 2-point pipe feature (a straight pipe with only a From Node and To Node).

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Click the Add 2-Point Pipe icon from the Graphic Construction Commands Toolbar.

- At the From Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The From Node will be placed at the selected location.

- Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- At the To Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The To Node will be placed at the selected location.

- Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- The pipe feature will be placed at the selected location.

- Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

Notes & Considerations

- This command can also be executed by selecting the Add 2-Point Pipe item from the GDI Command List, or by typing ADDPIPE or ADDP on the GDI Command Line and pressing the Enter key.
To change the Pipe Data, either use the *Edit Pipe Data* command or left-click on the desired pipe feature to display the data in the Data Panel.

To change the Node Data, either use the *Edit Node Data* command or left-click on the desired node to display the data in the Data Panel.

To change the location of a pipe feature, use the *Move Pipe* command. To change the location of one end of a pipe, use the *Move Pipe End* command or grips.

The *Hydraulic Length* is the value used for the pipe length in the GASWorkS calculations. The initial *Hydraulic Length* value is equal to the graphic length in the GDI Display. The *Hydraulic Length* value can be changed in the Pipe Data in the Data Panel or by using the *Edit Pipe Data* command.

To remove a pipe feature from the model, use the *Delete Pipe* command.

If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- *Delete A Pipe*
- *Edit Node Data*
- *Edit Pipe Data*
- *Grips*
- *Move A Pipe*
- *Move A Pipe End*
- *Set A Feature’s Location*
- *Undo The Last Data Or Graphic Change*
- *Use The Data Panel*
Add An Arc Pipe

Summary

Adds an arc-style pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Click the Add Arc Pipe icon from the Graphic Construction Commands Toolbar.

- At the From Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The From Node will be placed at the selected location.

- Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- At the To Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The To Node will be placed at the selected location.

- Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- At the Adjust Curve prompt, use one of the following methods:

  - Graphic - Move the mouse crosshairs to adjust the direction and radius of the arc in the GDI Display, then left-click the mouse. The arc will be drawn between the two nodes with the drawn angle.

  - Radius - Type the letter “R”, followed by an equal “=” sign, followed by a radius value in Coordinate units on the GDI Prompt Line and press the Enter key. The arc will be drawn between the two nodes with the specified radius.

  - Delta - Type the letter “D”, followed by an equal “=” sign, followed by a delta angle value in decimal degrees on the GDI Prompt Line and press the Enter key. The arc will be drawn between the two nodes with the specified delta angle.
GASWorkS™ 10.0

GDI Commands

**Table Of Contents**

- Semicircle - Type the letter “S”, followed by an equal “=” sign, followed by either “-1” for a counter-clockwise semicircle between the From Node and the To Node, “0” for a straight arc between the From Node and the To Node, or “1” for a clockwise semicircle between the From Node and the To Node on the GDI Prompt Line and press the Enter key.

  - **Note** - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

  - The arc pipe feature will be placed at the selected location.

**Notes & Considerations**

- This command can also be executed by selecting the Add Arc Pipe item from the GDI Command List, or by typing ADDARCPipe or ADDARC on the GDI Command Line and pressing the Enter key.

- To change the Pipe Data, either use the Edit Pipe Data command or left-click on the desired pipe feature to display the data in the Data Panel.

- To change the Node Data, either use the Edit Node Data command or left-click on the desired node to display the data in the Data Panel.

- To change the curve of an arc pipe after it has been added, use the Adjust Arc Pipe command.

- To change the location of an arc pipe feature, use the Move Pipe command. To change the location of one end of the arc pipe, either use the Move Pipe End command or the grips.

- The Hydraulic Length is the value used for the pipe length in the GASWorkS calculations. The initial Hydraulic Length value is equal to the graphic length in the GDI Display. The Hydraulic Length value can be changed in the Pipe Data in the Data Panel or by using the Edit Pipe Data command.

- To remove an arc pipe feature from the model, use the Delete Pipe command.

- If the Allow Undo Of Data/Graphic Changes Preference Settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Adjust An Arc Pipe
Delete A Pipe
Edit Node Data
Edit Pipe Data
Grips
Move A Pipe
Move A Pipe End
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Use The Data Panel
Add A Branch Customer

Summary

Adds a branch-style customer feature. A branch customer can only be added to an existing non-branch customer feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one trunk customer is present in the model. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Click the Add Branch Customer icon from the Customer Commands Toolbar.
- At the Select Branch Customer Location prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. A customer symbol will be displayed at the selected location.
- At the Select Customer To Branch From prompt, move the mouse pointer to a customer symbol and left-click the mouse. The selected customer will be highlighted. Note - A message may be displayed if the selected customer is not connected to a trunk service. Click the OK command button to clear the message.
- At the Select New Tap Location prompt, move the mouse crosshairs to a location on the highlighted service line and left-click the mouse.
- Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Customer Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.
- A service line will be drawn from the branch customer location to the selected tap location on the trunk service line.

Notes & Considerations

- This command can also be executed by selecting the Add Branch Customer item from the GDI Command List, or by typing ADDBRANCHCUST or ADDBRANCH on the GDI Command Line and pressing the Enter key.
A trunk customer service runs from the customer location to a tap location on a supply main. A branch customer service taps off of a trunk service rather than a main. Branch customers are assigned to the supply main of their trunk customer. Each trunk customer can only have one branch customer.

Branch services run in a straight line from the branch customer symbol to the tap location on the trunk service line.

To create a branch and a trunk customer from two existing customers, use the Create Branch Customer Tap command.

To change the Customer Data, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.

To change a customer's location, either use the Move Customer command or grips.

To move a branch service tap to a different trunk service, use the Move Branch Service Tap command.

The Node Load Application item in the Customer Data determines where the customer load is applied to in the model. The “From Node” option adds the entire value to the From Node of the tapped supply main. The “To Node” option adds the entire value to the To Node. The “Both Nodes” option splits the customer load evenly between the From Node and the To Node. The customer load value is added to the External Load of the chosen node(s). The “None” option does not apply the value to either node. The “Diversified” option indicates to use the selected Diversity load calculation method.

To remove a customer feature from the model, use the Delete Customer command.

If the Allow Undo Of Data/Graphic Changes Preference Settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Customer
Create A Branch Customer Tap
Delete A Customer
Edit Customer Data
Grips
Move A Branch Service Tap
Move A Customer
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Add A Compressor

Summary

Adds a compressor type “pipe” feature to the model.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Click the Add Compressor icon from the Graphic Construction Commands Toolbar.

- At the From (Suction/Upstream) Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The From Node will be placed at the selected location.

  Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- At the To (Discharge/Downstream) Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The To Node will be placed at the selected location.

  Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- At the Compressor Size & Type prompt, select the desired item from the GDI Prompt List.

- At the Control Style prompt, select the desired item from the GDI Prompt List.

- At the Control Pressure prompt, type a value on the GDI Prompt Line and press the Enter key. The pipe feature will be placed at the selected location.

  Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- The compressor symbol will be placed on the pipe feature.
Notes & Considerations

- This command can also be executed by selecting the *Add Compressor* item from the GDI Command List, or by typing ADDCOMPRESSOR or ADDCOMP on the GDI Command Line and pressing the *Enter* key.

- The From Node represents the upstream (suction) side of the compressor and the To Node represents the downstream (discharge) side of the compressor. The compressor symbol will automatically display “facing” in the direction of gas flow.

- To turn the display of compressor symbols “on” or “off”, use the *Display Pipe Symbols* command.

- To change the Compressor Pipe Data, either use the *Edit Pipe Data* command or left-click on the desired pipe feature to display the data in the Data Panel.

- To reverse the From Node and To Node, use the *Swap Pipe Ends* command.

- To change the location of a pipe feature, use the *Move Pipe* command. To change the location of one end of the arc pipe, either use the *Move Pipe End* command or the grips.

- When connecting compressors in a series, at least one pipe feature should be placed between the compressors.

- Compressor properties can be viewed or changed on the *Compressor* data tab of the Property Table Report. To access the report, select the *Property Tables* item from the *Edit* menu list.

- The size of the compressor symbol is set by the *Pipe Symbol Size* value on the Graphic Settings screen. To access the screen, select the *Settings* item from the *Graphics* menu list.

- To remove a compressor from the model, as well as remove the pipe feature, use the *Delete Pipe* command.

- If the *Allow Undo Of Data/Graphic Changes* Preference Settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.
See Also

Delete A Pipe
Display The Pipe Symbols
Edit Pipe Data
Grips
Insert A Compressor
Move A Pipe
Move A Pipe End
Set A Feature’s Location
Swap A Pipe’s Ends (The From Node & To Node)
Undo The Last Data Or Graphic Change
Use The Data Panel
Add A Customer

Summary

Adds a simple customer feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Click the Add Customer icon from the Customer Commands Toolbar.

- At the Select Customer Location prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. A customer symbol will be displayed at the selected location.

- At the Select Supply Main prompt, move the mouse pointer to a pipe feature and left-click the mouse. Note - A message may be displayed if the selected pipe cannot have customers attached. Click the OK command button to return to the prompt.

- Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Customer Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- A tap will be placed at the point on the supply main closest to the customer location. A service line will be drawn between the customer location and the tap location.

Notes & Considerations

- This command can also be executed by selecting the Add Customer item from the GDI Command List, or by typing ADDCUSTOMER or ADDCUST on the GDI Command Line and pressing the Enter key.

- To change the Customer Data, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.

- To change a customer’s location, either use the Move Customer command or grips.
To change the location of the service tap along a supply main, either use the *Move Service Tap* command or grips.

To change a customer’s supply main, use the *Reassign Customer Supply Main* command.

The *Node Load Application* item in the Customer Data determines where the customer load is applied to in the model. The “From Node” option adds the entire value to the From Node of the tapped supply main. The “To Node” option adds the entire value to the To Node. The “Both Nodes” option splits the customer load evenly between the From Node and the To Node. The customer load value is added to the *External Load* of the chosen node(s). The “None” option does not apply the value to either node. The “Diversified” option indicates to use the selected Diversity load calculation method.

To remove a customer feature from the model, use the *Delete Customer* command.

If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Delete A Customer
- Edit Customer Data
- Grips
- Move A Customer
- Move A Service Tap
- Reassign A Customer’s Supply Main
- Select A Feature
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Add A Customer & Automatically Assign The Main

Summary

Adds a simple customer feature and automatically assigns the customer to the main nearest the selected customer location.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Click the Add Customer - Auto Assign Main icon from the Customer Commands Toolbar.

- At the Select Customer Location prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. A customer symbol will be displayed at the selected location.

- Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Customer Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- A service line will be drawn from the customer location to the assigned supply main, and the tap will be placed at the intersection between the service and the main.

Notes & Considerations

- This command can also be executed by selecting the Add Customer - Auto Assign Main item from the GDI Command List, or by typing ADDAUTOCUSTOMER or AUTOCUST on the GDI Command Line and pressing the Enter key.

- When searching for the nearest main, only mains whose Facility Type is set to “Active” are considered. The “Active” setting can be found on the Facility Settings screen. To access the screen, select the Facility Settings item from the Edit menu list.

- To change the Customer Data, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.

- To change a customer’s location, either use the Move Customer command or grips.
- To change the location of the service tap along a supply main, either use the *Move Service Tap* command or grips.

- To change a customer’s supply main, use the *Reassign Customer Supply Main* command.

- The *Node Load Application* item in the Customer Data determines where the customer load is applied to in the model. The “From Node” option adds the entire value to the From Node of the tapped supply main. The “To Node” option adds the entire value to the To Node. The “Both Nodes” option splits the customer load evenly between the From Node and the To Node. The customer load value is added to the *External Load* of the chosen node(s). The “None” option does not apply the value to either node. The “Diversified” option indicates to use the selected Diversity load calculation method.

- To remove a customer feature from the model, use the *Delete Customer* command.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Delete A Customer
- Edit Customer Data
- Grips
- Move A Customer
- Move A Service Tap
- Reassign A Customer's Supply Main
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Add A Customer With A Tap Location

Summary

Adds a customer feature and allows the User to select the tap location on the main.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Select the Add Customer - With Tap item from the GDI Command List.
- At the Select Customer Location prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. A customer symbol will be displayed at the selected location.
- At the Select Supply Main Tap Location prompt, move the mouse pointer to a pipe feature and left-click the mouse. Note - A message may be displayed if the selected pipe cannot have customers attached. Click the OK command button to return to the prompt.
- Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Customer Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.
- A service line will be drawn from the customer location to the selected tap location on the assigned supply main.

Notes & Considerations

- This command can also be executed by typing ADDCUSTOMERTAP or ADDTAP on the GDI Command Line and pressing the Enter key.
- To change the Customer Data, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.
- To change a customer’s location, either use the Move Customer command or grips.
To change the location of the service tap along a supply main, either use the Move Service Tap command or grips.

To change a customer’s supply main, use the Reassign Customer Supply Main command.

The Node Load Application item in the Customer Data determines where the customer load is applied to in the model. The “From Node” option adds the entire value to the From Node of the tapped supply main. The “To Node” option adds the entire value to the To Node. The “Both Nodes” option splits the customer load evenly between the From Node and the To Node. The customer load value is added to the External Load of the chosen node(s). The “None” option does not apply the value to either node. The “Diversified” option indicates to use the selected Diversity load calculation method.

To remove a customer feature from the model, use the Delete Customer command.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Delete A Customer
Edit Customer Data
Grips
Move A Customer
Move A Service Tap
Reassign A Customer’s Supply Main
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Add A Duplicate Customer

Summary

Adds a new customer feature by duplicating an existing customer feature at the same location as the “base” customer.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the Add Customer - Duplicate item from the GDI Command List.
- At the Select Customer To Duplicate prompt, move the mouse pointer to a customer feature and left-click the mouse. The selected customer will be highlighted.
- At the Number Of Customers To Duplicate prompt, type a value on the GDI Prompt Line and press the Enter key. This sets the number of duplicate customers to be created.
- Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Customer Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button. The Customer Data will be displayed for the number of customers duplicated.

Notes & Considerations

- This command can also be executed by typing ADDDUPLICATECUSTOMER or ADDDUP on the GDI Command Line and pressing the Enter key.
- All values associated with the “base” customer are duplicated, except for the Record Number, Internal ID Number, and Link ID Number.
- Duplicate customers are assigned the next available customer Internal ID Number. For example, if the highest existing customer Internal ID Number in the model is 12, and three duplicate customers are added, the Internal ID Number for the duplicate customers will be 13, 14, and 15, respectively.
- Duplicate customers are placed at the same location as the “base” customer. Left-clicking on that customer location will display the Multiple Customers Found screen. Each customer is listed by either the Record Number or Link ID Number. From this screen, select an ID Number from the list to access an individual customer’s data.
To change the Customer Data, either use the *Edit Customer Data* command or left-click on the desired customer feature to display the data in the Data Panel.

To change a customer’s location, either use the *Move Customer* command or grips.

To change the location of the service tap along a supply main, either use the *Move Service Tap* command or grips.

To change a customer’s supply main, use the *Reassign Customer Supply Main* command.

To remove a customer feature from the model, use the *Delete Customer* command.

If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

### See Also

- Add A Customer
- Delete A Customer
- Edit Customer Data
- Grips
- Move A Customer
- Move A Service Tap
- Reassign A Customer’s Supply Main
- Select A Feature
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Add A Feature To A Group

Summary

Adds a pipe, User Graphic, or User Text feature to an existing group.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one pipe, User Graphic, or User Text feature is present, and a group has been created in the model.

- Select the Add Feature To Group item from the GDI Command List.

- At the Select A Feature In The Desired Group To Add Feature To prompt, move the mouse pointer to a pipe, User Graphic, or User Text feature that is part of a group and left-click the mouse. The selected feature’s group will be highlighted. Note - A message may be displayed if the selected feature is not part of a group. Click the OK command button to return to the prompt.

- At the Select First Feature prompt, move the mouse pointer to another pipe, User Graphic, or User Text feature to add to the group and left-click the mouse. The selected feature will be highlighted.

- At the Select Another Feature prompt, use the method above to select additional features for the group. When finished, right-click the mouse. Note - A message may be displayed if one of the selected features is part of another group. Either click the Yes command button to remove the feature from their original group and add them to the selected group, or click the No command button to keep them in their current group.

- A message will be displayed stating the Group ID and the number of features added to the group. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing ADDTOGROUP or ADDGRP on the GDI Command Line and pressing the Enter key.

- To unselect (unhighlight) a selected (highlighted) feature, move the mouse pointer to the selected feature and left-click the mouse. The feature will be unhighlighted, indicating it is no longer selected.

- Customers are not considered to be part of a group. If they are assigned to a pipe that is part of a group, and that group is moved, the customer locations will move along with their assigned pipe.
To create a set of features, use the *Create Group* command.

To remove features from an existing group, use the *Remove Feature From Group* command.

To remove a group and all of its features from the model, use the *Delete Group* command.

If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Add A User Graphic Image
Add A User Graphic Line
Add A User Graphic Symbol
Add User Text
Create A Group
Delete A Group
Remove A Feature From A Group
Select A Feature
Undo The Last Data Or Graphic Change
Add A Fitting

Summary

Adds a fitting type “pipe” feature.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

• Click the Add Fitting icon from the Graphic Construction Commands Toolbar.

• At the From Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The From Node will be placed at the selected location.

• Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

• At the To Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The To Node will be placed at the selected location.

• Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

• At the Fitting Size & Type prompt, select the desired item from the GDI Prompt List.

• The pipe feature will be placed at the selected location.

• Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.
Notes & Considerations

- This command can also be executed by selecting the Add Fitting item from the GDI Command List, or by typing ADDFITTING or ADDFIT on the GDI Command Line and pressing the Enter key.

- The Equivalent Length value in the Calculated Values section of the Pipe Data is used for fittings in the solution instead of the Hydraulic Length used for pipes. The Equivalent Length is unaffected by the graphic length of the feature.

- Another option for modeling fittings is to attach them to a pipe. This can be done in the Attached Fittings section of the Pipe Data.

- To change the Pipe Data, either use the Edit Pipe Data command or left-click on the desired pipe feature to display the data in the Data Panel.

- To change the Node Data, either use the Edit Node Data command or left-click on the desired node to display the data in the Data Panel.

- To change the location of a pipe feature, use the Move Pipe command. To change the location of one end of a pipe, use the Move Pipe End command or grips.

- To remove a fitting from the model, use the Remove Fittings command.

- Fitting properties can be viewed or changed from the Fitting data tab of the Property Table Report. To access the report, select the Property Tables item from the Edit menu list.

- If the Allow Undo Of Data/Graphic Changes Preference Settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Attach A Fitting To A Pipe
Edit Node Data
Edit Pipe Data
Grips
Move A Pipe
Move A Pipe End
Remove Attached Fittings
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Use The Data Panel
Add Multiple Customers

Summary

Adds multiple customer features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Select the Add Multiple Customers item from the GDI Command List.
- At the Select Customer Location prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. A customer symbol will be displayed at the selected location.
- At the Select Supply Main prompt, move the mouse pointer to a pipe feature and left-click the mouse. Note - A message may be displayed if the selected pipe cannot have customers attached. Click the OK command button to return to the prompt.
- Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Customer Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.
- A service line will be drawn from the customer location to the assigned supply main, and the tap will be placed at the intersection between the service and the main.
- The Select Customer Location prompt will be displayed again. Repeat the steps above to add more customer features. When finished, right-click the mouse to end the command.

Notes & Considerations

- This command can also be executed by typing ADDMULTICUST on the GDI Command Line and pressing the Enter key.
- To change the Customer Data, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.
● To change a customer’s location, either use the Move Customer command or grips.

● To change the location of the service tap along a supply main, either use the Move Service Tap command or grips.

● To change a customer’s supply main, use the Reassign Customer Supply Main command.

● The Node Load Application item in the Customer Data determines where the customer load is applied to in the model. The “From Node” option adds the entire value to the From Node of the tapped supply main. The “To Node” option adds the entire value to the To Node. The “Both Nodes” option splits the customer load evenly between the From Node and the To Node. The customer load value is added to the External Load of the chosen node(s). The “None” option does not apply the value to either node. The “Diversified” option indicates to use the selected Diversity load calculation method.

● To remove a customer feature from the model, use the Delete Customer command.

● If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Delete A Customer
Edit Customer Data
Grips
Move A Customer
Move A Service Tap
Reassign A Customer’s Supply Main
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Add Multiple Customers & Automatically Assign The Main

Summary

Adds multiple customer features and automatically assigns the supply main.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Click the Add Multiple Customers - Auto Assign Main icon from the Customer Commands Toolbar.

- At the Select Customer Location prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. A customer symbol will be displayed at the selected location.

- Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Customer Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- Note - There will be no prompt to select a supply main. GASWorkS will automatically assign the customer to the nearest pipe segment.

- A service line will be drawn from the customer location to the closet supply main, and the tap will be placed at the intersection between the service and the main.

- The Select Customer Location prompt will be displayed again. Repeat the process until all desired customers have been added. Right-click the mouse to end the command.

Notes & Considerations

- This command can also be executed by selecting the Add Multiple Customers - Auto Assign Main item from the GDI Command List, or by typing ADDMULTIAUTO on the GDI Command Line and pressing the Enter key.

- When searching for the nearest main, only mains whose Facility Type is set to “Active” are considered. The “Active” setting can be found on the Facility Settings screen. To access the screen, select the Facility Settings item from the Edit menu list.
To change the Customer Data, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.

To change a customer’s location, either use the Move Customer command or grips.

To change the location of the service tap along a supply main, either use the Move Service Tap command or grips.

To change a customer’s supply main, use the Reassign Customer Supply Main command.

The Node Load Application item in the Customer Data determines where the customer load is applied to in the model. The “From Node” option adds the entire value to the From Node of the tapped supply main. The “To Node” option adds the entire value to the To Node. The “Both Nodes” option splits the customer load evenly between the From Node and the To Node. The customer load value is added to the External Load of the chosen node(s). The “None” option does not apply the value to either node. The “Diversified” option indicates to use the selected Diversity load calculation method.

To remove a customer feature from the model, use the Delete Customer command.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Delete A Customer
Edit Customer Data
Grips
Move A Customer
Move A Service Tap
Reassign A Customer’s Supply Main
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Add A Polyline Pipe

Summary

Adds a polyline pipe feature - a pipe with a From Node, To Node, and deflections (vertices) in between.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

• Click the Add Polyline Pipe icon from the Graphic Construction Commands Toolbar.

• At the From Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The From Node will be placed at the selected location.

• Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

• At the Next Vertex prompt, move the mouse crosshairs to the desired vertex location in the GDI Display and left-click the mouse. A line segment will be drawn from the From Node to the selected vertex location.

• The Next Vertex prompt will be displayed again. Use one of the methods described above to continue adding segments. When finished, either right-click the mouse to end the command or type “E” on the GDI Prompt Line to end the polyline at the last entered location. Note - To undo the last entered line segment, type “U” on the GDI Prompt Line.

• Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

• Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.
Notes & Considerations

- This command can also be executed by selecting the *Add Polyline Pipe* item from the GDI Command List, or by typing ADDPOLYLINEPIPE or ADDPOLY on the GDI Command Line and pressing the *Enter* key.

- It is not recommended to place a polyline pipe vertex at the same location as an existing node. Such a location will be flagged as an “unbroken intersection” by the *Flag Unbroken Intersections* command.

- To change the Pipe Data, either use the *Edit Pipe Data* command or left-click on the desired pipe feature to display the data in the Data Panel.

- To change the Node Data, either use the *Edit Node Data* command or left-click on the desired node to display the data in the Data Panel.

- To display the Vertex Data in the Data Panel, either use the *Edit Polyline Pipe Vertex* command or left-click on the desired vertex to display the data in the Data Panel.

- To change the location of a pipe feature, use the *Move Pipe* command. To change the location of one end of a pipe, use the *Move Pipe End* command or grips.

- To change the location of a polyline vertex and redraw the adjacent pipe segments, either use the *Move Polyline Pipe Vertex* command or grips.

- To add a polyline pipe vertex to a polyline pipe, use the *Add Polyline Vertex* command.

- The *Hydraulic Length* is the value used for the pipe length in the GASWorkS calculations. The initial Hydraulic Length value is equal to the graphic length in the GDI Display. The Hydraulic Length value can be changed in the Pipe Data in the Data Panel or by using the *Edit Pipe Data* command.

- To remove a polyline pipe vertex from a polyline pipe feature, use the *Delete Polyline Vertex* command.

- To remove a pipe feature from the model, use the *Delete Pipe* command.

- If the *Allow Undo Of Data/Graphic Changes* Preference Settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.
See Also

Add A Polyline Pipe Vertex
Delete A Pipe
Delete A Polyline Pipe Vertex
Edit Node Data
Edit Pipe Data
Edit A Polyline Pipe Vertex
Flag Unbroken Intersections
Grips
Move A Pipe
Move A Pipe End
Move A Polyline Pipe Vertex
Select A Feature
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Use The Data Panel
Add A Polyline Pipe Vertex

Summary

Adds a vertex to an existing polyline or 2-point pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Click the Add Polyline Pipe Vertex icon from the Graphic Edit Commands Toolbar.

- At the Select Pipe To Add Vertex To prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted. Note - A message may be displayed if the selected pipe cannot be modified. Click the OK command button to return to the prompt.

- At the New Vertex Location prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- The selected pipe segment will be redrawn as two segments joined at the new vertex.

Notes & Considerations

- This command can also be executed by selecting the Add Polyline Pipe Vertex item from the GDI Command List, or by typing ADDPIPEVERTEX or ADDPVTX on the GDI Command Line and pressing the Enter key.

- Adding a vertex to a 2-point pipe will change the graphic type to a polyline pipe. The Pipe Line Type can be found in the Graphic Data Items section in the Pipe Data.

- Vertices cannot be added to arc pipes.

- It is not recommended to place a polyline pipe vertex at the same location as an existing node. Such a location will be flagged as an “unbroken intersection” by the Flag Unbroken Intersections command.

- To display the Vertex Data in the Data Panel, either use the Edit Polyline Pipe Vertex command or left-click on the desired vertex to display the data in the Data Panel.
• To change the location of a polyline vertex and redraw the adjacent pipe segments, either use the *Move Polyline Pipe Vertex* command or grips.

• To remove a polyline pipe vertex from a polyline pipe feature, use the *Delete Polyline Vertex* command.

• If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A 2-Point Pipe
- Add A Polyline Pipe
- Delete A Polyline Pipe Vertex
- Edit A Polyline Pipe Vertex
- Flag Unbroken Intersections
- grips
- Move A Polyline Pipe Vertex
- Select A Feature
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Add A Polyline Service Customer

Summary

Adds a customer feature with a polyline style service line.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Click the Add Polyline Service Customer icon from the Customer Commands Toolbar.

- At the Main Tap Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point on the desired pipe feature and left-click the mouse. The tap location will be placed on the pipe nearest to the selected point. Note - A message may be displayed if the selected pipe cannot have customers attached. Click the OK command button to return to the prompt.

- At the Next Vertex prompt, move the mouse crosshairs to the desired vertex location in the GDI Display and left-click the mouse. A line segment will be drawn from the tap location to the selected vertex location.

- The Next Vertex prompt will be displayed again. Use one of the methods described above to continue adding segments. When finished, either right-click the mouse to end the command or type “E” on the GDI Prompt Line to end the polyline at the last entered location. Note - To undo the last entered line segment, type “U” on the GDI Prompt Line.

- The last added vertex will become the customer location.

- Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Customer Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

Notes & Considerations

- This command can also be executed by selecting the Add Polyline Service Customer item from the GDI Command List, or by typing ADDPOLYSERVICE or ADDPOLYS on the GDI Command Line and pressing the Enter key.
To change the Customer Data, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.

To change a customer’s location, either use the Move Customer command or grips.

To change the location of the service tap along a supply main, either use the Move Service Tap command or grips.

To change a customer’s supply main, use the Reassign Customer Supply Main command.

To display the Vertex Data in the Data Panel, left-click on the desired vertex.

To add a service line vertex to a polyline service customer, use the Add Service Line Vertex command.

To change the location of a service line vertex and redraw the adjacent service line segments, either use the Move Service Line Vertex command or grips.

To remove a service line vertex from a polyline service customer, use the Delete Service Line Vertex command.

The Node Load Application item in the Customer Data determines where the customer load is applied to in the model. The “From Node” option adds the entire value to the From Node of the tapped supply main. The “To Node” option adds the entire value to the To Node. The “Both Nodes” option splits the customer load evenly between the From Node and the To Node. The customer load value is added to the External Load of the chosen node(s). The “None” option does not apply the value to either node. The “Diversified” option indicates to use the selected Diversity load calculation method.

To remove a customer feature from the model, use the Delete Customer command.

If the Allow Undo Of Data/Graphic Changes Preference Settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add A Polyline Pipe
Delete A Customer
Edit Customer Data
Move A Customer
Move A Service Tap
Select A Feature
Undo The Last Data Or Graphic Change
Add An Arc Pipe
Add A Service Line Vertex
Delete A Service Line Vertex
Grips
Move A Service Line Vertex
Reassign A Customer’s Supply Main
Set A Feature’s Location
Use The Data Panel
Add A Regulator

Summary

Add a regulator type “pipe” feature.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Click the Add Regulator icon from the Graphic Construction Commands Toolbar.

- At the From (Upstream) Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The From Node will be placed at the selected location.

  Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- At the To (Downstream) Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The To Node will be placed at the selected location.

  Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- At the Regulator Size & Type prompt, select the desired item from the GDI Prompt List.

- At the Set Pressure Units prompt, select the desired item from the GDI Prompt List.

- At the Set Pressure prompt, type a value (in the selected Pressure Units) on the GDI Prompt Line and press the Enter key.

- At the Facility Type prompt, select the desired item from the GDI Prompt List.

- The pipe feature will be placed at the selected location.
GASWorkS™ 10.0

GDI Commands

Table Of Contents

- Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- The regulator symbol will be placed on the pipe feature.

Notes & Considerations

- This command can also be executed by selecting the Add Regulator item from the GDI Command List, or by typing ADDREGULATOR or ADDREG on the GDI Command Line and pressing the Enter key.

- The From Node represents the upstream (inlet) side of the regulator and the To Node represents the downstream (outlet) side of the regulator. The regulator symbol will automatically display “facing” in the direction of gas flow.

- To turn the display of regulator symbols “on” or “off”, use the Display Pipe Symbols command.

- To change the Regulator Pipe Data, either use the Edit Pipe Data command or left-click on the desired pipe feature to display the data in the Data Panel.

- To reverse the From Node and To Node, use the Swap Pipe Ends command.

- To change the location of a pipe feature, use the Move Pipe command. To change the location of one end of the arc pipe, either use the Move Pipe End command or the grips.

- When connecting regulators in a series, at least one pipe feature should be placed between the regulators.

- Regulator properties can be viewed or changed on the Regulator data tab of the Property Table Report. To access the report, select the Property Tables item from the Edit menu list.

- The size of the regulator symbol is set by the Pipe Symbol Size value on the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.

- To remove a regulator from the model, as well as remove the pipe feature, use the Delete Pipe command.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

- Delete A Pipe
- Display The Pipe Symbols
- Edit Pipe Data
- Grips
- Insert A Regulator
- Move A Pipe
- Move A Pipe End
- Set A Feature's Location
- Swap A Pipe’s Ends (The From Node & To Node)
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Add A Service Line Vertex

Summary

Adds a vertex to an existing customer service line.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer feature is present in the model.

Add A Vertex To A 2-Point Service Line -

- Click the Add Service Line Vertex icon from the Customer Commands Toolbar.
- At the Select Customer To Add Service Vertex To prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted.
- At the New Vertex Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse.
- A vertex will be placed at the selected location, and the service will be redrawn as a two-segment polyline joined at the new vertex.

Add A Vertex To A Polyline Service Line -

- Click the Add Service Line Vertex icon from the Customer Commands Toolbar.
- At the Select Customer To Add Service Vertex To prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted.
- At the Select Service Segment To Add Vertex To prompt, move the mouse pointer to a segment of the selected service and left-click the mouse.
- At the New Vertex Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse.
A vertex will be placed at the selected location, and the selected segment will be redrawn as two segments joined at the new vertex.

**Notes & Considerations**

- This command can also be executed by selecting the *Add Service Line Vertex* item from the GDI Command List, or by typing ADDSERVICEVERTEX or ADDSVTX on the GDI Command Line and pressing the *Enter* key.

- Adding a vertex to a 2-point service line will change the *Service Line Type* to a “Polyline”. This item can be found in the *Graphic Data Items* section in the Customer Data.

- To display the Vertex Data in the Data Panel, left-click on the desired vertex.

- To change the location of a service line vertex, either use the *Move Service Line Vertex* command or grips.

- To remove a vertex from a polyline service line, use the *Delete Service Line Vertex* command.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A Customer
- Add A Polyline Service Customer
- Delete A Service Line Vertex
- Grips
- Move A Service Line Vertex
- Select A Feature
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
- Use The Data Panel

Bradley B Bean PE

ENGINEERING & SOFTWARE
Add An Unassigned Customer

Summary

Adds a customer feature, but does not require a supply main assignment.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Add Customer - Unassigned item from the GDI Command List.

- At the Select Customer Location prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. A customer symbol will be placed the selected location.

- Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Customer Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

Notes & Considerations

- This command can also be executed by typing ADDUNASSIGNED or ADDUNCUST on the GDI Command Line and pressing the Enter key.

- When the model is opened, a message may be displayed if unassigned customers exist in the model. An alternative to using an unassigned customer is to assign the customer to an adjacent main or pipe, and then set the Per Unit Load value equal to zero (0) or set the Load Status to “off”.

- To locate any unassigned customers, use the Flag Customers - Unassigned command.

- To connect one unassigned customer to a supply main, use the Reassign Customer Supply Main command. To connect all unassigned customers, use the Assign Customer Service Lines command.

- To change the Customer Data, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.

- To change a customer’s location, either use the Move Customer command or grips.

- To remove a customer feature from the model, use the Delete Customer command.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Assign The Customer Service Lines
Delete A Customer
Edit Customer Data
Flag Unassigned Customers
Grips
Move A Customer
Undo The Last Data Or Graphic Change
Use The Data Panel
Add A User Graphic Image

Summary

Adds a User Graphic Image from an existing Bitmap (BMP), Drawing Exchange Format (DXF), or Joint Exchange Photographer's Group (JPEG) file.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one file with a .bmp, .dxf, or .jpg extension is present in the “GASWorkS 10\support\images” folder.

- Click the Add User Graphic Image icon from the User Graphic Commands Toolbar.

- At the User Graphic Image Filename prompt, select the desired item from the GDI Prompt List.

- At the User Graphic Image Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The selected location will be the upper-left corner of the User Graphic Image.

- At the User Graphic Image Width prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The width of the User Graphic Image will be set equal to the length of the line that is displayed in the GDI Display.

- Note - If the User Graphic Image is a DXF File, at the Line Display Weight prompt, type a value on the GDI Prompt Line, then press the Enter key.

- The User Graphic Image will be displayed at the selected location.

Notes & Considerations

- This command can also be executed by selecting the Add User Graphic Image item from the GDI Command List, or by typing ADDIMAGE or ADDI on the GDI Command Line and pressing the Enter key.

- To turn the display of User Graphic Images “on” or “off”, use the Display User Graphics command.

- To change the User Graphic Image Data, either use the Edit User Graphic Image command or left-click on the desired User Graphic Image to display the data in the Data Panel.
To change the location of a User Graphic Image, either use the Move User Graphic Image command or grips.

To remove a User Graphic Image from the model, use the Delete User Graphic Image command.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Delete A User Graphic Image
Display The User Graphics
Edit A User Graphic Image
Grips
Move A User Graphic Image
Set A Feature’s Dimensions
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Use The Data Panel
Add A User Graphic Line

Summary

Adds a User Graphic Line.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Add User Graphic Line icon from the User Graphic Commands Toolbar.

- At the User Graphic Line Style prompt, select the desired item from the GDI Prompt List.

- At the User Graphic Line Width prompt, type a value (in Coordinate units) on the GDI Prompt Line and press the Enter key, or right-click the mouse to accept the default value.

- At the Start Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The first point will be placed at the selected location.

- At the Next End Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The next end will be placed at the selected location. A line segment will be drawn from the Start Location to the selected location.

- The Next End Location prompt will be displayed again. Use one of the methods described above to continue adding segments, or use one the following methods:
  - End - Type “E” on the GDI Prompt Line, or right-click the mouse, to end the line segment at the last entered location.
  - Close - Type “C” on the GDI Prompt Line to draw a line segment from the last entered point to the Start Location and create a closed geometric figure.
  - Undo - Type “U” on the GDI Prompt Line to undo the last entered line segment.
  - Note - The Next End Location prompt will continue to be displayed until the User Graphic Line is ended or closed, or the command is cancelled.

- Note - If “Circled”, “Crossed”, “Slashed - Left”, “Slashed - Right”, “Ticked”, or “Zig-Zagged” is selected for the User Graphic Line Style, the following prompt will be displayed.
At the **Pattern Spacing** prompt use one of the following methods:

- Type a value (in *Coordinate* units) and press the *Enter* key. This sets the space between the repeating elements of the line pattern.

- Move the crosshairs to a point within the GDI Display and left-click the mouse. The length of the line between the insertion point and the second point represents the space between the repeating elements of the line pattern.

*Note* - If “Leader” is selected for the *User Graphic Line Style*, the following prompt will be displayed.

At the **Arrowhead Length** prompt, use one of the following methods:

- Type a value (in *Coordinate* units) on the GDI Prompt Line and press the *Enter* key. This sets the length of the leader arrowhead.

- Move the crosshairs to a point within the GDI Display and left-click the mouse. The length of the line between the insertion point and the second point represents the length of the leader arrowhead.

The User Graphic Line will be displayed at the selected location.

**Notes & Considerations**

- This command can also be executed by selecting the *Add User Graphic Line* item from the GDI Command List, or by typing ADDLINE or ADDL on the GDI Command Line and pressing the *Enter* key.

- The leader arrowhead will point to the *Start Location* of the User Graphic Line.

- To turn the display of User Graphic Lines “on” or “off”, use the *Display User Graphics* command.

- To change the User Graphic Line Data, either use the *Edit User Graphic Line* command or left-click on the desired User Graphic Line to display the data in the Data Panel.

- To change the location of a User Graphic Line, either use the *Move User Graphic Line* command or grips.

- To change the location of a User Graphic Line segment, either use the *Move User Graphic Line End* command or grips.

- To remove a User Graphic Line from the model, use the *Delete User Graphic Line* command.
• If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

- Delete A User Graphic Line
- Display The User Graphics
- Edit A User Graphic Line
- Grips
- Move A User Graphic Line
- Move A User Graphic Line End
- Set A Feature’s Dimensions
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Add A User Graphic Symbol

Summary

Add a User Graphic Symbol.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Add User Graphic Symbol icon from the User Graphic Commands Toolbar.

- At the User Graphic Symbol Style prompt, select the desired item from the GDI Prompt List.

- At the User Graphic Symbol Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The selected location will be the center of the User Graphic Symbol.

- At the User Graphic Symbol Rotation prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the orientation of the User Graphic Symbol.

- At the User Graphic Symbol Size prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The length of the line between the insertion point and the second point represents the symbol size.

- The User Graphic Symbol will be displayed at the selected location.

Notes & Considerations

- This command can also be executed by selecting the Add User Graphic Symbol item from the GDI Command List, or by typing ADDSYMBOL OR ADDS on the GDI Command Line and pressing the Enter key.

- The default User Graphic Symbol size is set by the User Graphic Symbol Size value on the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.

- To turn the display of User Graphic Symbols “on” or “off”, use the Display User Graphics command.
To change the User Graphic Symbol Data, either use the *Edit User Graphic Symbol* command or left-click on the desired User Graphic Symbol to display the data in the Data Panel.

To create a copy of an existing User Graphic Symbol, use the *Copy User Graphic Symbol* command.

To change the location of a User Graphic Symbol, either use the *Move User Graphic Symbol* command or grips.

To create a legend of all of the User Graphic Symbols used in a model, use the *Create Symbol Legend* command.

To remove a User Graphic Symbol from the model, use the *Delete User Graphic Symbol* command.

If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

*Copy A User Graphic Symbol*
*Create A Symbol Legend*
>Delete A User Graphic Symbol*
*Display The User Graphics*
*Edit A User Graphic Symbol*
*Grips*
*Move A User Graphic Symbol*
*Set A Feature’s Dimensions*
*Set A Feature’s Location*
*Undo The Last Data Or Graphic Change*
*Use The Data Panel*
Add User Text

Summary

Adds a User Text feature.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Add User Text icon from the User Text Commands Toolbar.

- At the User Text Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The selected location will be the lower-left corner of the User Text Feature.

- At the User Text Rotation prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the orientation of the User Text feature.

- At the User Text Height prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The text height will be set to the length of the line that is displayed in the GDI Display.

- At the User Text Width prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The width of the User Text feature will be set equal to the length of the line that is displayed in the GDI Display.

- At the User Text Value prompt, enter text by typing it on the GDI Prompt Line and press the Enter key.

- The User Text will be displayed at the selected location.

Notes & Considerations

- This command can also be executed by selecting the Add User Text item from the GDI Command List, or by typing ADDUSERTEXT or ADDT on the GDI Command Line and pressing the Enter key.

- To turn the display of User Text features “on” or “off”, use the Display User Text command.
To change the User Text Data, either use the Edit User Text command or left-click on the desired User Text feature to display the data in the Data Panel.

To create a copy of an existing User Text feature, use the Copy User Text command.

To change the location of a User Text feature, either use the Move User Text command or grips.

To remove a User Text feature from the model, use the Delete User Text command.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

- Copy User Text
- Delete User Text
- Display The User Text
- Edit User Text
- Grips
- Move User Text
- Set A Feature’s Dimensions
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Add User Text Associated With A Feature

Summary

Adds a User Text feature that is associated with a specific customer, node, or pipe feature’s data text value.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Add User Text - Associated item from the GDI Command List.
- At the Select The Feature To Associate With prompt, move the mouse pointer to a customer, node, or pipe feature in the GDI Display and left-click the mouse.
- At the Select The Data Item To Display prompt, select the desired item from the GDI Prompt List.
- At the User Text Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The selected location will be the lower-left corner of the text feature.
- At the User Text Rotation prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the orientation of the text feature.
- At the User Text Height prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The text height will be set to the length of the line that is displayed in the GDI Display.
- The Associated User Text will be displayed at the selected location.
- At the Include A Leader Line prompt, select the desired item from the GDI Prompt List.
- If the “Yes” item is selected, at the Leader Line Width prompt, type a value (in Coordinate units) on the GDI Prompt Line and press the Enter key.
- At the Start Location (Arrowhead End) prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The arrowhead will be placed at the selected location.
At the Next End Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The next end will be placed at the selected location. A line segment will be drawn from the Start Location to the selected location.

The Next End Location prompt will be displayed again. Use one of the methods described above to continue adding segments, or use one the following methods:

- End - Type “E” on the GDI Prompt Line, or right-click the mouse, to end the line segment at the last entered location.
- Undo - Type “U” on the GDI Prompt Line to undo the last entered line segment.
- Note - The Next End Location prompt will continue to be displayed until the Leader Line is ended or the command is cancelled.

At the Arrowhead Length prompt, move the crosshairs to a point within the GDI Display and left-click the mouse. The length of the line between the insertion point and the second point represents the length of the leader arrowhead.

The Leader Line with Arrowhead will be displayed at the selected location.

Notes & Considerations

- This command can also be executed by typing ADDAT on the GDI Command Line and pressing the Enter key.
- To turn the display of Associated User Text features “on” or “off”, use the Display User Text command.
- To change the User Text Data, either use the Edit User Text command or left-click on the desired User Text feature to display the data in the Data Panel.
- To create a copy of an existing Associated User Text feature, use the Copy User Text command.
- To change the location of an Associated User Text feature, either use the Move User Text command or grips. The command will ask whether to move the leader line end. Either select “Yes” from the list to move the end of the leader line closest to the text, or select “No” to leave the leader line where it is.
- Leader Lines have their own grips, and can be moved independently of their associated feature.
- To remove an Associated User Text feature from the model, use the Delete User Text command. The leader line will also be deleted.
If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Copy User Text
- Delete User Text
- Display The User Text
- Edit User Text
- Grips
- Move User Text
- Select A Feature
- Set A Feature’s Dimensions
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Add User Text With A Leader Line

Summary

Adds a User Text feature with a leader line.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Add User Text - With Leader Line item from the GDI Command List.

- At the User Text Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The selected location will be the lower-left corner of the User Text feature.

- At the User Text Rotation prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the orientation of the User Text feature.

- At the User Text Height prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The text height will be set to the length of the line that is displayed in the GDI Display.

- At the User Text Width prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The width of the User Text feature will be set equal to the length of the line that is displayed in the GDI Display.

- At the User Text Value prompt, enter text by typing it on the GDI Prompt Line and press the Enter key. The entered text will be displayed in the GDI Display as specified in the prior steps.

- At the Leader Line Width prompt, type a value (in Coordinate units) on the GDI Prompt Line and press the Enter key.

- At the Start Location (Arrowhead End) prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The arrowhead will be placed at the selected location.

- At the Next End Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The next end will be placed at the selected location. A line segment will be drawn from the Start Location to the selected location.
The Next End Location prompt will be displayed again. Use one of the methods described above to continue adding segments, or use one of the following methods:

- **End** - Type “E” on the GDI Prompt Line, or right-click the mouse, to end the line segment at the last entered location.
- **Undo** - Type “U” on the GDI Prompt Line to undo the last entered line segment.
- **Note** - The Next End Location prompt will continue to be displayed until the Leader Line is ended or the command is cancelled.

At the Arrowhead Length prompt, move the crosshairs to a point within the GDI Display and left-click the mouse. The length of the line between the insertion point and the second point represents the length of the leader arrowhead.

The Leader Line with Arrowhead will be displayed at the selected location.

**Notes & Considerations**

- This command can also be executed by typing ADDLEADERTEXT or ADDLT on the GDI Command Line and pressing the Enter key.

- To turn the display of User Text features “on” or “off”, use the Display User Text command.

- To change the User Text Data, either use the Edit User Text command or left-click on the desired User Text feature to display the data in the Data Panel.

- To create a copy of an existing User Text feature, use the Copy User Text command.

- To change the location of a User Text feature, either use the Move User Text command or grips. The command will ask whether to move the leader line end. Either select “Yes” from the list to move the end of the leader line closest to the text, or select “No” to leave the leader line where it is.

- Leader Lines have their own grips, and can be moved independently of their associated feature.

- To remove a User Text feature from the model, use the Delete User Text command. The leader line will also be deleted.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Copy User Text
Delete User Text
Display The User Text
Edit User Text
Grips
Move User Text
Set A Feature’s Dimensions
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Use The Data Panel
Add A Valve

Summary

Adds a valve type “pipe” feature.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Click the Add Valve icon from the Graphic Construction Commands Toolbar.

- At the From Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The From Node will be placed at the selected location.

  Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- At the To Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The To Node will be placed at the selected location.

  Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- At the Valve Size & Type prompt, select the desired item from the GDI Prompt List.

- At the Valve Opening prompt, type a value between 0 (fully closed) and 100 (fully open) on the GDI Prompt Line and press the Enter key. The pipe feature will be placed at the selected location.

  Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- The valve symbol will be placed on the pipe feature.
Notes & Considerations

● This command can also be executed by selecting the Add Valve item from the GDI Command List, or by typing ADDVALVE or ADDV on the GDI Command Line and pressing the Enter key.

● A valve can also be modeled as a node or a fitting, but only a valve type hydraulic feature can stop the flow of gas in a model.

● To turn the display of valve symbols “on” or “off”, use the Display Pipe Symbols command.

● To change the Pipe Data, either use the Edit Pipe Data command or left-click on the desired pipe feature to display the data in the Data Panel.

● To change the Node Data, either use the Edit Node Data command or left-click on the desired node to display the data in the Data Panel.

● To change the location of a pipe feature, use the Move Pipe command. To change the location of one end of a pipe, use the Move Pipe End command or grips.

● The size of the valve symbol is set by the Pipe Symbol Size value on the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.

● To convert an existing pipe feature into a valve, use the Insert Valve command.

● To add a valve as a fitting to an existing pipe feature, use the Add Fitting command.

● To remove a valve from the model, use the Delete Pipe command. This will also remove the pipe feature.

● Valve properties can be viewed or changed on the Valve data tab of the Property Table Report. To access the report, select the Property Tables item from the Edit menu list.

● If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A Fitting
Attach A Fitting To A Pipe
Delete A Pipe
Display The Pipe Symbols
Edit Node Data
Edit Pipe Data
Grips
Insert A Valve
Move A Pipe
Move A Pipe End
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Use The Data Panel
Add A Valve Node

Summary

Adds a valve node to an existing pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe feature is present in the model.

- Select the Add Valve Node item from the GDI Command List.

- At the Select Pipe To Add Valve Node To prompt, move the mouse pointer to a point on the desired pipe and left-click the mouse. The selected pipe will be highlighted.

- At the Valve Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- At the Valve Node Number prompt, type a value on the GDI Prompt Line and press the Enter key.

- At the Valve Node Hydraulic Type prompt, select the desired item from the GDI Prompt List. A node will be placed at the selected location.

  Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- The valve node symbol will be placed on the pipe feature.

Notes & Considerations

- This command can also be executed by typing ADDVALVENODE or ADDVN on the GDI Command Line and pressing the Enter key.

- Valve nodes are always considered to be “fully open” and do not affect the hydraulic analysis. To include a valve in the hydraulic analysis, add a valve Hydraulic Type pipe feature by using the Add Valve command.
Adding a valve node to a pipe (not at an existing node) splits the pipe into two segments. The Hydraulic Length of the new segments is calculated by prorating the original pipe’s Hydraulic Length. The length assigned to each segment depends on the graphic location of the node.

*Example* - A pipe with a graphic length of 100 Feet, and a Hydraulic Length of 200 Feet, is split by a Valve Node placed 40 Feet (graphic) from one end. The original Hydraulic Length is divided 40-60 among the two segments. Thus, the new pipe segments have Hydraulic Lengths of 80 and 120 Feet, respectively.

- To change the Valve Node Data, either use the *Edit Node Data* command or left-click on the desired valve node to display the data in the Data Panel.

- To remove a valve node from the model, use the *Delete Valve Node* command.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Add A Valve
- Delete A Valve Node
- Edit Node Data
- Select A Feature
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Add A Well

Summary

Adds a well type “pipe” feature.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed. It is always a good idea to check the default data values and dimensional units before adding new features. To review the current values, select the Set Defaults item from the Utilities menu list.

- Click the Add Well item from the Graphic Construction Commands Toolbar.

- At the From (Wellhead) Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The From Node will be placed at the selected location.

  Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- At the To (Pipe) Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The To Node will be placed at the selected location.

  Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- At the Well Type prompt, select the desired item from the GDI Prompt List.

- At the Shut-In Pressure prompt, type a value (in the Pressure units) on the GDI Prompt Line and press the Enter key. The pipe feature will be placed at the selected location.

  Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- The well symbol will be placed on the pipe feature.
Notes & Considerations

- This command can also be executed by selecting the Add Well item from the GDI Command List, or by typing ADDWELL on the GDI Command Line and pressing the Enter key.

- The From Node represents the wellhead and the To Node represents the downstream pipe end. The well symbol will be displayed “facing up” when the direction of the gas flow is left to right, and the well symbol will be displayed “facing down” when the direction of the gas flow is right to left.

- The flow rate from a well depends on the downstream pressure at the To Node. As the downstream pressure increases, the flow rate decreases, and vice versa. An alternative method to model a well is to create a node with a known supply (positive load).

- When available, a “multi-point” flow test is recommended to validate a well’s operating characteristics.

- To turn the display of well symbols “on” or “off”, use the Display Pipe Symbols command.

- To change the Pipe Data, either use the Edit Pipe Data command or left-click on the desired pipe feature to display the data in the Data Panel.

- To change the location of a pipe feature, use the Move Pipe command. To change the location of one end of a pipe, use the Move Pipe End command or grips.

- To reverse the From Node and To Node, use the Swap Pipe Ends command.

- The size of the well symbol is set by the Pipe Symbol Size value on the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.

- To remove a well from the model, use the Delete Pipe command. This will also remove the pipe feature.

- Well properties can be viewed or changed on the Well data tab of the Property Table Report. To access the report, select the Property Tables item from the Edit menu list.

- If the Allow Undo Of Data/Graphic Changes Preference Settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Delete A Pipe
Display The Pipe Symbols
Edit Node Data
Edit Pipe Data
Grips
Move A Pipe
Move A Pipe End
Set A Feature’s Location
Swap A Pipe’s Ends (The From Node & To Node)
Undo The Last Data Or Graphic Change
Use The Data Panel
**Adjust An Arc Pipe**

**Summary**

Adjusts the radius of an existing arc pipe feature.

**Example**

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one arc type pipe is present in the model.

- Select the *Adjust Arc Pipe* item from the GDI Command List.
- At the *Select An Arc Pipe* prompt, move the mouse pointer to an arc type pipe and left-click the mouse. The selected arc pipe will be highlighted.
- At the *Adjust Curve* prompt, use one of the following methods:
  - **Graphic** - Move the mouse crosshairs to adjust the direction and radius of the arc in the GDI Display, then left-click the mouse. The arc will be drawn between the two nodes with the drawn angle.
  - **Radius** - Type the letter “R”, followed by an equal “=” sign, followed by a radius value in *Coordinate* units on the GDI Prompt Line and press the *Enter* key. The arc will be drawn between the two nodes with the specified radius.
  - **Delta** - Type the letter “D”, followed by an equal “=” sign, followed by a delta angle value in decimal degrees on the GDI Prompt Line and press the *Enter* key. The arc will be drawn between the two nodes with the specified delta angle.
  - **Semicircle** - Type the letter “S”, followed by an equal “=” sign, followed by either “-1” for a counter-clockwise semicircle between the From Node and the To Node, “0” for a straight arc between the From Node and the To Node, or “1” for a clockwise semicircle between the From Node and the To Node on the GDI Prompt Line and press the *Enter* key.

- If the *Automatically Update Pipe Length* graphic settings option is selected, the *Hydraulic Length* of the pipe will be recalculated. If the option is not selected, a message may be displayed asking to update the hydraulic *Pipe Length*. Either click the *Yes* command button to update the pipe length, or click the *No* command button to preserve the previous value.
Notes & Considerations

- This command can also be executed by typing ADJUSTARC on the GDI Command Line and pressing the Enter key.

- Moving an arc pipe end will also change the curvature of the arc. To do so, either use the Move Pipe End command or grips.

- The Hydraulic Length is the value used for the pipe length in the GASWorkS calculations. The initial Hydraulic Length value is equal to the graphic length in the GDI Display. The Hydraulic Length value can be changed in the Pipe Data in the Data Panel or by using the Edit Pipe Data command.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add An Arc Pipe
Edit Pipe Data
Grips
Move A Pipe End
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Assign The Customer Service Lines

Summary

Automatically assigns the customer features to the nearest supply main (pipe).

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe and one customer feature is present in the model.

- Select the Assign Customer Service Lines item from the GDI Command List.
- A message will be displayed asking to assign the service lines to all of the customers, or only to assign the service lines for customers with no tap location. Either click the Yes command button to assign all customers in the model to the supply main closest to the customer location (this includes any customers currently assigned to a supply main other than the one closest to the customer location), click the No command button to assign only the unassigned customers in the model, or click the Cancel command button to end the command and preserve the model as is.
- At the Maximum Service Line Length prompt, type a value (in Length units) on the GDI Prompt Line and press the Enter key. Customers that are not within the specified service line length of a pipe will not be assigned.
- A message will be displayed when the service line assignment is complete. Click the OK command button to close the message.
- A service line will be drawn from the customer location to the assigned supply main, and the tap will be placed at the intersection between the service and the main.

Notes & Considerations

- This command can also be executed by typing ASSIGNCUSTSERV or ASSIGNSERVICE on the GDI Command Line and pressing the Enter key.
- To change the location of the service tap along a supply main, either use the Move Service Tap command or grips.
- To change a customer’s supply main, use the Reassign Customer Supply Main command.
● When searching for the nearest main, only mains whose Facility Type is set to “Active” are considered. The “Active” setting can be found on the Facility Settings screen. To access the screen, select the Facility Settings item from the Edit menu list.

● The Node Load Application item in the Customer Data determines where the customer load is applied to in the model. The “From Node” option adds the entire value to the From Node of the tapped supply main. The “To Node” option adds the entire value to the To Node. The “Both Nodes” option splits the customer load evenly between the From Node and the To Node. The customer load value is added to the External Load of the chosen node(s). The “None” option does not apply the value to either node. The “Diversified” option indicates to use the selected Diversity load calculation method.

● If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Customer
Add A Polyline Pipe
Add An Unassigned Customer
Edit Customer Data
Grips
Move A Service Tap
Reassign A Customer’s Supply Main
Undo The Last Data Or Graphic Change
Use The Data Panel
Break Flagged Intersections

Summary

Automatically breaks the flagged unbroken intersection locations.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, the Flag Unbroken Intersections command has been executed, and at least one node has been flagged as a result.

- Select the Break Flagged Intersections item from the GDI Command List.
- The Fuzzy Tolerance screen is displayed. Type a value in the Fuzzy Tolerance Value data field. Click the Continue command button to proceed.
- A message will be displayed stating the number of flagged intersections that were broken, and ask whether to clear the node flags. Either click the Yes command button to clear the node flags, or click the No command button to keep the node flags displayed.
  - If the Yes command button is clicked, a message may be displayed asking to reset the Allow Intersection Flag option. Either click the Yes command button to enable the intersection flag option for the broken intersection nodes, or click the No command button to disable this option for the nodes.
  - If the No command button is clicked, a message may be displayed stating to use the Clear Unbroken Intersection Flags command to remove the flags. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing BREAKFLAGGED on the GDI Command Line and pressing the Enter key.
- An alternative to this command is to “break” each intersection individually using the Tap Pipe command.
- To mark any node crossed by an unconnected pipe with a graphic flag, use the Flag Unbroken Intersections command. This can include overlaps and other graphic errors that will not be fixed by simply “breaking” the pipes.
Before executing this command, verify that the flagged intersections should be broken. Flags can be set or unset using the Set Intersection Flag and Unset Intersection Flag commands.

The Allow Intersection Flag option can be in the Graphic Data Items section in the Node Data.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Edit Node Data
Flag Unbroken Intersections
Set An Intersection Flag
Tap A Pipe
Undo The Last Data Or Graphic Change
Unset An Intersection Flag
Use The Data Panel
Calculate Delta P (Linear)

Summary

Calculates the pressure difference between a pair of selected nodes.

Example

The example assumes that GASWorkS has been started, a solvable model is open, the GDI Window is displayed, and the model has been solved and balanced.

- Select the Calculate Delta P (Linear) item from the GDI Command List.
- At the Select First Node prompt, move the mouse the pointer to a node and left-click the mouse. The selected node will be highlighted.
- At the Select Second Node prompt, move the mouse the pointer to another node and left-click the mouse. The selected node will be highlighted.
- A message will be displayed stating the calculated difference in the absolute pressure values of the selected nodes. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing CALCULATEDELTAP or CALCDP on the GDI Command Line and pressing the Enter key.
- The pressure difference as a function of the absolute inlet and outlet pressures is used in pipe flow equations such as the Darcy-Weisbach equation. See the User’s Manual for full descriptions of the Pipe Flow Equations supported by GASWorkS.
- Any two nodes can be selected for this routine. They do not need to be adjacent or connected.

See Also

Select A Feature
Solve The Model
Calculate Delta P (Squared)

Summary

Calculates the difference of the squared pressures between a pair of selected nodes.

Example

The example assumes that GASWorkS has been started, a solvable model is open, the GDI Window is displayed, and the model has been solved and balanced.

- Select the Calculate Delta P (Squared) item from the GDI Command List.
- At the Select First Node prompt, move the mouse the pointer to a node and left-click the mouse. The selected node will be highlighted.
- At the Select Second Node prompt, move the mouse the pointer to another node and left-click the mouse. The selected node will be highlighted.
- A message will be displayed stating the calculated difference in the absolute pressure values of the selected nodes. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing CALCULATEDELTAP2 or CALCDP2 on the GDI Command Line and pressing the Enter key.
- The pressure difference as a function of the squared absolute inlet and outlet pressures is used in pipe flow equations such as the Institute of Gas Technology (IGT) -Improved equation. See the User’s Manual for full descriptions of the Pipe Flow Equations supported by GASWorkS.
- The two nodes selected for this routine do not need to be adjacent or connected.

See Also

Select A Feature
Solve The Model
Calculate The Design Factor

Summary

Calculate an adjustment factor (Design Factor value) to set the total system load to a specified value.

Example

The example assumes that GASWorkS has been started, a solvable model is open, the GDI Window is displayed, and the model has been solved and balanced.

- Select the Calculate Design Factor item from the GDI Command List.
- The Design Factor Calculation screen is displayed with the Current Design Factor value.
  
  - Set the Desired Total System Flow by typing a value in the data field and selecting the desired dimensional units from the list. Click the Calculate command button.
  
  - The Current Total System Flow value will be displayed, along with the Calculated Design Factor value required to meet the Desired Total System Flow value. Either click the Apply command button to apply the Calculated Design Factor value, or click the Close command button to keep the Current Design Factor value and return to the GDI Window.
  
  - If the Apply command button is clicked, a message will be displayed stating the Current Design Factor and Calculated Design Factor values. Either click the Yes command button to apply the Calculated Design Factor to the entire model, or click the No command button to end the command and preserve the model as is.
  
  - If the Yes command button is clicked, a message will be displayed when the process is complete as a reminder to solve the model to calculate the new pressure and load values. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing CALCULATEDESIGNFACTOR or CALCDF on the GDI Command Line and pressing the Enter key.

- The Design Factor is used during the solution to adjust selected node loads found in the Calculated Values section of the Node Data. This value is expressed as a decimal and is dimensionless. For example, a Design Factor of 0.5 will reduce the affected node loads by 50%.
The Design Factor does not change any node or customer load data.

The Design Factor can be found on the Solution Data screen. To access the screen, execute the **Solve Model** command.

For nodes, the Base Load represents the load entering or leaving the system at the node. The **Adjust Base Load By DF** option must be set to “Yes” to multiply the Base Load by the Design Factor. The **External Load** value is the sum of the assigned customer loads from customers whose **Adjust Load** option is set to “Yes”. The **Adjust External Load By DF** value must be set to “Yes” to multiply by the External Load by the Design Factor. The **External Load (Fixed)** value is the sum of the assigned customer loads from customers whose **Adjust Load** option is set to “No”. This value is excluded from the Design Factor calculation. The Total Load is the sum of all the other node load values.

The model should be solved and balanced after using this command.

See Also

- Edit Node Data
- Solve The Model
Calculate The Flow Efficiency

Summary

Calculates the hydraulic efficiency along the flow path between a pair of selected nodes.

Example

The example assumes that GASWorkS has been started, a solvable model is open, the GDI Window is displayed, and the model has been solved and balanced.

- Select the Calculate Efficiency item from the GDI Command List.

- At the Select First Node (Correct Pressure Node) prompt, move the mouse pointer to a node with a pressure known to be correct and left-click the mouse. The selected node will be highlighted.

- At the Select Second Node (Incorrect Pressure Node) prompt, move the mouse pointer to another node with a pressure known to be incorrect and left-click the mouse. The selected node will be highlighted.

- At the New (Correct) Pressure For Node prompt, type a value (in Pressure units) on the GDI Prompt Line and press the Enter key. This sets the known pressure value at the second node.

- A message will be displayed stating the calculated Efficiency Factor. Either click the Yes command button to proceed apply the factor to all of the highlighted pipes, or click the No command button to end the command and preserve the model as is.

- If the Yes command button is clicked, at the Select First Feature prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.

- At the Select Another Feature prompt, use the method described above to select additional pipe features. The GDI Prompt Line will update with the number of features selected. When finished, right-click the mouse to end the selection process.

- A message will be displayed asking whether to automatically change the Efficiency Factor and solve the model until the pressure is correct. Either click the Yes command button to solve the model and recalculate the efficiencies until the node pressures fall within a specified tolerance, or click the No command button to apply the new Efficiency Factor without solving the model and return to the GDI Window.

- If the Yes command button is clicked, at the Pressure Tolerance prompt, type a value on the GDI Prompt Line and press the Enter key. This sets the maximum acceptable node error for the solution.
A message will be displayed asking whether to reset the Efficiency Factor for the selected pipes before calculating. Either click the Yes command button to set the efficiencies for the selected pipes to 1 before the first iteration, or click the No command button to solve the model with the current efficiencies.

A message may be displayed when the calculation is complete. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing CALCULATEEFFICIENCY or CALCEFF on the GDI Command Line and pressing the Enter key.

- To unselect (unhighlight) a selected (highlighted) feature, move the mouse pointer to the selected feature and left-click the mouse. The feature will be unhighlighted, indicating it is no longer selected.

- This command is part of the calibration process. Adjusting pipe efficiencies is a way of tuning model pressures to match field data at given flow conditions. Low pipe efficiencies (values less than 0.85) may indicate an error in the model, or a potential field issue such as a gas leak or flow blockage.

- The Hydraulic Efficiency value is found in the Hydraulic Data Items section in the Pipe Data in the Data Panel.

- Recommended practices for calculating efficiencies include:
  - Set the efficiency to a value of one (1) for any pipe included in the calculation before starting.
  - Select pipes along the major flow path between the First Node and the Second Node.
  - Only include pipe Hydraulic Type features along the selected flow path.

- This routine assumes constant flow rates across the pipes. Only the pressure drops are used to compute the efficiency correction factor. This factor is then applied to the selected pipes to adjust their efficiencies.

- If there is more than one flow path between the First Node and Second Node, the flow distribution will be changed when the Hydraulic Efficiency Factor is applied. The resulting node pressures may not match the desired value. Clicking the Yes command button at the message asking to automatically change and solve until the pressure is correct will repeat the Hydraulic Efficiency Factor calculation until the pressure at the Second Node is within the Pressure Tolerance of the New (Correct) Node Pressure value.

- Other methods for changing pipe efficiency include:
  - Change the Hydraulic Efficiency value in the Pipe Data in the Data Panel.
  - Select the “Pipe Efficiency” item from the Set list on the Multiple Edit Specifications screen.
  - Select the “Efficiency” item from the Set list on the Mass Update Specifications screen (when “Pipe Model Data” is the selected Item Type).
• Change the Efficiency value in the Pipe Data Report.
• Select the “Pipe Efficiency” item from the Set list on the Trace & Update Data Specifications screen.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Edit Pipe Data
Select A Feature
Solve The Model
Trace & Update The Data
Undo The Last Data Or Graphic Change
Use The Data Panel
Use The Mass Update Routine
Cancel The Current GDI Command

**Summary**

Cancels the currently running GDI Command, or stops the display of the model image if it is currently being repainted.

**Example**

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a GDI Command is currently running.

*CANCEL Icon*

- Click the Cancel icon found in the upper-left corner of the GDI Window.

*GDI Command List*

- Select the Cancel Current GDI Command item from the GDI Command List.

*GDI Command Line*

- Type CANCEL on the GDI Command Line and press the Enter key.

*ESC Key*

- Press the Esc key.

**Notes & Considerations**

- Certain GDI Commands must be completed or canceled before any other routines can be executed.

- GASWorkS or the GDI Window will not close while a GDI Command is running.

- The Cancel icon may not be added to the Tool Palette.
The Repaint routine checks the status of the Cancel routine at certain intervals before continuing to repaint the model image. These intervals are set by the Refresh Increment value in the Graphic Settings screen. If the Cancel routine is executed while the model image is repainting, the Repaint routine will stop at the next check interval. Use the Repaint GDI Image command to refresh the model image if the Repaint routine was stopped before finishing by the Cancel routine.

See Also

- Repaint The GDI Image
- Use The Tool Palette
Clear All Customer Flags

Summary

Clears all of the customer flags (find and item) from the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model with a flag displayed.

- Select the Clear All Customer Flags item from the GDI Command List.
- All of the customer flags will be cleared.

Notes & Considerations

- This command can also be executed by typing CLEARALLCUSTFLAG or CLEARALLCFLAG on the GDI Command Line and pressing the Enter key.
- Graphic flags are used to identify model features with a specified attribute or value - for example, all of the customers with a zero load.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Clear The Customer Find Flag  
Clear Customer Item Flags  
Find A Customer By Address  
Find A Customer By Internal ID Number  
Find A Customer By Record Number  
Flag Customers By Item Value  
Flag Customers With Redundant Link ID Numbers  
Undo The Last Data Or Graphic Change  

Clear A Customer Flag  
Find A Customer  
Find A Customer By Attribute  
Find A Customer By Link ID Number  
Flag A Customer  
Flag Customers With Invalid Link ID Numbers  
Flag Unassigned Customers
Clear All Flags

Summary

Clears all of the feature flags (find, item, error, and supply) from the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one flag is displayed.

- Select the Clear All Flags item from the GDI Command List.
- All of the flags will be cleared.

Notes & Considerations

- This command can also be executed by typing CLEARALLFLAGS or CLEARALL on the GDI Command Line and pressing the Enter key.
- Graphic flags are used to identify model features with a specified attribute or value - for example, all customers with zero load.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Find Any Feature  Find A Customer
Find DXF Text  Find A Node
Find A Pipe  Find User Text
Flag A Customer  Flag A Node
Flag A Pipe  Flag The Supply Node
Flag Unbroken Intersections  Undo The Last Data Or Graphic Change
Clear All Node Flags

**Summary**

Clears all of the node flags (find, item, and supply) from the GDI Display.

**Example**

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model with a flag displayed.

- Select the *Clear All Node Flags* item from the GDI Command List.
- All of the node flags will be cleared.

**Notes & Considerations**

- This command can also be executed by typing CLEARALLNODEFLAG or CLEARALLNFLAG on the GDI Command Line and pressing the *Enter* key.
- Graphic flags are used to identify model features with a specified attribute or value - for example, all nodes with zero load.
- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Find A Node
- Find A Node By Name
- Find A Node By Record Number
- Flag A Node
- Flag Nodes By Item Value
- Flag The Supply Node
- Undo The Last Data Or Graphic Change
Clear All Pipe Flags

Summary

Clears all of the pipe flags (find and item) from the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model with a flag displayed.

- Select the *Clear All Pipe Flags* item from the GDI Command List.

- All of the pipe flags will be cleared.

Notes & Considerations

- This command can also be executed by typing CLEARALLPIPEFLAG or CLEARALLPFLAG on the GDI Command Line and pressing the *Enter* key.

- Graphic flags are used to identify model features with a specified attribute or value - for example, a specific pipe Record Number.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

See Also

- Find A Pipe
- Find A Pipe By Address
- Find A Pipe By Attribute
- Find A Pipe By Internal ID Number
- Find A Pipe By Link ID Number
- Find A Pipe By Record Number
- Flag A Pipe
- Flag Pipes By Item Value
- Undo The Last Data Or Graphic Change
Clear The Change Log

Summary

Clears (removes) the contents of the Change Log.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a Change Log has been created.

- Select the Clear Change Log item from the GDI Command List.

- A message will be displayed stating that the Change Log has been cleared. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing CLEARLOG on the GDI Command Line and pressing the Enter key.

- This command does not undo changes to the model - it only clears the Change Log of any records.

- To record model changes in a Change Log, use the Turn Change Log On command.

- To stop recording the model changes to the Change Log, use the Turn Change Log Off command.

See Also

Turn The Change Log Off
Turn The Change Log On
Clear The Customer Find Flag

Summary

Clears the last customer “find” flag from the GDI Display placed by one of the Find Customer commands.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, one of the Find Customer commands has been executed, and a customer has been flagged as a result.

- Click the Clear Customer Find Flag icon from the Customer Commands Toolbar.
- The customer find flag will be removed.

Notes & Considerations

- This command can also be executed by the Clear Customer Find Flag item from the GDI Command List, or by typing CLEARCUSTFINDFLAG or CLEARCFFLAG on the GDI Command Line and pressing the Enter key.

- Graphic flags are used to identify model features with a specified attribute or value - for example, a specific customer Record Number.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Clear All Customer Flags
Find A Customer
Find A Customer By Address
Find A Customer By Attribute
Find A Customer By Internal ID Number
Find A Customer By Link ID Number
Find A Customer By Record Number
Undo The Last Data Or Graphic Change
Clear A Customer Flag

Summary

Clears an individual customer flag from the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, one of the “Find” or “Flag Customer” commands has been executed, and a customer has been flagged as a result.

- Select the Clear Customer Flag item from the GDI Command List.
- At the Select Customer To Clear Flag For prompt, move the mouse pointer to a flagged customer and left-click the mouse.
- The selected customer flag will be removed.

Notes & Considerations

- This command can also be executed by typing CLEARCUSTFLAG or CLEARCFLAG on the GDI Command Line and pressing the Enter key.
- Graphic flags are used to identify model features with a specified attribute or value - for example, all customers with zero load.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Find A Customer
Find A Customer By Attribute
Find A Customer By Link ID Number
Flag A Customer
Flag Customers With Invalid Link ID Numbers
Flag Customers With Redundant Link ID Numbers
Select A Feature
Find A Customer By Address
Find A Customer By Internal ID Number
Find A Customer By Record Number
Flag Customers By Item Value
Flag Unassigned Customers
Undo The Last Data Or Graphic Change
Clear Customer Item Flags

Summary

Clears the customer “item” flags from the GDI Display placed by the Flag Customer or Flag Customers By Item Value command.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a customer item flagged is displayed.

- Select the Clear Customer Item Flags item from the GDI Command List.
- All of the customer item flags will be cleared.

Notes & Considerations

- This command can also be executed by typing CLEARCUSTITEMFLAG or CLEARCIFLAG on the GDI Command Line and pressing the Enter key.

- Graphic flags are used to identify model features with a specified attribute or value - for example, all customers with zero load.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Flag A Customer
Flag Customers By Item Value
Undo The Last Data Or Graphic Change
Clear The DXF Find Flag

Summary

Clears the DXF text find flag from the GDI Display placed by the *Find DXF Text* command.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, the *Find DXF Text* command has been executed, and text has been flagged as a result.

- Select the *Clear DXF Find Flag* item from the GDI Command List.
- The DXF text flag will be cleared.

Notes & Considerations

- This command can also be executed by typing CLEARDXFFLAG or CLEARDXF on the GDI Command Line and pressing the *Enter* key.
- Graphic flags are used to identify model features with a specified attribute or value - for example, “AVE” text on a DXF background image.

See Also

*Find DXF Text*
Clear Error Flags

Summary

Clears the Data Check “error” flags from the GDI Display placed by the Data Check routine.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, the Data Check routine has been executed, and a feature with an error has been flagged.

● Select the Clear Error Flags item from the GDI Command List.

● All of the error flags will be cleared.

Notes & Considerations

● This command can also be executed by typing CLEARERRORFLAG or CLEARERROR on the GDI Command Line and pressing the Enter key.

● The Data Check routine checks the model for possible errors. For example, pipes with duplicate ID Numbers or dead end nodes with no load. If the Graphically Flag Items With Errors option is selected on the Data Check Specifications screen, GASWorkS will place flags at the features identified as errors by the Data Check routine. To access the Data Check routine, select the Data Check item from the Utilities menu list.

● If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Undo The Last Data Or Graphic Change
Clear The GeoFind Flag

Summary

Clears the geographic “find” flag from the GDI Display placed by the Find Geographic Location command.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, the Find Geographic Location command has been executed, and a location has been flagged as a result.

- Click the Clear GeoFind Flag icon from the GeoMap Functions Toolbar.
- The geographic location find flag will be cleared.

Notes & Considerations

- This command can also be executed by the Clear GeoFind Flag item from the GDI Command List, or by typing CLEARGEOFIND on the GDI Command Line and pressing the Enter key.

See Also

Find A Geographic Location
Clear The Node Find Flag

Summary

Clears the node “find” flag from the GDI Display placed by one of the Find Node commands.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, one of the Find Node commands has been executed, and a node has been flagged as a result.

- Click the Clear Node Find Flag icon from the Data Edit Commands Toolbar.
- The node find flag will be cleared.

Notes & Considerations

- This command can also be executed by the Clear Node Find Flag item from the GDI Command List, or by typing CLEARNODEDEFINDFLAG or CLEARNFFLAG on the GDI Command Line and pressing the Enter key.

- Graphic flags are used to identify model features with a specified attribute or value - for example, a specific node Name.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Find A Node
Find A Node By Name
Find A Node By Record Number
Undo The Last Data Or Graphic Change
Clear A Node Flag

Summary

Clears an individual node flag from the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, one of the “Find” or “Flag Node” commands has been executed, and a node has been flagged as a result.

- Select the Clear Node Flag item from the GDI Command List.
- At the Select Node To Flag prompt, move the mouse pointer to a flagged node and left-click the mouse. The selected node and flag will be highlighted.
- Right-click the mouse. The selected node flag will be removed.

Notes & Considerations

- This command can also be executed by typing CLEARNODEFLAG or CLEARNFLAG on the GDI Command Line and pressing the Enter key.
- Graphic flags are used to identify model features with a specified attribute or value - for example, a specific node Name.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Find A Node
Find A Node By Name
Find A Node By Record Number
Flag A Node
Flag Nodes By Item Value
Flag The Supply Node
Select A Feature
Undo The Last Data Or Graphic Change
Clear Node Item Flags

Summary

Clears the node “item” flags from the GDI Display placed by the Flag Node and Flag Nodes By Item Value command.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a node item flag is displayed.

- Select the Clear Node Item Flags item from the GDI Command List.
- All of the node item flags will be cleared.

Notes & Considerations

- This command can also be executed by typing CLEARNODEITEMFLAG or CLEARNIFLAG on the GDI Command Line and pressing the Enter key.

- Graphic flags are used to identify model features with a specified attribute or value - for example, a node with a specific Record Number.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Flag A Node
Flag Nodes By Item Value
Undo The Last Data Or Graphic Change
Clear The Pipe Find Flag

Summary

Clears the pipe “find” flag from the GDI Display placed by one of the Find Pipe commands.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, one of the Find Pipe commands has been executed, and a pipe has been flagged as a result.

- Click the Clear Pipe Find Flag icon from the Data Edit Commands Toolbar.
- The pipe find flag will be cleared.

Notes & Considerations

- This command can also be executed by the Clear Pipe Find Flag item from the GDI Command List, or by typing CLEARPIPEFINDFLAG or CLEARPFFLAG on the GDI Command Line and pressing the Enter key.
- Graphic flags are used to identify model features with a specified attribute or value - for example, a specific pipe Record Number.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Find A Pipe
Find A Pipe By Address
Find A Pipe By Attribute
Find A Pipe By Internal ID Number
Find A Pipe By Link ID Number
Find A Pipe By Record Number
Undo The Last Data Or Graphic Change
Clear A Pipe Flag

Summary

Clears an individual pipe flag from the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, one of the “Find” and “Flag Pipe” commands has been executed, and a pipe has been flagged as a result.

- Select the Clear Pipe Flag item from the GDI Command List.
- At the Select Pipe To Flag prompt, move the mouse pointer to a flagged pipe and left-click the mouse. The selected pipe and flag will be highlighted.
- Right-click the mouse. The selected pipe flag will be removed.

Notes & Considerations

- This command can also be executed by typing CLEARPIPEFLAG or CLEARPFLAG on the GDI Command Line and pressing the Enter key.
- Graphic flags are used to identify model features with a specified attribute or value - for example, pipe features with a specific Pipe Pressure Drop.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

- Find A Pipe
- Find A Pipe By Address
- Find A Pipe By Attribute
- Find A Pipe By Internal ID Number
- Find A Pipe By Link ID Number
- Find A Pipe By Record Number
- Flag A Pipe
- Flag Pipes By Item Value
- Select A Feature
- Undo The Last Data Or Graphic Change
Clear Pipe Item Flags

Summary

Clears the pipe “item” flags from the GDI Display placed by the Flag Pipes By Item Value command.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, the Flag Pipes By Item Value command has been executed, and a pipe has been flagged as a result.

- Select the Clear Pipe Item Flags item from the GDI Command List.
- All of the pipe item flags will be cleared.

Notes & Considerations

- This command can also be executed by typing CLEAR PIPEITEMFLAG or CLEARPIFLAG on the GDI Command Line and pressing the Enter key.

- Graphic flags are used to identify model features with a specified attribute or value - for example, all pipes with a maximum pressure drop value.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Flag Pipes By Item Value
Undo The Last Data Or Graphic Change
Clear The Supply Flags

Summary

Clears the “supply” flags from the GDI Display placed by the Flag Supply Nodes command.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, the Flag Supply Nodes command has been executed, and a node has been flagged as a result.

- Select the Clear Supply Flags item from the GDI Command List.
- All of the supply node flags will be cleared.

Notes & Considerations

- This command can also be executed by typing CLEARSUPPLY or CLEARSFLAG on the GDI Command Line and pressing the Enter key.
- Graphic flags are used to identify model features with a specified attribute or value - for example, the node supply flags.

See Also

Flag The Supply Node
Clear Unbroken Intersection Flags

Summary

Clears the “unbroken” intersection flags from the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, the Flag Unbroken Intersections command has been executed, and a node has been flagged as a result.

- Select the Clear Unbroken Intersection Flags item from the GDI Command List.

- A message will be displayed asking whether to reset the Allow Intersection Flag option. Either click the Yes command button to enable the intersection flag option for the flagged nodes, or click the No command button to disable this option for these nodes.

- All of the unbroken intersection flags will be cleared from the model.

Notes & Considerations

- This command can also be executed by typing CLEARUNBROKEN on the GDI Command Line and pressing the Enter key.

- To remove the unbroken intersection flags individually, use the Unset Intersection Flag command.

- The Allow Intersection Flag option can be found in the Graphic Data Items section in the Node Data.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Edit Node Data
Flag Unbroken Intersections
Undo The Last Data Or Graphic Change
Unset An Intersection Flag
Use The Data Panel
Clear The User Text Find Flag

Summary

Clears the User Text “find” flag from the GDI Display placed by the Find User Text command.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, the Find User Text command has been executed, and text has been flagged as a result.

- Click the Clear User Text Find Flag icon from the User Text Commands Toolbar.
- The User Text find flag will be cleared.

Notes & Considerations

- This command can also be executed by the Clear User Text Find Flag item from the GDI Command List, or by typing CLEARTEXTFLAG or CLEARTFLAG on the GDI Command Line and pressing the Enter key.

- Graphic flags are used to identify model features with a specified attribute or value - for example, a User Text feature with a specific value.

See Also

Find User Text
Close The GDI Window

Summary

Closes the GDI (Graphic Data Interface) Window.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- **Close Icon** -
  
  - Click the *Close GDI Window* icon from the *GDI Window Controls Toolbar*.

- **GDI Command List** -
  
  - Select the *Close GDI Window* item from the GDI Command List.

- **GDI Command Line** -
  
  - Type CLOSE on the GDI Command Line and press the *Enter* key.

- **Windows Close Icon** -
  
  - Click the “X” icon in the upper-right corner of the GDI Window.

Notes & Considerations

- The GDI Window will close automatically either when a model is closed, the GASWorkS program is terminated, or when a GDI Command that requires closing the GDI Window is executed.

- The GDI Window cannot be closed if a GDI Command is running. Use the *Cancel The Current GDI Command* command to stop a running command.

- To redisplay the GDI Window, select the View/Edit item from the Graphics menu list.
See Also

Cancel The Current GDI Command
Graphically View A Model
Color Display Settings

Summary

The Color Display Settings screen allows for the default colors for the model features to be set, create a query to color features that meet a specified criteria, and create a color range based on a particular item value.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Color Display Settings icon from the Display Controls Toolbar. The Color Display Settings screen is displayed.
  - On the Default Colors data tab, left-click on one of the color panels to change the default color of the associated feature. Select an item from the Pipe Lines list to specify whether pipe colors default to either the “Facility Table”, the “Pipe Property Table”, or the “Selected Color” in the color panel. Click the Apply Default Colors command button to apply the specified colors to the model.
  - On the Color By Query data tab, left-click on the color panel to change the highlight color for queried features. Click the Define Query Specifications command button to display the Query Specifications screen. Click the Apply Query Colors command button to apply the specified color to the model features that match the query.
  - On the Range Colors data tab, select an item from the Item and Units lists to specify a data item. Left-click on one of the color panels to change the color of the associated range. Click the Apply Range Colors command button to apply the range colors to the model.
    - Either click the Allocate command button to compute value ranges with approximately an equal number of features in each range, click the Calculate command button to compute uniform value ranges based on the highest and lowest values for a particular item, or type values into the To data fields to set the ranges manually.
  - Either click the Save Feature Colors command button to save the applied colors, click the Reset Feature Colors command button to return all of the model features to the default colors, or click the Close command button to exit the Color Display Settings screen and return to the GDI Window.
Notes & Considerations

- This command can also be executed by the Color Display Settings item from the GDI Command List, or by typing SETCOLORS on the GDI Command Line and pressing the Enter key.

- The default color values will only apply to features whose Symbol Color item is set to “Default”. This setting can be found in the Graphic Data Items section in the Data Panel.

See Also

- Color Code By Query
- Color Code By Range
- Query Specifications Screen
- Use The Data Panel
Combine Pipes

Summary

Combines pipe features when the length of one of the pipe features is less than a User specified length and only connected to one pipe.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two pipes are present in the model.

- Select the Combine Pipes item from the GDI Command List. The Pipe Combination Specifications screen is displayed.
  
  - Type a value in the Combine Pipes With Length Less Than data field, and select the dimensional units from the list. This sets the length limit below which pipes will be combined.
  
  - To enable the Only Combine Same Size & Type Pipes and/or the Only Combine Pipes Where Common Load Has No Load options, select the checkboxes. To disable the options, unselect the checkboxes.
  
  - Click the Combine command button to execute the command. When the process is complete, the number of nodes eliminated be will be displayed in the Status Bar.
  
  - Click the Close command button to exit the screen.

Notes & Considerations

- This command can also be executed by typing COMBINEPIPES or COMBINE on the GDI Command Line and pressing the Enter key.

- Combining 2-point pipe features will change the graphic type to a polyline pipe.

- Arc pipe features cannot be combined.

- Importing a model can create extra nodes that result in pipes of very short length. This command is useful for quickly identifying and eliminating such extra nodes and pipes.
See Also

General Import & Merge Information
Compare Two Models

Summary

Compares User specified features and data values of the currently open model to a previously saved model.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and another previously saved model exists.

- Select the Compare Two Models item from the GDI Command List.

- The Model Comparison Options screen is displayed. Select the desired items to compare and enter a Fuzzy Tolerance value if needed. Click the Continue command button.

- The Model Selection screen is displayed. Select a model. Click the Continue command button. Note - A message may be displayed if the open model is selected. Click the OK command button to clear the message and return to the Model Selection screen.

- The Model Comparison Report will be displayed stating the differences between the open Current Model and the selected Comparison Model. Review the report. When finished, click the Close command button to exit the report.

Notes & Considerations

- This command can also be executed by typing COMPAREMODEL or COMPARE on the GDI Command Line and pressing the Enter key.

See Also

None
Connect Pipe Ends

Summary

Connects a group of pipe features to a common node.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two pipes are present in the model.

- Select the Connect Pipe Ends item from the GDI Command List.

- At the Select A Pipe Near The End To Move prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.

- Continue selecting pipes to connect with the method above. When finished, right-click the mouse.

- At the Location For The Common Node prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. A node will be placed at the selected location.

- Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- If the Automatically Update Pipe Length graphic settings option is selected, the Hydraulic Length of the pipe will automatically be recalculated. If not, a message will be displayed asking whether to update the Hydraulic Length. Either click the Yes command button to update the length, or click the No command button to preserve the previous value.

- The selected pipe features will now be connected at the common node.

Notes & Considerations

- This command can also be executed by typing CONNECTPIPEENDS or CONNECT on the GDI Command Line and pressing the Enter key.

- To unselect (unhighlight) a selected (highlighted) feature, move the mouse pointer to the selected feature and left-click the mouse. The feature will be unhighlighted, indicating it is no longer selected.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Select A Feature
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Use The Data Panel
Convert All Arc Pipes To Polyline Pipes

Summary

Converts all of the arc pipe features to polyline pipe features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one arc type pipe is present in the model.

- Select the *Convert All Arc Pipes To Polyline Pipes* item from the GDI Command List.
- A message will be displayed stating how many pipes were updated. Click the *OK* command button to clear the message.

Notes & Considerations

- This command can also be executed by typing CONVERTALLARCS or ALLARC2POLY on the GDI Command Line and pressing the *Enter* key.

- Some of the editing tools in GASWorkS cannot be used on arc type pipes. Converting arc pipes to polyline pipes allows the use of edit commands reserved for non-arc pipes while mostly keeping the original shape intact.

- Arc pipes are converted to polyline pipes by placing a vertex at each degree of curvature along the arc path, and drawing a straight line between each pair of vertices.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

See Also

- Add An Arc Pipe
- Undo The Last Data Or Graphic Change
Convert An Arc Pipe To A Polyline Pipe

Summary

Converts an arc pipe feature to a polyline pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one arc type pipe is present in the model.

- Select the Convert Arc Pipe To Polyline Pipe item from the GDI Command List.
- At the Select An Arc Pipe prompt, move the mouse pointer to an arc type pipe and left-click the mouse.
- The selected pipe will be converted to a polyline type pipe.

Notes & Considerations

- This command can also be executed by typing CONVERTARC or ARC2POLY on the GDI Command Line and pressing the Enter key.
- Some of the editing tools in GASWorkS cannot be used on arc type pipes. Converting arc pipes to polyline pipes allows the use of edit commands reserved for non-arc pipes while mostly keeping the original shape intact.
- Arc pipes are converted to polyline pipes by placing a vertex at each degree of curvature along the arc path, and drawing a straight line between each pair of vertices.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add An Arc Pipe
Select A Feature
Undo The Last Data Or Graphic Change
Convert Color Legend To User Text

Summary

Converts the Color Legend into a group of User Text features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and the Color Legend is displayed.

- Select the Convert Color Legend To User Text item from the GDI Command List. Note- If there is already a Color Legend Text present in the model, a message will be displayed asking whether to delete the existing legend after adding the new one. Either click the Yes command button to remove the existing legend, click the No command button to keep the existing legend and proceed with adding a second legend, or click the Cancel command button to end the command and preserve the model as is.

- At the Select Location For Color Legend Text prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The selected location will be the upper-left corner of the Color Legend.

- At the Text Rotation prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the orientation of the Color Legend Text.

- At the Text Height prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The text height will be set to the length of the line that is displayed in the GDI Display.

- The Color Legend Text will be displayed at the selected location. Note - If there is an existing Color Legend Text that was not deleted, a message will be displayed stating that the existing legend was changed to text values. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing CONVERTCOLORLEGEND OR CONVERTCL on the GDI Command Line and pressing the Enter key.

- A color range can be created from the Color Display Settings screen.
To change the location of a Color Legend Text, use the Move Color Legend Text command.

The Color Legend Text is treated as a group of features, and can be manipulated by the associated Group commands.

If a second Color Legend Text is created, the first Color Legend Text is ungrouped into individual User Text features. The first Color Legend Text can then be manipulated by the associated User Text commands.

To remove the Color Legend Text from the model, use the Delete Color Legend Text command.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Color Code By Range
Color Display Settings
Delete The Color Legend Text
Display The Color Legend
Move The Color Legend Text
Set A Feature’s Dimensions
Undo The Last Data Or Graphic Change
Convert Service Lines To Customers

Summary

Converts a pipe feature assigned to a specified Facility Type from a DXF layer to a customer symbol and service line.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a DXF file with service pipe lines is displayed as a background image.

- Select the Convert Service Lines To Customers item from the GDI Command List.
- At the Facility Type Associated With Service Lines prompt, select the desired item from the GDI Prompt List.
- At the Fuzzy Tolerance prompt, type a value (in Coordinate units) on the GDI Prompt Line and press the Enter key.
- A message will be displayed stating when the process is complete. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing CONVERTSERVICE or SERVICE2CUST on the GDI Command Line and pressing the Enter key.
- A Facility Type must be set to “Active” in order to convert DXF service lines to that type. The “Active” setting can be changed using the Facility Settings item from the Edit menu list.

See Also

Add A DXF Background Image
Copy A Customer

Summary

Copies an existing customer feature to one or more User specified locations.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer and one pipe feature are present in the model.

- Select the Copy Customer item from the GDI Command List.
- At the Select Customer To Copy prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted.
- At the Select New Customer Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse. The copied customer will be placed at the selected location.
- At the Select Supply Main prompt, move the mouse pointer to a pipe and left-click the mouse. Note - A message may be displayed if the selected pipe cannot have customers attached. Click the OK command button to return to the prompt.
- A service line will be drawn from the customer location to the assigned supply main, and the tap will be placed at the intersection between the service and the main.
- The Select New Customer Location prompt will be displayed again. Continue copying customers with the method described above. When finished, right-click the mouse to end the command.

Notes & Considerations

- This command can also be executed by typing COPYCUSTOMER or COPYC on the GDI Command Line and pressing the Enter key.
- Copies of customers are assigned the next available customer Record and Internal ID Number. For example, if the highest existing customer ID Number in the model is 12, and three customers are copied, the ID Number for the copied customers will be 13, 14, and 15, respectively.
- To create a copy of an existing customer and it's service line, use the Copy Customer & Service command.
To create a copy of an existing customer at the same location as that existing customer, use the **Add Duplicate Customer** command.

To change a customer’s location, either use the **Move Customer** command or grips.

To change a customer’s supply main, use the **Reassign Customer Supply Main** command.

To change the location of the service tap along a supply main, either use the **Move Service Tap** command or grips.

To change the Customer Data, either use the **Edit Customer Data** command or left-click on the desired customer feature to display the data in the Data Panel.

To remove a customer feature from the model, use the **Delete Customer** command.

If the **Allow Undo Of Data/Graphic Changes** preference settings option is enabled, click the **Undo** icon to restore the original configuration. To access the option, select the **Settings** item from the **Preferences** submenu from the **File** menu list.

**See Also**

- Add A Customer
- Add A Duplicate Customer
- Copy A Customer & Service
- Delete A Customer
- Edit Customer Data
- Grips
- Move A Customer
- Move A Service Tap
- Reassign A Customer’s Supply Main
- Select A Feature
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Copy A Customer & Service

Summary

Copies an existing customer feature and its service main to one or more User specified locations.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer and one pipe feature are present in the model.

- Select the Copy Customer & Service item from the GDI Command List.
- At the Select Customer To Copy prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted.
- At the Select New Tap Location prompt, move the mouse crosshairs to a pipe and left-click the mouse. A copy of the original service line will be drawn from the selected pipe location. The customer location will be placed at the end of the copied service line.
- The Select New Tap Location prompt will be displayed again. Repeat the steps above to copy more customer features. When finished, right-click the mouse to end the command.

Notes & Considerations

- This command can also be executed by typing COPYCUSTOMERSERVICE or COPYCS on the GDI Command Line and pressing the Enter key.
- Copies of customers are assigned the next available customer Record and Internal ID Number. For example, if the highest existing customer ID Number in the model is 12, and three customers are copied, the ID Number for the copied customers will be 13, 14, and 15, respectively.
- To create a copy of an existing customer at a new location and assign the supply main, use the Copy Customer command.
- To create a copy of an existing customer at the same location as that existing customer, use the Add Duplicate Customer command.
- To change a customer’s location, either use the Move Customer command or grips.
- To change a customer’s supply main, use the Reassign Customer Supply Main command.
• To change the location of the service tap along a supply main, either use the *Move Service Tap* command or grips.

• To change the Customer Data, either use the *Edit Customer Data* command or left-click on the desired customer feature to display the data in the Data Panel.

• To remove a customer feature from the model, use the *Delete Customer* command.

• If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A Customer
- Add A Duplicate Customer
- Copy A Customer Only
- Delete A Customer
- Edit Customer Data
- Grips
- Move A Customer
- Move A Service Tap
- Reassign A Customer’s Supply Main
- Select A Feature
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Copy A Group

Summary

Copies a previously created group to one or more User specified locations.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a group has been created in the model.

- Select the Copy Group item from the GDI Command List.

- At the Select A Feature In The Group To Copy prompt, move the mouse pointer to a group feature and left-click the mouse. Note - If the selected feature is not part of a group, a message will be displayed. Click the OK command button to return to the prompt. All group features will be highlighted.

- At the Select Base Point For The Group prompt, move the mouse crosshairs to a point on the group and left-click the mouse. This sets the base point relative to which the copied group features will be moved.

- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse. The line in the GDI Display represents the distance and direction the copied group features will move. The group of features will be copied to the selected location.

- The Select New Location prompt will be displayed again. Continue copying customers with the method described above. When finished, right-click the mouse to end the command.

Notes & Considerations

- This command can also be executed by typing COPYGROUP or COPYG on the GDI Command Line and pressing the Enter key.

- This command copies all of the features within a group, regardless of their type.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Create A Group
Select A Feature
Undo The Last Data Or Graphic Change
Copy A Pipe

Summary

Copies an existing pipe feature to a User specified location.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe feature is present in the model.

- Select the Copy Pipe item from the GDI Command List.

- At the Select Pipe To Copy prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.

- At the Select Base Node prompt, move the mouse pointer to a node and left-click the mouse. This sets the base node relative to which the copied pipe will move.

- At the Select New Location prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- Note - If customers are attached to the selected pipe, a message will be displayed asking whether to include the attached customers. Either click the Yes command button to create copies of the customers attached to the copy of the pipe, or click the No command button to copy the pipe only.

- The pipe feature will be copied to the selected location and drawn from the new Base Node location.

Notes & Considerations

- This command can also be executed by typing COPYPIPE or COPYP on the GDI Command Line and pressing the Enter key.

- Copies of pipes are assigned the next available pipe Record and Internal ID Number. For example, if the highest existing pipe ID Number in the model is 12, and three pipes are copied, the ID Number for the copied pipes will be 13, 14, and 15, respectively.

- To change the Pipe Data, either use the Edit Pipe Data command or left-click on the desired pipe feature to display the data in the Data Panel.
To change the location of a pipe feature, use the Move Pipe command. To change the location of one end of a pipe, use the Move Pipe End command or grips.

To remove a pipe feature from the model, use the Delete Pipe command.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Edit Pipe Data
Grips
Move A Pipe
Move A Pipe End
Select A Feature
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Use The Data Panel
Copy Saved Views From Model

Summary

Copies all of the saved views from a previously saved model to the currently open model.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and another model exists with saved views.

- Select the Copy Saved Views From Model item from the GDI Command List.

- The Model Selection screen is displayed. Select a Saved Graphic View file (.vew). Click the Continue command button.

- A message will be displayed asking whether to overwrite the existing file. Respond appropriately to return to the Model Selection screen.

- A message will be displayed when the views have been copied. Click OK to clear the message.

Notes & Considerations

- This command can also be executed by typing COPYVIEWS or COPYV on the GDI Command Line and pressing the Enter key.

- To create a saved view from the current limits of the GDI Display, use the Save Current View command.

See Also

Save The Current View
Copy A User Graphic Image

Summary

Copies an existing User Graphic Image to one or more User specified locations.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Image is present in the model, and the Display User Graphics option is “on”.

- Select the Copy User Graphic Image item from the GDI Command List.
- At the Select User Graphic Image To Copy prompt, move the mouse pointer to a User Graphic Image and left-click the mouse. The selected image will be highlighted.
- At the Select Base Point On User Graphic Image prompt, move the mouse crosshairs to a point on the User Graphic Image and left-click the mouse. This sets the base point relative to which the copied image will move.
- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse. The line in the GDI Display represents the distance and direction the copied image will move. The User Graphic Image will be copied to the selected location and drawn from the new Base Point location.
- The Select New Location prompt will be displayed again. Use the method above to create other copies of the selected User Graphic Image. When finished, press the Esc key, right-click the mouse, or click the Cancel icon.

Notes & Considerations

- This command can also be executed by typing COPYIMAGE or COPYI on the GDI Command Line and pressing the Enter key.
- To change the User Graphic Image Data, either use the Edit User Graphic Image command or left-click on the desired User Graphic Image to display the data in the Data Panel.
- To change the location of a User Graphic Image, either use the Move User Graphic Image command or grips.
- To remove a User Graphic Image from the model, use the Delete User Graphic Image command.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Image
Delete A User Graphic Image
Display The User Graphics
Edit A User Graphic Image
Grips
Move A User Graphic Image
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Copy A User Graphic Line

Summary

Copies an existing User Graphic Line to one or more User specified locations.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one User Graphic Line is present in the model, and the Display User Graphics option is “on”.

- Select the Copy User Graphic Line item from the GDI Command List.

- At the Select User Graphic Line To Copy prompt, move the mouse pointer to a User Graphic Line and left-click the mouse. The selected line will be highlighted.

- At the Select Base Point On User Graphic Line prompt, move the mouse crosshairs to a point on the User Graphic Line and left-click the mouse. This sets the base point relative to which the copied line will move.

- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse. The line in the GDI Display represents the distance and direction the copied image will move. The User Graphic Line will be copied to the selected location and drawn from the new Base Point location.

- The Select New Location prompt will be displayed again. Use the method above to create other copies of the selected User Graphic Line. When finished, press the Esc key, right-click the mouse, or click the Cancel icon.

Notes & Considerations

- This command can also be executed by typing COPYLINE or COPYL on the GDI Command Line and pressing the Enter key.

- To change the User Graphic Line Data, either use the Edit User Graphic Line command or left-click on the desired User Graphic Line to display the data in the Data Panel.

- To change the location of a User Graphic Line, either use the Move User Graphic Line command or grips.

- To remove a User Graphic Line from the model, use the Delete User Graphic Line command.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

### See Also

- Add A User Graphic Line
- Delete A User Graphic Line
- Display The User Graphics
- Edit A User Graphic Line
- Grips
- Move A User Graphic Line
- Select A Feature
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Copy A User Graphic Symbol

Summary

Copies an existing User Graphic Symbol to one or more User specified locations.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one User Graphic Symbol is present in the model, and the Display User Graphics option is “on”.

- Select the Copy User Graphic Symbol item from the GDI Command List.
- At the Select User Graphic Symbol To Copy prompt, move the mouse pointer to a User Graphic Symbol and left-click the mouse. The selected symbol will be highlighted.
- At the Select Base Point On User Graphic Symbol prompt, move the mouse crosshairs to a point on the User Graphic Symbol and left-click the mouse. This sets the base point relative to which the copied symbol will move.
- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse. The line in the GDI Display represents the distance and direction the copied symbol will move. The User Graphic Symbol will be copied to the selected location and drawn from the new Base Point location.
- The Select New Location prompt will be displayed again. Use the method above to create other copies of the selected User Graphic Symbol. When finished, press the Esc key, right-click the mouse, or click the Cancel icon.

Notes & Considerations

- This command can also be executed by typing COPYSYMBOL or COPYS on the GDI Command Line and pressing the Enter key.
- To change the User Graphic Symbol Data, either use the Edit User Graphic Symbol command or left-click on the desired User Graphic Symbol to display the data in the Data Panel.
- To change the location of a User Graphic Symbol, either use the Move User Graphic Symbol command or grips.
- To remove a User Graphic Symbol from the model, use the Delete User Graphic Symbol command.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Symbol
Delete A User Graphic Symbol
Display The User Graphics
Edit A User Graphic Symbol
Grips
Move A User Graphic Symbol
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Copy The User Graphics From A Model

Summary

Copies all of the User Graphic features (Lines and Symbols) from a previously saved model to the currently open model.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and another model exists with User Graphics.

- Select the Copy User Graphics From Model item from the GDI Command List.

- A message will be displayed stating that the User Graphic Images will not be copied. Either click the Yes command button to proceed, or click the No command button to end the command.

- If the Yes command button is clicked, the Model Selection screen is displayed. Select a User Graphics file (.ugd). Click the Continue command button.

- A message will be displayed stating that the User Graphic Lines and Symbols have been copied. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing COPYALLGRAPHICS on the GDI Command Line and pressing the Enter key.

- This command does not copy User Graphic Images.

- To turn the display of the User Graphics “on” or “off”, use the Display User Graphics command.

See Also

Add A User Graphic Line
Add A User Graphic Symbol
Display The User Graphics
Copy A User Table

Summary

Copies an existing User Table to one or more User specified locations.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Table is present in the model.

- Select the Copy User Table item from the GDI Command List.

- At the Select A Feature In The User Table To Copy prompt, move the mouse pointer to an item in the User Table and left-click the mouse. All table features will be highlighted. Note - If the selected feature is not part of a User Table, a message will be displayed. Click the OK command button to return to the prompt.

- At the Select Base Point On User Table prompt, move the mouse crosshairs to a point on the User Table and left-click the mouse. This sets the base point relative to which the copied User Table will move.

- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse. The line in the GDI Display represents the distance and direction the copied table will move. The User Table will be copied to the selected location and drawn from the new Base Point location.

- The Select New Location prompt will be displayed again. Use the method above to create other copies of the selected User Table. When finished, press the Esc key, right-click the mouse, or click the Cancel icon.

Notes & Considerations

- This command can also be executed by typing COPYTABLE on the GDI Command Line and pressing the Enter key.

- To change the contents of a User Table, use the Edit User Table command.

- To change the location of a User Table, use the Move User Table command.

- To remove a User Table from the model, use the Delete User Table command.
If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

### See Also

- Create A User Table
- Delete A User Table
- Edit A User Table
- Move A User Table
- Select A Feature
- Undo The Last Data Or Graphic Change
Copy User Text

Summary

Copies an existing User Text feature to one or more User specified locations.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one User Text feature is present in the model, and the Display User Text option is “on”.

- Select the Copy User Text item from the GDI Command List.

- At the Select User Text To Copy prompt, move the mouse pointer to a User Text feature and left-click the mouse. The selected text will be highlighted.

- At the Select Base Point On User Text prompt, move the mouse crosshairs to a point on the User Text and left-click the mouse. This sets the base point relative to which the copied text will move.

- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse. The line in the GDI Display represents the distance and direction the copied text will move. The User Text will be copied to the selected location and drawn from the new Base Point location.

- The Select New Location prompt will be displayed again. Use the method above to create other copies of the selected User Text. When finished, press the Esc key, right-click the mouse, or click the Cancel icon.

Notes & Considerations

- This command can also be executed by typing COPYTEXT or COPYT on the GDI Command Line and pressing the Enter key.

- To change the User Text Data, either use the Edit User Text command or left-click on the desired User Text feature to display the data in the Data Panel.

- To change the location of a User Text feature, either use the Move User Text command or grips.

- To remove a User Text feature from the model, use the Delete User Text command.
If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add User Text
- Delete User Text
- Display The User Text
- Edit User Text
- Grips
- Move User Text
- Select A Feature
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Copy The User Text From A Model

Summary

Copies all of the User Text features from a previously saved model to the currently open model.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and another model exists with User Text features.

- Select the Copy User Text From Model item from the GDI Command List.

- The Model Selection screen is displayed. Select a User Text file (.gtx). Click the Continue command button.

- A message will be displayed when the User Text features have been copied to the current model. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing COPYALLTEXT on the GDI Command Line and pressing the Enter key.

See Also

Add User Text
Add User Text Associated With A Feature
Create A Branch Customer Tap

Summary

Creates a branch and trunk style customer feature from two existing customer features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two customers are present in the model, with at least one trunk service.

- Click the Create Branch Customer Tap icon from the Customer Commands Toolbar.

- At the Select Customer To Create Branch Tap For prompt, move the mouse crosshairs over a customer and left-click the mouse. The selected customer will be highlighted, and this will be the branch customer. Note - A message may be displayed if the selected customer is already part of a branch service. Click the OK command button to clear the message and return to the prompt.

- At the Select Customer To Branch From prompt, move the mouse pointer to a trunk customer and left-click the mouse. The selected customer will be highlighted, and this will be the trunk customer. Note - A message may be displayed if the selected customer is not a trunk customer, or already has a branch customer. Click the OK command button to clear the message and return to the prompt.

- At the Select New Tap Location prompt, move the mouse crosshairs to a location on the highlighted trunk service line and left-click the mouse.

- A service line will be drawn from the customer location to the selected tap location on the selected trunk service line.

Notes & Considerations

- This command can also be executed by the Create Branch Customer Tap item from the GDI Command List, or by typing CREATEBRANCHCUST or CREATEBRANCH on the GDI Command Line and pressing the Enter key.

- Branch services in GASWorkS run in a straight line from the branch customer symbol to the tap location on the trunk service line.
A trunk customer service runs from the customer location to a tap location on a supply main. A branch customer service taps off of a trunk service rather than a main. Branch customers are assigned to the supply main of their trunk customer. Each trunk customer can only have one branch customer.

The branch customer will retain its original customer Internal ID Number.

To enter a name for the new branch customer off of an existing customer, use the Add Branch Customer command.

To change the Customer Data, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.

To move a branch service tap to a different trunk service, use the Move Branch Service Tap command.

The Node Load Application item in the Customer Data determines where the customer load is applied to in the model. The “From Node” option adds the entire value to the From Node of the tapped supply main. The “To Node” option adds the entire value to the To Node. The “Both Nodes” option splits the customer load evenly between the From Node and the To Node. The customer load value is added to the External Load of the chosen node(s). The “None” option does not apply the value to either node. The “Diversified” option indicates to use the selected Diversity load calculation method.

To remove a customer feature from the model, use the Delete Customer command.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Branch Customer
Add A Customer
Delete A Customer
Edit Customer Data
Grips
Move A Branch Service Tap
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Create A Group

Summary

Creates a group of pipe, User Graphics, and/or User Text features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe, User Graphic, or User Text feature is present in the model.

- Select the Create Group item from the GDI Command List.
- At the Select First Feature prompt, move the mouse pointer to a pipe, User Graphic, or User Text feature and left-click the mouse. The selected feature will be highlighted.
- At the Select Another Feature prompt, use the method above to select additional features for the group. When finished, right-click the mouse.
- At the Group Type prompt, select an item from the GDI Prompt List. Note - A message may be displayed if one of the selected features is part of another group. Either click the Yes command button to remove such features from their original group and add them to this group, or click the No command button to keep them in their current group.
- A message will be displayed stating the Group ID and the number of items added to the group. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing CREATEGROUP on the GDI Command Line and pressing the Enter key.
- To unselect (unhighlight) a selected (highlighted) feature, move the mouse pointer to the selected feature and left-click the mouse. The feature will be unhighlighted, indicating it is no longer selected.
- To add features to an existing group, use the Add Feature To Group command.
- To remove features from an existing group, use the Remove Feature From Group command.
- To ungroup a single group of features, use the Dissolve Group command.
To create copies of the features in a group, use the *Copy Group* command.

To change the location of a group, use the *Move Group* command.

To create a User specified *Group Type* list, use the Data List Definition routine. This routine is found from the *Data List Definition* item from the *Edit* menu list.

To remove a group and all of its features from the model, use the *Delete Group* command.

If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Feature To A Group
- Add A Polyline Pipe
- Add A User Graphic Image
- Add A User Graphic Line
- Add A User Graphic Symbol
- Add User Text
- Copy A Group
- Delete A Group
- Dissolve The Features In A Group
- Move A Group
- Remove A Feature From A Group
- Select A Feature
- Undo The Last Data Or Graphic Change
Create A Symbol Legend

Summary

Creates a legend (in table form) of the User Graphic Symbols that are used in the model.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Symbol is present in the model.

- Select the Create Symbol Legend item from the GDI Command List.
- At the Symbol Legend Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The selected location will be the upper-left corner of the legend.
- At the Table Width prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The length of the line between the two points represents the table width.
- At the Text Height prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The text height will be set to the length of the line that is displayed in the GDI Display.
- At the User Graphic Symbol Size prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The length of the line between the insertion point and the two points represents the symbol size.
- At the Number Of Columns prompt, type a value on the GDI Prompt Line and press the Enter key.
- The Symbol Legend will be created and displayed in the selected location.

Notes & Considerations

- This command can also be executed by typing CREATESYMBOLLEGEND or CREATESYMLEG on the GDI Command Line and pressing the Enter key.
- To change the location of the Symbol Legend, use either the Move Group or the Move User Table command.
To remove the Symbol Legend from the model, use either the Delete Group or the Delete User Table command.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Symbol
Delete A Group
Delete A User Table
Move A Group
Move A User Table
Set A Feature’s Dimensions
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Create A User Table

Summary

Creates and adds a User Table.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Create User Table item from the GDI Command List.
- At the Table Title prompt, type a title on the GDI Prompt Line and press the Enter key.
- At the Number Of Rows prompt, type a value on the GDI Prompt Line and press the Enter key.
- At the Number Of Columns prompt, type a value on the GDI Prompt Line and press the Enter key.
- The User Table Editor screen is displayed. Type information into the data cells, and edit as needed. When finished, click the Close command button.
- A message will be displayed asking whether to save the table contents to the model. Either click the Yes command button to proceed with adding the table to the model, click the No command button to end the command, or click the Cancel command button to return to the User Table Editor screen to make additional changes.
- If the Yes command button is clicked, at the Select Location For Upper-Left Corner prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The selected location will be the upper-left corner of the User Table.
- At the Text Height prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The text height will be set to the length of the line that is displayed in the GDI Display.
- The User Table will be displayed at the selected location.

Notes & Considerations

- This command can also be executed by typing CREATETABLE on the GDI Command Line and pressing the Enter key.
User Tables provide a way to print model or item data with the system layout - for example, a bill of materials for a plan set.

To change the contents of a User Table, use the *Edit User Table* command.

To change the location of a User Table, use the *Move User Table* command.

To create a copy of an existing User Table, use the *Copy User Table* command.

To remove a User Table from the model, use the *Delete User Table* command.

If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

### See Also

- Copy A User Table
- Delete A User Table
- Edit A User Table
- Move A User Table
- Set A Feature’s Dimensions
- Undo The Last Data Or Graphic Change
Delete The Color Legend Text

Summary

Deletes the Color Legend Text.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and the Color Legend is displayed as User Text in the model.

- Select the Delete Color Legend Text item from the GDI Command List.
- A message will be displayed asking whether to delete the Color Legend Text. Either click the Yes command button to proceed, or click the No command button to end the command.
- If the Yes command button is clicked, the Color Legend Text will be deleted.

Notes & Considerations

- This command can also be executed by typing DELETECOLOR on the GDI Command Line and pressing the Enter key.
- If a second Color Legend Text is displayed, the first Color Legend Text is the one deleted. Re-execute the command to delete the second Color Legend Text.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Convert Color Legend To User Text
Undo The Last Data Or Graphic Change
Delete A Customer

Summary

Deletes a customer feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Click the Delete Customer icon from the Customer Commands Toolbar.
- At the Select Customer prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be deleted.

Notes & Considerations

- This command can also be executed by the Delete Customer item from the GDI Command List, or by typing DELETECUSTOMER or DELC on the GDI Command Line and pressing the Enter key.
- Deleting a customer removes its load from the model. The External Load of any affected node will update automatically.
- To remove all customer features from the model, use the Delete All Customers command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Customer
Delete All Customers
Select A Feature
Undo The Last Data Or Graphic Change
Delete All Customers

Summary

Deletes all of the customer features in the current model.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the *Delete All Customers* item from the GDI Command List.

- A message will be displayed asking whether to delete all of the customers. Either click the *Yes* command button to proceed, or click the *No* command button to end the command.

- If the *Yes* command button is clicked, a message will be displayed when the process is complete. Click the *OK* command button to clear the message.

Notes & Considerations

- This command can also be executed by typing DELETEALLCUST on the GDI Command Line and pressing the *Enter* key.

- Deleting a customer removes its load from the model. The nodes where the load was assigned are updated automatically.

- To remove a single customer feature from the model, use the *Delete Customer* command.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

See Also

- Add A Customer
- Delete A Customer
- Undo The Last Data Or Graphic Change
Delete A Group

Summary

Deletes an existing group.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one group is present in the model.

- Select the Delete Group item from the GDI Command List.
- At the Select A Feature In The Group To Delete prompt, move the mouse pointer to a grouped feature and left-click the mouse. The selected group will be highlighted.
- A message will be displayed asking whether to delete the selected group features. Either click the Yes command button to proceed, or click the No command button to end the command.
- If the Yes command button is clicked, a message will be displayed asking whether to delete any attached customers. Either click the Yes command button to delete the group features and the attached customers, click the No command button to only delete the group features, or click the Cancel command button to end the command and preserve the model as is.
- A message will be displayed when the process is complete stating how many items were deleted. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing DELETEGROUP or DELG on the GDI Command Line and pressing the Enter key.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Create A Group
Undo The Last Data Or Graphic Change
Select A Feature
Delete A Marked View

Summary

Deletes a marked view.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one marked view is present in the model.

- Select the *Delete Marked View* item from the GDI Command List.
- At the *Select Center Of Marked View To Delete* prompt, move the mouse pointer to a point within the cross-hatched area of a marked view and left-click the mouse.
- The selected marked view will be deleted.

Notes & Considerations

- This command can also be executed by typing DELTEMARKEDVIEW or DELMVIEW on the GDI Command Line and pressing the *Enter* key.
- This command is for deleting a single marked view, which is not the same as a saved view.
- To remove all marked views from the model, use the *Delete All Marked Views* command.
- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

See Also

- Delete All Marked Views
- Mark The Current View
- Save The Current View
- Undo The Last Data Or Graphic Change
Delete All Marked Views

Summary

Deletes all of the marked views (indicated by cross-hatched areas in the GDI Display) in the current model.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one marked view is present in the model.

- Select the **Delete All Marked Views** item from the GDI Command List.

- A message will be displayed asking whether to delete all of the marked views. Either click the **Yes** command button to proceed, or click the **No** command button to end the command.

- If the **Yes** command button is clicked, all of the marked views will be deleted.

Notes & Considerations

- This command can also be executed by typing **DELETEALLVIEWS** on the GDI Command Line and pressing the **Enter** key.

- This command is for deleting all of the marked views, which are not the same as saved views.

- To remove a single marked view from the model, use the **Delete Marked View** command.

- If the **Allow Undo Of Data/Graphic Changes** preference settings option is enabled, click the **Undo** icon to restore the original configuration. To access the option, select the **Settings** item from the **Preferences** submenu from the **File** menu list.

See Also

- **Delete A Marked View**
- **Mark The Current View**
- **Save The Current View**
- **Undo The Last Data Or Graphic Change**
Delete A Node

Summary
Deletes a node.

Example
The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Select the Delete Node item from the GDI Command List.
- At the Select A Node prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be replaced by a vertex, and any connected pipes will be joined into one polyline pipe.

Note - If the selected node is connected to more than two pipes, a message will be displayed stating that the node cannot be deleted. Click the OK command button to continue.
- A message will be displayed stating that the common node is connected to more than two pipes. Either click the Yes command button to proceed, or click the No command button to end the command.
- If the Yes command button is clicked, the two pipes with the lowest Record Numbers will be joined into one polyline pipe with a vertex at the node location. The node will not be deleted.

Notes & Considerations
- This command can also be executed by typing DELETENODE or DELN on the GDI Command Line and pressing the Enter key.
- This command joins two pipe features that intersect at the node. The pipe with the lower Record Number is preserved, and its data is used for the new pipe. The Hydraulic Length of the new pipe is automatically updated by adding together the values of the combined pipes.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Select A Feature
Undo The Last Data Or Graphic Change
Delete A Pipe

Summary

Deletes a pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Click the Delete Pipe icon from the Graphic Construction Commands Toolbar.
- At the Select A Pipe prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be deleted.
- Note - If the selected pipe has attached customer features, a message will be displayed asking whether to delete the attached customers. Either click the Yes command button to delete the pipe and customers, click the No command button to only delete the pipe, or click the Cancel command button to end the command and preserve the model as is.
  - If the No command button is clicked, a message will be displayed reminding the User to reassign the disconnected customers. Click the OK command button to clear this message and continue.

Notes & Considerations

- This command can also be executed by the Delete Pipe item from the GDI Command List, or by typing DELETEPIPE or Delp on the GDI Command Line and pressing the Enter key.
- Any nodes that will no longer be connected to a pipe as a result of this process will also be deleted.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Select A Feature
Undo The Last Data Or Graphic Change
Delete A Polyline Pipe Vertex

Summary

Deletes a vertex from a polyline pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one polyline pipe is present in the model.

- Click the Delete Polyline Pipe Vertex icon from the Graphic Edit Commands Toolbar.

- At the Select Pipe To Delete Vertex From prompt, move the mouse pointer to a polyline pipe and left-click the mouse. The selected pipe will be highlighted. Note - If the selected pipe is not a polyline pipe, a message will be displayed stating that the selected pipe cannot be modified. Click the OK command button to clear the message and return to the prompt.

- At the Select A Vertex prompt, move the mouse pointer to a vertex on the selected pipe and left-click the mouse.

- If the Automatically Update Pipe Length graphic settings option is selected, the Hydraulic Length of the pipe will automatically update to the new graphic length. If not, a message will be displayed asking whether to update the pipe length. Either click the Yes command button to update the Hydraulic Length to equal the new graphic length, or click the No command button to keep the prior Hydraulic Length.

- The selected vertex will be deleted. The adjacent pipe segments will be combined and redrawn between the remaining vertices.

Notes & Considerations

- This command can also be executed by the Delete Polyline Pipe Vertex item from the GDI Command List, or by typing DELETEPOLYVERTEX or DELPVTX on the GDI Command Line and pressing the Enter key.

- To display vertices in the GDI Window, select the Display Vertex Symbols graphic settings option. To access the option, select the Settings item from the Graphics menu list.

- Grips, which are displayed at vertices when a polyline pipe is highlighted, do not display with this command.
Removing a vertex from a polyline pipe that only has one vertex will change the Pipe Line Type of the segment to a 2-point pipe.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Polyline Pipe
Select A Feature
Undo The Last Data Or Graphic Change
Delete A Saved View

Summary

Deletes a previously saved view.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one saved view is present in the model.

- Click the Delete Saved View icon from the View Controls Toolbar.
- At the Name Of Saved View To Delete prompt, select an item from the GDI Prompt List.
- The selected saved view will be removed, and no longer be available in the Saved View list.

Notes & Considerations

- This command can also be executed by the Delete Saved View item from the GDI Command List, or by typing DELETESAVEDVIEW or DELSVIEW on the GDI Command Line and pressing the Enter key.
- To create a saved view from the current limits of the GDI Display, use the Save Current View command.
- Deleting a saved view will not change the current view in the GDI Window.
- This command is for deleting a saved view, which is not the same as a marked view.

See Also

Save The Current View
Delete A Service Line Vertex

Summary

Deletes a vertex from a polyline style service line.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one polyline service is present in the model.

- Click the Delete Service Line Vertex icon from the Customer Commands Toolbar.
- At the Select Customer To Delete Service Line Vertex From prompt, move the mouse pointer to a polyline customer and left-click the mouse. The selected polyline service customer will be highlighted. Note - If the selected service is not a polyline, a message will be displayed stating that the selected service line contains no vertices. Click the OK command button to clear the message and return to the prompt.
- At the Select A Vertex prompt, move the mouse pointer to a vertex on the selected service line and left-click the mouse.
- The selected vertex will be deleted. The adjacent service line segments will be combined and redrawn between the remaining vertices.

Notes & Considerations

- This command can also be executed by the Delete Service Line Vertex item from the GDI Command List, or by typing DELETESERVICEVERTEX or DELSVTX on the GDI Command Line and pressing the Enter key.
- To display vertices in the GDI Window, select the Display Vertex Symbols graphic settings option. To access the option, select the Settings item from the Graphics menu list.
- Grips, which are displayed at vertices when a polyline service is highlighted, do not display with this command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A Polyline Service Customer
Select A Feature
Undo The Last Data Or Graphic Change
Delete A User Graphic Image

Summary

Deletes a User Graphic Image.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Image is present in the model.

- Click the Delete User Graphic Image icon from the User Graphic Commands Toolbar.
- At the Select User Graphic Image prompt, move the mouse pointer to a User Graphic Image and left-click the mouse. The selected User Graphic Image will be deleted.

Notes & Considerations

- This command can also be executed by the Delete User Graphic Image item from the GDI Command List, or by typing DELETEIMAGE or DELI on the GDI Command Line and pressing the Enter key.
- To remove all of the User Graphic (Images, Lines, and Symbols) features from the model, use the Delete All User Graphics command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Image
Delete All User Graphics
Select A Feature
Undo The Last Data Or Graphic Change
Delete A User Graphic Line

Summary

Deletes a User Graphic Line.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Line is present in the model.

- Click the Delete User Graphic Line icon from the User Graphic Commands Toolbar.

- At the Select User Graphic Line prompt, move the mouse pointer to a User Graphic Line and left-click the mouse. The selected line will be deleted.

- Note - If the selected line is part of a multi-segment line, a message will be displayed asking whether to delete all segments of the line. Either click the Yes command button to delete all segments, click the No command button to only delete the selected segment, or click the Cancel command button to end the command and preserve the model as is.

Notes & Considerations

- This command can also be executed by the Delete User Graphic Line item from the GDI Command List, or by typing DELETELINE or DELL on the GDI Command Line and pressing the Enter key.

- To remove all User Graphic (Images, Lines, and Symbols) features from the model, use the Delete All User Graphics command.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Line
Delete All User Graphics
Select A Feature
Undo The Last Data Or Graphic Change
Delete A User Graphic Symbol

Summary

Deletes a User Graphic Symbol.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Symbol is present in the model.

- Click the Delete User Graphic Symbol icon from the User Graphic Commands Toolbar.
- At the Select User Graphic Symbol prompt, move the mouse pointer to a User Graphic Symbol and left-click the mouse. The selected symbol will be deleted.

Notes & Considerations

- This command can also be executed by the Delete User Graphic Symbol item from the GDI Command List, or by typing DELETESYMBOL or DELS on the GDI Command Line and pressing the Enter key.

- To remove all User Graphic (Images, Lines, and Symbols) features from the model, use the Delete All User Graphics command.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Symbol
Delete All User Graphics
Select A Feature
Undo The Last Data Or Graphic Change
Delete All User Graphics

Summary

Deletes all of the User Graphic (Image, Line, and Symbol) features in the current model.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic is present in the model.

- Select the Delete All User Graphics item from the GDI Command List.

- A message will be displayed asking whether to delete all of the User Graphics. Either click the Yes command button to proceed, or click the No command button to end the command. Note - If a User Table is present in the model, a message will be displayed asking whether to delete the User Table Graphics (lines). Either click the Yes command button to proceed, or click the No command button to end the command.

- If the Yes command button is clicked, a message will be displayed stating how many User Graphic records were deleted. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing DELETEALLGRAPHICS on the GDI Command Line and pressing the Enter key.

- This command will delete User Images, Lines, and Symbols only. It will not delete any User Text features.

- Individual delete commands exist for each type of User Graphic feature.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A User Graphic Image
Add A User Graphic Line
Add A User Graphic Symbol
Delete A User Graphic Image
Delete A User Graphic Line
Delete A User Graphic Symbol
Undo The Last Data Or Graphic Change
Delete A User Table

Summary

Deletes a User Table.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Table is present in the model.

- Select the Delete User Table item from the GDI Command List.

- At the Select A Feature In The User Table To Delete prompt, move the mouse pointer to a feature that is part of a User Table and left-click the mouse. The selected table will be highlighted.

- A message will be displayed asking whether to delete the selected User Table. Either click the Yes command button to proceed, or click the No command button to end the command.

- If the Yes command button is clicked, the selected User Table will be deleted.

Notes & Considerations

- This command can also be executed by typing DELETETABLE or DELTAB on the GDI Command Line and pressing the Enter key.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Create A User Table
Select A Feature
Undo The Last Data Or Graphic Change
Delete User Text

Summary

Deletes a User Text feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Text feature is present in the model.

- Click the Delete User Text icon from the User Text Commands Toolbar.
- At the Select User Text prompt, move the mouse pointer to a User Text feature and left-click the mouse. The selected feature will be deleted.

Notes & Considerations

- This command can also be executed by the Delete User Text item from the GDI Command List, or by typing DELETETEXT or DELT on the GDI Command Line and pressing the Enter key.
- To remove all User Text features from the model, use the Delete All User Text command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add User Text
Delete All User Text
Select A Feature
Undo The Last Data Or Graphic Change
Delete All User Text

Summary

Deletes all of the User Text features in the current model.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Text feature is present in the model.

- Select the Delete All User Text item from the GDI Command List.

- A message will be displayed asking whether to delete all of the User Text features. Either click the Yes command button to proceed, or click the No command button to end the command. Note - If a User Table is present in the model, a message will be displayed asking whether to delete the User Table Text. Either click the Yes command button to proceed, or click the No command button to end the command.

- If the Yes command button is clicked, a message will be displayed stating how many User Text records were deleted. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing DELETEALLTEXT on the GDI Command Line and pressing the Enter key.

- To remove a single User Text feature from the model, use the Delete User Text command.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add User Text
Delete User Text
Undo The Last Data Or Graphic Change
Delete A Valve Node

Summary

Deletes a valve node.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one valve node is present in the model.

- Select the Delete Valve Node item from the GDI Command List.

- At the Select A Valve Node prompt, move the mouse pointer to a valve node and left-click the mouse. The selected node will be replaced by a vertex. The connected pipes will be joined into one polyline pipe. Note - A message will be displayed if the selected node is not a valve node. Click the OK command button to clear the message and return to the prompt.

- Note - If the selected node is connected to more than two pipes, a message will be displayed stating that the node cannot be removed, and will ask to reset the node Hydraulic Type. Either click the Yes command button to change the Hydraulic Type to a connection node, or click the No command button to return to the prompt.

Notes & Considerations

- This command can also be executed by typing DELETEVALVENODE or DELVN on the GDI Command Line and pressing the Enter key.

- To remove all valve nodes from the model, use the Delete All Valve Nodes command.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Valve Node  Delete All Valve Nodes
Join Adjacent Pipe Segments  Select A Feature
Undo The Last Data Or Graphic Change
Delete All Valve Nodes

Summary

Deletes all of the valve nodes in the current model. Valve nodes connecting two pipe segments are deleted, and the pipes are joined. Valve nodes connecting three or more pipe segments are converted into connection nodes.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one valve node is present in the model.

- Select the Delete All Valve Nodes item from the GDI Command List.
- A message will be displayed asking whether to delete all of the valve nodes. Either click the Yes command button to proceed, or click the No command button to end the command. Note - Nodes at the intersection of two pipes will be deleted, and the two pipes will be joined into one polyline pipe with a vertex at that location. All other valve nodes will be converted into connection nodes.
- If the Yes command button is clicked, a message will be displayed when the process is complete. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing DELETEALLVALVENODES and DELVNODES on the GDI Command Line and pressing the Enter key.
- To remove a single valve node from the model, use the Delete Valve Node command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Valve Node
Delete A Valve Node
Undo The Last Data Or Graphic Change
Delete Zero Length Pipes

Summary

Deletes all of the pipe features with a zero (0) Length value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one zero length pipe is present in the model.

- Select the Delete Zero Length Pipes item from the GDI Command List.
- A message will be displayed asking whether to delete all of the zero length pipes. Either click the Yes command button to proceed, or click the No command button to end the command.
- If the Yes command button is clicked, a message will be displayed stating the number of pipes deleted. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing DELETEZEROPIPES on the GDI Command Line and pressing the Enter key.
- A zero length pipe can be created during the Import routine if a pipe’s ends fall within the specified Fuzzy Tolerance value. GASWorkS will “snap” the node ends together. It is not possible to graphically select a pipe with a zero length.
- Another option for deleting zero length pipes is to create a selection set in the Pipe Data Report and manually delete the pipes from within the report. To access the report, select the Pipe Data item from the Report menu list.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Undo The Last Data Or Graphic Change
Display A Background Image

Summary

Turns the display of all of the background images “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one background image is attached to the model.

- Click the Display Background Image icon from the Display Controls Toolbar.
  - If background images are displayed, they will be turned “off”.
  - If background images are hidden, they will be turned “on”.

Notes & Considerations

- This command can also be executed by the Display Background Image item from the GDI Command List, or by typing DISPLAYBACKGROUND or DISPBACK on the GDI Command Line and pressing the Enter key.

- Individual background images can be displayed (or not) using the Background Image Settings screen. To access the screen, select the Background Settings item from the Graphics menu list. The screen displays a list of attached background images with a checkbox next to each. Select a checkbox to turn the associated background image “on”. Unselect a checkbox to turn the associated background image “off”. Click the Apply command button to close the screen and apply the new settings. Note - If the Display Background Image is set to “off”, background images will not display even if their checkbox is selected in the Background Image Settings.

- If Background Image Display is set to “on”, but the background image is not visible, the image may be in another part of the model. Use the Zoom To Fit command to change the display to include all features, including background images. The other view controls can also be used to find an image.

See Also

Add A BMP Background Image
Add A SHP Background Image
Add A DXF Background Image
Zoom The GDI Image
Display The Color Legend

Summary

Turns the display of the Color Legend “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a color range has been set.

- Click the Display Color Legend icon from the Display Controls Toolbar.
  - If the Color Legend is hidden, the Color Legend will be displayed in a new window.
  - If the Color Legend is displayed, the Color Legend window will be closed.

Notes & Considerations

- This command can also be executed by the Display Color Legend item from the GDI Command List, or by typing DISPLAYCOLOR or DISPCOLOR on the GDI Command Line and pressing the Enter key.

- The Color Legend window will automatically be hidden when a GDI Command is executed.

- To reveal the Color Legend when it is hidden, hover the mouse pointer to the Display Color Legend icon. (do not click on the icon), or select the Color Legend window from the list from the Window menu list.

- The Color Legend window can be closed by clicking the Windows close icon (the “X” in the upper-right corner of the Color Legend window). Note that using the Windows close icon does not change the status of the Display Color Legend option. To display the Color Legend again, execute the Display Color Legend command twice - first to set it to “off”, then to turn it back “on”.

See Also

Color Code By Query
Color Code By Range
Display The Crosshairs

Summary

Turns the display of the mouse cursor crosshairs “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Display Crosshairs icon from the GDI Window Controls Toolbar.
  - If the crosshairs are enabled, they will be turned “off”.
  - If the crosshairs are not enabled, they will be turned “on”.

Notes & Considerations

- This command can also be executed by the Display Crosshairs item from the GDI Command List, or by typing DISPLAYCROSSHAIRS or CRÖSSHAIRS on the GDI Command Line and pressing the Enter key.
- Use the crosshairs to help align objects horizontally and/or vertically, or when the cursor is difficult to see.

See Also

None
Display The Customer Symbols

Summary

Turns the display of the customer symbols “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Click the Display Customer Symbols icon from the Customer Commands Toolbar.
  - If the customer symbols are displayed, they will be turned “off”.
  - If the customer symbols are hidden, they will be turned “on”.

Notes & Considerations

- This command can also be executed by the Display Customer Symbols item from the GDI Command List, or by typing DISPLAYCUSTOMER or DISPCUST on the GDI Command Line and pressing the Enter key.

- If the Display Customer Symbols option is “on” and the customer symbols do not display, check the Customer Symbol Display Limit in the Settings section on the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list. If the value is too small, the symbols will not be displayed if the view is zoomed too far out. To see the customer symbols either zoom in on the model, increase the Display Limit value, or set the Display Limit to zero (0) to display the symbols at all view scales.

- The customer symbol size and style are set by the Customer Symbol Size and Customer Symbol Style options, respectively, on the Graphic Settings screen. The size value can be entered as an absolute value (in Coordinate units) or as a relative value (% Of Display Width).

See Also

Add A Customer
Zoom The GDI Image
Display The Flow Arrows

Summary

Turns the display of the flow direction arrows “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe with non-zero flow is present in the model.

- Click the Display Flow Arrows icon from the Display Controls Toolbar.
  - If the flow arrows are displayed, they will be turned “off”.
  - If the flow arrows are hidden, they will be turned “on”.

Notes & Considerations

- This command can also be executed by the Display Flow Arrows item from the GDI Command List, or by typing DISPLAYFLOW or FLOWARROW on the GDI Command Line and pressing the Enter key.

- If the Display Flow Arrows option is “on” and the flow arrows do not display, check the Flow Arrow Display Limit in the Settings section on the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list. If the value is too small, the flow arrows will not be displayed if the view is zoomed too far out. To see the flow arrows either zoom in on the model, increase the Display Limit value, or set the Display Limit to zero (0) to display the flow arrows at all view scales.

- Flow arrow size and style are set by the Flow Arrow Size and Flow Arrow Style options, respectively, on the Graphic Settings screen. The size value can be entered as an absolute value (in Coordinate units) or as a relative value (% Of Display Width). Entering a size of zero (0) will set the flow arrow size equal to the Node Symbol Size value.

- Pipe segments with zero flow or pressure drop will not display flow arrows.

- Polyline pipes can have flow arrows for each segment or one flow arrow for the entire pipe. Use the Display Flow Arrow Once Per Polyline Pipe graphic settings option to turn the feature “on” or “off”.

- The display of the flow arrows can be suppressed for pipes with very low flow rates. Use the Suppress Flow Arrow Where Flow Is Less Than Convergence Tolerance graphic settings option to turn the feature “on” or “off”.

Bradley B Bean PE
ENGINEERING & SOFTWARE
Revision - 003, Copyright 2020 All Rights Reserved.
See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Zoom The GDI Image
Display In Isometric View

Summary

Turns the Isometric (3D) View “on” and the Plan View “off”.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Display Isometric View item from the GDI Command List.

- A message will be displayed asking whether to turn ‘on’ the 3D Coordinate Option. Either click the Yes command button to turn 3D coordinates “on”, or click the No command button to leave the display in XY coordinates. Note - If 3D coordinates are already “on”, a message will be displayed stating that Isometric View is turned “on”. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing ISOMETRICVIEW or ISO on the GDI Command Line and pressing the Enter key.

- Isometric View is useful for graphically representing the height of a system in addition to the width and length.

- To switch to a two-dimensional top-down view, use the Display Plan View command.

See Also

Display In Plan View
Display The Node Symbols

Summary

Turns the display of the node symbols “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Click the Display Node Symbols icon from the Display Controls Toolbar.
  - If the node symbols are displayed, they will be turned “off”.
  - If the node symbols are hidden, they will be turned “on”.

Notes & Considerations

- This command can also be executed by the Display Node Symbols item from the GDI Command List, or by typing DISPLAYNODE or DISPNODE on the GDI Command Line and pressing the Enter key.

- If the Display Node Symbols option is “on” and the node symbols do not display, check the Node Symbol Display Limit in the Settings section on the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list. If the value is too small, the node symbols will not be displayed if the view is zoomed too far out. To see the node symbols either zoom in on the model, increase the Display Limit value, or set the Display Limit to zero (0) to display the symbols at all view scales.

- The node symbol size and style are set by the Node Symbol Size and Node Symbol Style options, respectively, on the Graphic Settings screen. The size value can be entered as an absolute value (in Coordinate units) or as a relative value (% Of Display Width).

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Zoom The GDI Image
Display The Pipe Symbols

Summary

Turns the display of the pipe symbols (compressors, regulators, valves, wells) “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe feature (Hydraulic Type other than pipe) is present in the model.

- Click the Display Pipe Symbols icon from the Display Controls Toolbar.
  - If the pipe symbols are displayed, they will be turned “off”.
  - If the pipe symbols are hidden, they will be turned “on”.

Notes & Considerations

- This command can also be executed by the Display Pipe Symbols item from the GDI Command List, or by typing DISPLAYPIPE or DISPPipe on the GDI Command Line and pressing the Enter key.

- If the Display Pipe Symbols option is “on” and the pipe symbols do not display, check the Pipe Symbol Display Limit in the Settings section on the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list. If the value is too small, the pipe symbols will not be displayed if the view is zoomed too far out. To see the pipe symbols either zoom in on the model, increase the Display Limit value, or set the Display Limit to zero (0) to display the symbols at all view scales.

- Pipe symbols can either be solid or hollow. To turn this option “on” or “off”, select the Display Solid Pipe Symbols option on the Graphic Settings screen.

- The pipe symbol size is set by the Pipe Symbol Size option on the Graphic Settings screen. The size value can be entered as an absolute value (in Coordinate units) or as a relative value (% Of Display Width).

See Also

- Add A Compressor
- Add A Regulator
- Add A Valve
- Add A Well
- Zoom The GDI Image
Display In Plan View

Summary

Turns the Plan View “on” and the Isometric (3D) View “off”.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Display Plan View item from the GDI Command List.

- A message will be displayed asking whether to turn “off” the 3D Coordinate Option. Either click the Yes command button to turn 3D coordinates “off” and return to XY coordinates, or click the No command button to leave the display in 3D coordinates. Note - If 3D coordinates are already “off”, a message will be displayed stating that Plan View is turned “on”. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing PLANVIEW or PLAN on the GDI Command Line and pressing the Enter key.

- To switch to a three-dimensional view, use the Display Isometric View command.

See Also

Display In Isometric View
Display The Tool Palette

Summary

Displays the Tool Palette in the lower-right corner of the GDI Window.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Tool Palette icon from the upper-right corner of the GDI Window.
  - If the GDI Command List is visible, it becomes hidden and the Tool Palette is displayed.
  - If the Tool Palette is visible, it becomes hidden.
  - If neither the GDI Command List or the Tool Palette are visible, the Tool Palette is displayed.

Notes & Considerations

- This command can also be executed by the Display Tool Palette item from the GDI Command List, or by typing DISPLAYTOOL or TOOLPALETTE on the GDI Command Line and pressing the Enter key.

- The lower-right corner of the GDI Window shows either the GDI Command List or the Tool Palette.

- To add commands to the Tool Palette, either right-click on an icon from one of the GDI Toolbars or a command from the GDI Command List.

See Also

Use The Tool Palette
Display The User Graphics

Summary

Turns the display of the User Graphics (Images, Lines, and Symbols) “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Image, Line, or Symbol is present in the model.

- Click the Display User Graphics icon from the User Graphic Commands Toolbar.
  - If the User Graphics are displayed, they will be turned “off”.
  - If the User Graphics are hidden, they will be turned “on”.

Notes & Considerations

- This command can also be executed by the Display User Graphics item from the GDI Command List, or by typing DISPLAYGRAPHICS on the GDI Command Line and pressing the Enter key.

See Also

Add A User Graphic Image
Add A User Graphic Line
Add A User Graphic Symbol
Display The User Text

Summary

Turns the display of the User Text features “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Text feature is present in the model.

- Click the Display User Text icon from the User Text Commands Toolbar.
  - If the User Text is displayed, they will be turned “off”.
  - If the User Text is hidden, they will be turned “on”.

Notes & Considerations

- This command can also be executed by the Display User Text item from the GDI Command List, or by typing DISPLAYTEXT on the GDI Command Line and pressing the Enter key.

See Also

Add User Text
Dissolve The Features In A Group

Summary

Dissolves (ungroups) all of the features from an existing group.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one group is present in the model.

- Select the Dissolve Group item from the GDI Command List.

- At the Select A Feature In The Group To Be Dissolved prompt, move the mouse pointer to a group feature and left-click the mouse. The selected group will be highlighted. Note - If the selected feature is not part of a group, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

- A message will be displayed asking whether to dissolve the features in the selected group. Either click the Yes command button to proceed, or click the No command button to return to the prompt.

- If the Yes command button is clicked, the features in the selected group will be dissolved.

Notes & Considerations

- This command can also be executed by typing DISSOLVEGROUP or UNGROUP on the GDI Command Line and pressing the Enter key.

- This command ungroups model features that were previously grouped, but does not delete them. To remove a group and all of its features from the model, use the Delete Group command.

- To remove features from an existing group, use the Remove Feature From Group command.

- To ungroup all of the grouped model features, use the Dissolve All Groups command.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Create A Group
Dissolve All Groups
Remove A Feature From A Group
Select A Feature
Undo The Last Data Or Graphic Change
Dissolve All Groups

Summary

Dissolves (ungroups) all of the existing groups in the current model.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one group is present in the model.

- Select the **Dissolve All Groups** item from the GDI Command List.

- A message will be displayed asking whether to dissolve all of the groups in the model. Either click the **Yes** command button to proceed, or click the **No** command button to end the command.

- If the **Yes** command button is clicked, a message will be displayed stating the number of items removed from groups. Click the **OK** command button to clear the message.

Notes & Considerations

- This command can also be executed by typing **DISSOLVEALL** or **UNGROUPALL** on the GDI Command Line and pressing the **Enter** key.

- This command ungroups all of the model features previously grouped, but does not delete them. To remove a group and all of its features from the model, use the **Delete Group** command.

- To remove features from an existing group, use the **Remove Feature From Group** command.

- To ungroup a single group of features, use the **Dissolve Group** command.

- If the **Allow Undo Of Data/Graphic Changes** preference settings option is enabled, click the **Undo** icon to restore the original configuration. To access the option, select the **Settings** item from the **Preferences** submenu from the **File** menu list.
See Also

Create A Group
Delete A Group
Dissolve The Features In A Group
Remove A Feature From A Group
Undo The Last Data Or Graphic Change
DXF Layer Identification

Summary

Identifies the layer that a selected DXF entity is on.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a DXF background image is attached to the model.

- Select the DXF Layer Identification item from the GDI Command List.

- At the Select A DXF Entity To Identify The Layer Assignment For prompt, move the mouse pointer to an entity in the DXF background image and left-click the mouse.

- A message will be displayed stating the layer of the selected entity. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing DXFLAYER on the GDI Command Line and pressing the Enter key.

- Drawing Exchange Format (DXF) files contain data in separate “layers”. When a DXF file has been attached as a background image, GASWorkS includes the layer data. Identifying the layer name makes it easier to determine which DXF layers can be hidden (turned “off”).

- To hide (turn “off”) a DXF layer from the GDI Display, use the Turn DXF Layer Off command.

- DXF layers can also be turned “on” or “off” from the Background Image Settings screen. To access the screen, select the Background Settings item from the Graphics menu list.

See Also

Add A DXF Background Image
Turn A DXF Layer Off
Edit Customer Data

Summary

Displays the data values associated with a customer feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Click the *Edit Customer Data* icon from the *Customer Commands Toolbar*.

- At the *Select Customer* prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted.

- The Customer Data & Results will be displayed in the Data Panel. Scroll through the sections. To make a change, left-click in a white cell and either type or select a new value. Left-click on an orange cell (*Actions* section) to execute the associated command. If changes are made, click the *Apply Data Values* command button. If no changes are made, click the *Dismiss* command button.

Notes & Considerations

- This command can also be executed by the *Edit Customer Data* item from the GDI Command List, or by typing EDITCUSTOMER or EDITCUST on the GDI Command Line and pressing the *Enter* key.

- Individual customer data can also be edited by left-clicking on a customer symbol in the GDI Display when no other command is running, or from the Customer Data Report. To access the report, select the *Customer Data* item from the *Report* menu list.

- Cells with a yellow background cannot be edited from the Data Panel. These cells may contain calculated values, or may be controlled by another command.

- Certain cells contain lists which have a “Default” option. For *Symbol Color*, the default values are found on the Color Display Settings screen. For the *Symbol Style* and *Symbol Size Style*, the default values are found on the Graphic Settings screen.

- The Attribute Data fields are populated by attaching an attribute database to the model from the Customer Attribute File Settings screen. To access the screen, select the *Attribute File* item from the *Customer Data* submenu from the *Utilities* menu list. Not all Attribute Data values may be edited, depending on the type of database connection.
● If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Customer
Color Display Settings
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
**Edit Customer Data By Pipe Selection**

**Summary**

Displays the data values of the customer features assigned to a selected pipe feature.

**Example**

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model and attached to a supply main.

- Select the *Edit Customer Data By Pipe Selection* item from the GDI Command List.

- At the *Select A Pipe* prompt, move the mouse pointer to a pipe and left-click the mouse. *Note* - If more than one customer is attached to the selected pipe, the Multiple Customers Found screen is displayed stating the Record/ID and Link ID Numbers for the attached customers. Double-click the mouse cursor on a Record/ID or Link ID Number.

- The Customer Data & Results will be displayed in the Data Panel. Scroll through the sections. To make a change, left-click in a white cell and either type or select a new value. Left-click on an orange cell (*Actions* section) to execute the associated command. If changes were made, click the *Apply Data Values* command button. If no changes were made, click the *Dismiss* command button.

- If applicable, make another selection from the Multiple Customers Found screen. When finished editing all of the customers, click the *Close* command button.

**Notes & Considerations**

- This command can also be executed by typing EDITCUSTBYPIPE on the GDI Command Line and pressing the *Enter* key.

- Cells with a yellow background cannot be edited from the Data Panel. These cells may contain calculated values, or may be controlled by another command.

- Certain cells contain lists which have a “Default” option. For *Symbol Color*, the default values are found on the Color Display Settings screen. For the *Symbol Style* and *Symbol Size Style*, the default values are found on the Graphic Settings screen.
The Attribute Data fields are populated by attaching an attribute database to the model from the Customer Attribute File Settings screen. To access the screen, select the Attribute File item from the Customer Data submenu from the Utilities menu list. Not all Attribute Data values may be edited, depending on the type of database connection.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Customer
- Add A Polyline Pipe
- Color Display Settings
- Select A Feature
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Edit Multiple Customers

Summary

Allows changes to be made to a selected group of customer features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Click the Edit Multiple Customers icon from the Customer Commands Toolbar. Note - If the Edit Multiple Customers command has previously been executed, a message will be displayed asking whether to use the previous customer selection. Either click the Yes command button to use the last customer selection, click the No command button to bring up the Select First Feature prompt, or click the Cancel command button to end the command.

- At the Select First Feature prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted.

- At the Select Another Feature prompt, use the method described above to select additional customers. The GDI Prompt Line will update with the number of customers selected. When finished, right-click the mouse to end the selection process.

- The Multiple Edit Specifications screen is displayed. Use one of the following methods to edit the selected features:

  - On the Model Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item;

  - Or, on the Commands data tab, select a command from the Command list;

  - Or, on the Attribute Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item.

  - Click the Apply command button.

- A message will be displayed stating the number of records updated. Click the OK command button to clear the message.
The Multiple Edit Specifications screen will still be displayed. Additional changes can be made using the methods described above. When all changes are complete either click the Close & Solve command button to exit the screen and solve the model, or click the Close command button to exit the screen.

Note - No changes will be applied until the Apply command button is clicked. Clicking either the Close or Close & Solve command buttons before clicking the Apply command button will display a message that no changes have been made. Either click the Yes command button to continue closing the window, or click the No command button to return to the Multiple Edit Specifications screen.

Notes & Considerations

- This command can also be executed by the Edit Multiple Customers item from the GDI Command List, or by typing EDITMULTICUST on the GDI Command Line and pressing the Enter key.

- To unselect (unhighlight) a selected (highlighted) feature, move the mouse pointer to the selected feature and left-click the mouse. The feature will be unhighlighted, indicating it is no longer selected.

- The Mass Update Routine can also be used to edit multiple customers.

- Only customers that fall completely within the selection window or polygon will be included in the selection set. If the selection set includes a customer that was already highlighted, that customer will be removed from the selection.

- Multiple changes can be made to the same selection set until the Close or Close & Solve command buttons are clicked on the Multiple Edit Specifications screen.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Customer
Add Multiple Customers
Select A Feature
Undo The Last Data Or Graphic Change
Use The Mass Update Routine
Edit Multiple Nodes

Summary

Allows changes to be made to a selected group of nodes.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Click the **Edit Multiple Nodes** icon from the **Data Edit Commands Toolbar**. Note - If the **Edit Multiple Nodes** command has previously been executed, a message will be displayed asking whether to use the previous selection. Either click the **Yes** command button to use the last node selection, click the **No** command button to bring up the **Select First Feature** prompt, or click the **Cancel** command button to end the command.

- At the **Select First Feature** prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be highlighted.

- At the **Select Another Feature** prompt, use the method described above to select additional nodes. The GDI Prompt Line will update with the number of nodes selected. When finished, right-click the mouse to end the selection process.

- The **Multiple Edit Specifications** screen is displayed. Use one of the following methods to edit the selected features:
  - On the **Model Data Items** data tab, select an item from the **Set** list to specify a data item to edit, then select an item from the **Equal To** list to specify a new value for the **Set** data item;
  - Or, on the **Commands** data tab, select a command from the **Command** list;
  - Or, on the **Attribute Data Items** data tab, select an item from the **Set** list to specify a data item to edit, then select an item from the **Equal To** list to specify a new value for the **Set** data item.

- Click the **Apply** command button.

- A message will be displayed stating the number of records updated. Click the **OK** command button to clear the message.
Additional changes can be made using the methods above without closing the Multiple Edit Specifications screen. When all changes are complete, click the Close & Solve command button to exit the screen and solve the model, or click the Close command button to exit the screen.

Note - No changes will be applied until the Apply command button is clicked. Clicking either the Close or Close & Solve command button before clicking the Apply command button will display a message that no changes have been made. Either click the Yes command button to continue closing the window, or click the No command button to return to the Multiple Edit Specifications screen.

Notes & Considerations

- This command can also be executed by the Edit Multiple Nodes item from the GDI Command List, or by typing EDITMULTINODE on the GDI Command Line and pressing the Enter key.

- To unselect (unhighlight) a selected (highlighted) feature, move the mouse pointer to the selected feature and left-click the mouse. The feature will be unhighlighted, indicating it is no longer selected.

- The Mass Update Routine can also be used to edit multiple nodes.

- Only nodes that fall completely within the selection window or polygon will be included in the selection set. If the selection set includes a node that was already highlighted, that node will be removed from the selection.

- Multiple changes can be made to the same selection set until the Close or Close & Solve command buttons are clicked on the Multiple Edit Specifications screen.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Select A Feature
- Undo The Last Data Or Graphic Change
- Use The Mass Update Routine
Edit Multiple Pipes

Summary

Allows changes to be made to a selected group of pipe features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Click the Edit Multiple Pipes icon from the Data Edit Commands Toolbar. Note - If the Edit Multiple Pipes command has previously been executed, a message will be displayed asking whether to use the previous selection. Either click the Yes command button to use the last pipe selection, click the No command button to bring up the Select First Feature prompt, or click the Cancel command button to end the command.

- At the Select First Feature prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.

- At the Select Another Feature prompt, use the method described above to select additional pipes. The GDI Prompt Line will update with the number of pipes selected. When finished, right-click the mouse to end the selection process.

- The Multiple Edit Specifications screen is displayed. Use one of the following methods to edit the selected features:
  - On the Model Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item;
  - Or, on the Commands data tab, select a command from the Command list;
  - Or, on the Attribute Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item.

- Click the Apply command button.

- A message will be displayed stating the number of records updated. Click the OK command button to clear the message.
Additional changes can be made using the methods above without closing the Multiple Edit Specifications screen. When all changes are complete, click the Close & Solve command button to exit the screen and solve the model, or click the Close command button to exit the screen.

Note - No changes will be applied until the Apply command button is clicked. Clicking either the Close or Close & Solve command button before clicking the Apply command button will display a message that no changes have been made. Either click the Yes command button to continue closing the window, or click the No command button to return to the Multiple Edit Specifications screen.

Notes & Considerations

- This command can also be executed by the Edit Multiple Pipes item from the GDI Command List, or by typing EDITMULTIPIPE on the GDI Command Line and pressing the Enter key.

- To unselect (unhighlight) a selected (highlighted) feature, move the mouse pointer to the selected feature and left-click the mouse. The feature will be unhighlighted, indicating it is no longer selected.

- The Mass Update Routine can also be used to edit multiple pipes.

- Only pipes that fall completely within the selection window or polygon will be included in the selection set. If the selection set includes a pipe that was already highlighted, that pipe will be removed from the selection.

- Multiple changes can be made to the same selection set until the Close or Close & Solve command buttons are clicked on the Multiple Edit Specifications screen.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Select A Feature
Undo The Last Data Or Graphic Change
Use The Mass Update Routine
Edit Multiple User Graphic Images

Summary

Allows changes to be made to a selected group of User Graphic Images.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Image is present in the model.

- Select the Edit Multiple User Graphic Images item from the GDI Command List. Note - If the Edit Multiple User Graphic Images command has previously been executed, a message will be displayed asking whether to use the previous selection. Either click the Yes command button to use the last image selection, click the No command button to bring up the Select First Feature prompt, or click the Cancel command button to end the command.

- At the Select First Feature prompt, move the mouse pointer to a User Graphic Image and left-click the mouse. The selected image will be highlighted.

- At the Select Another Feature prompt, use the method described above to select additional User Graphic Images. The GDI Prompt Line will update with the number of images selected. When finished, right-click the mouse to end the selection process.

- The Multiple Edit Specifications screen is displayed. Use one of the following methods to edit the selected features:

  - On the Model Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item;

  - Or, on the Commands data tab, select a command from the Command list;

  - Or, on the Attribute Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item.

- Click the Apply command button.

- A message will be displayed stating the number of records updated. Click the OK command button to clear the message.
● Additional changes can be made using the methods above without closing the Multiple Edit Specifications screen. When all changes are complete, click the Close & Solve command button to exit the screen and solve the model, or click the Close command button to exit the screen.

● Note - No changes will be applied until the Apply command button is clicked. Clicking either the Close or Close & Solve command button before clicking the Apply command button will display a message that no changes have been made. Either click the Yes command button to continue closing the window, or click the No command button to return to the Multiple Edit Specifications screen.

Notes & Considerations

● This command can also be executed by typing EDITMULTIUGIMAGE or EDITMULTIUGI on the GDI Command Line and pressing the Enter key.

● To unselect (unhighlight) a selected (highlighted) feature, move the mouse pointer to the selected feature and left-click the mouse. The feature will be unhighlighted, indicating it is no longer selected.

● The Mass Update Routine can also be used to edit multiple User Graphic Images.

● Only images that fall completely within the selection window or polygon will be included in the selection set. If the selection set includes an image that was already highlighted, that image will be removed from the selection.

● Multiple changes can be made to the same selection set until the Close or Close & Solve command buttons are clicked on the Multiple Edit Specifications screen.

● If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Image
Select A Feature
Undo The Last Data Or Graphic Change
Use The Mass Update Routine
Edit Multiple User Graphic Lines

Summary

Allows changes to be made to a selected group of User Graphic Lines.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Line is present in the model.

- Select the Edit Multiple User Graphic Lines item from the GDI Command List. Note - If the Edit Multiple User Graphic Lines command has previously been executed, a message will be displayed asking whether to use the previous selection. Either click the Yes command button to use the last line selection, click the No command button to bring up the Select First Feature prompt, or click the Cancel command button to end the command.

- At the Select First Feature prompt, move the mouse pointer to a User Graphic Line and left-click the mouse. The selected line will be highlighted.

- At the Select Another Feature prompt, use the method described above to select additional User Graphic Lines. The GDI Prompt Line will update with the number of line segments selected. When finished, right-click the mouse to end the selection process.

- The Multiple Edit Specifications screen is displayed. Use one of the following methods to edit the selected features:
  - On the Model Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item;
  - Or, on the Commands data tab, select a command from the Command list;
  - Or, on the Attribute Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item.

- Click the Apply command button.

- A message will be displayed stating the number of records updated. Click the OK command button to clear the message.
Additional changes can be made using the methods above without closing the Multiple Edit Specifications screen. When all changes are complete, click the Close & Solve command button to exit the screen and solve the model, or click the Close command button to exit the screen.

Note - No changes will be applied until the Apply command button is clicked. Clicking either the Close or Close & Solve command button before clicking the Apply command button will display a message that no changes have been made. Either click the Yes command button to continue closing the window, or click the No command button to return to the Multiple Edit Specifications screen.

Notes & Considerations

This command can also be executed by typing EDITMULTIUGLINE or EDITMULTIUGL on the GDI Command Line and pressing the Enter key.

To unselect (unhighlight) a selected (highlighted) feature, move the mouse pointer to the selected feature and left-click the mouse. The feature will be unhighlighted, indicating it is no longer selected.

The Mass Update Routine can also be used to edit multiple User Graphic Lines.

Only lines that fall completely within the selection window or polygon will be included in the selection set. If the selection set includes a line that was already highlighted, that line will be removed from the selection.

Multiple changes can be made to the same selection set until the Close or Close & Solve command buttons are clicked on the Multiple Edit Specifications screen.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Line
Select A Feature
Undo The Last Data Or Graphic Change
Use The Mass Update Routine
Edit Multiple User Graphic Symbols

Summary

Allows changes to be made to a selected group of User Graphic Symbols.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Symbol is present in the model.

- Select the Edit Multiple User Graphic Symbols item from the GDI Command List.

  Note - If the Edit Multiple User Graphic Symbols command has previously been executed, a message will be displayed asking whether to use the previous selection. Either click the Yes command button to use the last symbol selection, click the No command button to bring up the Select First Feature prompt, or click the Cancel command button to end the command.

- At the Select First Feature prompt, move the mouse pointer to a User Graphic Symbol and left-click the mouse. The selected symbol will be highlighted.

- At the Select Another Feature prompt, use the method described above to select additional User Graphic Symbols. The GDI Prompt Line will update with the number of symbols selected. When finished, right-click the mouse to end the selection process.

- The Multiple Edit Specifications screen is displayed. Use one of the following methods to edit the selected features:
  
  - On the Model Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item;
  
  - Or, on the Commands data tab, select a command from the Command list;
  
  - Or, on the Attribute Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item.

- Click the Apply command button.

- A message will be displayed stating the number of records updated. Click the OK command button to clear the message.
Additional changes can be made using the methods above without closing the Multiple Edit Specifications screen. When all changes are complete, click the Close & Solve command button to exit the screen and solve the model, or click the Close command button to exit the screen.

Note - No changes will be applied until the Apply command button is clicked. Clicking either the Close or Close & Solve command button before clicking the Apply command button will display a message that no changes have been made. Either click the Yes command button to continue closing the window, or click the No command button to return to the Multiple Edit Specifications screen.

Notes & Considerations

This command can also be executed by typing EDITMULTIUGSYMBOL or EDITMULTIUGS on the GDI Command Line and pressing the Enter key.

To unselect (unhighlight) a selected (highlighted) feature, move the mouse pointer to the selected feature and left-click the mouse. The feature will be unhighlighted, indicating it is no longer selected.

The Mass Update Routine can also be used to edit multiple User Graphic Symbols.

Only symbols that fall completely within the selection window or polygon will be included in the selection set. If the selection set includes a symbol that was already highlighted, that symbol will be removed from the selection.

Multiple changes can be made to the same selection set until the Close or Close & Solve command buttons are clicked on the Multiple Edit Specifications screen.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Symbol
Select A Feature
Undo The Last Data Or Graphic Change
Use The Mass Update Routine
Edit Multiple User Text

Summary

Allows changes to be made to a selected group of User Text features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Text feature is present in the model.

- Select the Edit Multiple User Text item from the GDI Command List. Note - If the Edit Multiple User Text command has previously been executed, a message will be displayed asking whether to use the previous selection. Either click the Yes command button to use the last text selection, click the No command button to bring up the Select First Feature prompt, or click the Cancel command button to end the command.

- At the Select First Feature prompt, move the mouse pointer to a User Text feature and left-click the mouse. The selected text will be highlighted.

- At the Select Another Feature prompt, use the method described above to select additional User Text features. The GDI Prompt Line will update with the number of text features selected. When finished, right-click the mouse to end the selection process.

- The Multiple Edit Specifications screen is displayed. Use one of the following methods to edit the selected features:

  - On the Model Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item;

  - Or, on the Commands data tab, select a command from the Command list;

  - Or on the Attribute Data Items data tab, select an item from the Set list to specify a data item to edit, then select an item from the Equal To list to specify a new value for the Set data item.

- Click the Apply command button.

- A message will be displayed stating the number of records updated. Click the OK command button to clear the message.
Additional changes can be made using the methods above without closing the Multiple Edit Specifications screen. When all changes are complete, click the Close & Solve command button to exit the screen and solve the model, or click the Close command button to exit the screen.

Note - No changes will be applied until the Apply command button is clicked. Clicking either the Close or Close & Solve command button before clicking the Apply command button will display a message that no changes have been made. Either click the Yes command button to continue closing the window, or click the No command button to return to the Multiple Edit Specifications screen.

This command can also be executed by typing EDITMULTIUSERTEXT or EDITMULTIUT on the GDI Command Line and pressing the Enter key.

To unselect (unhighlight) a selected (highlighted) feature, move the mouse pointer to the selected feature and left-click the mouse. The feature will be unhighlighted, indicating it is no longer selected.

The Mass Update Routine can also be used to edit multiple User Text features.

Only text features that fall completely within the selection window or polygon will be included in the selection set. If the selection set includes a text feature that was already highlighted, that text feature will be removed from the selection.

Multiple changes can be made to the same selection set until the Close or Close & Solve command buttons are clicked on the Multiple Edit Specifications screen.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

Add User Text  
Select A Feature  
Undo The Last Data Or Graphic Change  
Use The Mass Update Routine
Edit Node Data

Summary
Displays the data values associated with a node.

Example
The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Click the **Edit Node Data** icon from the **Node Commands Toolbar**.
- At the **Select A Node** prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be highlighted.
- The Node Data & Results will be displayed in the Data Panel. Scroll through the sections. To make a change, left-click in a white cell and either type or select a new value. Left-click on an orange cell (**Actions** section) to execute the associated command. If changes were made, click the **Apply Data Values** command button. If no changes were made, click the **Dismiss** command button.

Notes & Considerations
- This command can also be executed by the **Edit Node Data** item from the GDI Command List, or by typing EDITNODE on the GDI Command Line and pressing the **Enter** key.
- Individual node data can also be edited by left-clicking on a node symbol in the GDI Display when no other command is running, or from the Node Data Report. To access the report, select the **Node Data** item from the **Report** menu list.
- Cells with a yellow background cannot be edited from the Data Panel. These cells may contain calculated values, or may be controlled by another command.
- Certain cells contain lists which have a “Default” option. For **Symbol Color**, the default values are found on the Color Display Settings screen. For the **Symbol Style** and **Symbol Size Style**, the default values are found on the Graphic Settings screen.
- The Attribute Data fields are populated by linking an attribute database to the model from the Node Attribute File Settings screen. To access the screen, select the **Attribute File** item from the **Node Data** submenu from the **Utilities** menu list. Not all Attribute Data values may be edited, depending on the type of database connection.
● If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Color Display Settings
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Edit A Node’s External Load

Summary

Changes the External Load calculated value for a selected node.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Select the Edit Node External Load item from the GDI Command List.
- At the Select A Node prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be highlighted.
- At the New External Load Value prompt, type a value (in Load units) on the GDI Prompt Line and press the Enter key.

Notes & Considerations

- This command can also be executed by typing EDITNODELOAD on the GDI Command Line and pressing the Enter key.
- The external load represents all of the customer loads assigned to a node. This is separated into two data items. The External Load value is the sum of the assigned customer loads from customers whose Adjust Load option is set to “Yes”. This value can be adjusted by the model Design Factor.
- Use of this command may corrupt the automatic External Load accounting. It is only recommended to use this command when the calculated External Load value is known to be incorrect.
- To set the External Load (Fixed) value for a node, use the Edit External Load (Fixed) command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Edit A Node’s Fixed External Load
Select A Feature
Undo The Last Data Or Graphic Change
Edit A Node’s Fixed External Load

Summary

Changes the “fixed” External Load calculated value for a selected node.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Select the Edit Node External Load (Fixed) item from the GDI Command List.
- At the Select A Node prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be highlighted.
- At the New External Load (Fixed) Value prompt, type a value (in Load units) on the GDI Prompt Line and press the Enter key.

Notes & Considerations

- This command can also be executed by typing EDITNODELOADFIX on the GDI Command Line and pressing the Enter key.
- The external load represents all the customer loads assigned to a node. This is separated into two data items. The External Load (Fixed) value is the sum of the assigned customer loads from customers whose Adjust Load option is set to “No”. This value is not subject to the model Design Factor.
- Use of this command may corrupt the automatic External Load accounting. It is recommended only to use this command only when the calculated External Load value is known to be incorrect.
- To set the External Load value for a node, use the Edit External Load command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Select A Feature
Undo The Last Data Or Graphic Change
Edit Pipe Data

Summary

Displays the data values associated with a pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Click the Edit Pipe Data icon from the Data Edit Commands Toolbar.
- At the Select A Pipe prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.
- The Pipe Data & Results will be displayed in the Data Panel. Scroll through the sections. To make a change, left-click in a white cell and either type or select a new value. Left-click on an orange cell (Actions section) to execute the associated command. If changes were made, click the Apply Data Values command button. If no changes were made, click the Dismiss command button.

Notes & Considerations

- This command can also be executed by the Edit Pipe Data item from the GDI Command List, or by typing EDITPIPE on the GDI Command Line and pressing the Enter key.
- Individual pipe data can also be edited by left-clicking on a pipe line in the GDI Display when no other command is running, or from the Pipe Data Report. To access the report, select the Pipe Data item from the Report menu list.
- Cells with a yellow background cannot be edited from the Data Panel. These cells may contain calculated values, or may be controlled by another command.
- Certain cells contain lists which have a “Default” option. For Pipe Line Color, the default values are found on the Color Display Settings screen. For the Pipe Line Style and Pipe Line Thickness, the default values are found on the Graphic Settings screen.
- The Attribute Data fields are populated by linking an attribute database to the model from the Pipe Attribute File Settings screen. To access the screen, select the Attribute File item from the Pipe Data submenu from the Utilities menu list. Not all Attribute Data values may be edited, depending on the type of database connection.
If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Color Display Settings
- Select A Feature
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Edit A Pipe’s Customer Count

Summary

Changes the Customer Count value for a selected pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Edit Pipe Customer Count item from the GDI Command List.
- At the Select A Pipe prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.
- At the New Customer Count prompt, type a value on the GDI Prompt Line and press the Enter key.
- The Customer Count for the selected pipe will be changed to the entered value.

Notes & Considerations

- This command can also be executed by typing EDITPIPECOUNT on the GDI Command Line and pressing the Enter key.
- The Customer Count item records the number of customers attached to a particular pipe. Normally, GASWorkS will update this value automatically as customers are added or deleted.
- Use of this command may corrupt the automatic External Load accounting. It is recommended only to use this command only when the calculated Customer Count value is known to be incorrect.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe  Add An Arc Pipe
Add A Polyline Pipe  Select A Feature
Undo The Last Data Or Graphic Change
Edit A Polyline Pipe Vertex

Summary

Displays the data values associated with a polyline pipe vertex.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one polyline pipe is present in the model.

- Select the Edit Polyline Pipe Vertex item from the GDI Command List.
- At the Select A Polyline Pipe Vertex prompt, move the mouse pointer to a polyline pipe vertex and left-click the mouse. If the Display Vertex Symbols graphic settings option is selected, the selected vertex will be highlighted.
- The Vertex Data will be displayed in the Data Panel. To make a change, left-click in a white cell and type a new value. Left-click on an orange cell (Actions section) to execute the associated command. If changes were made, click the Apply Data Values command button. If no changes were made, click the Dismiss command button.

Notes & Considerations

- This command can also be executed by typing EDITPOLYVERTEX or EDITPVTX on the GDI Command Line and pressing the Enter key.
- This command only supports the editing of polyline pipe vertices.
- To change the location of a polyline vertex and redraw the adjacent pipe segments, either use the Move Polyline Pipe Vertex command or grips.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A Polyline Pipe
Grips
Move A Polyline Pipe Vertex
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Edit A User Graphic Image

Summary

Displays the data values associated with a User Graphic Image.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Image is present in the model.

- Click the Edit User Graphic Image icon from the User Graphic Commands Toolbar.
- At the Select User Graphic Image prompt, move the mouse pointer to a User Graphic Image and left-click the mouse. The selected image will be highlighted.
- The User Graphic Image Data will be displayed in the Data Panel. Scroll through the sections. To make a change, left-click in a white cell and either type or select a new value. Left-click on an orange cell (Actions section) to execute the associated command. If changes were made, click the Apply Data Values command button. If no changes were made, click the Dismiss command button.

Notes & Considerations

- This command can also be executed by the Edit User Graphic Image item from the GDI Command List, or by typing EDITIMAGE or EDITI on the GDI Command Line and pressing the Enter key.
- The User Graphic Image data can also be edited by left-clicking on an image in the GDI Display when no other command is running.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Image
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
**Edit A User Graphic Line**

**Summary**

Displays the data values associated with a User Graphic Line.

**Example**

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Line is present in the model.

- Click the *Edit User Graphic Line* icon from the *User Graphic Commands Toolbar*.

- At the *Select User Graphic Line* prompt, move the mouse pointer to a User Graphic Line and left-click the mouse. The selected line segment will be highlighted.

- The User Graphic Line Data will be displayed in the Data Panel. Scroll through the sections. To make a change, left-click in a white cell and either type or select a new value. Left-click on an orange cell (*Actions* section) to execute the associated command. If changes were made, click the *Apply Data Values* command button. If no changes were made, click the *Dismiss* command button.

**Notes & Considerations**

- This command can also be executed by the *Edit User Graphic Line* item from the GDI Command List, or by typing EDITLINE or EDITL on the GDI Command Line and pressing the *Enter* key.

- The User Graphic Line Data can also be edited by left-clicking on a line in the GDI Display when no other command is running.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A User Graphic Line
- Select A Feature
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Edit A User Graphic Symbol

Summary

Displays the data values associated with a User Graphic Symbol.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Symbol is present in the model.

- Click the Edit User Graphic Symbol icon from the User Graphic Commands Toolbar.
- At the Select User Graphic Symbol prompt, move the mouse pointer to a User Graphic Symbol and left-click the mouse. The selected symbol will be highlighted.
- The User Graphic Symbol Data will be displayed in the Data Panel. Scroll through the sections. To make a change, left-click in a white cell and either type or select a new value. Left-click on an orange cell (Actions section) to execute the associated command. If changes were made, click the Apply Data Values command button. If no changes were made, click the Dismiss command button.

Notes & Considerations

- This command can also be executed by the Edit User Graphic Symbol item from the GDI Command List, or by typing EDITSYMBOL or EDITS on the GDI Command Line and pressing the Enter key.
- The User Graphic Symbol Data can also be edited by left-clicking on a symbol in the GDI Display when no other command is running.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Symbol
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Edit A User Table

Summary

Displays the data values associated with a User Table.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Table is present in the model.

- Select the Edit User Table item from the GDI Command List.
- At the Select A Text Item In The Associated User Table prompt, move the mouse pointer to a text item in the User Table to edit and left-click the mouse.
- The selected table will be highlighted, and the User Table Editor screen is displayed.
  - Either left-click on one of the icons to execute the associated command, or left-click the mouse on a data cell to highlight the cell, then type a new value.
  - Either click the Close command button to save all changes and return to the GDI Window, or click the Cancel command button to exit the screen without saving.
  - If the Close command button is clicked, a message may be displayed stating that the table contents have not been saved to the model. Either click the Yes command button to save changes before closing the screen, click the No command button to proceed without saving changes, or click the Cancel command button to return to the User Table Editor screen.

Notes & Considerations

- This command can also be executed by typing EDITTABLE on the GDI Command Line and pressing the Enter key.
- For a more detailed description of the User Table Editor screen, refer to the User Table Editor Graphic Data Interface topic in the User’s Manual.
- The User Table data can also be edited by left-clicking on a table in the GDI Display when no other command is running. A message will be displayed asking whether to display the User Table Editor screen. Either click the Yes command button to display the screen, or click the No command button to return to the GDI Window.
• If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Create A User Table
Select A Feature
Undo The Last Data Or Graphic Change
Edit User Text

Summary

Displays the data values associated with a User Text feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Text feature is present in the model.

- Click the Edit User Text icon from the User Text Commands Toolbar.
- At the Select User Text prompt, move the mouse pointer to a User Text feature and left-click the mouse. The selected text will be highlighted.
- The User Text Data will be displayed in the Data Panel. Scroll through the sections. To make a change, left-click in a white cell and either type or select a new value. Left-click on an orange cell (Actions section) to execute the associated command. If changes were made, click the Apply Data Values command button. If no changes were made, click the Dismiss command button.

Notes & Considerations

- This command can also be executed by the Edit User Text item from the GDI Command List, or by typing EDITTEXT or EDITT on the GDI Command Line and pressing the Enter key.
- The User Text data can also be edited by left-clicking on a text feature in the GDI Display when no other command is running.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add User Text
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Export User Text

Summary

Exports the User Text features to a text file (.txt).

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Text feature is present in the model.

- Select the Export User Text item from the GDI Command List.
- The File Selection screen is displayed. Type the full file path in the Filename data field. Click the Continue command button to export the User Text to the specified file.
- A message will be displayed when the text file has been saved. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing EXPORTTEXT on the GDI Command Line and pressing the Enter key.

See Also

Add User Text
Feature Snap

Summary

Turns the Feature Snap “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Feature Snap icon from the lower-left corner of the GDI Window.
  - If the background of the icon is darkened, the Feature Snap is enabled.
  - If the background of the icon is the normal gray background, the Feature Snap is disabled.

Notes & Considerations

- This command can also be executed by the Feature Snap item from the GDI Command List, or by typing SNAP on the GDI Command Line and pressing the Enter key.

- When the Feature Snap is enabled, a graphic circle will be displayed around the mouse crosshairs with a radius equal to the snap target. If the mouse is left-clicked and a feature is within the snap target circle, the feature will be selected. If a location is entered as a coordinate pair on the GDI Prompt Line, and a feature is within the snap target of the coordinates, the feature will be selected. These values can be changed from the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.

- If more than one feature is found within the snap target circle when a selection is made, the feature with the lowest Record Number will be used.

See Also

Select A Feature
Find Any Feature

Summary

Finds and flags the location of a general feature (customer, DXF Text, node, pipe, or User Text) based on a User input value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe, node, customer, DXF Text, or User Text feature is present in the model.

- Select the Find Any Feature item from the GDI Command List.
- At the Find What prompt, select an item from the GDI Prompt List, or right-click the mouse to accept the default value. The selected item specifies the type of model feature being searched.
- At the “Search By” prompt, select an item from the GDI Prompt List, or right-click the mouse to accept the default value. The selected item specifies the data item being searched.
- At the “To Find” prompt, type a value on the GDI Prompt Line and press the Enter key. The routine will search the model for a feature of the specified type with the specified data item that matches the entered value.
- A find flag will be placed at the feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FIND on the GDI Command Line and pressing the Enter key, or by simultaneously pressing the Ctrl and “F” keys.
- The find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. Only one find flag per feature type can be displayed at a time.
- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.
See Also

Find A Customer
Find DXF Text
Find A Node
Find A Pipe
Find User Text
Find A Customer

Summary

Finds and flags a customer feature based on a User input value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Click the Find Customer icon from the Customer Commands Toolbar.
- At the Customer Search Method - Search By prompt, select an item from the GDI Prompt List, or right-click the mouse to accept the default value. The selected item specifies the data item being searched.
- At the “To Find” prompt, type a value on the GDI Prompt Line and press the Enter key. The routine will search the model for a customer with the specified data item that matches the entered value.
- A find flag will be placed at the customer feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by the Find Customer item from the GDI Command List, or by typing FINDCUSTOMER or FINDCUST on the GDI Command Line and pressing the Enter key.
- The display of the Customer Symbols must be turned “on” for the customer find flag to display.
- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.
- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.
- The search methods are described in greater detail under the associated Help topics.
To search for a feature by an attribute value, an attribute database must be attached with the appropriate field assigned. The Find Customer routine is case sensitive. For example, if the search value is “Main”, the routine will not find a feature whose value is “MAIN”. The search string must either match the entire DXF Text value (for example, to find “Main St” the search string must be “Main St”), or type the term “LIKE” before the search value. This allows for partial matches to be found. For example, if “LIKE Main” is entered at the search prompt, the routine will flag a feature with the address “Main St” or “Main Rd”. If the entered search string is not found, a message will be displayed stating no feature was found.

The Search By “Attribute Value” routine uses a SQL style search statement called a Search String. To find a feature with an attribute item named “FACILITATE” equals 1998, the search string would be entered as FACILITATE = 1998. See the Using SQL Statements Attribute Data topic in the User’s Manual for more information.

See Also

- Add A Customer
- Clear The Customer Find Flag
- Clear A Customer Flag
- Display The Customer Symbols
- Find A Customer By Address
- Find A Customer By Attribute
- Find A Customer By Internal ID Number
- Find A Customer By Link ID Number
- Find A Customer By Record Number
Find A Customer By Address

Summary

Finds and flags a customer feature based on a User input Street Address value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the Find Customer By Address item from the GDI Command List.
- At the Address Of Customer To Find prompt, type a value on the GDI Prompt Line, then press the Enter key.
- A find flag will be placed at the customer feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDCUSTOMERADDRESS or FINDCUSTADD on the GDI Command Line and pressing the Enter key.
- For a customer flag to be displayed, the Display Customer Symbols option must be “on”.
- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.
- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.
- To search for a customer feature by an attribute value, an attribute database must be attached with the appropriate field assigned.
Enter the term “LIKE” before the search value to allow partial matches where a search value of length “n” matches the first “n” characters of the specified field. Otherwise, the search value must match the data value exactly. For example, if the Search By field is Address, and the User enters “LIKE 123 Main” at the search prompt, the routine will flag the feature with the address “123 Main St”. However, if the User searches only for “123 Main”, a message will be displayed stating no feature was found.

See Also

Add A Customer  
Clear The Customer Find Flag  
Clear A Customer Flag  
Display The Customer Symbols  
Find A Customer
Find A Customer By Attribute

Summary

Finds and flags a customer feature based on a User input “attribute” value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the Find Customer By Attribute item from the GDI Command List.
- At the Enter Search String prompt, type a value on the GDI Prompt Line and press the Enter key.
- A find flag will be placed at the customer feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDCUSTOMERATTRIBUTE or FINDCUSTATT on the GDI Command Line and pressing the Enter key.
- For a customer flag to be displayed, the Display Customer Symbols option must be “on”.
- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.
- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.
- To search for a customer feature by an attribute value, an attribute database must be attached with the appropriate field assigned.
- The search string represents an SQL style search statement. For example, to find a customer where an attribute item named “FACILITY” equals 1998, the search string would be entered as FACILITY = 1998. See the Using SQL Statements Attribute Data topic in the User’s Manual for more information.
See Also

Add A Customer
Clear The Customer Find Flag
Clear A Customer Flag
Display The Customer Symbols
Find A Customer
Find A Customer By Internal ID Number

Summary

Finds and flags a customer feature by its Internal ID Number.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the Find Customer By Internal ID Number item from the GDI Command List.
- At the Internal ID Number Of Customer To Find prompt, type a value on the GDI Prompt Line, then press the Enter key.
- A find flag will be placed at the customer feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDCUSTOMERID or FINDCID on the GDI Command Line and pressing the Enter key.
- For a customer flag to be displayed, the Display Customer Symbols option must be “on”.
- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.
- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.

See Also

Add A Customer  Clear The Customer Find Flag
Clear A Customer Flag  Display The Customer Symbols
Find A Customer
Find A Customer By Link ID Number

Summary

Finds and flags a customer feature by its Link ID Number.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the *Find Customer By Link ID Number* item from the GDI Command List.
- At the *Link ID Number Of Customer To Find* prompt, type a value on the GDI Prompt Line, then press the *Enter* key.
- A find flag will be placed at the customer feature that matches the search criteria. *Note* - If no match is found, a message will be displayed. Click the *OK* command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDCUSTOMERLINKID or FINDCLINK on the GDI Command Line and pressing the *Enter* key.
- For a customer flag to be displayed, the *Display Customer Symbols* option must be “on”.
- Find flags will remain displayed until they are cleared using one of the *Clear Flag* commands or another feature of the same type is flagged using a *Find* command. One find flag per feature type can be displayed at a time.
- If the *Automatically Zoom On Find* graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the *Settings* item from the *Graphics* menu list.
- To search for a customer feature by an attribute value, an attribute database must be attached with the appropriate field assigned.
See Also

Add A Customer
Clear The Customer Find Flag
Clear A Customer Flag
Display The Customer Symbols
Find A Customer
Find A Customer By Record Number

Summary

Finds and flags a customer feature by its Record Number.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the Find Customer By Record Number item from the GDI Command List.

- At the Record Number Of Customer To Find prompt, type a value on the GDI Prompt Line, then press the Enter key.

- A find flag will be placed at the customer feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDCUSTOMERRECORD or FINDCREC on the GDI Command Line and pressing the Enter key.

- For a customer flag to be displayed, the Display Customer Symbols option must be “on”.

- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.

- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.

See Also

Add A Customer
Clear A Customer Flag
Find A Customer

Clear The Customer Find Flag
Display The Customer Symbols
Find DXF Text

Summary

Finds and flags a DXF Text location based on a User input value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a DXF Text feature is present in the model.

- Select the Find DXF Text item from the GDI Command List.
- At the Text Value To Find prompt, type a value on the GDI Prompt Line, then press the Enter key.
- A flag will be placed at the feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDDXFTEXT or FINDDXF on the GDI Command Line and pressing the Enter key.
- Only the first DXF text feature that matches the search criteria will be flagged.
- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.
- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using the Find DXF Text command. One find flag per feature type can be displayed at a time.
- The Find DXF Text routine is not case sensitive. The search string must either match the entire DXF Text value (for example, to find “Main St” the search string must be “Main St”), or type the term “LIKE” before the search value. This allows for partial matches to be found. For example, if “LIKE Main” is entered at the search prompt, the routine will flag a feature with the address “Main St” or “Main Rd”. If the entered search string is not found, a message will be displayed stating no feature was found.
See Also

Add A DXF Background Image
Clear The DXF Find Flag
Find A Geographic Location

Summary

Finds and flags a geographic location based on a User input street Address or geographic Location Name.

Example

The example assumes that GASWorkS has been started, an internet connection is active, a model using the GeoMap function is open, and the GDI Window is displayed.

- Click the Find Geographic Location icon from the GeoMap Functions Toolbar.

- At the Address, or Location Name prompt, type Pikes Peak Colorado on the GDI Prompt Line, then press the Enter key.

- A GeoFind flag will be placed at the geographic location that matches the search criteria.

Notes & Considerations

- This command can also be executed by the Find Geographic Location item from the GDI Command List, or by typing GEOFIND on the GDI Command Line and pressing the Enter key.

- For a GeoFind flag to be displayed, the GeoMap Functions must be enabled.

- A street address, geographic name, or place name can be used for the location name. The more specific or detailed the location description the more precise the GeoFind flag will be positioned. When entering a street address, include the zip code, postal code, or city name and state.

- Each map service may use a different physical location to define the same geographic location.

- Regional language and naming conventions may affect the ability for the map service to find a location. The Find Geographic Location command may not work as expected for international Users.

- If no location is found or the description understood, either a message may be displayed or a GeoFind flag may be placed in a seemingly random location.

- When a location is found, the GDI Image will be resized to center the location at the current zoom scale.

- A GeoFind flag will remain displayed until it is cleared using the Clear GeoFind Flag command.
See Also

Clear The GeoFind Flag
Turn The GeoMap Functions On
Find A Node

Summary

Finds and flags a node based on a User input value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Click the Find Node icon from the Data Edit Commands Toolbar.
- At the Node Search Method - Search By prompt, select an item from the GDI Prompt List, or right-click the mouse to accept the default value. The selected item specifies the data item being searched.
- At the “To Find” prompt, type a value on the GDI Prompt Line and press the Enter key. The routine will search the model for a node with the specified data item that matches the entered value.
- A find flag will be placed at the feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by the Find Node item from the GDI Command List, or by typing FINDNODE on the GDI Command Line and pressing the Enter key.
- For a node flag to be displayed, the Display Node Symbols option must be “on”.
- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.
- Enter the term “LIKE” before the search value to allow partial matches where a search value of length “n” matches the first “n” characters of the specified field. Otherwise, the search value must match the data value exactly. For example, if the Search By field is Address, and the User enters “LIKE 123 Main” at the search prompt, the routine will flag the feature with the address “123 Main St”. However, if the User searches only for “123 Main”, a message will be displayed stating no feature was found.
Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.

The search methods are described in greater detail under the associated Help topics.

See Also

- Clear The Node Find Flag
- Clear A Node Flag
- Display The Node Symbols
- Find A Node By Name
- Find A Node By Record Number
Find A Node By Name

Summary

Finds and flags a node by its node Name.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Select the Find Node By Name item from the GDI Command List.

- At the Name Of Node To Find prompt, type a value on the GDI Prompt Line and press the Enter key. The routine will search the model for a node with the specified data item that matches the entered value.

- A find flag will be placed at the feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDNODENAME or FINDNNAME on the GDI Command Line and pressing the Enter key.

- For a node flag to be displayed, the Display Node Symbols option must be “on”.

- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.

- Enter the term “LIKE” before the search value to allow partial matches where a search value of length “n” matches the first “n” characters of the specified field. Otherwise, the search value must match the data value exactly. For example, if the Search By field is Address, and the User enters “LIKE 123 Main” at the search prompt, the routine will flag the feature with the address “123 Main St”. However, if the User searches only for “123 Main”, a message will be displayed stating no feature was found.

- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.
See Also

Clear The Node Find Flag
Clear A Node Flag
Display The Node Symbols
Find A Node By Record Number

Summary

Finds and flags a node by its Record Number.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Select the Find Node By Record Number item from the GDI Command List.

- At the Record Number Of Node To Find prompt, type a value on the GDI Prompt Line and press the Enter key. The routine will search the model for a node with the specified data item that matches the entered value.

- A find flag will be placed at the feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDNODERECORD or FINDNREC on the GDI Command Line and pressing the Enter key.

- For a node flag to be displayed, the Display Node Symbols option must be “on”.

- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.

- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.

See Also

Clear The Node Find Flag
Clear A Node Flag
Display The Node Symbols
Find A Pipe

Summary

Finds and flags a pipe feature based on a User input value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Click the Find Pipe icon from the Data Edit Commands Toolbar.

- At the Pipe Search Method - Search By prompt, select an item from the GDI Prompt List, or right-click the mouse to accept the default value. The selected item specifies the data item being searched.

- At the “To Find” prompt, type a value on the GDI Prompt Line and press the Enter key. The routine will search the model for a pipe with the specified data item that matches the entered value.

- A find flag will be placed at the pipe feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by the Find Pipe item from the GDI Command List, or by typing FINDPIPE on the GDI Command Line and pressing the Enter key.

- For a pipe flag to be displayed, the Display Pipe Symbols option must be “on”.

- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.

- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.

- The search methods are described in greater detail under the associated Help topics.
● To search for a feature by an attribute value, an attribute database must be attached with the appropriate field assigned. The Find Pipe routine is case sensitive. For example, if the search value is “Main”, the routine will not find a feature whose value is “MAIN”. The search string must either match the entire DXF Text value (for example, to find “Main St” the search string must be “Main St”), or type the term “LIKE” before the search value. This allows for partial matches to be found. For example, if “LIKE Main” is entered at the search prompt, the routine will flag a feature with the address “Main St” or “Main Rd”. If the entered search string is not found, a message will be displayed stating no feature was found.

● The Search By “Attribute Value” routine uses a SQL style search statement called a Search String. To find a feature with an attribute item named “FACILITATE” equals 1998, the search string would be entered as FACILITATE = 1998. See the Using SQL Statements Attribute Data topic in the User’s Manual for more information.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Clear The Pipe Find Flag
Clear A Pipe Flag
Display The Pipe Symbols
Find A Pipe By Address
Find A Pipe By Attribute
Find A Pipe By Internal ID Number
Find A Pipe By Link ID Number
Find A Pipe By Record Number
Find A Pipe By Address

Summary

Finds and flags a pipe feature based on a User input Address value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Find Pipe By Address item from the GDI Command List.

- At the Address Of Pipe To Find prompt, type a value on the GDI Prompt Line and press the Enter key. The routine will search the model for a pipe with the specified data item that matches the entered value.

- A find flag will be placed at the pipe feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDPIPEADDRESS or FINDPADD on the GDI Command Line and pressing the Enter key.

- For a pipe flag to be displayed, the Display Pipe Symbols option must be “on”.

- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.

- To search for a feature by an attribute value, an attribute database must be attached with the appropriate field assigned.

- Enter the term “LIKE” before the search value to allow partial matches where a search value of length “n” matches the first “n” characters of the specified field. Otherwise, the search value must match the data value exactly. For example, if the Search By field is Address, and the User enters “LIKE 123 Main” at the search prompt, the routine will flag the feature with the address “123 Main St”. However, if the User searches only for “123 Main”, a message will be displayed stating no feature was found.
Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Clear The Pipe Find Flag
Clear A Pipe Flag
Display The Pipe Symbols
Find A Pipe By Attribute

Summary

Finds and flags a pipe feature based on a User input “attribute” value.

Example

This example assumes that GASWorkS has been started, that a model is open, that the GDI Window is open, and that at least one pipe feature is present in the model.

- Select the Find Pipe By Attribute item from the GDI Command List.

- At the Enter Search String prompt, type a value on the GDI Prompt Line and press the Enter key. The routine will search the model for a pipe with the specified data item that matches the entered value.

- A find flag will be placed at the pipe feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDPIPEATTRIBUTE or FINDPATT on the GDI Command Line and pressing the Enter key.

- For a pipe flag to be displayed, the Display Pipe Symbols option must be “on”.

- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.

- To search for a feature by an attribute value, an attribute database must be attached with the appropriate field assigned.

- The search string represents an SQL style search statement. For example, to find a pipe where an attribute item named “FACILITATE” equals 1998, the search string would be entered as FACILITATE = 1998. See the Using SQL Statements Attribute Data topic in the User’s Manual for more information.

- The pipe find flag will remain displayed until turned “off” using the associated Clear Flag commands, or until another pipe is flagged.
See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Clear The Pipe Find Flag
Clear A Pipe Flag
Display The Pipe Symbols
Find A Pipe By Internal ID Number

Summary

Finds and flags a pipe feature by its Internal ID Number.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Find Pipe By Internal ID Number item from the GDI Command List.
- At the Internal ID Number Of Pipe To Find prompt, type a value on the GDI Prompt Line and press the Enter key. The routine will search the model for a pipe with the specified data item that matches the entered value.
- A find flag will be placed at the pipe feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDPIPEID or FINDPID on the GDI Command Line and pressing the Enter key.
- For a pipe flag to be displayed, the Display Pipe Symbols option must be “on”.
- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.
- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.

See Also

Add A 2-Point Pipe    Add An Arc Pipe
Add A Polyline Pipe    Clear The Pipe Find Flag
Clear A Pipe Flag    Display The Pipe Symbols
Find A Pipe By Link ID Number

Summary

Finds and flags a pipe feature by its Link ID Number.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Find Pipe By Link ID Number item from the GDI Command List.

- At the Link ID Number Of Pipe To Find prompt, type a value on the GDI Prompt Line and press the Enter key. The routine will search the model for a pipe with the specified data item that matches the entered value.

- A find flag will be placed at the pipe feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDPIPELINKID or FINDPLINK on the GDI Command Line and pressing the Enter key.

- For a pipe flag to be displayed, the Display Pipe Symbols option must be “on”.

- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.

- To search for a feature by an attribute value, an attribute database must be attached with the appropriate field assigned.

- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.
See Also

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Clear The Pipe Find Flag
- Clear A Pipe Flag
- Display The Pipe Symbols
Find A Pipe By Record Number

Summary

Finds and flags a pipe feature by its Record Number.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Find Pipe By Record Number item from the GDI Command List.
- At the Record Number Of Pipe To Find prompt, type a value on the GDI Prompt Line and press the Enter key. The routine will search the model for a pipe with the specified data item that matches the entered value.
- A find flag will be placed at the pipe feature that matches the search criteria. Note - If no match is found, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by typing FINDPIPERECORD or FINDPREC on the GDI Command Line and pressing the Enter key.
- For a pipe flag to be displayed, the Display Pipe Symbols option must be “on”.
- If the Automatically Zoom On Find graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the Settings item from the Graphics menu list.
- Find flags will remain displayed until they are cleared using one of the Clear Flag commands or another feature of the same type is flagged using a Find command. One find flag per feature type can be displayed at a time.

See Also

Add A 2-Point Pipe  Add An Arc Pipe
Add A Polyline Pipe  Clear The Pipe Find Flag
Clear A Pipe Flag  Display The Pipe Symbols
Find User Text

Summary

Finds and flags a User Text feature based on a User input value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Text feature is present in the model.

- Click the *Find User Text* icon from the *User Text Commands Toolbar*.

- At the *User Text Value To Find* prompt, type a value on the GDI Prompt Line and press the *Enter* key. The routine will search the model for a User Text feature with the specified value that matches the entered value.

- A find flag will be placed at the User Text feature that matches the search criteria. *Note* - If no match is found, a message will be displayed. Click the *OK* command button to clear the message and return to the prompt.

Notes & Considerations

- This command can also be executed by the *Find User Text* item from the GDI Command List, or by typing FINDTEXT or FINDT on the GDI Command Line and pressing the *Enter* key.

- Only the first User Text feature that matches the search criteria will be flagged.

- The *Find User Text* routine is not case sensitive. The search string must either match the entire DXF Text value (for example, to find “Main St” the search string must be “Main St”), or type the term “LIKE” before the search value. This allows for partial matches to be found. For example, if “LIKE Main” is entered at the search prompt, the routine will flag a feature with the address “Main St” or “Main Rd”. If the entered search string is not found, a message will be displayed stating no feature was found.

- If the *Automatically Zoom On Find* graphic settings option is selected, the view in the GDI Window will be centered on the flagged feature. To access the option, select the *Settings* item from the *Graphics* menu list.

- Find flags will remain displayed until they are cleared using the *Clear User Text Flag* command or another User Text feature is flagged using the *Find User Text* command. Only one find flag per feature type can be displayed at a time.
See Also

Add User Text
Clear The User Text Find Flag
Flag A Customer

Summary

Finds and flags a User specified customer feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one customer is present in the model, and the Display Customer Symbols option is “on”.

- Select the Flag Customer item from the GDI Command List.
- At the Select Customer To Clear prompt, move the mouse pointer to a customer and left-click the mouse. An item flag will be placed at the selected customer.
- The Select Customer To Clear prompt will remain displayed. Use the method above to flag additional customers. When finished, right-click the mouse or press the “E” key.

Notes & Considerations

- This command can also be executed by typing FLAGCUST or FLAGC on the GDI Command Line and pressing the Enter key.
- Item flags will remain displayed until they are cleared using one of the Clear Flag commands. Multiple features of the same type can be flagged in this manner.

See Also

Add A Customer
Clear All Customer Flags
Clear All Flags
Clear A Customer Flag
Clear Customer Item Flags
Display The Customer Symbols
Select A Feature
Flag Customers By Item Value

Summary

Finds and flags customer features based on a User specified item value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one customer is present in the model, and the Display Pipe Symbols option is “on”.

- Select the Flag Customers By Item Value item from the GDI Command List.

- The Query Specifications screen is displayed.
  
  - Select a data item from the Where list. Select an operator from the Is list. Either select an item from the To list, or type a value in the To field. Once the query is defined, click the Perform Query command button.

  - A message will be displayed stating the number of matches found. Click the OK command button to clear the message and return to the Query Specifications screen.

  - Use the method above to perform additional queries. When finished, click the Close command button to exit the Query Specifications screen and return to the GDI Display.

  - Item flags will be placed at any feature that matches the search criteria from the queries performed.

Notes & Considerations

- This command can also be executed by typing FLAGCUSTOMERITEM or FLAGCUSTITEM on the GDI Command Line and pressing the Enter key.

- Item flags will remain displayed until they are cleared using one of the Clear Flag commands. Multiple features of the same type can be flagged in this manner.

- On the Query Specifications screen, the Save Current Specification command button saves the current query for future use. Saved queries can be accessed from the Saved Specifications list. To remove a saved query from the list, click the Delete Displayed Specification command button.
See Also

Add A Customer
Clear All Customer Flags
Clear All Flags
Clear A Customer Flag
Clear Customer Item Flags
Display The Customer Symbols
Query Specifications Screen
Flag Customers With Invalid Link ID Numbers

Summary

Finds and flags customer features with “invalid” Link ID Numbers.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one customer is present in the model, and the Display Customer Symbols option is “on”.

- Select the Flag Customers - Invalid Link ID Numbers item from the GDI Command List.

- A message will be displayed stating the number of customers with invalid Link ID Numbers. Click the OK command button to clear the message. Error flags will be placed at the customers where invalid Link ID Numbers were found.

- The Customer Link ID Number Report will be displayed showing the records with invalid Link ID Numbers. Review the report. When finished, click the Close command button to exit the report window and return to the GDI Display.

Notes & Considerations

- This command can also be executed by typing FLAGBADCID on the GDI Command Line and pressing the Enter key.

- Error flags will remain displayed until they are cleared using one of the Clear Flag commands or another Flag command is executed for features of the same type. Multiple features of the same type can be flagged in this manner.

See Also

- Add A Customer
- Clear All Customer Flags
- Clear All Flags
- Clear A Customer Flag
- Clear Error Flags
- Display The Customer Symbols
Flag Customers With Redundant Link ID Numbers

Summary

Finds and flags customer features with redundant Link ID Numbers.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one customer is present in the model, and the Display Customer Symbols option is “on”.

- Select the Flag Customers - Redundant Link ID Numbers item from the GDI Command List.

- A message will be displayed stating the number of customers with redundant Link ID Numbers. Click the OK command button to clear the message. Error flags will be placed at the customers where redundant Link ID Numbers were found.

- The Customer Link ID Number Report will be displayed stating the records with redundant Link ID Numbers. Review the report. When finished, click the Close command button to exit the report window and return to the GDI Display.

Notes & Considerations

- This command can also be executed by typing FLAG2XCID on the GDI Command Line and pressing the Enter key.

- Error flags will remain displayed until they are cleared using one of the Clear Flag commands or another Flag command is executed for features of the same type. Multiple features of the same type can be flagged in this manner.

See Also

Add A Customer
Clear All Customer Flags
Clear All Flags
Clear A Customer Flag
Clear Error Flags
Display The Customer Symbols
Flag A Node

Summary

Finds and flags a User specified node.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one node is present in the model, and the Display Node Symbols option is “on”.

- Select the Flag Node item from the GDI Command List.
- At the Select Node To Clear prompt, move the mouse pointer to a node and left-click the mouse. An item flag will be placed at the selected node.
- The Select Node To Clear prompt will remain displayed. Use the method above to flag additional nodes. When finished, right-click the mouse or press the “E” key.

Notes & Considerations

- This command can also be executed by typing FLAGNODE or FLAGN on the GDI Command Line and pressing the Enter key.
- Item flags will remain displayed until they are cleared using one of the Clear Flag commands or another Flag command is executed for features of the same type. Multiple features of the same type can be flagged in this manner.

See Also

Clear All Flags
Clear All Node Flags
Clear A Node Flag
Clear Node Item Flags
Display The Node Symbols
Select A Feature
Flag Nodes By Item Value

Summary

Finds and flags nodes based on a User specified item value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one node is present in the model, and the Display Node Symbols option is “on”.

- Select the Flag Nodes By Item Value item from the GDI Command List.

- The Query Specifications screen is displayed.
  - Select a data item from the Where list. Select an operator from the Is list. Either select an item from the To list, or type a value in the To field. When the query is defined, click the Perform Query command button.
  - A message will be displayed stating the number of matches found. Click the OK command button to clear the message and return to the Query Specifications screen.
  - Use the method above to perform additional queries. When finished, click the Close command button to exit the Query Specifications screen and return to the GDI Display.

- Item flags will be placed at any feature that matches any search criteria from the queries performed.

Notes & Considerations

- This command can also be executed by typing FLAGNODEITEM or FLAGNITEM on the GDI Command Line and pressing the Enter key.

- Item flags will remain displayed until they are cleared using one of the Clear Flag commands or another Flag command is executed for features of the same type. Multiple features of the same type can be flagged in this manner.

- On the Query Specifications screen, the Save Current Specification command button saves the current query for future use. Saved queries can be accessed from the Saved Specifications list. To remove a saved query from the list, click the Delete Displayed Specification command button.
See Also

Clear All Flags
Clear All Node Flags
Clear A Node Flag
Clear Node Item Flags
Display The Node Symbols
Query Specifications Screen
Flag A Pipe

Summary

Finds and flags a User specified pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one pipe is present in the model, and the Display Pipe Symbols option is “on”.

- Select the Flag Pipe item from the GDI Command List.
- At the Select Pipe To Clear prompt, move the mouse pointer to a pipe and left-click the mouse. An item flag will be placed at the selected pipe.
- The Select Pipe To Clear prompt will remain displayed. Use the method above to flag additional pipes. When finished, right-click the mouse or press the “E” key.

Notes & Considerations

- This command can also be executed by typing FLAGPIPE or FLAGP on the GDI Command Line and pressing the Enter key.
- Item flags will remain displayed until they are cleared using one of the Clear Flag commands or another Flag command is executed for features of the same type. Multiple features of the same type can be flagged in this manner.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Clear All Flags
Clear All Pipe Flags
Clear A Pipe Flag
Clear Pipe Item Flags
Display The Pipe Symbols
Select A Feature
Flag Pipes By Item Value

Summary

Finds and flags pipe features based on a User specified item value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one pipe is present in the model, and the Display Pipe Symbols option is “on”.

- Select the Flag Pipes By Item Value item from the GDI Command List.
- The Query Specifications screen is displayed.
  - Select a data item from the Where list. Select an operator from the Is list. Either select an item from the To list, or type a value in the To field. When the query is defined, click the Perform Query command button.
  - A message will be displayed stating the number of matches found. Click the OK command button to clear the message and return to the Query Specifications screen.
  - Use the method above to perform additional queries. When finished, click the Close command button to exit the Query Specifications screen and return to the GDI Display.
  - Item flags will be placed at any feature that matches any search criteria from the queries performed.

Notes & Considerations

- This command can also be executed by typing FLAGPIPEITEM or FLAGPITEM on the GDI Command Line and pressing the Enter key.

- Item flags will remain displayed until they are cleared using one of the Clear Flag commands or another Flag command is executed for features of the same type. Multiple features of the same type can be flagged in this manner.

- On the Query Specifications screen, the Save Current Specification command button saves the current query for future use. Saved queries can be accessed from the Saved Specifications list. To remove a saved query from the list, click the Delete Displayed Specification command button.
When *Pipe Diameter* is selected from the *Where* list, the *To* list allows the User to enter any value for the pipe size; when *Pipe Size/Type Code* is selected from the *Where* list, it provides a list of Size/Typ Codes contained in the Pipe Property Table; and when *Pipe Size/Type Code (Unlisted)* is selected from the *Where* list, the User can enter a code not listed in the Pipe Property Table.

**See Also**

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Clear All Flags
- Clear All Pipe Flags
- Clear A Pipe Flag
- Clear Pipe Item Flags
- Display The Pipe Symbols
- Query Specifications Screen
Flag The Supply Node

Summary

Finds and flags nodes with positive load values (supply nodes).

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one node is present in the model, and the Display Node Symbols option is “on”.

- Select the Flag Supply Nodes item from the GDI Command List. Note - There are no prompts for this command.
- All of the supply nodes will be flagged.

Notes & Considerations

- This command can also be executed by typing FLAGSUPPLY on the GDI Command Line and pressing the Enter key.
- A supply node is a node with a Total Load value greater than zero (0). Supply nodes represent points where gas flows into the system being modeled.
- The supply node flags will remain displayed until they are cleared using one of the Clear Flags command.

See Also

Clear All Flags
Clear The Supply Flags
Display The Node Symbols
Flag Unassigned Customers

Summary

Finds and flags customer features which are not assigned to a supply main.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, at least one unassigned customer is present in the model, and the Display Customer Symbols option is “on”.

- Select the Flag Customers - Unassigned item from the GDI Command List.
- A message will be displayed stating the number of customers with “bad” pipe assignments. Click the OK command button to clear the message.
- All of the unassigned customer locations will be flagged.

Notes & Considerations

- This command can also be executed by typing FLAGUNASSIGNED or FLAGUNCUST on the GDI Command Line and pressing the Enter key.
- An unassigned customer has a customer location, but no tap location and no service line. Unassigned customers have a Supply Main Number of “0” in the Customer Data, and are not included in the solution.
- Item flags will remain displayed until they are cleared using one of the Clear Flag commands or another Flag command is executed for features of the same type. Multiple features of the same type can be flagged in this manner.

See Also

Add An Unassigned Customer
Assign The Customer Service Lines
Clear All Customer Flags
Clear All Flags
Clear A Customer Flag
Display The Customer Symbols
Use The Data Panel
Flag Unbroken Intersections

Summary

Finds and flags intersections where the lateral pipe is not connected to the header pipe.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and an unbroken intersection is present in the model.

- Select the Flag Unbroken Intersections item from the GDI Command List.

- The Fuzzy Tolerance screen is displayed. Type a value in the Fuzzy Tolerance Value data field. Click the Continue command button to proceed.

- A message will be displayed asking whether to reset the Allow Intersection Flag option for the nodes. Either click the Yes command button to enable the intersection flag option for the flagged nodes, or click the No command button to disable this option for the nodes.

- A message will be displayed stating the number of unbroken intersections found. Click the OK command button to clear the message.

- The unbroken intersections will be flagged.

Notes & Considerations

- This command can also be executed by typing FLAGUNBROKEN on the GDI Command Line and pressing the Enter key.

- The purpose of this command is to find unconnected laterals off of headers, pipe ends that are not snapped together, and sometimes, redundant pipes (where a pipe is on top of another pipe but not connected on the ends). For example, DXF files often contain long, unbroken lines spanning several intersections with laterals. When importing such a DXF file, GASWorkS will create nodes at the ends of each lateral, but these nodes may not be connected to the header.

- Unbroken intersections only occur at nodes. The routine will not flag a crossing of two pipes unless there is a node within the Fuzzy Tolerance.

- The Fuzzy Tolerance value is expressed in terms of the Coordinate units. In this routine, the value represents the radius of an imaginary circle drawn around each node. If an unconnected pipe falls within the circle, the node will be flagged.
Be patient when using this command - search times can be quite long for larger models.

Only pipes whose Facility Type is set to “Active” are considered. The “Active” setting can be found on the Facility Settings screen. To access the screen, select the Facility Settings item from the Edit menu list.

To mark an individual intersection with a graphic flag, use the Set Intersection Flag command.

Once flagged, the Break Flagged Intersections command will “break” all of the unconnected pipes into two segments joined at the node.

To remove all unbroken intersection flags from the model, use the Clear Unbroken Intersection Flags command.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Break Flagged Intersections
Clear Unbroken Intersection Flags
Set An Intersection Flag
Get A Group ID

Summary

Displays the Group ID Number for a User selected group.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a group has been created.

- Select the Get Group ID item from the GDI Command List.
- At the Select A Feature In The Associated Group prompt, move the mouse pointer to a group feature and left-click the mouse. Note - If the selected feature is not part of a group, a message will be displayed. Click the OK command button to clear the message and return to the prompt.
- A message will be displayed stating the Group ID Number of the selected group. Either click the Yes command button to select another group feature, or click the No command button to end the command.

Notes & Considerations

- This command can also be executed by typing GETGROUPID or GETGRP on the GDI Command Line and pressing the Enter key.

See Also

Add A Feature To A Group
Create A Group
Go To An XY Coordinate Location

Summary

Positions the upper-left corner of the model image at a User specified XY-Coordinate location.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Go To XY Location icon from the View Controls Toolbar.

- At the X,Y Coordinates prompt, type a coordinate pair on the GDI Prompt Line and press the Enter key.

- The model image will be moved so that the upper-left corner of the window will be at the entered coordinates.

Notes & Considerations

- This command can also be executed by the Go To XY Location item from the GDI Command List, or by typing GOTOXY or GOTO on the GDI Command Line and pressing the Enter key.

- To return to the last view, use the Zoom Previous command.

See Also

Enter GDI Coordinates
Zoom The GDI Image
Highlight A Group

Summary

Highlights the features in a User selected group.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a group has been created in the model.

- Select the *Highlight Group* item from the GDI Command List.

- At the *Select A Feature In The Group To Be Highlighted* prompt, move the mouse pointer to a group feature and left-click the mouse. *Note* - If the selected feature is not part of a group, a message will be displayed. Click the *OK* command button to clear the message and return to the prompt.

- All features in the same group as the selected feature will be highlighted.

Notes & Considerations

- This command can also be executed by typing HIGHLIGHTGROUP or HILITGRP on the GDI Command Line and pressing the *Enter* key.

- To unselect (unhighlight) the group features, use the *Unhighlight Group* command.

See Also

- Create A Group
- Select A Feature
- Unhighlight A Group
Highlight A Pipe

Summary

Highlights a User selected pipe feature, and displays information about the pipe in the GDI Prompt Line.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Highlight Pipe item from the GDI Command List.
- At the Select A Pipe prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.
- The “Last Selected” prompt will display the Facility Type status (“Active” or “Not Active”) and Size/Type Code of the last selected pipe on the GDI Prompt Line.
- Either select another pipe using the method above, or press the Esc key to end the command.

Notes & Considerations

- This command can also be executed by typing HIGHLIGHTPIPE or HILITP on the GDI Command Line and pressing the Enter key.
- The pipes will remain highlighted until the command is ended.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Select A Feature
Insert A Compressor

Summary

Inserts a compressor type feature into an existing pipe type feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Insert Compressor item from the GDI Command List.
- At the Select Pipe To Insert The Compressor Into prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.
- At the From (Suction/Upstream) Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point on the selected pipe and left-click the mouse.
  - If a new node is created, a message will be displayed asking whether to tap the selected pipe near the selected location. Either click the Yes command button to proceed, or click the No command button to return to the prompt.
    - If the Yes command button is clicked, and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.
    - If the No command button is clicked, the From Node Location prompt will be displayed again. Move the mouse crosshairs to pick another point in the GDI Display and left-click the mouse.
  - The From Node will be placed at the selected location.
- At the To (Discharge/Downstream) Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point on the selected pipe and left-click the mouse.
  - If a new node is created, a message will be displayed asking whether to tap the selected pipe near the selected location. Either click the Yes command button to proceed, or click the No command button to return to the prompt.
If the Yes command button is clicked, and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

If the No command button is clicked, the To Node Location prompt will be displayed again. Move the mouse crosshairs to pick another point in the GDI Display and left-click the mouse.

- The To Node will be placed at the selected location.
- At the Compressor Size & Type prompt, select the desired item from the GDI Prompt List.
- At the Discharge Set Pressure prompt, type a value (in the Pressure units) on the GDI Prompt Line and press the Enter key.

Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the compressor Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- The compressor symbol will be placed on the pipe feature.

**Notes & Considerations**

- This command can also be executed by typing INSERTCOMPRESSOR or INCOMP on the GDI Command Line and pressing the Enter key.

- The From Node represents the upstream (suction) side of the compressor and the To Node represents the downstream (discharge) side of the compressor. The compressor symbol will automatically display “facing” in the direction of gas flow.

- When connecting compressors in series, at least one pipe feature should be placed between compressors.

- This command requires an existing pipe to insert a compressor. To enter a name for the new compressor-type hydraulic feature, use the Add Compressor command.

- To change the Pipe Data, either use the Edit Pipe Data command or left-click on the desired pipe feature to display the data in the Data Panel.

- To reverse the From Node and To Node, use the Swap Pipe Ends command.

- Compressor properties can be viewed or changed from the Compressor data tab of the Property Table Report. To access the report, select the Property Tables item from the Edit menu list.
To turn the display of compressor symbols “on” or “off”, use the Display Pipe Symbols command.

The size of the compressor symbol is set by the Pipe Symbol Size value on the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Compressor
Add A Polyline Pipe
Display The Pipe Symbols
Edit Node Data
Edit Pipe Data
Select A Feature
Set A Feature’s Location
Swap A Pipe’s Ends (The From Node & To Node)
Undo The Last Data Or Graphic Change
Use The Data Panel
Insert A Regulator

Summary

Inserts a regulator type feature into an existing pipe type feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Insert Regulator item from the GDI Command List.
- At the Select Pipe To Insert The Regulator Into prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.
- At the From (Upstream) Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point on the selected pipe and left-click the mouse.
- If a new node is created, a message will be displayed asking whether to tap the selected pipe near the selected location. Either click the Yes command button to proceed, or click the No command button to return to the prompt.
  - If the Yes command button is clicked, and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.
  - If the No command button is clicked, the From Node Location prompt will be displayed again. Move the mouse crosshairs to pick another point in the GDI Display and left-click the mouse.
- The From Node will be placed at the selected location.
- At the To (Downstream) Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point on the selected pipe and left-click the mouse.
  - If a new node is created, a message will be displayed asking whether to tap the selected pipe near the selected location. Either click the Yes command button to proceed, or click the No command button to return to the prompt.
If the **Yes** command button is clicked, and the *Allow Data Entry During New Feature Entry* graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the *Apply Data Values* command button.

If the **No** command button is clicked, the From Node Location prompt will be displayed again. Move the mouse crosshairs to pick another point in the GDI Display and left-click the mouse.

- The To Node will be placed at the selected location.

- At the *Regulator Size & Type* prompt, select the desired item from the GDI Prompt List.

- At the *Set Pressure* prompt, type a value (in the *Pressure Units*) on the GDI Prompt Line and press the *Enter* key.

- *Note* - If the *Allow Data Entry During New Feature Entry* graphic settings option is selected, the Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the *Apply Data Values* command button.

- The regulator symbol will be placed on the pipe feature.

### Notes & Considerations

- This command can also be executed by typing INSERTREGULATOR or INREG on the GDI Command Line and pressing the *Enter* key.

- The From Node represents the upstream (inlet) side of the regulator and the To Node represents the downstream (outlet) side of the regulator. The regulator symbol will automatically display “facing” in the direction of gas flow.

- This command requires an existing pipe to be present to insert a regulator into. To add a new regulator-type hydraulic feature, use the *Add Regulator* command.

- To turn the display of regulator symbols “on” or “off”, use the *Display Pipe Symbols* command.

- To change the Pipe Data, either use the *Edit Pipe Data* command or left-click on the desired pipe feature to display the data in the Data Panel.

- To reverse the From Node and To Node, use the *Swap Pipe Ends* command.

- When connecting regulators in series, at least one pipe feature should be placed between regulators.
Regulator properties can be viewed or changed from the Regulator data tab of the Property Table Report. To access the report, select the Property Tables item from the Edit menu list.

The size of the regulator symbol is set by the Pipe Symbol Size value on the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Add A Regulator
Display The Pipe Symbols
Edit Pipe Data
Select A Feature
Set A Feature’s Location
Swap A Pipe’s Ends (The From Node & To Node)
Undo The Last Data Or Graphic Change
Use The Data Panel
Insert A Valve

Summary

Inserts a valve type feature into an existing pipe type feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Insert Valve item from the GDI Command List.
- At the Select Pipe To Insert The Valve Into prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.
- At the From Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point on the selected pipe and left-click the mouse.
  - If a new node is created, a message will be displayed asking whether to tap the selected pipe near the selected location. Either click the Yes command button to proceed, or click the No command button to return to the prompt.
    - If the Yes command button is clicked, and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.
    - If the No command button is clicked, the From Node Location prompt will be displayed again. Move the mouse crosshairs to pick another point in the GDI Display and left-click the mouse.
  - The From Node will be placed at the selected location.
- At the To Node Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point on the selected pipe and left-click the mouse.
  - If a new node is created, a message will be displayed asking whether to tap the selected pipe near the selected location. Either click the Yes command button to proceed, or click the No command button to return to the prompt.
If the Yes command button is clicked, and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

If the No command button is clicked, the From Node Location prompt will be displayed again. Move the mouse crosshairs to pick another point in the GDI Display and left-click the mouse.

- The To Node will be placed at the selected location.
- At the Valve Size & Type prompt, select the desired item from the GDI Prompt List.
- At the Valve Opening prompt, type a value between 0 (fully closed) and 100 (fully open) on the GDI Prompt Line and press the Enter key.

**Note** - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

- The valve symbol will be placed on the pipe feature.

### Notes & Considerations

- This command can also be executed by typing INSERTVALVE or INV on the GDI Command Line and pressing the Enter key.

- To turn the display of valve symbols “on” or “off”, use the Display Pipe Symbols command.

- This command requires an existing pipe to be present to insert a valve into. To add a new valve-type hydraulic feature, use the Add Valve command.

- A valve can also be modeled as a node or a fitting, but only a valve-type hydraulic feature can stop the flow of gas in a model. To add a valve as a fitting to an existing pipe, use the Add Fitting command. To create a valve as a node, use the Add Valve Node command.

- To change the Pipe Data, either use the Edit Pipe Data command or left-click on the desired pipe feature to display the data in the Data Panel.

- Valve properties can be viewed or changed from the Valve data tab of the Property Table Report. To access the report, select the Property Tables item from the Edit menu list.

- Attribute valves are not included in the flow (hydraulic) model.
The size of the valve symbol is set by the Pipe Symbol Size value on the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Fitting
- Add A Polyline Pipe
- Add A Valve
- Add A Valve Node
- Attach A Fitting To A Pipe
- Display The Pipe Symbols
- Edit Pipe Data
- Select A Feature
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Join Adjacent Pipe Segments

Summary

Joins two adjacent (connected) pipe features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two adjacent pipes are present in the model.

- Click the Join Adjacent Pipes icon from the Graphic Edit Commands Toolbar.
- At the Select First Pipe prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.
- At the Select Second Pipe prompt, move the mouse pointer to a pipe adjacent to the first and left-click the mouse.
  - If an arc pipe is selected, a message will be displayed asking whether to convert it to a polyline pipe. Either click the Yes command button to proceed, or click the No command button to return to the prompt.
  - If the common node between the selected pipes is connected to more than two pipes, a message will be displayed asking whether to continue. Either click the Yes command button to join the two selected pipes, or click the No command button to return to the prompt.
  - If the selected pipes are not adjacent, a message will be displayed. Click the OK command button to clear the message and return to the prompt.
  - The selected pipes will be joined into one pipe. If no other pipes are connected to the common node, the node will be deleted.

Notes & Considerations

- This command can also be executed by the Join Adjacent Pipes item from the GDI Command List, or by typing JOINPIPE on the GDI Command Line and pressing the Enter key.
- This command can join any two pipe hydraulic features. This includes compressors, fittings, regulators, valves, and wells. Arc type pipes must be converted to a polyline pipe before being joined.
The routine preserves the *Hydraulic Type* of the first selected pipe. If the first pipe’s *Hydraulic Type* is “Pipe”, the joined pipe will be a polyline type pipe with a vertex replacing the common node. If the first pipe has any other *Hydraulic Type*, the joined pipe will be the same *Hydraulic Type*, redrawn between the new From Node (the preserved node from the first pipe) and To Node (the preserved node from the second pipe).

The *Length* value of the combined pipe will equal the sum of the two adjacent pipe lengths. The remaining data for the combined pipe will be set to the values of first pipe.

After the process is complete, the second pipe record is deleted from the pipe data file, and the combined pipe line type is set to polyline. If the common node is deleted from the model, it is also removed from the node data file.

If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Convert An Arc Pipe To A Polyline Pipe
- Select A Feature
- Undo The Last Data Or Graphic Change
Mark The Current View

Summary

Marks the view currently displayed (GDI Image) in the GDI Display with a cross-hatched area.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Mark Current View item from the GDI Command List.
- The current view will be marked.

Notes & Considerations

- This command can also be executed by typing MARKVIEW on the GDI Command Line and pressing the Enter key.
- A marked view is not the same as a saved view.
- Multiple marked views can exist in the same model.
- To remove a single marked view from the model, use the Delete Marked View command.
- To remove all of the marked views from the model, use the Delete All Marked Views command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

- Delete A Marked View
- Delete All Marked Views
- Undo The Last Data Or Graphic Change
Match The Customer Graphic Properties

Summary

Assigns the graphic data items from one customer feature to one or more other customer features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two customers are present in the model.

- Select the Match Customer Graphic Properties item from the GDI Command List.
- At the Select Base Customer prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted. This will be the base customer whose graphic properties will be copied.
- At the Select Customer To Change prompt, move the mouse pointer to another customer and left-click the mouse. The selected customer will be highlighted.
- The Select Customer To Change prompt will be displayed again. Use the method above to select additional customers. When finished, right-click the mouse or press the “E” key.
- The graphic data of all of the selected customers will be set equal to the graphic data of the base customer.

Notes & Considerations

- This command can also be executed by typing MATCHCUSTOMERGRAPHIC or MATCHCG on the GDI Command Line and pressing the Enter key.
- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.
- To change the base customer’s data before using this command, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
GASWorkS™ 10.0

GDI Commands

See Also

Add A Customer
Cancel The Current GDI Command
Edit Customer Data
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Match The Customer Hydraulic Properties

Summary

Assigns the hydraulic data items from one customer feature to one or more other customer features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two customers are present in the model.

- Select the Match Customer Hydraulic Properties item from the GDI Command List.
- At the Select Base Customer prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted. This will be the base customer whose hydraulic properties will be copied.
- At the Select Customer To Change prompt, move the mouse pointer to another customer and left-click the mouse. The selected customer will be highlighted.
- The Select Customer To Change prompt will be displayed again. Use the method above to select additional customers. When finished, right-click the mouse or press the “E” key.
- The hydraulic data of all of the selected customers will be set equal to the hydraulic data of the base customer.

Notes & Considerations

- This command can also be executed by typing MATCHCUSTOMERHYDRAULIC or MATCHCHYD on the GDI Command Line and pressing the Enter key.
- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.
- To change the base customer’s data before using this command, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A Customer
Cancel The Current GDI Command
Edit Customer Data
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
GASWorkS™ 10.0

GDI Commands

Table Of Contents

Match All Of The Customer Properties

Summary

Assigns the graphic and hydraulic data items from one customer feature to one or more other customer features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two customers are present in the model.

- Select the Match Customer Properties (All) item from the GDI Command List.

- At the Select Base Customer prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted. This will be the base customer whose hydraulic and graphic properties will be copied.

- At the Select Customer To Change prompt, move the mouse pointer to another customer and left-click the mouse. The selected customer will be highlighted.

- The Select Customer To Change prompt will be displayed again. Use the method above to select additional customers. When finished, right-click the mouse or press the “E” key.

- The graphic and hydraulic data of all of the selected customers will be set equal to the graphic and hydraulic data of the base customer.

Notes & Considerations

- This command can also be executed by typing MATCHCUSTOMERPROP or MATCHC on the GDI Command Line and pressing the Enter key.

- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.

- To change the base customer’s data before using this command, either use the Edit Customer Data command or left-click on the desired customer feature to display the data in the Data Panel.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A Customer
Cancel The Current GDI Command
Edit Customer Data
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Match The Node Graphic Properties

Summary

Assigns the graphic data items from one node to one or more other nodes.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two nodes are present in the model.

- Select the Match Node Graphic Properties item from the GDI Command List.
- At the Select Base Node prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be highlighted. This will be the base node whose graphic properties will be copied.
- At the Select Node To Change prompt, move the mouse pointer to another node and left-click the mouse. The selected node will be highlighted.
- The Select Node To Change prompt will be displayed again. Use the method above to select additional nodes. When finished, right-click the mouse or press the “E” key.
- The graphic data of all of the selected nodes will be set equal to the graphic data of the base node.

Notes & Considerations

- This command can also be executed by typing MATCHNODEGRAPHIC or MATCHNG on the GDI Command Line and pressing the Enter key.
- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.
- To change the base node’s data before using this command, either use the Edit Node Data command or left-click on the desired node to display the data in the Data Panel.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Cancel The Current GDI Command
Edit Node Data
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Match The Node Hydraulic Properties

Summary

Assigns the hydraulic data items from one node to one or more other nodes.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two nodes are present in the model.

- Select the *Match Node Hydraulic Properties* item from the GDI Command List.

- At the *Select Base Node* prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be highlighted. This will be the base node whose hydraulic properties will be copied.

- At the *Select Node To Change* prompt, move the mouse pointer to another node and left-click the mouse. The selected node will be highlighted.

- The *Select Node To Change* prompt will be displayed again. Use the method above to select additional nodes. When finished, right-click the mouse or press the “E” key.

- The hydraulic data of all of the selected nodes will be set equal to the hydraulic data of the base node.

Notes & Considerations

- This command can also be executed by typing MATCHNODEHYDRAULIC or MATCHNHYD on the GDI Command Line and pressing the *Enter* key.

- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.

- To change the base node’s data before using this command, either use the *Edit Node Data* command or left-click on the desired node to display the data in the Data Panel.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.
See Also

Cancel The Current GDI Command
Edit Node Data
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Match All Of The Node Properties

Summary

Assigns both the graphic and hydraulic data items from one node to one or more other nodes.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two nodes are present in the model.

- Select the *Match Node Properties (All)* item from the GDI Command List.

- At the *Select Base Node* prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be highlighted. This will be the base node whose hydraulic and graphic properties will be copied.

- At the *Select Node To Change* prompt, move the mouse pointer to another node and left-click the mouse. The selected node will be highlighted.

- The *Select Node To Change* prompt will be displayed again. Use the method above to select additional nodes. When finished, right-click the mouse or press the “E” key.

- The graphic and hydraulic data of all of the selected nodes will be set equal to the graphic and hydraulic data of the base node.

Notes & Considerations

- This command can also be executed by typing MATCHNODEPROP or MATCHN on the GDI Command Line and pressing the *Enter* key.

- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.

- To change the base node’s data before using this command, either use the *Edit Node Data* command or left-click on the desired node to display the data in the Data Panel.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.
See Also

Cancel The Current GDI Command
Edit Node Data
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Match The Pipe Facility

Summary

Assigns the Facility Type value from one pipe feature to one or more other pipe type features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two pipes are present in the model.

- Select the Match Pipe Facility item from the GDI Command List.
- At the Select Base Pipe prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted. This will be the base pipe whose Pipe Facility will be copied.
- At the Select Pipe To Change prompt, move the mouse pointer to another pipe and left-click the mouse. The selected pipe will be highlighted.
- The Select Pipe To Change prompt will be displayed again. Use the method above to select additional pipes. When finished, right-click the mouse or press the “E” key.
- The Facility Type of all of the selected pipes will be set equal to the Facility Type of the base pipe.

Notes & Considerations

- This command can also be executed by typing MATCHPIPEFACILITY or MATCHPFAC on the GDI Command Line and pressing the Enter key.
- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.
- The settings for each Facility Type can be viewed or edited on the Facility Settings screen. To access the screen, select the Facility Settings item from the Edit menu list.
- To change the Pipe Data, either use the Edit Pipe Data command or left-click on the desired pipe feature to display the data in the Data Panel.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
GASWorkS™ 10.0

GDI Commands

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Cancel The Current GDI Command
Edit Pipe Data
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Match The Pipe Graphic Properties

Summary

Assigns the graphic data items from one pipe feature to one or more other pipe features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two pipes are present in the model.

- Select the *Match Pipe Graphic Properties* item from the GDI Command List.

- At the *Select Base Pipe* prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted. This will be the base pipe whose graphic properties will be copied.

- At the *Select Pipe To Change* prompt, move the mouse pointer to another pipe and left-click the mouse. The selected pipe will be highlighted.

- The *Select Pipe To Change* prompt will be displayed again. Use the method above to select additional pipes. When finished, right-click the mouse or press the “E” key.

- The graphic data of all of the selected pipes will be set equal to the graphic data of the base pipe.

Notes & Considerations

- This command can also be executed by typing MATCHPIPEGRAPHIC or MATCHPG on the GDI Command Line and pressing the *Enter* key.

- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.

- To change the Pipe Data, either use the *Edit Pipe Data* command or left-click on the desired pipe feature to display the data in the Data Panel.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.
See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Cancel The Current GDI Command
Edit Pipe Data
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Match The Pipe Hydraulic Properties

Summary

Assigns the hydraulic data items from one pipe feature to one or more other pipe features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two pipes are present in the model.

- Select the Match Pipe Hydraulic Properties item from the GDI Command List.

- At the Select Base Pipe prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted. This will be the base pipe whose hydraulic properties will be copied.

- At the Select Pipe To Change prompt, move the mouse pointer to another pipe and left-click the mouse. The selected pipe will be highlighted.

- The Select Pipe To Change prompt will be displayed again. Use the method above to select additional pipes. When finished, right-click the mouse or press the “E” key.

- The hydraulic data of all of the selected pipes will be set equal to the hydraulic data of the base pipe.

Notes & Considerations

- This command can also be executed by typing MATCHPIPEHYDRAULIC or MATCHPHYD on the GDI Command Line and pressing the Enter key.

- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.

- To change the Pipe Data, either use the Edit Pipe Data command or left-click on the desired pipe feature to display the data in the Data Panel.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Cancel The Current GDI Command
Edit Pipe Data
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Match All Of The Pipe Properties

Summary

Assigns the graphic and hydraulic data items from one pipe feature to one or more other pipe features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two pipes are present in the model.

- Select the **Match Pipe Properties (All)** item from the GDI Command List.
- At the **Select Base Pipe** prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted. This will be the base pipe whose graphic and hydraulic properties will be copied.
- At the **Select Pipe To Change** prompt, move the mouse pointer to another pipe and left-click the mouse. The selected pipe will be highlighted.
- The **Select Pipe To Change** prompt will be displayed again. Use the method above to select additional pipes. When finished, right-click the mouse or press the “E” key.
- The graphic and hydraulic data of all of the selected pipes will be set equal to the graphic and hydraulic data of the base pipe.

Notes & Considerations

- This command can also be executed by typing MATCHPIPEPROP or MATCHP on the GDI Command Line and pressing the **Enter** key.
- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.
- To change the Pipe Data, either use the **Edit Pipe Data** command or left-click on the desired pipe feature to display the data in the Data Panel.
- If the **Allow Undo Of Data/Graphic Changes** preference settings option is enabled, click the **Undo** icon to restore the original configuration. To access the option, select the **Settings** item from the **Preferences** submenu from the **File** menu list.
See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Cancel The Current GDI Command
Edit Pipe Data
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Match The User Graphic Line Properties

Summary

Assigns the graphic data items from one User Graphic Line to one or more other User Graphic Lines.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two User Graphic Lines are present in the model.

- Select the Match User Graphic Line Properties item from the GDI Command List.
- At the Select Base User Graphic Line prompt, move the mouse pointer to a User Graphic Line and left-click the mouse. The selected line will be highlighted. This will be the base line whose graphic properties will be copied.
- At the Select User Graphic Line To Change prompt, move the mouse pointer to another User Graphic Line and left-click the mouse. The selected line will be highlighted.
- The Select User Graphic Line To Change prompt will be displayed again. Use the method above to select additional lines. When finished, right-click the mouse or press the “E” key.
- The graphic data of all of the selected lines will be set equal to the graphic data of the base line.

Notes & Considerations

- This command can also be executed by typing MATCHLINEPROP or MATCHL on the GDI Command Line and pressing the Enter key.
- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.
- To change the base line’s data before using this command, either use the Edit User Graphic Line command or left-click on the desired User Graphic Line to display the data in the Data Panel.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A User Graphic Line
Cancel The Current GDI Command
Edit A User Graphic Line
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Match The User Graphic Symbol Properties

Summary

Assigns the graphic data items from one User Graphic Symbol to one or more other User Graphic Symbols.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two User Graphic Symbols are present in the model.

- Select the Match User Graphic Symbol Properties item from the GDI Command List.
- At the Select Base User Graphic Symbol prompt, move the mouse pointer to a User Graphic Symbol and left-click the mouse. The selected symbol will be highlighted. This will be the base symbol whose graphic properties will be copied.
- At the Select User Graphic Symbol To Change prompt, move the mouse pointer to another User Graphic Symbol and left-click the mouse. The selected symbol will be highlighted.
- The Select User Graphic Symbol To Change prompt will be displayed again. Use the method above to select additional symbols. When finished, right-click the mouse or press the “E” key.
- The graphic data of all of the selected symbols will be set equal to the graphic data of the base symbol.

Notes & Considerations

- This command can also be executed by typing MATCHSYMBOLPROP or MATCHS on the GDI Command Line and pressing the Enter key.
- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.
- To change the base symbol’s data before using this command, either use the Edit User Graphic Symbol command or left-click on the desired User Graphic Symbol to display the data in the Data Panel.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A User Graphic Symbol
Cancel The Current GDI Command
Edit A User Graphic Symbol
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Match The User Text Properties

Summary

Assigns the graphic data items from one User Text feature to one or more other User Text features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two User Text features are present in the model.

- Select the Match User Text Properties item from the GDI Command List.
- At the Select Base User Text prompt, move the mouse pointer to a User Text feature and left-click the mouse. The selected text will be highlighted. This will be the base User Text feature whose graphic properties will be copied.
- At the Select User Text To Change prompt, move the mouse pointer to another User Text feature and left-click the mouse. The selected text will be highlighted.
- The Select User Text To Change prompt will be displayed again. Use the method above to select additional text features. When finished, right-click the mouse or press the “E” key.
- The graphic data of all of the selected text features will be set equal to the graphic data of the base text feature.

Notes & Considerations

- This command can also be executed by typing MATCHTEXT or MATCHT on the GDI Command Line and pressing the Enter key.
- There is no unselecting of features during this command. Cancel the command to preserve the model without making any changes to model data.
- To change the base text’s data before using this command, either use the Edit User Text command or left-click on the desired User Text feature to display the data in the Data Panel.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add User Text
Cancel The Current GDI Command
Edit User Text
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Maximize The GDI Window

Summary

Increases the size of the Graphic Data Interface (GDI) Window to fill the entire GASWorkS display area.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Maximize GDI Window icon from the GDI Window Controls Toolbar.
- The GDI Window will be maximized.

Notes & Considerations

- This command can also be executed by the Maximize GDI Window item from the GDI Command List, or by typing MAXIMIZEWINDOW or MAXWIN on the GDI Command Line and pressing the Enter key.
- Resizing the GDI Window can show or hide other windows in GASWorkS. The Window menu contains a list of all open GASWorkS windows. Selecting an item from that list will bring the selected window to the front of the GASWorkS display.

See Also

None
Measure An Angle

Summary

Calculates an angle based on two User specified points.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed in Plan View.

- Select the Measure Angle item from the GDI Command List. Note - If the model is in Isometric View, a message will be displayed. Click the OK command button to clear the message and end the command.

- At the First Point prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- At the Second Point prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse.

- A message will be displayed stating the angle measure (measured counterclockwise from the horizontal axis) and the rotation (measured clockwise from the vertical axis) values between the selected points. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing MEASUREANGLE or ANGLE on the GDI Command Line and pressing the Enter key.

- If the Feature Snap is turned “on”, and a node is located within the snap target circle of a selected point, the node will be selected.

See Also

Display In Plan View
Feature Snap
Measure A Distance

Summary

Calculates a distance based on two or more User specified points.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed in Plan View.

- Click the Measure Distance icon from the Utility Commands Toolbar. Note - If the model is in Isometric View, a message will be displayed. Click the OK command button to clear the message and end the command.

- At the First Point prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- At the Next Point prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse. A line will be displayed in the GDI Display between the selected points indicating the route to be measured.

- The Next Point prompt will be displayed again. Use the method above to add another segment to the measured route. When finished, right-click the mouse or press the “E” key to end the selection process.

- A message will be displayed stating the distances measured between the First Point and the last selected Next Point. The distances will be given in the Coordinate units; if the Length units are different from the Coordinate units, the distances in Length units will also be displayed. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by the Measure Distance item from the GDI Command List, or by typing MEASUREDISTANCE or DISTANCE on the GDI Command Line and pressing the Enter key.

- The Coordinate and Length units can be changed from the Default Data Values screen. To access the screen, select the Set Defaults item from the Utilities menu list.

- If the Feature Snap is turned “on”, and a node is located within the snap target circle of a selected point, the node will be selected.
See Also

Display In Plan View
Feature Snap
Measure An X-Axis Isometric Distance

Summary

Calculates a distance along the x-axis based on two User specified points.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Measure X Distance item from the GDI Command List.

- At the First Point prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- At the Next Point prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse.

- A message will be displayed stating the distance along the X-axis (in Coordinate units) between the selected points. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing MEASUREX or DISTANCEX on the GDI Command Line and pressing the Enter key.

- If the Feature Snap is turned “on”, and a node is located within the snap target circle of a selected point, the node will be selected.

See Also

Feature Snap
Measure A Y-Axis Isometric Distance

Summary

Calculates a distance along the y-axis based on two User specified points.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Measure Y Distance item from the GDI Command List.
- At the First Point prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse.
- At the Next Point prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse.
- A message will be displayed stating the distance along the Y-axis (in Coordinate units) between the selected points. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing MEASUREY or DISTANCEY on the GDI Command Line and pressing the Enter key.
- If the Feature Snap is turned “on”, and a node is located within the snap target circle of a selected point, the node will be selected.

See Also

Feature Snap
Measure A Z-Axis Isometric Distance

Summary

Calculates a distance along the z-axis based on two User specified points.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed in Isometric View.

- Select the Measure Z Distance item from the GDI Command List. Note - If the model is in Plan View, a message will be displayed. Click the OK command button to clear the message and end the command.

- At the First Point prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- At the Next Point prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse.

- A message will be displayed stating the distance along the Z-axis (in Coordinate units) between the selected points. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing MEASUREZ or DISTANCEZ on the GDI Command Line and pressing the Enter key.

- If the Feature Snap is turned “on”, and a node is located within the snap target circle of a selected point, the node will be selected.

See Also

Display In Isometric View
Feature Snap
Move A Background Image

Summary

Moves an attached background image.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a background image is attached to the model.

- Select the Move Background Image item from the GDI Command List.

- At the Background Image File To Move prompt, select an item from the GDI Prompt List and press the Enter key.

- At the Select Base Point On Background Image prompt, move the mouse crosshairs to a point on the background image and left-click the mouse. A line will be displayed from the selected point.

- At the New Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- The background image will be redrawn relative to the new base point location.

Notes & Considerations

- This command can also be executed by typing MOVEBACKGROUNDIMAGE or MOVEBIMG on the GDI Command Line and pressing the Enter key.

- Background images can also be moved by changing the Origin Shift or Insertion Point values on the Background Image Settings screen. To access the screen, select the Background Settings item from the Graphics menu list. Note - The Move Background Image command will change the Origin Shift or Insertion Point values for the selected background image.

- To restore the background image to its last saved location, use the Regenerate Model Data command prior to saving any changes. Note - Any changes made to the model since the last save will be lost as well.
See Also

Add A BMP Background Image
Add A DXF Background Image
Add A SHP Background Image
Regenerate The Model Data
Set A Feature’s Location
Move A Branch Service Tap

Summary

Moves the service tap location associated with a branch customer feature from one trunk customer feature to another customer feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a branch customer is present in the model.

- Click the Move Branch Service Tap icon from the Customer Commands Toolbar.

- At the Select Customer To Move Branch Tap For prompt, move the mouse pointer to a branch customer and left-click the mouse. The selected customer will be highlighted. Note - A message will be displayed if the selected customer is not a branch customer. Click the OK command button to return to the prompt.

- At the Select Customer To Move Branch To prompt, move the mouse pointer to a trunk customer and left-click the mouse. The selected customer will be highlighted. Note - A message will be displayed if the selected customer is a branch customer or a trunk customer that already has a branch customer. Click the OK command button to return to the prompt.

- At the Select New Tap Location prompt, move the mouse crosshairs to a point on the trunk service line and left-click.

- The branch customer tap will be placed at the selected location.

Notes & Considerations

- This command can also be executed by the Move Branch Service Tap item from the GDI Command List, or by typing MOVEBRANCHTAP or MOVEBRANCH on the GDI Command Line and pressing the Enter key.

- A trunk customer service runs from the customer location to a tap location on a supply main. A branch customer service taps off of a trunk service rather than a main. Branch customers are assigned to the supply main of their trunk customer. Each trunk customer can only have one branch customer.

- Grips offer another method for moving graphic features.
This command requires an existing service to tap from. To create a branch and a trunk customer from two existing customers, use the *Create Branch Customer Tap* command.

If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A Branch Customer
- Create A Branch Customer Tap
- Grips
- Select A Feature
- Undo The Last Data Or Graphic Change
Move The Color Legend Text

Summary

Moves the Color Legend Text.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a Color Legend Text is present in the model.

- Select the Move Color Legend Text item from the GDI Command List.

- At the Select Base Point On Color Legend Text prompt, move the mouse crosshairs to a point on the Color Legend Text and left-click the mouse. A line will be displayed from the selected point.

- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse. The Color Legend Text will be moved to the selected location.

Notes & Considerations

- This command can also be executed by typing MoveColor on the GDI Command Line and pressing the Enter key.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Convert Color Legend To User Text
Undo The Last Data Or Graphic Change
Move A Customer

Summary

Moves a customer feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Click the Move Customer icon from the Customer Commands Toolbar.

- At the Select Customer To Move prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted.

- At the New Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- A message will be displayed asking whether to move the tap location. Either click the Yes command button to move the tap to the pipe closest to the customer location, or click the No command button to keep the existing tap location.

- The selected customer will be moved to the selected location.

Notes & Considerations

- This command can also be executed by the Move Customer item from the GDI Command List, or by typing MOVECUSTOMER or MOVEC on the GDI Command Line and pressing the Enter key.

- To change the location of the service tap along a supply main, either use the Move Service Tap command or grips.

- To move a customer and select its new supply main, use the Move Customer - Reassign Main command.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

- Add A Customer
- Grips
- Move A Customer & Reassign The Supply Main
- Move A Service Tap
- Select A Feature
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
Move A Customer & Reassign The Supply Main

Summary

Moves a customer feature and reassigns the supply main.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the Move Customer - Reassign Main item from the GDI Command List.

- At the Select Customer To Move prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted.

- At the New Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The selected customer will be moved to the selected location.

- At the Select New Supply Main prompt, move the mouse pointer to a pipe and left-click the mouse.

- A tap will be placed at the point on the selected pipe closest to the customer location. A service line will be drawn between the customer location and the tap location.

Notes & Considerations

- This command can also be executed by typing MOVECUSTREASSIGN on the GDI Command Line and pressing the Enter key.

- To change the location of the service tap along a supply main, either use the Move Service Tap command or grips.

- To change a customer’s location, either use the Move Customer command or grips.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A Customer
Grips
Move A Customer
Move A Service Tap
Select A Feature
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Move Customer Text

Summary

Moves the text item associated with a customer feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model with the text displayed.

- Click the Move Customer Text icon from the Customer Commands Toolbar.

- At the Select Customer To Move Text For prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted.

- At the Select Base Point On Customer Text prompt, use one of the following methods:
  - Move the mouse crosshairs to a point in the GDI Display and left-click the mouse to select a base point. A box the size of the customer text will be added to mouse crosshairs.
  - Type “A” (not case-sensitive) on the GDI Prompt Line and press the Enter key. This will set the text to its default location and end the command.

- At the New Text Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs and box to a point in the GDI Display and left-click the mouse.

- At the New Text Rotation prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the orientation of the text.

- The text will be moved to the selected location.

Notes & Considerations

- This command can also be executed by the Move Customer Text item from the GDI Command List, or by typing MOVECUSTOMERTEXT or MOVECTEXT on the GDI Command Line and pressing the Enter key.

- Grips offer another method for moving graphic features.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Customer
Grips
Select A Feature
Set A Feature’s Dimensions
Set A Feature’s Location
Text Display Settings
Undo The Last Data Or Graphic Change
GASWorkS™ 10.0

GDI Commands

Move A Group

Summary

Moves a group of features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one group is present in the model.

- Select the Move Group item from the GDI Command List.
- At the Select A Feature In The Desired Group To Move prompt, move the mouse pointer to a group feature and left-click the mouse. All group features will be highlighted. Note - If the selected feature is not part of a group, a message will be displayed. Click the OK command button to clear the message and return to the prompt.
- At the Select Base Point On Group prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. A line will be displayed from the selected point.
- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse.
- A message will be displayed stating the number of features moved. Click the OK command button to clear the message.
- The group features will move in the distance and direction of the line from the base point to the new location.

Notes & Considerations

- This command can also be executed by typing MOVEGROUP or MOVEG on the GDI Command Line and pressing the Enter key.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Create A Group
Select A Feature
Undo The Last Data Or Graphic Change
Move A Node

Summary

Moves a node and its connected pipe features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Click the Move Node icon from the Graphic Edit Commands Toolbar.

- At the Select Node To Move prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be highlighted.

- At the New Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- If the Automatically Update Pipe Length graphic settings option is selected, the Hydraulic Length values of any connected pipes will be recalculated. If not, a message will be displayed asking whether to update the Hydraulic Length. Either click the Yes command button to update the lengths, or click the No command button to preserve the original values.

- The selected node and connected pipes will be redrawn to the new selected location.

Notes & Considerations

- This command can also be executed by the Move Node item from the GDI Command List, or by typing MOVENODE or MOVEN on the GDI Command Line and pressing the Enter key.

- Grips offer another method for moving graphic features.

- To move the end of one pipe without moving the existing node if it is connected to other pipes, use the Move Pipe End command.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

- Grips
- Move A Pipe End
- Select A Feature
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
Move Node Text

Summary

Moves the text item associated with a node.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model with the text displayed.

- Click the Move Node Text icon from the Data Edit Commands Toolbar.
- At the Select Node To Move Text For prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be highlighted.
- At the Select Base Point On Node Text prompt, use one of the following methods:
  - Move the mouse crosshairs to a point in the GDI Display and left-click the mouse to select a base point. A box the size of the node text will be added to mouse crosshairs.
  - Type “A” (not case-sensitive) on the GDI Prompt Line and press the Enter key. This will set the text to its default location and end the command.
- At the New Text Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs and box to a point in the GDI Display and left-click the mouse.
- At the New Text Rotation prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the orientation of the text.
- The text will be moved to the selected location.

Notes & Considerations

- This command can also be executed by the Move Node Text item from the GDI Command List, or by typing MOVENODETEXT or MOVENTEXT on the GDI Command Line and pressing the Enter key.
- Grips offer another method for moving graphic features.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Grips
Select A Feature
Set A Feature’s Dimensions
Set A Feature’s Location
Text Display Settings
Undo The Last Data Or Graphic Change
Move Node Text For Multiple Nodes

Summary

Moves the text items associated with multiple nodes.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two nodes are present in the model with the text displayed.

- Select the Move Node Text - Multiple item from the GDI Command List.

- At the Select Node To Move Text For prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be highlighted.

- At the Select Base Point On Node Text prompt, use one of the following methods:
  - Move the mouse crosshairs to a point in the GDI Display and left-click the mouse to select a base point. A box the size of the node text will be added to mouse crosshairs.
  - Type “A” (not case-sensitive) on the GDI Prompt Line and press the Enter key. This will set the text to its default location and end the command.

- At the New Text Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs and box to a point in the GDI Display and left-click the mouse.

- At the New Text Rotation prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the orientation of the text.

- The text will be moved to the selected location.

- The Select Node To Move Text For prompt will be displayed again. Repeat the steps above to move text for multiple nodes. When finished, right-click the mouse to end the command.

Notes & Considerations

- This command can also be executed by typing MOVEMULTINODETEXT or MXNT on the GDI Command Line and pressing the Enter key.
Grips offer another method for moving graphic features.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Grips
Select A Feature
Set A Feature’s Dimensions
Set A Feature’s Location
Text Display Settings
Undo The Last Data Or Graphic Change
Move A Pipe

Summary

Moves a pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the *Move Pipe* item from the GDI Command List.

- At the *Select Pipe To Move* prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.

- At the *Select A Base Node* prompt, move the mouse pointer to a node and left-click the mouse. The selected node will be highlighted.

- At the *New Location* prompt, either type a coordinate pair on the GDI Prompt Line and press the *Enter* key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- The pipe will be redrawn relative to the new selected node location.

Notes & Considerations

- This command can also be executed by typing MOVEPIPE or MOVEP on the GDI Command Line and pressing the *Enter* key.

- Connected nodes will only be moved if they are connected to the pipe being moved. Common nodes connected to at least one other pipe will not be moved. If an existing node was selected as the new node location, the pipe will be connected to the existing node. Otherwise, a new node will be created at the pipe end with data taken from the node previously connected to that pipe end. Any nodes no longer connected to a pipe when this routine is complete will be deleted.

- Customers will be moved with the pipes they are assigned to. Customer and tap locations will remain in the same position relative to the moved pipe.

- To change the location of one end of a pipe, use the *Move Pipe End* command or grips.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Grips
- Move A Pipe End
- Select A Feature
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
**Move A Pipe End**

**Summary**

Moves a pipe feature end from one node to another.

**Example**

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Click the *Move Pipe End* icon from the *Graphic Edit Commands Toolbar*.

- At the *Select Pipe To Move End For* prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.

- At the *Select Pipe End (Node) To Move* prompt, move the mouse pointer to one of the two nodes on the highlighted pipe and left-click the mouse.

- At the *New Location* prompt, either type a coordinate pair on the GDI Prompt Line and press the *Enter* key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The node will be moved to the selected location.

  - *Note* - If a new node is created and the *Allow Data Entry During New Feature Entry* graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the *Apply Data Values* command button.

  - If the *Automatically Update Pipe Length* graphic settings option is selected, the *Hydraulic Length* of the pipe will be recalculated. If not, a message will be displayed asking whether to update the *Hydraulic Length*. Either click the *Yes* command button to update the length, or click the *No* command button to preserve the original value.

  - The pipe will be redrawn to the new selected node location.

**Notes & Considerations**

- This command can also be executed by the *Move Pipe End* item from the GDI Command List, or by typing MOVEPIPEEND or MOVEPEND on the GDI Command Line and pressing the *Enter* key.

- Grips offer another method for moving graphic features.

- Any nodes no longer connected to a pipe when this routine is complete will be deleted.
Customer locations are not changed by this command. Tap locations will be moved to the point on the pipe closest to their associated customer location.

To move a node and all pipe ends connected to that node, use the **Move Node** command.

To move an entire pipe without changing its length or direction, use the **Move Pipe** command.

The *Hydraulic Length* is the value used for the pipe length in the GASWorkS calculations. The initial *Hydraulic Length* value is equal to the graphic length in the GDI Display. The *Hydraulic Length* value can be changed in the Pipe Data in the Data Panel or by using the **Edit Pipe Data** command.

If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the **Undo** icon to restore the original configuration. To access the option, select the **Settings** item from the **Preferences** submenu from the **File** menu list.

**See Also**

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Edit Pipe Data
- Grips
- Move A Node
- Move A Pipe
- Select A Feature
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
- Use The Data Panel
Move Pipe Text

Summary

Moves the text items associated with a pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model with the text displayed.

- Click the *Move Pipe Text* icon from the *Data Edit Commands Toolbar*.

- At the *Select Pipe To Move Text For* prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.

- At the *Select Base Point On Pipe Text* prompt, use one of the following methods:
  - Move the mouse crosshairs to a point in the GDI Display and left-click the mouse to select a base point. A box the size of the pipe text will be added to mouse crosshairs.
  - Type “A” (not case-sensitive) on the GDI Prompt Line and press the *Enter* key. This will set the text to its default location and end the command.

- At the *New Text Location* prompt, either type a coordinate pair on the GDI Prompt Line and press the *Enter* key, or move the mouse crosshairs and box to a point in the GDI Display and left-click the mouse.

- At the *New Text Rotation* prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the orientation of the text.

- The text will be moved to the selected location.

Notes & Considerations

- This command can also be executed by the *Move Pipe Text* item from the GDI Command List, or by typing MOVEPIPETEXT or MOVEPTEXT on the GDI Command Line and pressing the *Enter* key.

- Grips offer another method for moving graphic features.
If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Grips
- Select A Feature
- Set A Feature’s Dimensions
- Set A Feature’s Location
- Text Display Settings
- Undo The Last Data Or Graphic Change
Move Pipe Text For Multiple Pipes

Summary

Moves the text items associated with multiple pipe features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two pipes are present in the model with the text displayed.

- Select the Move Pipe Text - Multiple item from the GDI Command List.

- At the Select Pipe To Move Text For prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.

- At the Select Base Point On Pipe Text prompt, use one of the following methods:
  - Move the mouse crosshairs to a point in the GDI Display and left-click the mouse to select a base point. A box the size of the pipe text will be added to mouse crosshairs.
  - Type “A” (not case-sensitive) on the GDI Prompt Line and press the Enter key. This will set the text to its default location and end the command.

- At the New Text Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs and box to a point in the GDI Display and left-click the mouse.

- At the New Text Rotation prompt, move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the orientation of the text.

- The Select Pipe To Move Text For prompt will be displayed again. Repeat the steps above to move other pipe text. Right-click the mouse to end the command.

- The text will be moved to the selected location.

Notes & Considerations

- This command can also be executed by typing MOVEMULTIPIPETEXT or MXPT on the GDI Command Line and pressing the Enter key.
Grips offer another method for moving graphic features.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Grips
Select A Feature
Set A Feature’s Dimensions
Set A Feature’s Location
Text Display Settings
Undo The Last Data Or Graphic Change
Move A Polyline Pipe Vertex

Summary

Moves a vertex for a polyline pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one polyline pipe is present in the model.

- Click the Move Polyline Pipe Vertex icon from the Graphic Edit Commands Toolbar.
- At the Select Polyline Pipe Vertex To Move prompt, move the mouse pointer to a polyline pipe vertex and left-click the mouse.
- At the New Vertex Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse.
- If the Automatically Update Pipe Length graphic settings option is selected, the Hydraulic Length of the pipe will be recalculated. If not, a message will be displayed asking whether to update the Hydraulic Length. Either click the Yes command button to update the length, or click the No command button to preserve the original value.
- The vertex and the adjacent pipe segments will be moved to the selected location.

Notes & Considerations

- This command can also be executed by the Move Polyline Pipe Vertex item from the GDI Command List, or by typing MOVEPOLYVERTEX or MOVEPVTX on the GDI Command Line and pressing the Enter key.
- To display the Vertex Data in the Data Panel, either use the Edit Polyline Pipe Vertex command or left-click on the desired vertex to display the data in the Data Panel.
- Grips offer another method for moving graphic features.
- The Display Vertex Symbols graphic settings option can be turned “on” to make the vertices easier to see. To access the option, select the Settings item from the Graphics menu list.
The Hydraulic Length is the value used for the pipe length in the GASWorkS calculations. The initial Hydraulic Length value is equal to the graphic length in the GDI Display. The Hydraulic Length value can be changed in the Pipe Data in the Data Panel or by using the Edit Pipe Data command.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Polyline Pipe
Edit Pipe Data
Edit A Polyline Pipe Vertex
Grips
Select A Feature
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Use The Data Panel
Move A Service Line Vertex

Summary

Moves a vertex for a polyline type customer service.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one polyline service is present in the model.

- Click the Move Service Line Vertex icon from the Customer Commands Toolbar.

- At the Select Customer To Move Service Line Vertex For prompt, move the mouse pointer to a polyline service customer and left-click the mouse. The selected customer will be highlighted.

- At the Select A Vertex prompt, move the mouse pointer to a polyline service vertex and left-click the mouse.

- At the New Vertex Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- The vertex and the adjacent service line segments will be moved to the selected location.

Notes & Considerations

- This command can also be executed by the Move Service Line Vertex item from the GDI Command List, or by typing MOVESERVICEVERTEX or MOVESVTX on the GDI Command Line and pressing the Enter key.

- To display the Vertex Data in the Data Panel, left-click on the desired vertex.

- Grips offer another method for moving graphic features.

- The Display Vertex Symbols graphic settings option can be turned “on” to make the vertices easier to see. To access the option, select the Settings item from the Graphics menu list.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A Polyline Service Customer
Grips
Select A Feature
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Use The Data Panel
Move A Service Tap

Summary

Moves a customer service line tap location.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Click the Move Service Tap icon from the Customer Commands Toolbar.
- At the Select Customer To Move Service Tap For prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted.
- At the New Tap Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point on the selected customer’s supply main and left-click the mouse.
- The service tap will be moved to the selected location. The service line segment will be redrawn from the new tap location to the next point on the service.

Notes & Considerations

- This command can also be executed by the Move Service Tap item from the GDI Command List, or by typing MOVESERVICETAP or MOVESTAP on the GDI Command Line and pressing the Enter key.
- Grips offer another method for moving graphic features.
- To move a customer’s service tap to a different main, use the Reassign Customer Supply Main command.
- If the selected service is a polyline, only the segment between the service tap and the first vertex will be moved. To move the other segments of a polyline service, use the Move Service Line Vertex command.
- If the selected service is a branch, the service will be converted into a trunk and connected to a supply main. To move a branch service tap to a different trunk service, use the Move Branch Service Tap command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

- Add A Customer
- Grips
- Move A Branch Service Tap
- Move A Service Line Vertex
- Reassign A Customer’s Supply Main
- Select A Feature
- Undo The Last Data Or Graphic Change
Move A User Graphic Image

Summary

Moves a User Graphic Image.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Image is present in the model.

- Click the Move User Graphic Image icon from the User Graphic Commands Toolbar.
- At the Select User Graphic Image To Move prompt, move the mouse pointer to a User Graphic Image and left-click the mouse. The selected image will be highlighted.
- At the Select Base Point prompt, move the mouse crosshairs to a point on the image and left-click the mouse. A line will be displayed from the selected point.
- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse.
- The selected User Graphic Image will move in the distance and direction of the line from the base point to the selected location.

Notes & Considerations

- This command can also be executed by the Move User Graphic Image item from the GDI Command List, or by typing MOVEIMAGE or MOVEI on the GDI Command Line and pressing the Enter key.
- Grips offer another method for moving graphic features.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Image  Grip
Select A Feature  Undo The Last Data Or Graphic Change
Move A User Graphic Line

Summary

Moves a User Graphic Line.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Line is present in the model.

- Click the Move User Graphic Line item from the User Graphic Commands Toolbar.
- At the Select User Graphic Line To Move prompt, move the mouse pointer to a User Graphic Line and left-click the mouse. The selected line will be highlighted.
- At the Select Base Point On User Graphic Line prompt, move the mouse crosshairs to a point on the line and left-click the mouse. A line will be displayed from the selected point.
- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse.
- The selected User Graphic Line will move in the distance and direction of the line from the base point to the selected location.

Notes & Considerations

- This command can also be executed by the Move User Graphic Line item from the GDI Command List, or by typing MOVELINE or MOVEL on the GDI Command Line and pressing the Enter key.
- To change the location of a User Graphic Line segment, either use the Move User Graphic Line End command or grips.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A User Graphic Line
Grips
Move A User Graphic Line End
Select A Feature
Undo The Last Data Or Graphic Change
Move A User Graphic Line End

Summary

Moves a User Graphic Line end or vertex.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Line is present in the model.

- Click the Move User Graphic Line End icon from the User Graphic Commands Toolbar.

- At the Select User Graphic Line Segment To Move End For prompt, move the mouse pointer to a User Graphic Line and left-click the mouse. The selected line segment will be highlighted.

- At the Select End To Move prompt, move the mouse pointer to one of the two ends of the highlighted segment and left-click the mouse.

- At the New Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

- The User Graphic Line segment will be redrawn to the selected end location.

Notes & Considerations

- This command can also be executed by the Move User Graphic Line End item from the GDI Command List, or by typing MOVELINEEND or MOVELE on the GDI Command Line and pressing the Enter key.

- To change the location of a User Graphic Line, either use the Move User Graphic Line command or grips.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

- Add A User Graphic Line
- Grips
- Move A User Graphic Line
- Select A Feature
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change
**Move A User Graphic Symbol**

**Summary**

Moves a User Graphic Symbol.

**Example**

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Symbol is present in the model.

- Click the *Move User Graphic Symbol* icon from the *User Graphic Commands Toolbar*.

- At the *Select User Graphic Symbol To Move* prompt, move the mouse pointer to a User Graphic Symbol and left-click the mouse. The selected symbol will be highlighted.

- At the *Select Base Point* prompt, move the mouse crosshairs to a point on the symbol and left-click the mouse. A line will be displayed from the selected point.

- At the *Select New Location* prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse.

- The selected symbol will move in the distance and direction of the line from the base point to the selected location.

**Notes & Considerations**

- This command can also be executed by the *Move User Graphic Symbol* item from the GDI Command List, or by typing MOVESYMBOL or MOVES on the GDI Command Line and pressing the *Enter* key.

- Grips offer another method for moving graphic features.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

**See Also**

- **Add A User Graphic Symbol**
- **Select A Feature**
- **Grips**
- **Undo The Last Data Or Graphic Change**
Move A User Table

Summary

Moves a User Table.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Table is present in the model.

- Select the Move User Table item from the GDI Command List.

- At the Select A Feature In The Desired Group To Move prompt, move the mouse pointer to a User Table feature and left-click the mouse. All of the table features will be highlighted. Note - If the selected feature is not part of a group, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

- At the Select Base Point On Group prompt, move the mouse crosshairs to a point ON THE User Table and left-click the mouse. A line will be displayed from the selected point.

- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse.

- The table features will move in the distance and direction of the line from the base point to the new location.

Notes & Considerations

- This command can also be executed by typing MOVETABLE on the GDI Command Line and pressing the Enter key.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

- Create A User Table
- Select A Feature
- Move A Group
- Undo The Last Data Or Graphic Change
Move User Text

Summary

Moves a User Text feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Text feature is present in the model.

- Click the Move User Text icon from the User Text Commands Toolbar.
- At the Select User Text To Move prompt, move the mouse pointer to a User Text feature and left-click the mouse. The selected feature will be highlighted.
- At the Select Base Point On User Text prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. A box will be displayed around the selected text.
- At the Select New Location prompt, move the mouse crosshairs and box to another point in the GDI Display and left-click the mouse.
- The selected text feature will move to the selected location indicated by the box.

Notes & Considerations

- This command can also be executed by the Move User Text item from the GDI Command List, or by typing MOVETEXT or MOVET on the GDI Command Line and pressing the Enter key.
- Grips offer another method for moving graphic features.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add User Text
Select A Feature
Grips
Undo The Last Data Or Graphic Change
Multiply Customer Loads

Summary

Multiplies all of the customer Per Unit Load values by a specified factor.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the Multiply Customer Loads item from the GDI Command List.
- At the Multiplication Factor prompt, type a value on the GDI Prompt Line and press the Enter key.
- A message will be displayed when the routine is complete. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing MULTIPLYCUSTLOAD or MULTICLOAD on the GDI Command Line and pressing the Enter key.
- Imported load data with a positive value can introduce errors into the model, since the solution treats positive load as gas entering the system as opposed to leaving. To change the numeric sign of the load value, without changing the absolute value, enter a “-1” at the Multiplication Factor prompt.
- This command changes the customer data. The Design Factor item on the Solution Data screen scales the load during the solution, but does not affect the actual data associated with the customers. To access the screen, execute the Solve Model command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Customer
Undo The Last Data Or Graphic Change
Solve The Model
Multiply Node Loads

Summary

Multiplies all of the node *Base Load* values by a specified factor.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Select the *Multiply Node Loads* item from the GDI Command List.
- At the *Multiplication Factor* prompt, type a value on the GDI Prompt Line and press the *Enter* key.
- A message will be displayed when the routine is complete. Click the *OK* command button to clear the message.

Notes & Considerations

- This command can also be executed by typing MULTIPLYNODELOAD or MULTINLOAD on the GDI Command Line and pressing the *Enter* key.
- This command does not affect the external load values associated with the nodes. That is, the routine does not adjust customer load values. To adjust the customer load values, use the *Multiply Customer Loads* command.
- Imported load data with a positive value can introduce errors into the model, since the solution treats positive load as gas entering the system as opposed to leaving. To change the numeric sign of the load value, without changing the absolute value, enter a “-1” at the *Multiplication Factor* prompt.
- This command changes the node data. The *Design Factor* item on the Solution Data screen scales the load during the solution, but does not affect the actual data associated with the nodes. To access the screen, execute the *Solve Model* command.
- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.
See Also

Multiply Customer Loads
Solve The Model
Undo The Last Data Or Graphic Change
Pan The GDI Image

Summary

Repositions the GDI Image based on a User specified location.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Pan GDI Image icon from the View Controls Toolbar.
- At the Select Base Point On The GDI Image prompt, left-click the mouse inside the GDI Display. A line will be displayed from the selected point.
- At the Select New Location prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse. The model image will move in the distance and direction of the line from the base point to the selected location.

Notes & Considerations

- This command can also be executed by the Pan GDI Image item from the GDI Command List, or by typing PANIMAGE or PAN on the GDI Command Line and pressing the Enter key.
- This command cannot be used while another command is running. Use the Scroll icon to pan the model image during a GDI Command.
- If the Automatically Pan & Zoom graphic settings option has been selected, the model image can be panned by holding down the left mouse button in the GDI Display and dragging the resulting line in the direction the User wants to “drag” the model image. When the left mouse button is released, the model image will move.

See Also

Automatically Pan & Zoom GDI Display
Move The GDI Image
Plot The GDI Image

Summary

Plots the current GDI Image.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Plot GDI Image icon from the Utility Commands Toolbar.
- A message will be displayed to ensure that the desired items to be plotted are in the GDI Display. Click the OK command button to clear the message.
- The Plot Settings screen is displayed.

  - On the Page Layout data tab, type values for the margins, Border Line Width, and Title Font Size in the associated data fields. Select the Include Border and Include Title options to include those items with the plotted image. Select the Landscape Orientation option to plot the bottom of the image on the long edge of the page. Select a Printer from the list. Click the Printer Setup command button to display the Print Setup screen.

  - On the Settings data tab, select the various Plot Data Values checkboxes to include the associated data values in the plot. Type values in the Font Size data fields to specify the font size of the associated data value. Select an item from the Font Size lists to specify whether the associated font size value is in “Printer Points” or “Coordinates”. The data fields under the Other Settings section control the plotted size of model data features. Select an item from the top list to set the units for these values. Select an item from the Number Of Copies list to set how many copies of the imaged will be plotted. Either select the Fit To Page option to scale the image to fit the size of the page, or unselect the option to specify a scale for the image. Select the options in the bottom window to enable the associated options.

  - On the Style data tab, select one of the Plot Style options. The Plot Current Display option plots the current model image. The Plot A User Selected Window option allows the User to specify an area of the model image to be plotted. The Plot Full Extents Of Model & Background Image option plots the entire model, including displayed background images. The Plot A Saved View option plots the image from a previously Saved View selected from the associated list. The Plot A Saved Plot Window option plots a previously saved User-selected plot window selected from the associated list.
Either click the *Plot* command button to proceed, click the *Close* command button to exit the Plot Settings screen and save the current settings, or click the *Cancel* command button to close the Plot Settings window without saving any changes.

If the *Plot A User Selected Window* option is selected, specify the portion of the model image to plot.

- At the *Select First Corner Of Plot Window* prompt, move the mouse pointer to the desired upper-left corner of the plot window and left-click the mouse.

- At the *Select Opposite Corner Of Plot Window* prompt, move the mouse pointer to the desired lower-right corner and left-click the mouse. The dashed box in the GDI Display represents the plot window.

- A message will be displayed asking whether to save the selected Plot Window. Either click the *Yes* command button to save the plotted image, or click the *No* command button to proceed without saving the plotted image.

- The Plot Preview will be displayed. Either click the *Continue* command button to send the image in the preview frame to the selected printer, or click the *Cancel* command button to return to the Plot Settings screen.

**Notes & Considerations**

- This command can also be executed by the *Plot GDI Image* item from the GDI Command List, or by typing PLOT on the GDI Command Line and pressing the *Enter* key.

- Not all printers and plotters support raster style output. It is not possible to plot a BMP background image to a device that doesn’t support raster images.

- The plot features of GASWorkS are intended to produce good quality plots of the model for checking, review, and presentation. However, these features fall short of the plotting capabilities of a full featured Computer Aided Drafting (CAD) or mapping system. If more robust plotting capabilities are required, try exporting the GASWorkS model to a DXF file, then import the DXF file into your CAD or mapping system to produce more sophisticated plots.

- Data text items can sometimes clutter the plot and make it unattractive. If the plot is too cluttered, try using the *Move Customer Text*, *Move Node Text*, or *Move Pipe Text* commands to relocate the text. Alternatively, the *Settings* data tab of the Plot Settings screen contains options that control the appearance of text in the plotted image. Try changing the *Font Size*, or turning the text off by unselecting the *Plot Data Values* options.

- Data text items may be displayed on the plot even if the GDI Display is zoomed out past the *Display Limit* specified on the Text Display Settings screen.
See Also

Move Customer Text
Move The GDI Image
Move Node Text
Move Pipe Text
Save The Current View
Text Display Settings
Zoom The GDI Image
Project To Plane Coordinates

Summary

Projects the model from longitude and latitude into plane coordinates, or vice versa, based on specifications provided in a specified projection file.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Project Coordinates item from the GDI Command List.
- The Convert To Projected Coordinate System screen is displayed.
  - Select an item from the Conversion list to specify the direction of the conversion.
  - Select an item from the File Type list to specify the extension of the projection file - “ESRI Projection (.prj)” or “EPSG Well Known Text (.wkt)”.
  - Click the Browse command button to display the File Selection screen. Select a projection file. Click the Continue command button.
  - Either select the Update Pipe Lengths option to automatically recalculate the Hydraulic Length values of any pipes in the model after the projection is complete, or unselect this option to preserve the original Hydraulic Length values.
  - Either click the Continue command button to proceed with the command, or click the Cancel command button to end the command and preserve the model as is.
  - Note - A message will be displayed if GASWorkS detects that the model may already be in the specified coordinate system. Either click the Yes command button to proceed with the projection, or click the No command button to return to the previous screen.
  - If the Continue command button is clicked, a message will be displayed stating when the projection is complete. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing PROJECTCOORDS or PRJ on the GDI Command Line and pressing the Enter key.
Plane coordinates are a method used in regional surveying, mapping, and design for representing geographic data using X-Y coordinates, which make for easier calculations of direction and distance than the more complex spherical coordinates of longitude and latitude. Examples of plane coordinate systems include the State Plane Coordinate System in the United States, the Ordinance Survey National Grid in the United Kingdom, and the Universal Transverse Mercator system worldwide.

Plane coordinate systems are typically broken into grids or zones to improve accuracy. Each zone is associated with a projection file that contains specific data for projecting coordinates within that zone. GASWorkS supports two types of projection files - "prj" files from ESRI and "wkt" files from EPSG. Make sure the projection file matches the zone that contains the model data, or the projection will not be accurate.

The Projection routine uses either the Transverse Mercator or Lambert Conformal Conic projection, depending on which is specified by the selected projection file.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Project A Model
Undo The Last Data Or Graphic Change
Prorate Customer Loads

Summary

Prorates all of the customer *Per Unit Load* values by a multiplication factor.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the *Prorate Customer Loads* item from the GDI Command List.
- At the *Multiplication Factor* prompt, type a value on the GDI Prompt Line and press the *Enter* key. The entered value will be the total load for the model after the routine is finished.
- A message will be displayed stating the prorated values. Click the *OK* command button to clear the message.

Notes & Considerations

- This command can also be executed by typing PRORATECUSTOMERLOAD or PRORATECLOAD on the GDI Command Line and pressing the *Enter* key.
- After this command is finished, individual customer loads will be expressed by their percentage of the total load in the model.
- This command changes the customer data. The *Design Factor* item on the Solution Data screen scales the load during the solution, but does not affect the actual data associated with the customers. To access the screen, execute the *Solve Model* command.
- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

See Also

- Add A Customer
- Undo The Last Data Or Graphic Change
- Solve The Model
Purge Customers

Summary

Purges (deletes) customer features with invalid coordinate values.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the *Purge Customers* item from the GDI Command List.

- A message will be displayed asking whether to delete all of the customers with zero or out-of-range coordinates. Either click the *Yes* command button to proceed, or click the *No* command button to end the command.

- If the *Yes* command button is clicked, a message will be displayed stating how many records were deleted. Click the *OK* command button to clear the message.

Notes & Considerations

- This command can also be executed by typing PURGECUSTOMER or PURGEC on the GDI Command Line and pressing the *Enter* key.

- Customers with invalid coordinates (large or negative values, for example) cannot be deleted graphically. Invalid coordinates can sometimes occur when importing or merging customer data. This command targets and removes such customers from the model as an alternative to using the *Delete All Customers* command to remove all customers from the model. Another option for removing customers with invalid coordinates is the Customer Data Report. To access the screen, select the *Customer Data* item from the *Report* menu list.

- This command will remove all unassigned customers from the model. To remove a single customer from the model, use the *Delete Customer* command.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.
See Also

Add A Customer
Add An Unassigned Customer
Delete A Customer
Delete All Customers
Undo The Last Data Or Graphic Change
Purge User Text

Summary

Purges (deletes) User Text features with invalid coordinate values.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Text feature is present in the model.

- Select the Purge User Text item from the GDI Command List.
- A message will be displayed asking whether to delete all of the User Text features with zero or out-of-range coordinates. Either click the Yes command button to proceed, or click the No command button to end the command.
- If the Yes command button is clicked, a message will be displayed stating how many records were deleted. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing PURGETEXT or PURGET on the GDI Command Line and pressing the Enter key.
- User Text features with invalid coordinates (large or negative values, for example) cannot be deleted graphically. Once placed at an invalid location, this command is the only option for removing the misplaced User Text features.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add User Text
Undo The Last Data Or Graphic Change
Quick Size

Summary

Perform a pipe sizing calculation on the model using a saved sizing specification.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the *Quick Size* item from the GDI Command List.
- At the *Pipe Sizing Specification Name* prompt, select an item from the GDI Prompt List.
- A message will be displayed stating the number of Facility Types processed, the number of facilities which have assigned pipes, and the number of facilities which have processing errors. Click the *OK* command button to clear the message.

Notes & Considerations

- This command can also be executed by typing QUICKSIZE or QSIZE on the GDI Command Line and pressing the *Enter* key.
- The Solution Log Report contains detailed results of the sizing process. To access the report, select the *Solution Log* item from the *Report* menu list.
- The Quick Pipe Sizing Specification screen can create a specification to be used by this command. To access this screen, select the *Quick Size Specification* item from the *Edit* menu list.

See Also

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Solve The Model
Quick Solve A Model

Summary

Solve the model using the solution data values from the last time the model was solved.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and the model contains at least one known load and known pressure.

- Click the Quick Solve icon from the lower-right corner of the GDI Window.
- The results can be viewed in the GDI Window or in one of the reports.

Notes & Considerations

- This command can also be executed by the Quick Solve Model item from the GDI Command List, or by typing QUICKSOLVE or QSOLVE on the GDI Command Line and pressing the Enter key.

- The Solve (balance scale) icon indicates whether or not the model has been solved in its current configuration. A blue, balanced scale icon indicates the model has been solved and a steady-state solution has been found. A red, unbalanced scale icon indicates that a change has been made to the model that was not included in the solution. Examples of changes that unbalance the model include adding a customer, adding a pipe, or changing the load on a model feature. Left-clicking the icon in either state will bring up the Solution Data screen.

See Also

Solve The Model
Quick Trace

Summary

Performs a Trace based on the most previously used Trace Specifications.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a Trace has been performed in the model.

- Select the Quick Trace item from the GDI Command List.
- At the “Select Starting” prompt, move the mouse pointer to a feature of the specified type and left-click the mouse.
- The routine will color code all connected features based on the specifications from the previously executed Trace routine.

Notes & Considerations

- This command can also be executed by typing QUICKTRACE or QTRACE on the GDI Command Line and pressing the Enter key.

See Also

Select A Feature
Trace
Quick User Text

Summary

Adds a User Text feature based on the most previously used *Add User Text* values.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and the a User Text feature is present in the model.

- Select the *Quick Text* item from the GDI Command List.

- At the *User Text Location* prompt, either type a coordinate pair on the GDI Prompt Line and press the *Enter* key, or move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The selected location will be the lower-left corner of the User Text Feature.

- At the *User Text Value* prompt, enter text by typing it on the GDI Prompt Line and press the *Enter* key.

- The User Text will be displayed at the selected location.

Notes & Considerations

- This command can also be executed by typing QUICKTEXT or QTEXT on the GDI Command Line and pressing the *Enter* key.

- To change the location of a User Text feature, either use the *Move User Text* command or grips.

- To remove a User Text feature from the model, use the *Delete User Text* command.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

See Also

- Add User Text
- Delete User Text
- Grips
- Move User Text
- Set A Feature’s Location
- Undo The Last Data Or Graphic Change

Bradley B Bean PE

Revision - 003, Copyright 2020 All Rights Reserved.
Reassign A Customer’s Supply Main

Summary

Reassigns a customer feature to a different supply main.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe and one customer are present in the model.

- Click the Reassign Customer Supply Main icon from the Customer Commands Toolbar.
- At the Select Customer To Reassign prompt, move the mouse pointer to a customer and left-click the mouse. The selected customer will be highlighted.
- At the Select New Supply Main prompt, move the mouse pointer to a pipe and left-click the mouse.
- The tap will be moved to the point on the selected pipe closest to the customer location. The service line will be redrawn between the customer location and the new tap location.

Notes & Considerations

- This command can also be executed by the Reassign Customer Supply Main item from the GDI Command List, or by typing REASSIGNCUSTOMER or REASSIGNC on the GDI Command Line and pressing the Enter key.
- The customer’s load will be reassigned to the nodes associated with the new main based on the selected Node Load Application in the customer’s Hydraulic Data Items.
- To reassign the supply main for more than one customer at a time, use the Edit Multiple Customers command.
- If the Supply Main Number for a customer becomes corrupt, use the Reassign Customer Supply Main Numbers command to correct the value.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Customer
Add A Polyline Pipe
Edit Customer Data
Edit Multiple Customers
Reassign The Customer’s Supply Main Numbers
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Reassign The Customer’s Supply Main Numbers

Summary
Reassigns the supply main (pipe) numbers for all of the customer features.

Example
The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe and one customer are present in the model.

- Select the Reassign Customer Supply Main Numbers item from the GDI Command List.
- A message will be displayed stating how many customers were unchanged, reassigned, and unassigned. Click the OK command button to clear the message.

Notes & Considerations
- This command can also be executed by typing REASSIGNSUPPLYNUMBER on the GDI Command Line and pressing the Enter key.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also
Add A 2-Point Pipe
Add An Arc Pipe
Add A Customer
Add A Polyline Pipe
Undo The Last Data Or Graphic Change
Redo The Last Data Or Graphic Change

Summary
Restores the last data or graphic edit that was undone by the *Undo* command.

Example
The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the *Redo* icon from the *Undo/Redo Commands Toolbar*.

- The previous data or graphic edit will be undone. *Note* - If nothing has been undone, or the *Redo* command has been used once, a message will be displayed stating that there is nothing to redo. Click the *OK* command button to clear the message.

Notes & Considerations

- This command can also be executed by the *Redo (Restore Last Undo)* item from the GDI Command List, or by typing REDO on the GDI Command Line and pressing the *Enter* key.

- The *Redo* command can only restore the last edit that was undone.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

See Also

*Undo The Last Data Or Graphic Change*
Reduce Nodes

Summary

Eliminates hydraulically unneeded nodes.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least two pipes of equal size and type are present in the model.

- Select the Reduce Nodes item from the GDI Command List.
- The Node Reduction Specifications screen is displayed.
  
  - Type a value in the Maximum Combined Segment Length data field and select a length unit from the list. The routine will remove common nodes between two pipes whose combined length is less than the entered value.
  
  - Select the Convert Arc Pipes To Polyline Pipes Before Processing option to convert arc pipes into polyline pipes. If this option is not selected, arc pipes cannot be combined with other types of pipes. Common nodes between arc pipes and other pipe types will not be removed.
  
  - Select the Only Combine Pipes Where Common Node Has No Load option to remove only those nodes with no load. Unselect this option to remove all common nodes between two pipes of equal size and type.
  
  - Click the Reduce command button to process the model. The yellow data panel will display the number of nodes eliminated. This routine can be executed again without exiting the screen.
  
  - Click the Close command button to exit the screen and return to the GDI Window.

Notes & Considerations

- This command can also be executed by typing REDUCENODE or REDUCE on the GDI Command Line and pressing the Enter key.
- It is recommended to save the model before executing this command.
- Only nodes connected to two pipe features are considered for elimination.
This command is useful when “cleaning up” model data imported from external sources.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Undo The Last Data Or Graphic Change
Regenerate The Model Data

Summary

Rereads the model data and background images from the disk file.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Regenerate Model Data icon from the GDI Windows Controls Toolbar.

- A message will be displayed asking whether to regenerate the model from the original data files. Either click the Yes command button to regenerate the model and lose any changes since the last save, or click the No command button to end the command.

Notes & Considerations

- This command can also be executed by the Regenerate Model Data item from the GDI Command List, or by typing REGENERATE on the GDI Command Line and pressing the Enter key.

- All changes made since the last save will be lost.

- When trying to restore a previous model configuration, keep in mind the Undo command can undo up to the last ten (10) changes to the model. The Regenerate Model Data command cannot be undone.

See Also

Undo The Last Data Or Graphic Change
### Remove Attached Fittings

#### Summary

Removes attached fittings from a pipe type feature.

#### Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Remove Fittings item from the GDI Command List.
- At the Select Pipe To Remove Fittings From prompt, move the mouse pointer to a pipe and left-click the mouse.
- All attached fittings for the selected pipe will be removed.

#### Notes & Considerations

- This command can also be executed by typing REMOVEFITTINGS or RMVFIT on the GDI Command Line and pressing the Enter key.

- The Equivalent Length value under the Attached Fittings section of the Pipe Data is a sum of the equivalent lengths of all the fittings attached to the pipe. This value is added to the pipe’s Hydraulic Length when solving the model.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

#### See Also

- Add A 2-Point Pipe
- Add A Fitting
- Attach A Fitting To A Pipe
- Select A Feature
- Use The Data Panel
- Add An Arc Pipe
- Add A Polyline Pipe
- Edit Pipe Data
- Undo The Last Data Or Graphic Change
Remove A Feature From A Group

Summary

Removes a feature from an existing group.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a group has been created in the model.

- Select the Remove Feature From Group item from the GDI Command List.
- At the Select First Feature prompt, move the mouse pointer to a group feature (pipe, User Graphic, or User Text) and left-click the mouse. The selected feature will be highlighted. Note - If the selected feature is not part of a group, a message will be displayed. Click the OK command button to clear the selection and return to the prompt.
- At the Select Another Feature prompt, move the mouse pointer to another group feature and left-click the mouse. The selected feature will be highlighted. Note - If the selected features were from different groups, a message will be displayed. Either click the Yes command button to proceed, or click the No command button to end the command.
- The Select Another Feature prompt will be displayed again. Use the method above to select more group features. When finished, press the Esc key, right-click the mouse, or click the Cancel icon.
- A message will be displayed stating the number of features removed from the group. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing REMOVEGROUP or RMVGRP on the GDI Command Line and pressing the Enter key.
- This command “ungroups” the model features, but does not delete them. To remove a group and all of its features from the model, use the Delete Group command.
- To ungroup a single group of features, use the Dissolve Group command.
- To ungroup all of the grouped model features, use the Dissolve All Groups command.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Feature To A Group
Create A Group
Delete A Group
Dissolve The Features In A Group
Dissolve All Groups
Select A Feature
Undo The Last Data Or Graphic Change
Renumber The Nodes

Summary

Renumerates the model’s node names automatically based on user-specified criteria.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a node is present in the model.

- Select the Renumber Nodes item from the GDI Command List.
- The Renumber Specifications screen is displayed.
  - Type a value in the Starting Number data field and the Increment Value data field. The routine will renumber the node names starting at the Starting Number and increase by the entered Increment Value.
  - Click the Renumber command button.
  - When finished, click the Close command button.
- The node names will be renumbered as specified.

Notes & Considerations

- This command can also be executed by typing RENUMBERNODES or RENUMBER on the GDI Command Line and pressing the Enter key.
- It is recommended to save the model before executing this command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Undo The Last Data Or Graphic Change
Repaint The GDI Image

Summary

Repaint (redraw) the current model image.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Repaint GDI Image icon from the GDI Window Controls Toolbar.

- The model image will be redrawn.

Notes & Considerations

- This command can also be executed by the Repaint GDI Image item from the GDI Command List, or by typing REPAINTGDI or REPAINT on the GDI Command Line and pressing the Enter key.

- The Automatically Repaint GDI Image graphic settings option will update the model image after graphic changes if selected. To access the screen, select the Settings item from the Graphics menu list.

See Also

None
Report Customers With Invalid Coordinates

Summary

Finds all customers with large out-of-range or negative coordinate values, and displays them in a report.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the Report Customers With Invalid Coordinates item from the GDI Command List.

- The Customer Coordinate Error Report will be displayed stating all of the customer records with invalid coordinate values. Click the Print icon to print a copy of the report. Click the Copy To Clipboard icon to copy the contents of the report to the Clipboard (this can then be pasted into another program such as a text editor or word processor). When finished, click the Close command button to exit the report window and return to the GDI Window.

Notes & Considerations

- This command can also be executed by typing REPORTBADCOORD or REPORTBADCUST on the GDI Command Line and pressing the Enter key.

- The Customer Data Report can also be used to view and find customer features with invalid coordinates. To access the report, select the Customer Data item from the Report menu list.

- To remove all of the customers with invalid coordinates from the model, use the Purge Customers command.

See Also

Add A Customer
Purge Customers
Reset The Customer Symbol Colors

Summary

Resets the color of the customer symbols to their currently saved values.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one customer is present in the model.

- Select the Reset Customer Symbol Colors item from the GDI Command List.
- All of the customer symbols will be set to their specified colors.

Notes & Considerations

- This command can also be executed by typing RESETCUSTOMERCOLOR or RESETCCOLOR on the GDI Command Line and pressing the Enter key.
- This command resets colors that have been temporarily changed as a result of another command such as a Trace or Color Code.
- The Symbol Color data field can be set one of two options - “Default” sets the color to the value specified by the Customer Symbols setting on the Default Colors data tab of the Color Display Settings screen, or “Selected Color” allows the User to specify a unique color for the selected customer symbol.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Customer
Color Code By Query
Color Code By Range
Color Display Settings
Trace
Undo The Last Data Or Graphic Change
Reset The Feature Colors

Summary

Resets the colors for all of the model features (customer symbols, node symbols, pipe lines, and pipe symbols) to their currently saved values.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe, node, or customer is present in the model.

- Select the Reset Feature Colors item from the GDI Command List.
- All pipes, nodes, and customers will be set to their specified colors.

Notes & Considerations

- This command can also be executed by typing RESETCOLORS or RESET on the GDI Command Line and pressing the Enter key.
- This command resets colors that have been temporarily changed as a result of another command such as a Trace or Color Code.
- Clicking the Reset Feature Colors command button on the Trace Specifications screen will also reset all feature colors.
- Feature default colors can be changed on the Default Colors data tab of the Color Display Settings screen.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add A Customer
Color Code By Query
Color Display Settings
Undo The Last Data Or Graphic Change

Add An Arc Pipe
Add A Polyline Pipe
Color Code By Range
Trace
Reset The Node Symbol Colors

Summary

Resets the color of the node symbols to their currently saved values.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Select the *Reset Node Symbol Colors* item from the GDI Command List.
- All of the node symbols will be set to their specified colors.

Notes & Considerations

- This command can also be executed by typing RESETNODECOLOR or RESETNCOLOR on the GDI Command Line and pressing the *Enter* key.

- This command resets colors that have been temporarily changed as a result of another command such as a Color Code.

- The *Symbol Color* data field can be set one of two options - “Default” sets the color to the value specified by the *Node Symbols* setting on the *Default Colors* data tab of the Color Display Settings screen, or “Selected Color” allows the User to specify a unique color for the selected node symbol.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

See Also

- Color Code By Query
- Color Code By Range
- Color Display Settings
- Undo The Last Data Or Graphic Change
Reset The Pipe Colors

Summary

Resets the color of the pipe lines and symbols to their currently saved values.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Reset Pipe Colors item from the GDI Command List.
- All of the pipes will be set to their specified colors.

Notes & Considerations

- This command can also be executed by typing RESETPIPECOLOR or RESETPCOLOR on the GDI Command Line and pressing the Enter key.

- This command resets colors that have been temporarily changed as a result of another command such as a Trace or Color Code.

- The Pipe Line Color data field can be set one of the following options - “Default” sets the color to the value specified by the Pipe Lines setting on the Default Colors data tab of the Color Display Settings screen, “Facility Table” sets the color to the value specified on the Facility Settings screen for the selected pipe Facility Type (to access the screen select the Facility Settings item from the Edit menu list), “Pipe Property Table” sets the color to the value specified on the Pipe data tab of the Property Table Report for the selected pipe Size/Type Code (to access the report select the Property Tables item from the Edit menu list), or “Selected Color” allows the User to specify a unique color for the selected pipe.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Color Code By Query
Color Code By Range
Color Display Settings
Trace
Undo The Last Data Or Graphic Change
Reset The Tool Palette

Summary

Resets the Tool Palette by removing all of the GDI Icons and returns the Tool Palette to a blank (empty) state.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Reset Tool Palette icon from the Utility Commands Toolbar.

- A message will be displayed asking whether to clear all of the commands from the Tool Palette. Either click the Yes command button to proceed, or click the No command button to end the command and preserve the current Tool Palette configuration.

- If the Yes command button is clicked, the Tool Palette will be cleared of any commands.

Notes & Considerations

- This command can also be executed by the Reset Tool Palette item from the GDI Command List, or by typing RESETTOOL on the GDI Command Line and pressing the Enter key.

- To remove an individual icon (command) from the Tool Palette, right-click on the icon then select the Remove Icon From Tool Palette item.

- Commands removed from the Tool Palette are still accessible from the GDI Command List, the GDI Command Line, or the GDI Toolbar if they have a preset icon. Commands can be added back to the Tool Palette after being removed.

See Also

Use The Tool Palette
Resize The GDI Window

Summary

Resizes the Graphic Data Interface (GDI) Window to its default size.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the *Resize GDI Window* icon from the *GDI Window Controls Toolbar*.
- The GDI Window will be resized.

Notes & Considerations

- This command can also be executed by the *Resize GDI Window* item from the GDI Command List, or by typing RESIZEGDI or RESIZE on the GDI Command Line and pressing the *Enter* key.
- This command does not “minimize” the GDI Window like the familiar Windows command. Rather, it resizes the GDI Window to maximize the remaining space in the GASWorkS window while still providing access to all the GDI Command Toolbars and features.
- The size of the GDI Window may be manually changed by holding the left mouse button with the mouse cursor over a corner of the window, dragging the window to the desired size, and released the mouse button.
- To resize the GDI Window to the maximize screen size, use the *Maximize GDI Window* command.

See Also

[Maximize The GDI Window](#)
Save The Current View

Summary

Saves a “bookmark” of the current GDI Display limits that can later be accessed by the Zoom To Saved View command.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Save Current View icon from the View Controls Toolbar.
- At the View Name prompt, enter a name by typing it on the GDI Prompt Line and press the Enter key.
- The current display will be saved.

Notes & Considerations

- This command can also be executed by the Save Current View item from the GDI Command List, or by typing SAVEVIEW on the GDI Command Line and pressing the Enter key.

- A saved view is not the same as a marked view.

- Saved views are stored in a list which is sorted alphabetically by their entered View Name. This list of saved views can be accessed later by the Zoom To Saved View command.

- To remove a saved view from the model, use the Delete Saved View command.

See Also

Delete A Saved View
Mark The Current View
Zoom The GDI Image
Save The Feature Colors

Summary

Saves the colors of the features which have temporarily been set using either the Color Code or Trace routines.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a Color Code or Trace has been performed.

- Select the Save Feature Colors item from the GDI Command List.
- A message will be displayed stating that the colors have been saved. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing SAVECOLORS on the GDI Command Line and pressing the Enter key.
- This command changes the Color Graphic Data Item for all hydraulic features to “Selected Color”, and changes the Selected Color Graphic Data Item to the feature’s current color in the GDI Display. This includes temporary colors generated by a Color Coding routine, such as the Trace routine.
- To return all of the features to the color saved by this command, use the Reset Feature Colors command.
- The feature colors may also be saved by clicking the Save Feature Colors command button on the Color Display Settings screen.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Color Code By Query
Color Code By Range
Color Display Settings
Reset The Feature Colors
Trace
Undo The Last Data Or Graphic Change
Use The Data Panel
Scale A Background Image

Summary

Adjusts the Scale Factor required to make the background image match a specified linear distance.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one background image is present in the model.

- Select the Scale Background Image item from the GDI Command List.
- At the Background Image File To Scale prompt, select an item from the GDI Prompt List.
- At the Select A Known Point On The Background Image prompt, move the mouse crosshairs to a reference point on the background image and left-click the mouse.
- At the Select Another Known Point On The Background Image prompt, move the mouse crosshairs to a second reference point on the background image and left-click the mouse. Be sure that the distance between the reference points is known.
- At the What Is The Actual Distance Between The Selected Points prompt, type the known distance value on the GDI Prompt Line and press the Enter key.
- A message will be displayed stating the adjustment Scale Factor. Either click the Yes command button to apply the Scale Factor to the background image, or click the No command button to end the command.

Notes & Considerations

- This command can also be executed by typing SCALEBACKGROUND or SCALEBACK on the GDI Command Line and pressing the Enter key.
- To verify that the background image has been correctly rescaled, use the Measure Distance command.
See Also

Add A BMP Background Image
Add A DXF Background Image
Add A SHP Background Image
Measure A Distance
Segment A Pipe

Summary

Divides either a 2-point pipe feature or an arc pipe feature into a User specified number of individual pipe segments.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one 2-point or arc pipe is present in the model.

- Select the Segment Pipe item from the GDI Command List.
- At the Select Pipe To Segment prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.
- At the Number Of Segments prompt, type a value on the GDI Prompt Line and press the Enter key.
- The selected pipe will be divided into the entered number of equal-length segments. Nodes will be placed at the junction of each pipe segment.

Notes & Considerations

- This command can also be executed by typing SEGMENTPIPE on the GDI Command Line and pressing the Enter key.
- Segmenting of polyline pipes is not supported by this command.
- To segment a pipe at a specific point, use the Tap Pipe command.
- To change the location of a node, either use the Move Node command or grips.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A 2-Point Pipe
Add An Arc Pipe
Grips
Move A Node
Select A Feature
Tap A Pipe
Undo The Last Data Or Graphic Change
Set To Flat Isometric Coordinates

Summary

Allows for an isometric detail while in plan view.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and the model is displayed in Plan View.

- Select the *Set Flat Isometric Coordinates* item from the GDI Command List.

- A message will be displayed stating the current Flat Isometric Coordinates setting. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing SETFLATISO on the GDI Command Line and pressing the Enter key.

See Also

Display In Plan View
Set An Intersection Flag

Summary

Turns the display of the intersection flag for a selected node “on”.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Select the Set Intersection Flag item from the GDI Command List.
- At the Select Node To Flag prompt, move the mouse pointer to a node and left-click the mouse. An intersection flag will be placed at the selected node.
- The Select Node To Flag prompt will be displayed again. Continue flagging nodes as necessary. When finished, right-click the mouse or press the “E” key to end the command.

Notes & Considerations

- This command can also be executed by typing SETINTERSECTIONFLAG or SETIFLAG on the GDI Command Line and pressing the Enter key.
- Use intersection flags to mark locations where a “header” pipe is not broken at the connection to an associated “lateral” pipe. Once flagged, the Break Flagged Intersections command will “break” the unconnected pipes into two segments joined at the node.
- To remove all unbroken intersection flags from the model, use the Clear Unbroken Intersection Flags command.
- To remove an individual unbroken intersection flag, use the Unset Intersection Flag command.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Break Flagged Intersections
Clear Unbroken Intersection Flags
Select A Feature
Undo The Last Data Or Graphic Change
Unset An Intersection Flag
Set The Orthogonal Coordinates

Summary

Turns the use of Orthogonal Coordinates “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the **Set Orthogonal Coordinates** item from the GDI Command List.

- A message will be displayed stating the current Orthogonal Coordinates setting. Click the **OK** command button to clear the message.

Notes & Considerations

- This command can also be executed by typing SETORTHO or ORTHO on the GDI Command Line and pressing the **Enter** key.

- Orthogonal Coordinates forces new lines to be drawn at 0, 90, 180, or 270 degrees from north.

- When this option is “on”, the words “Ortho On” will be displayed next to the coordinates displayed above the GDI Command Line.

- Combine this command with the **Snap Grid Intersections** command to draw lines that “snap” to the reference grid. Select the **Display Reference Grid** graphic settings option to show grid lines in the GDI Display. To access the option, select the **Settings** item from the **Graphics** menu list.

- Turning Orthogonal Coordinates “on” will automatically turn Orthogonal Plus Coordinates “off”.

See Also

**Snap To A Grid Intersection**
Set The Orthogonal Plus Coordinates

Summary

Turns the use of Orthogonal Plus Coordinates “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the *Set Orthogonal Plus Coordinates* item from the GDI Command List.

- A message will be displayed stating the current Orthogonal Plus Coordinates setting. Click the *OK* command button to clear the message.

Notes & Considerations

- This command can also be executed by typing SETORTHOPLUS or ORTHOP on the GDI Command Line and pressing the *Enter* key.

- Orthogonal Plus Coordinates forces new lines to be drawn at 0, 45, 90, 135, 180, 225, 270, or 315 degrees from north (the Orthogonal Coordinates “plus” the diagonals).

- When this option is “on”, the words “Ortho Plus On” will be displayed next to the coordinates displayed above the GDI Command Line.

- Combine this command with the *Snap Grid Intersections* command to draw lines that “snap” to the reference grid. Select the *Display Reference Grid* graphic settings option to show grid lines in the GDI Display. To access the option, select the *Settings* item from the *Graphics* menu list.

- Turning Orthogonal Plus Coordinates “on” will automatically turn Orthogonal Coordinates “off”.

See Also

*Snap To A Grid Intersection*
Set The User Graphic Line Size For All Features

Summary

Sets the pattern spacing (display size) for all of the User Graphic Lines.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Line is present in the model.

- Select the Set User Graphic Line Size (All) item from the GDI Command List.
- At the Select Item To Set prompt, select an item from the GDI Prompt List. The selected item will determine the method for setting the display size.

  **Pattern Spacing** - Type a value on the GDI Prompt Line to specify the New User Graphic Line Size as an absolute value in Coordinate units. Type a value followed by a “%” sign to specify the New User Graphic Line Size as a relative value in percent of the display width, then press the Enter key to apply the value.

  **Scale Pattern Spacing** - Type a value on the GDI Prompt Line to specify a Scale Factor, then press the Enter key to multiply the current User Graphic Line Size by the specified factor.

- A message will be displayed when the process is complete. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing SEITLINESIZE on the GDI Command Line and pressing the Enter key.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A User Graphic Line
Undo The Last Data Or Graphic Change
Set The User Graphic Symbol Size For All Features

Summary

Sets the symbol size (display size) for all of the User Graphic Symbols.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Graphic Symbol is present in the model.

- Select the Set User Graphic Symbol Size (All) item from the GDI Command List.
- At the Select Item To Set prompt, select an item from the GDI Prompt List. The selected item will determine the method for setting the display size.

  **User Graphic Symbol Size** - Type a value on the GDI Prompt Line to specify the New User Graphic Symbol Size as an absolute value in Coordinate units. Type a value followed by a “%” sign to specify the New User Graphic Symbol Size as a relative value in percent of the display width, then press the Enter key to apply the value.

  **Scale User Graphic Symbol Size** - Type a value on the GDI Prompt Line to specify a Scale Factor, then press the Enter key to multiply the current User Graphic Symbol Size by the specified factor.

- A message will be displayed when the process is complete. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing SETSYMBOLSIZE on the GDI Command Line and pressing the Enter key.
- The User Graphic Symbol Size can also be set from the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.
See Also

Add A User Graphic Symbol
Undo The Last Data Or Graphic Change
Set The User Text Size For All Features

Summary

Sets the display size for all of the User Text features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one User Text feature is present in the model.

- Select the Set User Text Size (All) item from the GDI Command List.

- At the Select Item To Set prompt, select an item from the GDI Prompt List. The selected item will determine the method for setting the display size.

  User Text Size - Type a value on the GDI Prompt Line to specify the New User Text Size as an absolute value in Coordinate units. Type a value followed by a “%” sign to specify the New User Text Size as a relative value in percent of the display width, then press the Enter key to apply the value.

  Scale User Text Size - Type a value on the GDI Prompt Line to specify a Scale Factor, then press the Enter key to multiply the current User Text Size by the specified factor.

- A message will be displayed when the process is complete. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing SETTEXTSIZE on the GDI Command Line and pressing the Enter key.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add User Text
Undo The Last Data Or Graphic Change
Set A Valve Node

Summary

Turns an existing node into a valve node.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one node is present in the model.

- Select the *Set Valve Node* item from the GDI Command List.

- At the *Select A Node To Set As A Valve* prompt, move the mouse pointer to a node and left-click the mouse.

- The selected node will be converted in a valve node.

Notes & Considerations

- This command can also be executed by typing SETVALVENODE or SETVN on the GDI Command Line and pressing the *Enter* key.

- To set a valve node back to a node, use the *Unset Valve Node* command.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

See Also

- Select A Feature
- Undo The Last Data Or Graphic Change
- Unset A Valve Node
Shift The Model Coordinates

Summary

Allows the model coordinates to be shifted, scaled, or rotated based on User specified values.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the *Shift Model Coordinates* item from the GDI Command List.

- The Shift Specifications screen is displayed.

  - For the *Shift* items, type a value (in *Coordinate* units) in the associated data field to set the distance along the associated axis that the model points will move.

  - For the *Scale* items, type a value in the associated data field to set the Scale Factor for the associated axis. The Coordinate values will be multiplied by the entered Scale Factor.

  - For the *Rotation Angle* item, type a value (in degrees from north) in the data field to set the angle of rotation for model points.

  - For the *Rotation Point* items, type a value in the associated data field to set the X and Y Coordinates of the center of rotation.

  - Either click the *Shift* command button to proceed, or click the *Close* command button to return to the GDI Window without making any changes.

  - If the *Shift* command button is clicked, a message will be displayed stating when the specified shift has been applied to the model. Click the *OK* command button to clear the message and return to the GDI Window.

Notes & Considerations

- This command can also be executed by typing SHIFTCOORDS or SHIFT on the GDI Command Line and pressing the *Enter* key.

- Models can be shifted during the Import routine by entering values in the *Origin Shift* or *Insertion Point* data fields. The name of the data item depends on the type of file being imported.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

General Import & Merge Information
Undo The Last Data Or Graphic Change
Show The Route Profile

Summary

Displays a profile of the various data values along a User selected route.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Show Route Profile item from the GDI Command List.

- The Route Profile Options screen is displayed.

  - Select the options under Items To Include to set the values to be shown in the Route Profile. Multiple options can be selected.

  - Select a Selection Style option. The Individual Graphical Selection option allows the User to select pipes for the route profile. The Trace Downstream option will create a profile for all pipes downstream of a selected node. The Trace Upstream option will create a profile for all pipes upstream of a selected node. The Trace To Primary Source option will follow along the primary flow path upstream of the selected node location until a regulator, compressor, or supply node is reached.

  - Either click the Continue command button to proceed, or click the Cancel command button to close the screen and return to the GDI Window.

- The next prompt will depend on the selected Selection Style.

  Individual Graphical Selection - At the Select First Pipe prompt, move the mouse cursor to a pipe and left-click the mouse. The selected pipe will be highlighted. Continue selecting pipes as necessary. When finished, right-click the mouse.

  Trace Downstream, Trace Upstream, or Trace To Primary Source - At the Select Starting Node prompt, move the mouse cursor over a node and left-click the mouse. The route will be highlighted. A message will be displayed asking whether the highlighted route is OK - either click the Yes command button to proceed, or click the No command button to return to the Route Profile Options screen.

- The Route Profile screen is displayed when the routine is complete. Data tabs will be enabled for every Item To Include option that was selected. The other data tabs will be grayed out. Review the results. When finished, click the Close command button to exit the screen.
Notes & Considerations

- This command can also be executed by typing ROUTEPROFILE or PROFILE on the GDI Command Line and pressing the Enter key.

- This command is intended to be used on a solved model.

- The horizontal scale of the Route Profile represents the hydraulic distance along the route. The vertical scale of the Route Profile represents the specified data value. If selected, the Combined data tab will show the profiles of all included data items. The values on the vertical scale will be color coded to match the associated profile.

- When using the Individual Graphical Selection style, pipe segments are displayed in the Route Profile from left to right in the order in which they were selected.

- When using either of the Trace styles, pipe segments are displayed in the Route Profile from left to right starting from the furthest upstream node and ending at the last downstream node.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Select A Feature
Solve The Model
Snap To A Grid Intersection

Summary

Turns the Grid Snap “on” or “off” depending on the current status.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Snap Grid Intersections item from the GDI Command List.
- A message will be displayed stating the current Grid Snap status. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing SNAPGRID on the GDI Command Line and pressing the Enter key.
- Combine this command with one of the Set Orthogonal Coordinates or Set Orthogonal Coordinates - Plus commands to draw lines that “snap” to the reference grid.
- Select the Display Reference Grid graphic settings option to show grid lines in the GDI Display. If this option is unselected, grid snapping will not work even if it is turned “on”. To access the option, select the Settings item from the Graphics menu list.
- The increments for the reference grid lines are determined by the Reference Grid Spacing value on the Graphic Settings screen.
- When grid snap is turned “on”, the Display Reference Grid graphic settings option is automatically selected.

See Also

Set The Orthogonal Coordinates
Set The Orthogonal Plus Coordinates
Snap Loose Pipe Ends

Summary

Snaps pipe ends together where the ends fall within a User specified Fuzzy Tolerance value.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Snap Loose Pipe Ends item from the GDI Command List.
- The Fuzzy Tolerance screen is displayed.
  - Type a value (in Coordinate units) in the Fuzzy Tolerance Value data field. Click the Continue command button to proceed. Pipe ends within a radius less than the Fuzzy Tolerance will be “snapped” together.
  - If the Automatically Update Pipe Length graphic settings option is selected, the Hydraulic Length of affected pipes will be recalculated. If not, a message will be displayed asking whether to update the pipe lengths. Either click the Yes command button to update the lengths, or click the No command button to preserve the previous values.
  - A message will be displayed stating the number of pipe ends that were changed. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing SNAPPPIPES on the GDI Command Line and pressing the Enter key.
- This command is useful for correcting connectivity errors encountered when importing data from external sources.
- Take care not to use a Fuzzy Tolerance value that is greater than or equal to the length of any pipes in the model, as the routine will combine the pipe ends into a single node, resulting in a zero-length pipe.
- The Hydraulic Length is the value used for the pipe length in the GASWorkS calculations. The initial Hydraulic Length value is equal to the graphic length in the GDI Display. The Hydraulic Length value can be changed in the Pipe Data in the Data Panel or by using the Edit Pipe Data command.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Edit Pipe Data
Undo The Last Data Or Graphic Change
Use The Data Panel
Solve The Model

Summary

Calculates a steady-state solution for a model.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and the model is solvable.

- Click the Solve icon from the lower-right corner of the GDI Window.
- The Solution Data screen is displayed.
  
  - On the Solution Data tab, enter values and select options used in the calculation of the steady-state solution.
  
  - On the Pipe Sizing Control data tab, enter values and select options used to optimize the pipe sizes in the model. Click the Solve & Calculate Pipe Sizes command button to compute a solution to the model with pipe sizes optimized for the specified settings.
  
  - On the Other Settings data tab, enter values and select options to account for additional factors that can affect the solution results.
  
  - On the Model Notes data tab, enter text into the Notes panel. Text entered here will be saved to the Model Notes.
  
  - Either click the Solve command button to proceed, click the Close command button to save the current settings and exit the screen and return to the GDI Window without solving the model, or click the Cancel command button to return to the GDI Window without solving the model or saving the settings.
  
  - If the Solve command button is clicked, the Solution Log will be displayed stating the results of each iteration and any exceptions found during the process. Review the Solution Log. When finished, click the Close command button to return to the GDI Window.

Notes & Considerations

- This command can also be executed by selecting the Solve Single Model item from the Analysis menu list, selecting the Solve Model item from the GDI Command List, or by typing SOLVE on the GDI Command Line and pressing the Enter key.
Refer to the User’s Manual for a detailed description of the Solution Data screen, and the various options and data fields contained on each data tab.

The Solve (balance scale) icon indicates whether or not the model has been solved in its current configuration. A blue, balanced scale icon indicates the model has been solved and a steady-state solution has been found. A red, unbalanced scale icon indicates that a change has been made to the model that was not included in the solution. Examples of changes that unbalance the model include adding a customer, adding a pipe, or changing the load on a model feature. Left-clicking the icon in either state will bring up the Solution Data screen.

If the Display Favorite Results List Upon Completion option is selected, the Favorite Results will be displayed in the Data Panel after the Solution Log is closed.

The Model Notes can be accessed by selecting the Model Notes item from the Edit menu list.

See Also

Use The Data Panel
GASWorkS™ 10.0

GDI Commands

Straighten A Polyline Pipe

Summary

Straightens a polyline pipe feature by deleting User selected vertices.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one polyline pipe is present in the model.

- Select the *Straighten Polyline Pipe* item from the GDI Command List.

- At the *Select A Polyline Pipe To Straighten* prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted. *Note* - If the selected pipe is not a polyline pipe, a message will be displayed. Click the *OK* command button to return to the prompt.

- At the *Select Starting Vertex* prompt, move the mouse pointer to a vertex and left-click the mouse. The selected vertex will be highlighted in a different color than the pipe.

- At the *Select Ending Vertex* prompt, move the mouse pointer to another vertex and left-click the mouse.

- A message will be displayed asking whether to delete the selected and intermediate vertices. Either click the *Yes* command button to remove the selected vertices and any vertices in between them from the selected pipe, or click the *No* command button to return to the *Select Starting Vertex* prompt.

- If the *Automatically Update Pipe Length* graphic settings option is selected, the *Hydraulic Length* of the pipe will be recalculated. If not, a message will be displayed asking whether to update the pipe length. Either click the *Yes* command button to update the length, or click the *No* command button to preserve the previous value.

Notes & Considerations

- This command can also be executed by typing STRAIGHTENPIPE on the GDI Command Line and pressing the *Enter* key.

- The *Hydraulic Length* is the value used for the pipe length in the GASWorkS calculations. The initial *Hydraulic Length* value is equal to the graphic length in the GDI Display. The *Hydraulic Length* value can be changed in the Pipe Data in the Data Panel or by using the *Edit Pipe Data* command.
If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Polyline Pipe
Edit Pipe Data
Select A Feature
Undo The Last Data Or Graphic Change
Use The Data Panel
Swap A Pipe’s Ends (The From Node & To Node)

Summary
Swaps the From Node and To Nodes for a pipe feature.

Example
The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Click the Swap Pipe Ends icon from the Graphic Edit Commands Toolbar.
- At the Select Pipe To Swap Ends On prompt, move the mouse pointer to a pipe and left-click the mouse.
- The original To Node becomes the From Node, and vice versa. Note - If the selected pipe is a polyline pipe, a message may be displayed when the process is complete advising that the node order cannot be undone using the Undo command. Click the OK command button to clear the message.

Notes & Considerations
- This command can also be executed by the Swap Pipe Ends item from the GDI Command List, or by typing SWAPPIPEENDS or SWAPENDS on the GDI Command Line and pressing the Enter key.
- The order of the From Node and To Node is affects the modeling of compressors and regulators. The From Node must be the upstream node of the device, and the To Node must be the downstream node. This command is useful if any such features have been inserted backwards into the model. Swapping the pipe ends has no effect on any other pipe Hydraulic Types.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add A Compressor
Add A Regulator
Add An Arc Pipe
Add A Polyline Pipe
Undo The Last Data Or Graphic Change
Select A Feature
Tap A Pipe

Summary

Taps (splits or breaks) a pipe feature.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Click the Tap Pipe icon from the Graphic Edit Commands Toolbar.

- At the Select Pipe To Tap prompt, move the mouse pointer to a pipe and left-click the mouse. The selected pipe will be highlighted.

- At the Tap Location prompt, either type a coordinate pair on the GDI Prompt Line and press the Enter key, or move the mouse crosshairs over a point on the selected pipe and left-click the mouse. Note - If the selected location coincides with an existing node, a message will be displayed. Click the OK command button to clear the message and return to the prompt.

- A new node will be placed at the point on the selected pipe. The selected pipe will be split into two segments connected to the new node.

- Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the Apply Data Values command button.

Notes & Considerations

- This command can also be executed by the Tap Pipe item from the GDI Command List, or by typing PIPETAP or TAP on the GDI Command Line and pressing the Enter key.

- To change the Pipe Data, either use the Edit Pipe Data command or left-click on the desired pipe feature to display the data in the Data Panel.

- To change the Node Data, either use the Edit Node Data command or left-click on the desired node to display the data in the Data Panel.
The length of the new pipe segments will be equal to the prorated length of the original pipe. For example, if the overall length of the original pipe was 100 Feet, and the tap is placed at a distance of 40 Feet from one end of the pipe, two pipe segments will be created, one of length 40 Feet and one of length 60 Feet. One of the two pipe segments will keep the Record Number of the original pipe. The other will be assigned the next available Record Number. All other data from the original pipe will be copied to both new pipe segments.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Polyline Pipe
Edit Node Data
Edit Pipe Data
Select A Feature
Set A Feature’s Location
Undo The Last Data Or Graphic Change
Use The Data Panel
Text Display Settings

Summary

Displays the text display options for the customer, node, and pipe features.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Text Display Settings icon from the Display Controls Toolbar.
- The Text Display Settings screen is displayed.
  - The Pipe Items, Node Items, and Customer Items data tabs contain the options and settings for each particular feature.
  - The Text Size item sets the display size for the text associated with the associated feature.
  - The Text Size Style list determines how the Text Size is calculated - “Coordinates” sets the Text Size in the Coordinate units (absolute), or “Printer Points” sets the Text Size as a percentage of the GDI Display (relative).
  - The Text Rotation item sets the rotation for the text associated with the feature, as measured by the angle from north (zero (0) degrees represents horizontal text).
  - The Display Limit item is a measure of the extent of the GDI Display, taken from one corner of the display window diagonally to the opposite corner. The associated text will be visible only if the GDI Display is zoomed in below the Display Limit value. A value of zero (0) will make the text visible at all zoom levels.
  - The Text Color item sets the color for the text associated with the feature. Left-click the mouse on the color panel to display the Color screen. Select a color. Click the OK command button to return to the Text Display Settings screen.
  - Either click the Apply command button to save all of the changes and close the screen, or click the Cancel command button to close the screen without saving any changes.

Notes & Considerations

- This command can also be executed by the Text Display Settings item from the GDI Command List, or by typing SETTEXT on the GDI Command Line and pressing the Enter key.
The Display Customer Symbols and Display Node Symbols options must be turned “on” to display the text items for each feature, respectively.

Text items will be displayed at preset locations. Use the “Move” commands associated with each feature text type to change the location and rotation of the text items.

Use the “Edit” commands for each feature data type to turn “on” or “off” text items for an individual feature. The Display Text Items option must be selected to display text items for a given feature type, regardless of the setting for an individual feature.

See Also

Determine An Appropriate Display Limit
Display The Node Symbols
Display The Pipe Symbols
Edit Customer Data
Edit Node Data
Edit Pipe Data
Move Customer Text
Move Node Text
Move Pipe Text
Trace

Summary

Performs a Trace and color codes the features along the trace route.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Click the **Trace** icon from the **Utility Commands Toolbar**.

  - The Trace Specifications screen is displayed.

    - Select an item from the **Trace Style** list.

    - Select an option for the **Start Trace At** item to set the type of feature from which the trace will begin.

    - The **Trace Highlight Color** item sets the color used to highlight the traced features. Left-click the mouse on the color panel to display the Color screen. Select a color. Click the **OK** command button to return to the Trace Specifications screen.

    - Select the **Highlight Customers** option to color code customers attached to pipes included in the trace. Unselect this option to exclude customers from the trace.

    - Select the **Reset Feature Colors Before Tracing** option to automatically change all of the model features back to their specified colors before starting the trace. Unselect this option to preserve any current color coding, such as a prior trace.

    - Select the **Blend Colors On Overlapping Trace Paths** option to blend the trace colors if they overlap on the trace path. Unselect this option to not overlap the colors on the trace paths.

    - Select the **Create A Trace Results File** option to create a file containing the Trace Results. Select options to include in the report from the list. Unselect this option to perform a trace without creating a file.

    - Click the **Reset Feature Colors** command button to change all of the model features back to their specified colors.
Either click the *Trace* command button to proceed, or click the *Cancel* command button to close the screen and return to the GDI Window without performing a trace.

- If the *Trace* command button is clicked, at the “*Select Starting*” prompt, move the mouse pointer to a feature of the specified type and left-click the mouse.
- The routine will color code all of the connected features based on the specifications from the Trace Specifications screen.

### Notes & Considerations

- This command can also be executed by the *Trace* item from the GDI Command List, or by typing TRACE on the GDI Command Line and pressing the *Enter* key.
- Refer to the User’s Manual for a detailed description of the Trace Specifications screen and its various options.
- This command is useful for verifying the connectivity of a model. Features that are not colored by a trace indicate a discontinuity in the flow of gas, such as a closed valve or two adjacent features that are not connected. Running a trace before solving a model is a way to eliminate a possible source of error.
- To save the trace color coding, use the *Save Feature Colors* command.
- To return all of the feature colors to the colors specified prior to the trace, use the *Reset Feature Colors* command.
- Selecting the *Create A Trace Results File* option on the Trace Specifications screen will generate and save a report of the results once the trace is complete. Use the *View Trace Results* command to view this file.

### See Also

- Add A 2-Point Pipe
- Add An Arc Pipe
- Add A Polyline Pipe
- Reset The Feature Colors
- Save The Feature Colors
- Select A Feature
- View The Trace Results
Trace & Update The Data

Summary

Performs a Trace and updates User specified data values for features found along the trace route.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Trace & Update Data item from the GDI Command List.
- The Trace & Update Data Specifications screen is displayed.
  - Select an item from the Trace Style list.
  - Select an option for the Start Trace At item to set the type of feature from which the trace will begin.
  - The Trace Highlight Color item sets the color used to highlight the traced features. Left-click the mouse on the color panel to display the Color screen. Select a color. Click the OK command button to return to the Trace & Update Data Specifications screen.
  - Select the Highlight Customers option to color code customers attached to pipes included in the trace. Unselect this option to exclude customers from the trace.
  - Select an item from the Set list to set the data item to be updated.
  - Select an item from the Equal To list to specify a new value for the Set data item.
  - Either click the Trace & Update command button to proceed, or click the Cancel command button to close the screen and return to the GDI Window without performing a trace.
  - If the Trace & Update command button is clicked, at the “Select Starting” prompt, move the mouse pointer to a feature of the specified type and left-click the mouse.
  - The routine will color code all connected features based on the specifications from the Trace Specifications screen.
A message will be displayed stating the number of pipes selected. Either click the Yes command button to continue with updating the feature data, or click the No command button to return to the Trace & Update Data Specifications screen.

If the Yes command button is clicked, a message will be displayed stating how many records were updated. Click the OK command button to clear the message.

**Notes & Considerations**

- This command can also be executed by typing TRACEUPDATE on the GDI Command Line and pressing the Enter key.

- This command is useful for updating model features along a flow path. For example, if the pressure at a node is incorrect, this command can be used to adjust the pipe efficiencies along the major flow path between the supply point and the incorrect node. This can help to identify sections of the system due for replacement or upgrading.

- To save the trace color coding, use the Save Feature Colors command.

- To return all of the feature colors to the colors specified prior to the trace, use the Reset Feature Colors command.

**See Also**

Add A 2-Point Pipe  
Add An Arc Pipe  
Reset The Feature Colors  
Save The Feature Colors  
Select A Feature
**Turn A Background Image Display Off**

**Summary**

Turns “off” the background image that is displayed.

**Example**

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a background image is attached to the model.

- Select the *Turn Background Image Display Off* item from the GDI Command List.
- At the *Background Image File To Turn Off* prompt, select a file from the list.
- The selected background image will be turned “off” from the display.

**Notes & Considerations**

- This command can also be executed by typing TURNIMGOFF or IMGOFF on the GDI Command Line and pressing the *Enter* key.
- The background image can be turned back “on” from the Background Image Settings screen. To access the screen, select the *Background Settings* item from the *Graphics* menu list.

**See Also**

- Add A BMP Background Image
- Add A DXF Background Image
- Add A SHP Background Image
Turn The Change Log Off

Summary

Turns “off” the Change Log.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Turn Change Log Off item from the GDI Command List.

- A message will be displayed stating that the Change Log has been turned “off”. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing LOGOFF on the GDI Command Line and pressing the Enter key.

- The Change Log is a record of User changes to a model. Events such as adding a pipe, deleting a pipe, and tapping a pipe are saved to a text file. This file can later be reviewed to check the edits made to a model. Only edits made while the Change Log is turned “on” are recorded.

- To record model changes to the Change Log, use the Turn Change Log On command.

- To view the contents of the Change Log, use the View Change Log command.

- To clear the contents of the Change Log, use the Clear Change Log command.

See Also

Clear The Change Log
Turn The Change Log On
View The Change Log
Turn The Change Log On

Summary

Turns “on” the Change Log to record model edits.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Select the Turn Change Log On item from the GDI Command List.

- A message will be displayed asking whether to prompt for Change Log Comments on a new feature entry. Either click the Yes command button to have GASWorkS prompt the User for comments after certain commands - these comments will be recorded to the Change Log, or click the No command button to record all changes without User comments.

- If an existing change log file is found, a message will be displayed. Either click the Yes command button to delete the existing log and replace it with a new one, click the No command button to append new changes to the existing log, or click the Cancel command button to end the command without changing the status of the Change Log.

Notes & Considerations

- This command can also be executed by typing LOGON on the GDI Command Line and pressing the Enter key.

- The Change Log is a record of User changes to a model. Events such as adding a pipe, deleting a pipe, and tapping a pipe are saved to a text file. This file can later be reviewed to check the edits made to the model. Only edits made while the Change Log is turned “on” are recorded.

- To view the contents of the Change Log, use the View Change Log command.

- To stop recording the model changes to the Change Log, use the Turn Change Log Off command.

- To clear the contents of the Change Log, use the Clear Change Log command.
See Also

Clear The Change Log
Turn The Change Log Off
View The Change Log
Turn A DXF Layer Off

Summary

Turns “off” a DXF layer associated with an attached DXF background image file.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one DXF file is attached as a background image.

- Select the Turn DXF Layer Off item from the GDI Command List.
- At the Select A DXF Entity On The Layer To Be Turned ‘Off’ prompt, move the mouse pointer to a DXF entity and left-click the mouse. The selected entity will be highlighted.
- A message will be displayed asking whether to turn “off” the selected DXF layer (displayed Layer Name). Either click the Yes command button to proceed, or click the No command button to end the command.
- If the Yes command button is clicked, the selected DXF layer will be turned “off”.

Notes & Considerations

- This command can also be executed by typing DXFLAYER on the GDI Command Line and pressing the Enter key.
- The DXF Layers can be turned “on” from the Background Image Settings screen. To access the screen, select the Background Settings item from the Graphics menu list.
- Changing the DXF Layer settings in GASWorkS does not affect the settings in the original file.

See Also

Add A DXF Background Image
Turn The GeoMap Functions On

Summary

Enables the GeoMap functions to search to allow the use of geographic map services to help in building or maintaining a model.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the GeoMap icon from the bottom of the GDI Toolbar list.
- A message will be displayed asking whether to continue with the GeoMap functions. Either click the Yes command button to continue with the use of the GeoMap functions, or click the No command button to disable (turn “off”) the GeoMap functions.
- If the Yes command button is clicked, the GeoMap icon will change display style and the GDI Image will be resized to the extents of the entire world.

Notes & Considerations

- This command can also be executed by selecting the Turn GeoMap Functions On item from the GDI Command List, or by typing GEOMAP on the GDI Command Line and pressing the Enter key.
- A detailed description of the terms-of-use and privacy policy for the selected map service may be viewed by selecting the appropriate item from the Third Party Terms & Conditions submenu of the Help menu list. You must agree to the associated terms-of-use and privacy policy to use the GeoMap functions.

See Also

General GeoMapping Information
Undo The Last Data Or Graphic Change

Summary

Will undo up to the last ten (10) data or graphic changes.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the Undo icon from the Undo/Redo Commands Toolbar. Note - There are no prompts for this command. The previous eligible model edit will be undone.

- Note - If there are no data or graphic edits to undo or the Undo command has been used ten times consecutively, a message will be displayed stating that there is "Nothing To Restore". Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by the Undo Last Change item from the GDI Command List, or by typing UNDO on the GDI Command Line and pressing the Enter key.

- The Allow Undo Of Data/Graphic Changes preference settings option must be selected for the Undo command to be functional. To access the screen, select the Settings item from the Preferences submenu from the File menu list.

- This command can only restore the previous ten (10) edits.

- Be aware that some GDI Commands cannot be undone. If the Undo command is used after a command that cannot be undone, the routine will undo the most recent edit that can be undone. The Notes & Considerations section in each topic indicate which commands can be undone.

See Also

Redo The Last Data Or Graphic Change
Unhighlight A Group

Summary

Unhighlights previously highlighted features in a group.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a group has been highlighted in the model.

- Select the *Unhighlight Group* item from the GDI Command List.
- The highlighted group will be unhighlighted, and the model features will return to their specified colors.

Notes & Considerations

- This command can also be executed by typing UNHIGHLIGHTGROUP or UNHILITGRP on the GDI Command Line and pressing the *Enter* key.

See Also

- Create A Group
- Highlight A Group
- Select A Feature
Unset An Intersection Flag

Summary

Turns the display of the intersection flag for a selected node “off”.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and that a node intersection flag is present in the model.

- Select the Unset Intersection Flag item from the GDI Command List.
  
  - At the Select Node To Flag prompt, move the mouse pointer to a node and left-click the mouse. The intersection flag on the selected node will be highlighted.
  
  - The Select Node To Flag prompt will be displayed again. Continue flagging nodes as necessary. When finished, right-click the mouse or press the “E” key to end the command.

  - The displayed intersection flag(s) will be removed.

Notes & Considerations

- This command can also be executed by typing UNSETINTERSECTIONFLAG or UNSETIFLAG on the GDI Command Line and pressing the Enter key.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Select A Feature
Set An Intersection Flag
Undo The Last Data Or Graphic Change
Unset A Valve Node

Summary

Turns an existing valve node into a “normal” system node.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one valve node is present in the model.

- Select the Unset Valve Node item from the GDI Command List.
- At the Select A Valve Node prompt, move the mouse pointer to a valve node and left-click the mouse.
- The selected valve node will be converted into a connection node.

Notes & Considerations

- This command can also be executed by typing UNSETVALVENODE or UNSETVN on the GDI Command Line and pressing the Enter key.
- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Add A Valve Node
Select A Feature
Undo The Last Data Or Graphic Change
Update The Pipe Customer Count

Summary

Updates the Customer Count value for all of the pipe features.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select the Update Pipe Customer Count item from the GDI Command List.
- A message will be displayed stating when the update process is complete. Click the OK command button to clear the message.

Notes & Considerations

- This command can also be executed by typing UPDATEPIPECOUNT or UPDPIPE on the GDI Command Line and pressing the Enter key.

- The Customer Count item records the number of customers attached to a particular pipe. Normally, GASWorkS will update this value automatically as customers are added or deleted. This command is useful for repairing corrupted Customer Count values.

See Also

Add A 2-Point Pipe
Add An Arc Pipe
Add A Customer
Add A Polyline Pipe
View The Change Log

Summary

Displays the Change Log.

Example

The example assumes that GASWorkS has been started, a model is open, GDI Window is displayed, and a Change Log has been created.

- Select the View Change Log item from the GDI Command List. Note - If a Change Log has not been created and this command is executed, a message will be displayed stating the Change Log is not found. Click the OK command button to clear the message and return to the GDI Window.

- A message will be displayed asking whether to display the Change Log contents. Either click the Yes command button to display the Change Log, or click the No command button end the command.

- If the Yes command button is clicked, a message will be displayed stating that the Change Log has been turned “off”. Click the OK command button to clear the message.

- The Change Log will be displayed. Review the contents of the Change Log. When finished, click the Close command button to exit the log and return to the GDI Window.

Notes & Considerations

- This command can also be executed by typing VIEWLOG on the GDI Command Line and pressing the Enter key.

- The Change Log is a record of User changes to a model. Events such as adding a pipe, deleting a pipe, and tapping a pipe are saved to a text file. This file can later be reviewed to check the edits made to a model. Only edits made while the Change Log is turned “on” are recorded.

- To clear the contents of the Change Log, use the Clear Change Log command.

- To stop recording the model changes to the Change Log, use the Turn Change Log Off command.
See Also

Clear The Change Log
Turn The Change Log Off
View A CSV Table

Summary
Displays a previously created CSV file (table).

Example
The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a .csv file has previously been saved.

- Select the View CSV Table item from the GDI Command List.
- The File Selection screen is displayed. Select a “.csv” file. Click the Continue command button.
- The contents of the CSV file will be displayed on the Table Editor screen. View or edit the table. Click the Close command button to return to the GDI Display.

Notes & Considerations
- This command can also be executed by typing VIEWTABLE on the GDI Command Line and pressing the Enter key.

See Also
Create A User Table
View The Trace Results

Summary
Displays a previously created Trace Results file.

Example
The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a Trace Results file has been created.

- Click the View Trace Results icon from the Utility Commands Toolbar.
- The File Selection screen is displayed. Select a Trace Results “.trc” file. Click the Continue command button.
- The Trace Results will be displayed. Review the contents of the Trace Results. When finished, click the Close command button to return to the GDI Window.

Notes & Considerations
- This command can also be executed by selecting the View Trace Results item from the GDI Command List, or by typing VIEWTRACE on the GDI Command Line and pressing the Enter key.
- To create a Trace Results file, click the Trace icon from the Utility Commands Toolbar. The Trace Specifications screen is displayed. Select the Create A Trace Results File option. A Trace Results file will be created when the Trace command is executed.

See Also
Trace
Zoom The GDI Image

Summary

A description of the controls available for resizing the model image within the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

*Zoom To Fit The Entire GDI Image In The GDI Display* -

- Click the *Zoom To Fit* icon from the *View Controls Toolbar*. *Note* - This command can also be executed by selecting the *Zoom To Fit* item from the GDI Command List, or by typing ZOOMFIT or ZF on the GDI Command Line and pressing the *Enter* key.

- The entire model and any attached background images will be displayed to fit within the GDI Display.

*Zoom In (Enlarge) The GDI Image* -

- Click the *Zoom In* icon from the *View Controls Toolbar*. *Note* - This command can also be executed by selecting the *Zoom In* item from the GDI Command List, or by typing ZOOMIN or ZI on the GDI Command Line and pressing the *Enter* key.

- At the *Select Center Of Zoom Area* prompt, move the mouse cursor to a point in the GDI Display and left-click the mouse.

- The model image will be enlarged and re-centered around the selected location.

*Zoom The Model Only In The GDI Display* -

- Select the *Zoom Model* item from the GDI Command List. *Note* - This command can also be executed by typing ZOOMMODEL or ZM on the GDI Command Line and pressing the *Enter* key.

- The model, excluding any background images, will be displayed to fit within the GDI Display.
Display The Next “Zoomed View” Of The GDI Image -

- Click the Zoom Next icon from the View Controls Toolbar. Note - This command can also be executed by selecting the Zoom Next item from the GDI Command List, or by typing ZOOMNEXT or ZN on the GDI Command Line and pressing the Enter key.

- The view of the model image prior to using the Zoom Previous command will displayed.

- Note - This command only works after using the Zoom Previous command.

Zoom Out (Reduce) The GDI Image -

- Click the Zoom Out icon from the View Controls Toolbar. Note - This command can also be executed by selecting the Zoom Out item from the GDI Command List, or by typing ZOOMOUT or ZO on the GDI Command Line and pressing the Enter key.

- The model image will be reduced and re-centered around the selected location.

Display The Previous “Zoomed View” Of The GDI Image -

- Click the Zoom Previous icon from the View Controls Toolbar. Note - This command can also be executed by selecting the Zoom Previous item from the GDI Command List, or by typing ZOOMPREVIOUS or ZP on the GDI Command Line and pressing the Enter key.

- The last view of the model image will displayed.

Zoom To A Previously Saved View Of The GDI Image -

- Click the Zoom To Saved View icon from the View Controls Toolbar. Note - This command can also be executed by selecting the Zoom To Saved View item from the GDI Command List, or by typing ZOOMVIEW or ZV on the GDI Command Line and pressing the Enter key.

- At the View Name prompt, select a file from the GDI Prompt List.

- The selected saved view will be displayed.

- Note - There must be a Saved View present in the model.
**Zoom The GDI Image By A Scale Factor** -

- Click the Zoom By Scale Factor icon from the View Controls Toolbar. Note - This command can also be executed by selecting the Zoom Scale item from the GDI Command List, or by typing ZOOMSCALE or ZS on the GDI Command Line and pressing the Enter key.

- At the Scale Factor prompt, type a value on the GDI Prompt Line and press the Enter key. A value larger than 1 will zoom in, while a value less than 1 will zoom out.

- The image will be zoomed by the entered Scale Factor.

**Zoom The GDI Image To A User Selected Window** -

- Click the Zoom Window icon from the View Controls Toolbar. Note - This command can also be executed by selecting the Zoom Window item from the GDI Command List, or by typing ZOOMWINDOW or ZW on the GDI Command Line and pressing the Enter key.

- At the Select First Corner Of Zoom Window prompt, move the mouse crosshairs to a point in the GDI Display and left-click the mouse. This sets the upper-left corner of the zoom window.

- At the Select Opposite Corner Of Zoom Window prompt, move the mouse crosshairs to another point in the GDI Display and left-click the mouse. The rectangle in the GDI Display represents the zoom window.

- The selected zoom window will be displayed.

**Notes & Considerations**

- The Zoom To Fit, Zoom In, and Zoom Out icons can also be found in the lower-left corner of the GDI Window. Left-click on one of these icons to execute the associated command. The Zoom In and Zoom Out command buttons do not let the User choose the zoom location. These command buttons can be used while most (not all) other commands are running.

- When using the Zoom Window command, the portion of the model image that is selected will be enlarged to fill as much of the GDI Display as possible.

- The Zoom In command increases the size of the model image by the Zoom Ratio value. The Zoom Out command reduces the size of the model image by the Zoom Ratio value. The Zoom Ratio value can be viewed or changed from the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.
Each GDI Panel stores up to ten (10) previous views in memory in the order that they were created. This includes both pans and zooms. The *Zoom Previous* or *Zoom Next* commands can be used to move back and forth through the sequence of views.

**See Also**

- Automatically Pan & Zoom GDI Display
- Save The Current View
GDI Window Examples
Add A BMP Background Image

Summary

A step-by-step guide to attaching a bitmap (BMP) style background image to a model. The process is similar for attaching a JPG or TIF background image.

Example

The example assumes that GASWorkS has been started.

1) Create The New Model

   ● From the File menu list, select the New item.
     ● The Model Selection screen is displayed. Type a name for the new model in the Model Name data field. Click the Continue command button.
     ● Note - If the GDI Window does not automatically display, select the View/Edit item from the Graphics menu list to display the GDI Window.

   ● Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls Toolbar.

2) Set The Model Coordinate Units

   ● From the Utilities menu list, select the Set Defaults item.

     ● The Default Data Values screen is displayed. On the Dimensional Units data tab, select Feet from the Coordinates list. Click the Apply Dimensional Units Only command button to apply the new Coordinate units. Click the OK command button on the message. Click the Close command button to exit the screen.

3) Add The Background Image

   ● From the Graphics menu list, select the Background Settings item.

     ● The Background Image Settings screen is displayed. Click the Attach New Image command button.
The Attachment File Type screen is displayed. Select **BMP - Windows Bitmap Style Raster Or Image File** from the list. Click the **Continue** command button.

- The File Selection screen is displayed. Use the **Drives** and **Directories** lists to navigate to the **GASWorkS 10\Files** directory. Select the **sample.bmp** file. Click the **Continue** command button.

- The Background Image Settings screen is displayed again. The default settings for the BMP file will be fine for this example. Click the **Apply** command button to save the changes and attach the BMP image to the model.

4) **Zoom The GDI Image**

- Click the **Zoom To Fit** icon from the lower-left corner of the GDI Window.

- **Note** - If the background image does not be display in the GDI Display, go to the **Display Controls Toolbar** and move the mouse cursor over the **Display Background Image** icon. The status of the Background Image Display will be displayed in the Information Panel. If the option is “off”, left-click on the icon to turn it “on”. Click the **Zoom To Fit** icon again. The background image should now be displayed in the GDI Display.

5) **Check The Scale Of The Background Image**

Use the GASWorkS tools to check whether the dimensions of the background image match the field measurements.

- Click the **Zoom Window** icon from the **View Controls Toolbar**.

- Set the corners of the zoom window to approximately the square shown in Figure 1. The selected area should now fill the GDI Display.
• Click the **Measure Distance** icon from the **Utility Commands Toolbar**.

  • Measure the distance between Point A and Point B on Figure 2.

  ![Image of Figure 2]

  Figure 2

• The Measured Values screen will display the measured distances. The **Absolute Distance** value should be approximately 825 Feet. The actual distance is approximately 412 feet. The scale of the background image needs to be adjusted. Click the **OK** command button to clear the message.

**6) Adjust The Scale Of The Background Image**

The background image can be scaled by changing the **Coordinate-To-Pixel Ratio** value. A BMP image is made up of a number of bits or pixels. The **Coordinate-To-Pixel Ratio** indicates the horizontal distance that one pixel represents in the image. For example, if one pixel in the image represents a 5 Feet by 5 Feet portion of the image, the **Coordinate-To-Pixel Ratio** would be 5. GASWorkS supports two methods for changing this value.

**The Background Image Settings Screen**

• From the **Graphics** menu list, select the **Background Settings** item.

  • The Background Image Settings screen is displayed. Ensure that the **sample.bmp** file in the **Attached Background Image Files** list is highlighted. The settings for the file will be displayed in the **Settings** section.

  • The measured distance on the BMP image (825 Feet) is approximately twice the length measured in the field (412 Feet). This indicates that the **Coordinate-To-Pixel Ratio** is twice as large as it should be. To adjust the **Coordinate-To-Pixel Ratio**, change the **Scale Factor** value from 10 to **5**.

  • Click the **Apply** command button to change the BMP image in the GDI Display.
Use The Scale Background Image Command -

- Select the Scale Background Image item from the GDI Command List.
  - At the Background Image File To Scale prompt, select sample.bmp from the GDI Prompt List.
  - At the Select A Known Point On The Background Image prompt, click Point A as shown in Figure 2.
  - At the Select Another Known Point On The Background Image prompt, click Point B as shown in Figure 2.
  - At the What Is The Actual Distance Between The Selected Points prompt, type the value of 412 (Feet) on the GDI Prompt Line and press the Enter key.
  - A message will be displayed stating the Scale Factor value for the background image (it should be approximately 0.5). Click the Yes command button to apply the new Scale Factor.

7) Zoom The GDI Image

- Click the Zoom To Fit icon from the lower-left corner of the GDI Window.
- The background image should now fill the GDI Display. Recheck the scale of the background image using the Measure Distance command. Is it correct? If not, repeat the previous steps to change the scale of the background image.

Notes & Considerations

- Attaching a JPG or TIF background image follows roughly the same procedure as for a BMP style background image. The options and settings on the Background Image Settings screen are the same for all three file types.
- Ensure that the proper Coordinate units have been set for the model before attempting to attach and/or scale any background images.
- Only standard Windows bitmap files can be displayed by GASWorkS. Scanned images or the raster output of a graphic application can be converted to a Windows standard bitmap (BMP) file, then attached to the model as a background image.
• Bitmap images have a fixed resolution and cannot be resized without affecting the image quality. Loss of image quality is especially noticeable when enlarging a section of the image. This is normal when working with bitmap images and is not specific to GASWorkS.

• The Insertion Point values determine the X and Y coordinates of the upper-left corner of the image. The default is set to (0,0). These values can be changed from the Background Image Settings screen. The background image can also be moved using the Move Background Image command. The scale should be established before establishing the position.

• Multiple background images of different file types can be attached to the same model. GASWorkS supports the use of BMP, DXF, JPG, KML, PDF, SHP, and TIF files as background images.

See Also

Display A Background Image
Graphically View A Model
Maximize The GDI Window
Measure A Distance
Move A Background Image
Scale A Background Image
Zoom The GDI Image
Add A DXF Background Image

Summary

A step-by-step guide to attaching a Drawing Exchange Format (DXF) style background image to a model.

Example

The example assumes that GASWorkS has been started.

1) Create The New Model

- From the File menu list, select the New item.
  - The Model Selection screen is displayed. Type a name for the new model in the Model Name data field. Click the Continue command button.

- Note - If the GDI Window does not automatically display, select the View/Edit item from the Graphics menu list to display the GDI Window.

- Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls Toolbar.

2) Set The Model Coordinate Units

- From the Utilities menu list, select the Set Defaults item.
  - The Default Data Values screen is displayed. On the Dimensional Units data tab, select Feet from the Coordinates list. Click the Apply Dimensional Units Only command button to apply the new Coordinate units. Click the OK command button on the message. Click the Close command button to exit the screen.

3) Add The Background Image

- From the Graphics menu list, select the Background Settings item.
  - The Background Image Settings screen is displayed. Click the Attach New Image command button.
  - The Attachment File Type screen is displayed. Select DXF - Drawing Exchange Format
Style CAD File from the list. Click the Continue command button.

- The File Selection screen is displayed. Use the Drives and Directories lists to navigate to the GASWorkS 10\Files directory. Select the plat.dxf file. Click the Continue command button.

- The Background Image Settings screen is displayed again. The default settings for the DXF file will be fine for this example. Click the Apply command button to save the changes and attach the DXF image to the model.

4) Zoom The GDI Image

- Click the Zoom To Fit icon from the lower-left corner of the GDI Window.

- Note - If the background image does not display in the GDI Display, go to the Display Controls Toolbar and move the mouse cursor over the Display Background Image icon. If the option is “off”, left-click on the icon to turn it “on”. Click the Zoom To Fit icon again. The background image should now be displayed in the GDI Display.

5) Check The Scale Of The Background Image

Use the GASWorkS tools to check whether the dimensions of the background image match the field measurements.

- Click the Zoom Window icon from the View Controls Toolbar.

  - Set the corners of the zoom window to approximately the square shown in Figure 1. The selected area should now fill the GDI Display.

- Click the Measure Distance icon from the Utility Commands Toolbar.
Measure the distance between Point A and Point B on Figure 2.

The Measured Values screen will display the measured distances. The Absolute Distance value should be approximately 40 Feet. Click the OK command button to clear the message.

6) Zoom The GDI Image

Click the Zoom To Fit icon from the lower-left corner of the GDI Window.

7) Turn Some DXF Layers “Off”

Clear up the GDI Display by hiding some of the DXF text layers.

From the Graphics menu list, select the Background Settings item.

The Background Image Settings screen is displayed. Ensure that the plat.dxf file in the Attached Background Image Files list is highlighted. The settings for the file will be displayed in the Settings section.

In the Layer Names, find the PP-ROW layer and unselect the layer. Find the PP-TEXT layer and unselect the layer. Click the Apply command button to save the changes and apply them to the DXF image.

Notes & Considerations

Ensure that the proper Coordinate units have been set for the model before attempting to attach and/or scale any background images.
If more than one DXF file is attached, the coordinate values for all of the files must be expressed in the same Coordinate units.

If a DXF image contains too many features, the model image may refresh slowly. Turning “off” layers (unselect) on the Background Image Settings screen that contain irrelevant data features is a way to declutter the image and make the model run more smoothly.

The background image can be displayed in any of a number of colors by unselecting the Convert Colors To Gray option on the Background Image Settings screen. To avoid confusion, it is recommended to choose a color for the background image not being used for any of the model features.

The Origin Shift values determine the X and Y coordinates of the upper-left corner of the image. The default is set to (0,0). These values can be changed from the Background Image Settings screen. The background image can also be moved using the Move Background Image command. The scale should be established before establishing the position.

The Scale Factor value determines the Drawing Unit-To-Coordinate Ratio of the background image. This value sets the number of distance units covered in each incremental change in coordinates. The Scale Background Image command can also be used to correct the scale. The recommended approach for scaling DXF files is to rescale them using the CAD program in which they were generated before attaching the DXF file to a GASWorkS model.

A DXF file that contains system piping data can be imported to create the piping schematic.

Multiple background images of different file types can be attached to the same model. GASWorkS supports the use of BMP, DXF, JPG, KML, PDF, SHP, and TIF files as background images.

See Also

Display A Background Image
Graphically View A Model
Import A DXF File
Maximize The GDI Window
Measure A Distance
Move A Background Image
Scale A Background Image
Turn A DXF Layer Off
Zoom The GDI Image
Add A SHP Background Image

Summary

A step-by-step guide to attaching a shapefile (SHP) style background image to a model. The process is similar for attaching a KML background image.

Example

The example assumes that GASWorkS has been started.

1) Create The New Model

- From the File menu list, select the New item.
  - The Model Selection screen is displayed. Enter a name for the new model in the Model Name data field. Click the Continue command button.
- Note - If the GDI Window does not automatically display, select the View/Edit item from the Graphics menu list to display the GDI Window.
- Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls Toolbar.

2) Set The Model Coordinate Units

- From the Utilities menu list, select the Set Defaults item.
  - The Default Data Values screen is displayed. On the Dimensional Units data tab, select Feet from the Coordinates list. Click the Apply Dimensional Units Only command button to apply the new Coordinate units. Click the OK command button to clear the message. Click the Close command button to exit the screen.

3) Add The Background Image

- From the Graphics menu list, select the Background Settings item.
  - The Background Image Settings screen is displayed. Click the Attach New Image command button.
GASWorkS™ 10.0  

GDI Window Examples  

Table Of Contents

- The Attachment File Type screen is displayed. Select SHP - Shapefile Style GIS File from the list. Click the Continue command button.
- The File Selection screen is displayed. Use the Drives and Directories lists to navigate to the GASWorkS 10\Files directory. Select the SHP_MAIN.shp file. Click the Continue command button.
- The Background Image Settings screen is displayed again. The default settings for the SHP file will be fine for this example. Click the Apply command button to save the changes and attach the SHP image to the model.

4) Zoom The GDI Image

- Click the Zoom To Fit icon from the lower-left corner of the GDI Window.

Note - If the background image does not display in the GDI Display, go to the Display Controls Toolbar and move the mouse cursor over the Display Background Image icon. If the option is “off”, left-click on the icon to turn it “on”. Click the Zoom To Fit icon again. The background image should now be displayed in the GDI Display.

Notes & Considerations

- Attaching a KML background image follows roughly the same procedure as for a SHP style background image. The options and settings on the Background Image Settings screen are the same for both file types.
- Ensure that the proper Coordinate units have been set for the model before attempting to attach and/or scale any background images.
- The Origin Shift values determine the X and Y coordinates of the upper-left corner of the image. The default is set to (0,0). These values can be changed on the Background Image Settings screen. The background image can also be moved using the Move Background Image command. The scale should be established before establishing the position.
- The Scale Factor value determines the Drawing Unit-To-Coordinate Ratio of the background image. This value sets the number of distance units covered in each incremental change in coordinates. The Scale Background Image command can also be used to correct the scale.
- A SHP file background image can be projected from latitude and longitude to a planar coordinate system such as the State Plane Coordinate System. Select the Project To Model Coordinates option on the Background Image Settings screen to project the SHP file. If a projection file is not associated with the model, a message be displayed asking the User to specify a file.
The background image can be displayed in any of a number of colors by unselecting the Convert Colors To Gray option on the Background Image Settings screen. To avoid confusion, it is recommended to choose a color for the background image not being used for any of the model features.

The Line Weight and Line Style only apply to line type features. The Point Symbol Size and Point Symbol Style only apply to point type features.

SHP files containing arcs (lines), points, and polygon type geographic features can be attached as a background image.

Multiple background images of different file types can be attached to the same model. GASWorkS supports the use of BMP, DXF, JPG, KML, PDF, SHP, and TIF files as background images.

See Also

Display A Background Image
Graphically View A Model
Maximize The GDI Window
Move A Background Image
Project A Model
Scale A Background Image
Working With Shapefiles (SHP)
Zoom The GDI Image
Attach A Fitting To A Pipe

Summary

A step-by-step guide to attaching a fitting to a pipe.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

- Select a pipe by moving the mouse cursor over a pipe feature and left-click the mouse. The selected pipe will be highlighted.

- The Pipe Data will be displayed in the Data Panel. In the Attached Fittings section, next to the Fitting item, left-click the mouse on the Click To Add option.

  - The Fitting Selection screen is displayed. Select a fitting from the Full List. Click the Attach command button.

  - The selected fitting will be added to the Fitting list, and the Attached Fittings and Equivalent Length values will be updated.

  - Click the Apply Data Values command button to save any changes.

Notes & Considerations

- The Equivalent Length value under the Attached Fittings section of the Pipe Data is a sum of the equivalent lengths of all the fittings attached to the pipe. This value is added to the pipe’s Hydraulic Length when solving the model.

- To create a fitting as a graphic feature, use the Add Fitting command.

- Left-click in the white cell for any Fitting item to display a list. Either select Edit Fitting to change the type of fitting attached to the pipe, select Delete Fitting to remove the fitting from the pipe, or select Cancel to return the cell to displaying the type of fitting attached.

- The Pipe Fittings option on the Pipe Items data tab on the Text Display Settings screen can be selected to have pipes with attached fittings displayed with the text “Fittings Attached”. Also, the Pipe Size/Type Code text item will be followed by the text “(F)” for pipes with attached fittings.
See Also

Add A Fitting
Edit Pipe Data
Remove Attached Fittings
Select A Feature
Text Display Settings
Use The Data Panel
Automatically Pan & Zoom GDI Display

Summary

Move (pan) and zoom the image in the GDI Display using the mouse.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- From the Graphics menu list, select the Settings item.
- The Graphic Settings screen is displayed.
  - In the Options list, select the Automatically Pan & Zoom option.
  - Click the Apply command button to apply the new setting and return to the GDI Window.

Pan

- Move the mouse pointer to a point in the GDI Display. Click and hold the left mouse button.
- While holding down the left mouse button, move the mouse crosshair cursor to another point in the GDI Display. A line will be displayed from the first selected point. This line represents the distance and direction that the model image will be “dragged”. Release the left mouse button to move the image.

Zoom In

- Move the mouse pointer to a point toward the upper-left corner of the GDI Display. Click and hold the right mouse button.
- While holding down the right mouse button, move the mouse crosshair cursor to another point in the GDI Display below and to the right of the first point. A box will be displayed representing the zoom window. Release the right mouse button to zoom the image to the specified window.

Zoom Out

- Move the mouse pointer to a point toward the lower-right corner of the GDI Display. Click and hold the right mouse button.
While holding down the right mouse button, move the mouse crosshair cursor to another point in the GDI Display above and to the left of the first point. A line will be displayed in the GDI Display. The longer the line, the further the model image will be zoomed out. Release the right mouse button to zoom out the image.

Notes & Considerations

- The *Automatically Pan & Zoom* option cannot be used while a GDI Command is running. Use the *Scroll* icon to move the model image while a GDI Command is running.

- To return to the last view, use the *Zoom Previous* command.

See Also

- Move The GDI Image
- Zoom The GDI Image
Color Code By Query

Summary

A step-by-step guide to color code pipes by a data value, using pressure drop across the pipe.

Example

The example assumes that GASWorkS has been started.

1) Open A Model

- From the File menu list, select the Open item.
- The Model Selection screen is displayed.
  - Use the Drives and Directories lists to navigate to the GASWorkS 10\Files directory. Select the distribution demo.hdr model. The Model Name will be displayed in the Model Name data field. Click the Continue command button.

  - Note - If the GDI Window does not automatically display, select the View/Edit item from the Graphics menu list to display the GDI Window.

- Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls Toolbar.
- Click the Zoom To Fit icon from the lower-left corner of the GDI Window.

2) Solve The Model

- Click the Solve icon from the lower-right corner of the GDI Window.
- The Solution Data screen is displayed.
  - The default settings will be fine for this example. Click the Solve command button.
  - The Solution Log will be displayed. Review the contents. When finished, click the Close command button.
3) Color Code The Two Highest Pressure Drop Pipes

- Click the Color Display Settings icon from the Display Controls Toolbar.

- The Color Display Settings screen is displayed.
  
  - On the Color By Query data tab, left-click on the color panel to display the Color screen. Click “Red” as the color. Click the OK command button.

  - Click the Define Query Specifications command button.

  - The Query Specifications screen is displayed.
    
    - From the Where list, select Pipe Pressure Drop. From the Is list, select Max. In the To data list, type 2. Click the Perform Query command button.

    - A message will be displayed stating that 2 matches were found. Click the OK command button to clear the message and return to the Query Specifications screen.

    - Click the Close command button to return to the Color Display Settings screen.

  - Click the Apply Query Colors command button to return to the GDI Window.

- The main on Main St between First St and Second St, and the main on South St should be colored “Red”.

Notes & Considerations

- The colors set by this routine are only set temporarily. To save the color coding, use the Save Feature Colors command.

- Color settings can be overwritten by running additional Color Coding routines, such as the Trace routine.

- To return all of the feature colors to their original colors, use the Reset Feature Colors command.

See Also

Color Display Settings  
Maximize The GDI Window  
Save The Feature Colors  
Trace

Graphically View A Model  
Reset The Feature Colors  
Solve The Model  
Zoom The GDI Image
Color Code By Range

Summary

A step-by-step guide to color code pipes by a range of data values, using average pipe pressure.

Example

The example assumes that GASWorkS has been started.

1) Open A Model

- From the File menu list, select the Open item.
- The Model Selection screen is displayed.
  - Use the Drives and Directories lists to navigate to the GASWorkS 10\Files directory. Select the distribution demo.hdr model. The model name will be displayed in the Model Name data field. Click the Continue command button.
  - Note - If the GDI Window does not automatically display, select the View/Edit item from the Graphics menu list to display the GDI Window.
- Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls Toolbar.
- Click the Zoom To Fit icon from the lower-left corner of the GDI Window.

2) Solve The Model

- Click the Solve icon from the lower-right corner of the GDI Window.
- The Solution Data screen is displayed.
  - The default settings will be fine for this example. Click the Solve command button.
  - The Solution Log will be displayed. Review the contents. When finished, click the Close command button.
3) Color Code The Results

- Click the Color Display Settings icon from the Display Controls Toolbar.
- The Color Display Settings screen is displayed.
  - On the Range Colors data tab, select Pipe Pressure, Average from the Item list and select Psi from the Units list. Click the Allocate command button to create a color range. Click the Apply Range Colors command button to apply the colors to the model and return to the GDI Window.

4) Display The Color Legend

- Click the Display Color Legend icon from the Display Controls Toolbar.
  - The Color Legend will be displayed.

Notes & Considerations

- In this example, the pipe features in an existing model were colored to reflect their minimum pressure values. The pipe features (as well as the customer features and nodes) can also be color coded based on a number of other data items which are listed in the Items list on the Color By Range data tab on the Color Display Settings screen.

- This example used the Allocate method to create color ranges containing approximately the same number of features in each range. The Calculate method finds the highest and lowest value for the specified item, then creates eight approximately equal ranges, not necessarily containing the same number of features. The ranges can also be set manually by typing values into the To data fields; the From fields will autofill with the previous To value.

- The colors used for each range can be changed by left-clicking on a color panel. The Color screen is displayed. Select a color. Click the OK command button.

- The colors set by this routine are only set temporarily. To save the color coding, use the Save Feature Colors command.

- Color settings can be overwritten by running additional Color Coding routines, such as the Trace routine.

- To return all of the feature colors to their original colors, use the Reset Feature Colors command.
See Also

- Color Display Settings
- Display The Color Legend
- Graphically View A Model
- Maximize The GDI Window
- Reset The Feature Colors
- Save The Feature Colors
- Solve The Model
- Zoom The GDI Image
Determine An Appropriate Display Limit

Summary

Two methods for setting the Display Limit to show pipe text items when the model fills the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

Method 1 - Determine The Display Limit By Measurement

1) Zoom The GDI Image
   - Click the Zoom To Fit icon from the lower-left corner of the GDI Window.

2) Measure The Display Extent
   - Click the Measure Distance icon from the Utility Commands Toolbar.
     - At the First Point prompt, move the mouse crosshairs as close to the lower-left corner of the GDI Display as possible and left-click the mouse.
     - At the Next Point prompt, move the mouse crosshairs as close to the upper-right corner of the GDI Display as possible and left-click the mouse.
     - Right-click the mouse to end the routine.
     - The Measured Values screen is displayed. The measured distances are in the Coordinate units. Take note of the Absolute Distance value. Click the OK command button to clear the message.

3) Set The Display Limit Value
   - Click the Text Display Settings icon from the Display Controls Toolbar.
     - The Text Display Settings screen is displayed.
GASWorkS™ 10.0  GDI Window Examples

On the Pipe Items data tab, in the Display Limit data field enter the Absolute Distance value from Step 2 (or a number slightly larger). Click the Apply command button to save the changes.

**Method 2 - Automatically Determine The Display Limit**

1) Zoom The GDI Image
   - Click the Zoom To Fit icon from the lower-left corner of the GDI Window.

2) Set The Display Limit Value
   - Click the Text Display Settings icon from the Display Controls Toolbar.
   - The Text Display Settings screen is displayed.
     - On the Pipe Items data tab, double-click in the Display Limit data field. The number will change to the current diagonal extent of the GDI Display. Click the Apply command button to save the changes.

**Notes & Considerations**

- The Display Limit item is a measure of the extent of the GDI Display, taken from one corner of the display window diagonally to the opposite corner. The associated feature text will be visible only if the GDI Display is zoomed in below the Display Limit value. A value of zero (0) makes the text visible at all zoom levels.

- An appropriate Display Limit value depends on the model in the GDI Display. Properly setting the Display Limit helps to avoid having text items that cover up model features, and vice versa.

- The Display Limit value is saved to the model data. Creating a new model, or opening a different one, will change the Display Limit to that model’s saved or default value.

**See Also**

Measure A Distance
Text Display Settings
Zoom The GDI Image
Display The GDI Command List

Summary

Toggle the visibility of the GDI Command List.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Click the *GDI Command List* icon from the upper-right corner of the GDI Window.
  - If the Tool Palette is visible, it becomes hidden and the GDI Command List is displayed.
  - If the GDI Command List is visible, it becomes hidden.
  - If nothing is displayed in the lower right corner, the GDI Command List will be displayed.

Notes & Considerations

- This command has no item on the GDI Command List, nor any associated GDI Command Line codes.
- The lower-right corner of the GDI Window shows either the GDI Command List or the Tool Palette.

See Also

Execute A GDI Command
Use The Tool Palette
Enter GDI Coordinates

Summary

Describes the methods for entering or specifying the coordinates of a feature.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

Start by executing a command that requires coordinate entry. When prompted for a location, use one of the following methods.

Method 1 - Coordinate Entry

- Type a coordinate pair (X,Y) on the GDI Prompt Line and press the Enter key. Note - Ensure that the coordinate values are in the current Coordinate units. Do not include decimal values when typing the coordinates.

Method 2 - Graphic

- Move the mouse crosshairs to a point in the GDI Display and left-click the mouse.

Method 3 - Entered Distance & Angle

- Type the “@” symbol, followed by the length value, followed by the “<” symbol, followed by the angle value (@ length < angle) on the GDI Prompt Line and then press the Enter key.

  For Example: Type @500<90 and press the Enter key. This will draw a line of 500 Length units in length at an angle of 90 degrees clockwise from the Y-axis.

Method 4 - Entered Distance/Selected Angle

- Type the “@” symbol, followed by a distance (in Coordinate units), followed by the “<” symbol, followed by the question mark “?” symbol on the GDI Prompt Line and then press the Enter key.

  For Example: Type @500<? and press the Enter key. This will draw a line of 500 Length units in length at an angle to be determined.
At the Pick A Point To Establish The Angle prompt, move the mouse crosshairs to a point in the GDI Display, and left-click the mouse.

**Method 5 - Entered X-Y Distance**

- Type the “@” symbol, followed by an X-distance (in Coordinate units), followed by a comma “,”, followed by a Y-distance (in Coordinate units) on the GDI Prompt Line and then press the Enter key.

  *For Example:* Type @500, 500 and press the Enter key. This will draw a line to a point 500 Length units in the X-direction and 500 Length units in the Y-direction from the previous point.

**Method 6 - Node Entry**

- Type the letter “N” followed by the name of a node on the GDI Prompt Line and press the Enter key.

**Method 7 - Node Selection**

- If the Feature Snap is enabled, move the mouse crosshairs so that a node is within the snap target circle and left-click the mouse.

- If the Feature Snap is not enabled, move the mouse crosshairs near a node, hold down the Shift key, and left-click the mouse.

**Notes & Considerations**

- The X-coordinates represent the position on the horizontal axis. X-values start in the west at -99999999 and increase going east to 99999999. The Y-coordinates represent the position on the vertical axis. Y-values start in the south at -99999999 and increase going north to 99999999.

- The snap target is the product of the Feature Snap Ratio times the default Node Symbol Size. These values can be changed from the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list. When the Feature Snap is enabled, a graphic circle will be displayed around the mouse crosshairs with a radius equal to the snap target. If the mouse is left-clicked and a node is within the snap target circle, the node will be selected. If a location is entered as a coordinate pair on the GDI Prompt Line, and a node is within the snap target of the coordinates, the node will be selected.

- If more than one node is found within the snap target circle when a selection is made, the node with the lowest Record Number will be used.
See Also

Execute A GDI Command
Feature Snap
Execute A GDI Command

Summary

Descriptions of the methods for executing commands in the GDI Window.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

Method 1 - The GDI Toolbars

The left side of the GDI Window contains the GDI Toolbars. Each GDI Toolbar contains a set of GDI Commands grouped by functionality. These commands are represented on the toolbars by GDI Icons.

- Move the mouse pointer over a GDI Toolbar. The toolbar will expand and display the available GDI Icons.
- Move the mouse pointer over a GDI Icon and left-click the mouse.
- The associated GDI Command will be executed and the GDI Toolbar will collapse.

Method 2 - The GDI Command List

The GDI Command List contains a list of all of the GDI Commands available in GASWorkS. The GDI Command List can be displayed in two different formats - an alphabetical list or a command tree with certain commands grouped by functionality.

- If the GDI Command List is not displayed, click the GDI Command List icon from the upper-right corner of the GDI Window. The GDI Command List will be displayed in the lower-right corner of the GDI Window.
- The Alphabetic data tab shows a list of all of the GDI Commands in alphabetical order. Scroll through the list by using the scroll bar or by typing the name of a command in the Type Or Select A GDI Command data field - the list will scroll automatically to the first command that matches the entry in the data field. Select a command by left-clicking on the command name.
- The Grouped data tab shows the GDI Commands in a command tree grouped by functionality. A list item with a red toolbox icon indicates a group of commands; left-click on the plus sign (+) to expand the group. A list item with a gray tool icon indicates a GDI Command. Select a command by left-clicking on the command name.
**Method 3 - The GDI Command Line**

The GDI Command Line is located below the GDI Display in the lower portion of the GDI Window. GDI Commands are executed by typing their associated code in the GDI Command Line and pressing the *Enter* key. A complete list of codes can be found in the *Graphic Data Interface (GDI)* section of the GASWorkS User’s Manual. The codes can also be found in this guide in the *Notes & Considerations* section of each GDI Command topic. Codes for GDI Commands are not case-sensitive and can contain spaces in the syntax.

**Method 4 - The Tool Palette**

The Tool Palette can be customized by the User to display the most often used GDI Commands. If commands have been added to the Tool Palette, click a GDI Icon to execute the command.

**Notes & Considerations**

- Executing a command while a feature is selected will execute the command routine using the selected feature. For example, if a pipe is selected and the *Delete Pipe* command is executed, the selected pipe will be deleted without any prompts. If the selected feature does not match the type required by the command, the feature will be unselected and the command will be executed normally. For example, selecting a pipe then executing the *Delete Customer* command will not delete the pipe.

- Some GDI Commands do not contain any prompts or messages. These are noted in the examples in this guide. To avoid repeating a command unnecessarily, it is best to check for the expected results of a command after executing it.

- The GDI Command List and the Tool Palette will be displayed in the same space in the lower-right corner of the GDI Window. Only one of these can be visible at any one time.

- To cancel (terminate) a running GDI Command, click the *Cancel* icon located in the upper-left corner of the GDI Window.

**See Also**

- Cancel The Current GDI Command
- Display The GDI Command List
- Display The Tool Palette
- Use The Tool Palette
Graphically View A Model

Summary
Display the GDI Window when it is hidden.

Example
The example assumes that GASWorkS has been started, a model is open, and the GDI Window is not displayed.

- From the Graphics menu list, select the View/Edit item.
- The GDI Window will be displayed. If the model is not visible in the model image, click the Zoom To Fit icon from the lower-left corner of the GDI Window.
- To close the GDI Window, click the Close GDI Window icon from the GDI Window Controls Toolbar.

Notes & Considerations
- If no model is open, selecting the View/Edit item will bring up the Model Selection screen, and the User will be able to select a model to open and view.
- To close a model, select the Close item from the File menu list.

See Also
Close The GDI Window
Zoom The GDI Image
Grips

Summary

- How to enable and use grips.
- In this example, grips will be used to move a pipe end and to move text associated with a pipe.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one pipe is present in the model.

1) Enable Grips

- From the Graphics menu list, select the Settings item.
- The Graphic Settings screen is displayed.
  - In the Options section, select the Display Grips option. Click the Apply command button to close the screen.

2) Display Pipe Text & Leader Lines

- Click the Text Display Settings icon from the Display Controls Toolbar.
- The Text Display Settings screen is displayed.
  - On the Pipe Items data tab, set the following values:
    Display Pipe Text Items = Select
    Leader Lines On Moved Text = Select
    *Make sure that at least one pipe text item is selected from the Items list.
  - Click the Apply command button to save the changes.

3) Move A Pipe End

- Select a pipe by moving the mouse cursor over a pipe and left-clicking the mouse. The selected pipe will be highlighted.
Two small squares will be displayed over the pipe ends. These are the grips for the pipe ends. Left-click on one of these squares.

- At the *New Location* prompt, move the mouse cursor to another point within the GDI Display and left-click the mouse. The dashed line shows the new pipe route.

- *Note* - If a new node is created and the *Allow Data Entry During New Feature Entry* graphic settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse to accept the default data values. If changes are made, click the *Apply Data Values* command button.

- If the *Automatically Update Pipe Length* graphic settings option is selected, the *Hydraulic Length* of the pipe will be recalculated. If not, a message will be displayed asking whether to update the hydraulic *Pipe Length*. Either click the *Yes* command button to update the length, or click the *No* command button to preserve the previous value.

- The selected pipe will be redrawn to the new location.

4) **Move The Pipe Text**

- Select a pipe by moving the mouse cursor over a pipe and left-clicking the mouse. The selected pipe will be highlighted.

- A small square will be displayed in the center of the pipe. This is the grip for the pipe text. Left-click on the square.

- At the *New Text Location* prompt, move the mouse cursor to another point within the GDI Display and left-click the mouse. The square indicates the new text location.

- The text is now displayed at the selected location. A leader line is drawn from the text location to the associated pipe.

**Notes & Considerations**

- This example uses pipes, but grips can be used to move customers, nodes, service taps, User Graphics (Images, Lines, Symbols), User Text, and vertices, as well as any text associated with those features.

- When moving a node, take care not to select the connected pipe. If a pipe is selected, using the grip will move the pipe end, not the node. If a pipe is selected by mistake, press the *Esc* key then left-click on the node to select the node.

- If the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled, click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.
See Also

Select A Feature
Text Display Settings
Undo The Last Data Or Graphic Change
Use The Data Panel
Import A DXF File (Example)

Summary

Create a model from a DXF file by importing the pipe line work in the DXF file. The DXF file will also be used as a background image to the model. The imported model will be checked using the Trace routine. Then the model will be solved and the results reviewed.

Example

*Note* - It is not required, but if a model is open, it is a good idea to close it before importing the new data to prevent changes from being made to the open model’s default data settings. Select the *Close* item from the *File* menu list to close an open model.

1) Set The Default Data Values

- From the *Utilities* menu list, select the *Import* item.
- The Model Selection screen is displayed. Type a new name for the model in the *Model Name* data field. Click the *Continue* command button.
  - The Import screen is displayed. Click the *Set Default Data Values* command button. The Default Data Values screen is displayed.
    - On the *Dimensional Units* data tab, set the following values:
      
      Coordinates = **Feet** [Metres]
      Customer Load = **Btu/hr** [M3h]
      Diameter = **Inches** [Centimetre]
      Efficiency = **Decimal**
      Elevation = **Feet** [Metres]
      Heating Value = **Btu/cf** [KJoules/m3]
      Length = **Feet** [Metres]
      Node Load = **Mcfh** [M3d]
      Pipe Flow Rate = **Mcfh** [M3d]
      Pressure = **Psi** [Bar]
      Temperature = **Fahrenheit** [Celsius]
      Velocity = **Feet/sec** [Metres/sec]
      Viscosity = **Lbm/Ft-sec** [Pascal-sec]
**On the Hydraulic Data tab, set the following values:**

- **Pipe Size/Type = 99 Inches [Centimetre]**
  
  *Note* - We will use this value to help identify pipes where the diameter is not automatically assigned during the Import routine.

- **Pipe Equation = IGT-Improved**

- **Pipe Efficiency = 0.95 Decimal**
  
  *Allow Pipe Sizing = Unselect*

- **Node Pressure = 0 Psi [0 Bar]**
  
  *Value Is Unknown = Select*

- **Node Base Load = -0.5 Mcfh [-14 M3d]**
  
  *Value Is Unknown = Unselect*

  *Note* - This value is arbitrary just to get started with.

- **Node Elevation = 0 Feet [0 Metres]**

- **Node Temperature = 60 Fahrenheit [15 Celsius]**
  
  *Value Is Unknown = Unselect*

**On the Gas Properties data tab, set the following values:**

- **Specific Gravity = 0.6**

- **Viscosity = 0.000007 Lbm/Ft-sec [0.0000107 Pascal-sec]**

- **Heating Value = 1000 Btu/cf [28 KJoules/m3]**

- **Specific Heat Ratio = 1.3**

  *Values Are Unknown = Unselect*

- Click the *Close* command button.

---

**2) Import The DXF File**

- On the Import screen, select the **DXF (Drawing Exchange Format) File** item from the *File Type* list. Click the *Import* command button.

  - The File Selection screen is displayed. Use the *Drives* and *Directories* lists to navigate to the GASWorkS 10\Files directory. Select the *town.dxf* file. Click the *Continue* command button.

  - The Import Specifications screen is displayed.

    - On the *Pipe Settings* data tab, click the *Clear Pipe Layer Assignments* command button. Set the following values:

      - **Pipe Layers -**
        
        *Layer Assignment = Pipe Size*
        
        - Main_2P = 2P
        - Main_2S = 2S
        - Main_3P = 3P
        - Main_4P = 4P
        - Main_6P = 6P
Fuzzy Tolerance = 1
Arc Resolution = 0
Pipe Length Units = Feet [Metres]
Assign Entity Handle To Pipe Link ID Number = Unselect

Valve Node Layer = VALVES

- On the Other Settings data tab, set the following values:

  Drawing Coordinate Units = Feet [Metres]
  Origin Shift: X = 0 Y = 0

- Click the Continue command button.

- The Import screen is displayed again updating the progress of the Import routine. When the routine is complete, click the Close command button to return to the Graphic Data Interface (GDI) Window.

- Note - If the GDI Window is not automatically displayed, select the View/Edit item from the Graphics menu list to display the GDI Window.

- Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls Toolbar.

- Zoom the model image to fill the GDI Display using the Zoom To Fit icon from the lower-left corner of the GDI Window.

3) Set The Graphic Settings

- From the Graphics menu list, select the Settings item.

- The Graphic Settings screen is displayed.

  - In the Settings section, set the following values:

    Node Symbol Size = 1% Of Display Width

  - In the Options section, select the Allow Data Entry During New Feature Entry option.

  - Click the Apply command button.
4) Attach The Background Image

- From the Graphics menu list, select the Background Settings item.
- The Background Image Settings screen is displayed.
  - Click the Attach New Image command button.
    - The Attachment File Type screen is displayed. Select DXF - Drawing Exchange Format Style CAD File from the list. Click the Continue command button.
    - The File Selection screen is displayed. Use the Drives and Directories lists to navigate to the GASWorkS 10\Files directory. Select the town.dxf file. Click the Continue command button.
- The Background Image Settings screen is displayed again. Click the Apply command button.
- **Note** - If the background image does not display in the GDI Display, click the Display Background Image icon from the Display Controls Toolbar. The background image should now be visible.

5) Check & Edit The Model Connectivity

Use the Trace routine to check the model connectivity.

- Click the Trace icon from the Utility Commands Toolbar.
- The Trace Specifications screen is displayed. Set the following values:
  - Trace Style = Trace All Directions
  - Start Trace At = A Node
  - Trace Highlight Color = Red
    - **Note** - Click in the color panel. The Color screen is displayed. Select the color “Red”. Click the OK command button.
- Click the Trace command button.
  - For the Starting Node, select the node on the very south end of the pipe extending south at the center of the system (this is the supply end of the supply line), Node 185.

Notice that the Trace only colors the pipe from Node 185 to Node 180. The rest of the system should have remained blue. To see what’s going on, zoom into the section of the system where the color changes. This is the area of the town border station.
Click the **Zoom Window** icon from the **View Controls Toolbar**. Left-click the mouse slightly to the northwest of the desired area to set the first corner of the zoom window. Left-click the mouse slightly to the southeast of the desired area to set the second corner of the window.

The regulator between the supply line and the distribution system is missing.

Click the **Add Regulator** icon from the **Graphic Construction Commands** toolbar.

- At the **From (Upstream) Node Location** prompt, hold down the **Shift** key while left-clicking the mouse on **Node 180**. **Note** - Holding down the **Shift** key “snaps” the pipe end to the existing node.

- At the **To (Downstream) Node Location** prompt, hold down the **Shift** key while left-clicking the mouse on **Node 175**.

- At the **Regulator Size & Type** prompt, select **Universal** from the list.

- At the **Set Pressure Units** prompt, select **Psi [Bar]** from the list.

- At the **Set Pressure** prompt, type **20 [1.4]** on the GDI Prompt Line and press the **Enter** key.

- At the **Facility Type** prompt, select **UnSpecified** from the list.

- At the **New Pipe Data** prompt, right-click the mouse to accept the data values and finish the process.

**Note** - If the new pipe is not displayed with a regulator symbol, click the **Display Pipe Symbols** icon from the **Display Controls Toolbar**.

The new pipe segment should now be drawn as a regulator symbol. The inlet side of the regulator is always to the left of the control head as it is pointing up. The inlet side of the regulator must be the same as the From Node, and the inlet must always be connected to the high pressure (upstream) system.

Set the **Pressure** as “Known” for the outlet node of the regulator.

- Left-click on the outlet node, **Node 175**.

- The Node Data will be displayed in the Data Panel. In the **Hydraulic Data Items** section, for the **Pressure Known** item click until **Yes** is displayed. Click the **Apply Data Values** command button to save the changes.
6) Recheck The Connectivity

- Click the Zoom To Fit icon from the lower-left corner of the GDI Window.
- Use the Trace routine again to recheck the connectivity.

Notice anything wrong? The lateral pipe from Node 5 to Node 10 is still colored blue.

- Use the Zoom Window icon from the View Controls Toolbar to view the area around the south end of the lateral. The end at Node 5 is not connected to the header pipe.

Let’s fix the connectivity using the Tap Pipe command.

- Click the Tap Pipe icon from the Graphic Edit Commands Toolbar.
  - At the Select Pipe To Tap prompt, left-click the mouse on the header pipe (Node 35 to 170).
  - At the Tap Location prompt, left-click the mouse on Node 5.
- The header pipe will now be split into two pipe segments joined at Node 5.

- Retrace from Node 5. All pipes connected to the node should now be colored in the Trace Highlight Color (Red).
- Perform a Zoom To Fit to confirm that the entire system is now red.

7) Set The Non-Default Pipe Data

Set the correct length for the supply line.

- Left-click on the supply line (the southern most line in the south-central portion of the system, running north and south).
- The Pipe Data will be displayed in the Data Panel.
  - In the Hydraulic Data Items section, set the following values:
    - Hydraulic Length = 10 [16]
    - Length Units = Miles [Kilometres]
- Click the Apply Data Values command button.
Set the pressure on the supply end of the supply line.

- Left-click on the node at the south end of supply line, **Node 185**.
  - The Node Data will be displayed in the Data Panel. In the **Hydraulic Data Items** section, set the following values:
    - Pressure = **200** [13.8]
    - Pressure Units = **Psi** [Bar]
    - Pressure Known = **Yes**
    
    *Note* - The **Base Load Known** value should automatically be set to “No”.
  
- Click the **Apply Data Values** command button.

This example ends here. Other help topics explain the next steps from this point. The User can add customers, solve the model, check the results, and refine and calibrate the model.

**Notes & Considerations**

- In this example, an existing DXF file was used as the basis for the model. The pipes were snapped together and broken at each intersection. The pipes were accurately grouped on the appropriate layers. However, drawings are not always this well prepared. GASWorkS provides various tools for editing the piping data after it has been imported. However, it is best to make any graphic revisions in the original DXF file. That way, if the drawing ever needs to be imported again, the corrections will not need to be repeated.

- This drawing was assumed to be to scale. If a drawing isn’t to scale, GASWorkS can scale and rotate it after it is imported. Ideally, the original drawing would be scaled in the application used to create the DXF file. This would ensure that the file would be properly scaled the next time it is used. If the drawing is scaled in GASWorkS after it has been imported, the background image would not display properly unless it was also scaled.

- Here are a few tips to consider when preparing a drawing for use with GASWorkS:
  - Create the drawing to scale.
  - Use decimal or engineering notation for lengths - avoid using architectural notation.
  - Snap all line (pipe) ends together.
  - Break lines (pipes) at intersections where the intersecting lines (pipes) are connected.
  - When practical, group the piping on separate layers based on size and material type.
  - Only place lines that represent pipes on the pipe layer - avoid including symbols or blocks on the pipe layer.
  - If valve nodes are included in the DXF file, place them on a separate layer using a consistent block symbol to identify their locations.
Only a cursory check of the pipe sizes and connectivity was made in this example. Before actually using a model created by importing, each pipe size and the pipe connectivity should be carefully checked in detail. The Flag Unbroken Intersections command is useful for finding a variety of additional connectivity errors not generally discovered by only using the Trace routine.

Only generic loads were applied when the model was imported. The actual system loads would need to be determined and accurately assigned before using an imported model to make any decisions.

As with any existing system, once the model data has been checked and the loads accurately assigned, the model should be calibrated against actual field data. The calibrated model can then be used as the basis for additional analysis and what-if scenarios.

In this example, one regulator was installed at the end of the supply line. This regulator represented the “regulator station”. For most models of this nature, this representation is adequate. If a more detailed station analysis is required, more details of the regulator station can be added to the model, or a separate detail model of the regulator station can be created.

When including a regulator in a model, the Set Pressure value must be entered. The outlet and inlet pressures can be “Known” or “Unknown”. However, if the outlet pressure is “Unknown”, its calculated value will be based on the Set Pressure and the regulator characteristics. Generally, the load value for the inlet and outlet of a regulator is set to zero (0) and “Known”.

See Also

Add A Regulator
Display A Background Image
Display The Pipe Symbols
Edit Node Data
Edit Pipe Data
Execute A GDI Command
Flag Unbroken Intersections
Graphically View A Model
Import A DXF File
Maximize The GDI Window
Select A Feature
Tap A Pipe
Trace
Use The Data Panel
Zoom The GDI Image
Import A GASWorkS 9.0 Property Table

Summary

How to import a previously created GASWorkS 9.0 Property Table.

Example

The example assumes that GASWorkS has been started and a model is open.

- From the Edit menu list, select the Property Tables item.
- The Property Table Report will be displayed.
  - Select the data tab associated with the desired Property Table type to import.
  - Click the Open icon.
    - The File Selection screen is displayed. Use the Drives and Directories lists to navigate to the directory containing the desired GASWorkS 9.0 Property Table. Select the file from the Files list. Click the Continue command button.
    - Click the Save icon to save the displayed contents to a new GASWorkS 10.0 Property Table.

Notes & Considerations

- When saving the imported Property Table contents to the new version, it is a good idea to change the name of the file; for example, add a “_90” suffix to the original file name to indicate that it is an imported Property Table.
- Use the Property Tables item from the Preferences submenu from the File menu list to change the current Property Table assignments.

See Also

None
Increase The GDI Image Display Speed

Summary

A list of suggestions to improve the graphic performance.

Notes & Considerations

- Several of the Graphic Settings can affect the display speed of the model image. To access the Graphic Settings screen, select the Settings item from the Graphics menu list. On the Graphic Settings screen, make the following changes:
  - Use solid style pipes - select “Solid” from the Pipe Line Style list.
  - Use narrower pipe line thickness - decrease the Pipe Line Thickness value.
  - The Refresh Increment controls how much of the model image is displayed while the image is refreshing. It is measured in terms of the percentage (%) of the image that has been updated. A value of 1 means that the model image will update for every 1% of the image that has been refreshed. Conversely, a value of 100 means that the model image will not update until the image has completely refreshed (the image will be blank until the refresh is complete). The small, incremental changes in the model image at lower Refresh Increment values might give the appearance of being faster, but the full image will be displayed more quickly at higher values.
  - Select the Ignore Pipes Outside GDI Display option.

- Customers, nodes, pipe symbols, flow arrows, User Graphics, and User Text all take time to display. Consider if all of these features need to be displayed in the model. See the various “Display” topics in this guide for details on how to display or hide various features.

- Text items in particular can slow the display of the model image. The Display Limit values on the Text Display Settings screen can limit the scale at which text items are displayed, preventing the screen from becoming cluttered with text and slowing down the display speed. Turn the text items “off” when they are not needed.

- Turn the display of background images “off” when not required. This can be done from the Background Image Settings screen. To access the screen, select the Background Settings item from the Graphics menu list. If a DXF background image is attached, try turning “off” the layers that contain text or redundant information.
See Also

Determine An Appropriate Display Limit
Display A Background Image
Text Display Settings
Turn A DXF Layer Off
Move The GDI Image

Summary

Pan the image in the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- Move the mouse cursor over the Scroll icon in the lower-left corner of the GDI Window. Left-click the mouse on one of the arrows to move the model image in the specified direction.

Notes & Considerations

- This command has no item on the GDI Command List nor any associated GDI Command Line codes.

- The Scroll icon can be used to move the model image even while another GDI Command is running.

- The Pan/Scroll Change - Horizontal and Vertical values control the amount that the model image moves, as measured in percent of the display width and height, respectively. These values can be set from the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.

- To return to the last view, use the Zoom Previous command.

See Also

- Automatically Pan & Zoom GDI Display
- Pan The GDI Image
- Zoom The GDI Image
Project A Model

Summary

A step-by-step guide for projecting latitude/longitude coordinates into a plane coordinate system.

Example

The example assumes that GASWorkS has been started.

1) Open A Model

- From the File menu list, select the Open item.
  - The File Selection screen is displayed. Use the Drives and Directories lists to navigate to the GASWorkS 10\Files directory. Select the projection demo.hdr model. Click the Continue command button.

- Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls Toolbar.

- Click the Zoom To Fit icon from the lower-left corner of the GDI Window.

2) Check The Latitude & Longitude Coordinate Values

- Left-click on the associated nodes to display the X and Y Coordinate values in the Data Panel. The Coordinate values will match those shown below in the table. Note -The decimal settings may need to be adjusted on the Report Options screen. To access the screen, select the Report Options item from the Report menu list.

<table>
<thead>
<tr>
<th>Node</th>
<th>Lat-Long (X,Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUPPLY</td>
<td>-104.817055, 38.856237</td>
</tr>
<tr>
<td>15</td>
<td>-104.815300, 38.856138</td>
</tr>
<tr>
<td>20</td>
<td>-104.815459, 38.853747</td>
</tr>
<tr>
<td>25</td>
<td>-104.812272, 38.856063</td>
</tr>
<tr>
<td>35</td>
<td>-104.812349, 38.853733</td>
</tr>
</tbody>
</table>
3) Project The Model

- To execute the Project Model Coordinates command, on the GDI Command Line type PRJ and press the Enter key.

- The Convert To Projected Coordinate System screen is displayed.

  - From the Conversion list, select Longitude/Latitude To Plane Coordinates.

  - From the File Type list, select ESRI Projection (*.prj).

  - Click the Browse command button. The File Selection screen is displayed. Use the Drives and Directories lists to navigate to the GASWorkS 10\Files directory. Select the projection demo.prj file. Click the Continue command button.

  - Select the Update Pipe Lengths option.

  - The contents of the projection file will be displayed in the Parameters panel. Make sure the Projection is “Lambert Conformal Conic”.

  - Click the Continue command button to proceed.

- A message will be displayed when the routine is complete. Click the OK command button to clear the message.

4) Check The Projection

- Check the results by confirming that the X and Y coordinates of the nodes match the table below.

<table>
<thead>
<tr>
<th>Node</th>
<th>Projected (X,Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUPPLY</td>
<td>3194639.36, 1373337.29</td>
</tr>
<tr>
<td>15</td>
<td>3195139.43, 1373305.12</td>
</tr>
<tr>
<td>20</td>
<td>3195100.73, 1372434.13</td>
</tr>
<tr>
<td>25</td>
<td>3196002.08, 1373284.31</td>
</tr>
<tr>
<td>35</td>
<td>3195986.41, 1372435.64</td>
</tr>
</tbody>
</table>
Plane coordinates are a method used in regional surveying, mapping, and design for representing geographic data using X-Y coordinates, which make for easier calculations of direction and distance than the more complex spherical coordinates of longitude and latitude. Examples of plane coordinate systems include the State Plane Coordinate System in the United States, the Ordinance Survey National Grid in the United Kingdom, and the Universal Transverse Mercator system worldwide.

Plane coordinate systems are typically broken into grids or zones to improve accuracy. Each zone is associated with a projection file that contains specific data for projecting coordinates within that zone. GASWorkS supports two types of projection files; “.prj” files from ESRI and “.wkt” files from EPSG. Make sure the projection file matches the zone that contains the model data, or the projection will not be accurate.

This example uses the projection file for the NAD1983 Colorado Central State Plane Coordinate grid. Projection files are specific to a coordinate system and grid. Using this projection file to project coordinates from a different system or grid will lead to errors.

The projection can be reversed by following the steps above and selecting “Plane Coordinates To Longitude/Latitude” from the Conversion list.

Projected coordinate systems can be in units of Meters, US Survey Feet, or International Feet. Ensure that the Coordinate units match the units in the projection file before proceeding.

If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

Maximize The GDI Window
Project To Plane Coordinates
Undo The Last Data Or Graphic Change
Use The Data Panel
Zoom The GDI Image
Query Specifications Screen

Summary

The Make Selection Set routine found in the various Data Reports, the Color-By-Query routine, and the various Flag Item routines allow the selection of data features based on a User specified selection criteria. These selection sets are created using the Query Specifications screen.

Notes & Considerations

- The following table lists the query operators available under the Is list. The Query routine will flag features that meet the definition of the selected operator. Not all operators are available for every data item.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Definition</th>
<th>Applies To</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal To - The value of the Where item is an exact match of the specified To value</td>
<td>Both numeric and string values.</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not Equal To - The value of the Where item does not match the specified To value</td>
<td>Both numeric and string values.</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less Than - The value of the Where item is less than the specified To value</td>
<td>Numeric values only.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater Than - The value of the Where item is greater than the specified To value</td>
<td>Numeric values only.</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less Than Or Equal To - The value of the Where item is less than or equal to the specified To value</td>
<td>Numeric values only.</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater Than Or Equal To - The value of the Where item is greater than or equal to the specified To value</td>
<td>Numeric values only.</td>
</tr>
<tr>
<td>Ends With</td>
<td>The value of the Where item ends with the specified To string</td>
<td>String values only.</td>
</tr>
<tr>
<td>Like</td>
<td>The value of the Where item contains the specified To string</td>
<td>String values only.</td>
</tr>
<tr>
<td>Max</td>
<td>The To number of features that have the highest values of the Where item</td>
<td>Numeric values only.</td>
</tr>
<tr>
<td>Min</td>
<td>The To number of features that have the lowest values of the Where item</td>
<td>Numeric values only.</td>
</tr>
</tbody>
</table>
### Operator Definition Applies To

<table>
<thead>
<tr>
<th>Operator</th>
<th>Definition</th>
<th>Applies To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Like</td>
<td>The value of the <em>Where</em> item does not contain the specified <em>To</em> string</td>
<td>String values only.</td>
</tr>
<tr>
<td>Starts With</td>
<td>The value of the <em>Where</em> item starts with the specified <em>To</em> string</td>
<td>String values only.</td>
</tr>
</tbody>
</table>

**See Also**

- Flag Customers By Item Value
- Flag Nodes By Item Value
- Flag Pipes By Item Value
Repeat A GDI Command

Summary

Execute the last GDI Command used in the GDI Window.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a GDI Command has previously been executed.

Method 1 - The Enter Key

Pressing the Enter key while the GDI Window is active may repeat the last GDI Command if no other GDI Command is currently running. Note - The GDI Command Line needs to be empty.

Notes & Considerations

● GDI Commands cannot be repeated while another command is running.

See Also

Execute A GDI Command
Save The GDI Image As A BMP File

Summary

Save the current image in the GDI Image as a bitmap (BMP) file.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- From the Graphics menu list, select the Save GDI Image As BMP item.

- The File Selection screen is displayed. Enter a Filename for the BMP image. Click the Continue command button.

- A message may be displayed when the GDI Image has been saved. Click the OK command button to clear the message.

Notes & Considerations

- Make sure that the desired features of the model image to be saved are currently displayed in the GDI Display. Use the various “Zoom” commands, the Scroll icon, or the Automatically Pan & Zoom graphic settings option to display the desired features.

- Once the GDI Image has been saved as a BMP file, the file can be used with other applications, or it can be placed into a document or presentation.

See Also

Automatically Pan & Zoom GDI Display
Move The GDI Image
Zoom The GDI Image
Select A Feature

Summary

Use the mouse to select different types of model features in the GDI Display to view/edit data, or as part of another routine.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

Select The Nearest Feature

Left-click the mouse within the GDI Display. The selection routine will find the model feature closest to the selected point.

Select A Customer

Hold either the Ctrl key or the “C” key and left-click the mouse within the GDI Display. The selection routine will find the customer closest to the selected point.

Select A Node

Hold either the Shift key or the “N” key and left-click the mouse within the GDI Display. The selection routine will find the node closest to the selected point.

Select A Pipe

Hold the “P” key and left-click the mouse within the GDI Display. The selection routine will find the pipe closest to the selected point.

Select A User Text Feature

Hold the Alt key and left-click the mouse within the GDI Display. The selection routine will find the User Text feature closest to the selected point.
Select Multiple Features

Polygon -
While holding down the “P” key, left-click the mouse within the GDI Display to set the start point of the selection polygon. Release the “P” key, then move the mouse pointer to another point in the GDI Display. Left-click the mouse to set the next vertex. Continue adding vertices to the selection polygon as needed. When finished, right-click the mouse or press the “C” key to close the polygon. Any pipes completely inside the selection polygon will be highlighted.

Window -
While holding down the “W” key, left-click the mouse within the GDI Display to set the upper-left corner of the selection window (rectangle). Release the “W” key, then move the mouse pointer to another point in the GDI Display. Left-click the mouse to set the lower-right corner of the selection window (rectangle). Any pipes completely inside the selection window will be highlighted. Note - Holding the Shift key has the same effect as holding the “W” key.

Notes & Considerations

● If more than one feature of the same type exists in the same location, the feature with the highest Record Number is selected. Use the “Move” command associated with that feature type to relocate one feature and allow the other feature(s) to be selected.

● Executing a command while a feature is selected will execute the command routine using the selected feature. For example, if a pipe is selected, then the Delete Pipe command is executed, the selected pipe will be deleted without any prompts. If the selected feature does not match the type required by the command, the feature will be unselected and the command will be executed normally. So, selecting a pipe, then executing the Delete Customer command will not delete the pipe.

● When a command is running and calls for the User to select a certain type of feature, left-clicking the mouse anywhere in the GDI Display will cause the selection routine to find the specified feature closest to the selected point. This can lead to unexpected results, such as selecting a feature that is off-screen.

● To make the intended feature easier to select, it may be necessary to move or zoom the model image to reduce congestion or increase detail. Use the various “Zoom” commands, the Scroll icon, or the Automatically Pan & Zoom Graphic Settings feature.

See Also

Automatically Pan & Zoom GDI Display
Move The GDI Image
Zoom The GDI Image
Set A Feature’s Dimensions

Summary

Describes the different ways to set a model features (User Graphic, User Table, or User Text) dimensions (width, height, and rotation) in the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a GDI Command is running that requires the dimension of a model feature to be set.

Rotation

Graphic -
Move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the orientation of the associated model feature.

Default -
Type “D” (not case-sensitive) on the GDI Prompt Line and press the Enter key. This will set the text rotation to its default value.

Value Entry -
Type a value (in degrees clockwise from the Y-axis) on the GDI Prompt Line and press the Enter key. The orientation of the associated model feature will be set to the entered angle.

Height

Graphic -
Move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The height of the feature will be set equal to the length of the line that is displayed in the GDI Display.

Default -
If a previous GDI Command created a new node, those coordinates will be displayed on the GDI Prompt Line. Right-click the mouse or press the Enter key to select this location as the From Node.

Value Entry -
Type a value (in Coordinate units) on the GDI Prompt Line and press the Enter key. The height of the feature will be set to the entered value.
**Entered Distance/Selected Angle -**
Type the “@” symbol, followed by a distance (in Coordinate units), followed by the “<” symbol, followed by the question mark “?” symbol on the GDI Prompt Line and then press the Enter key. At the Pick A Point To Establish The Angle prompt, move the mouse crosshairs to a point in the GDI Display, and left-click the mouse. The To Node will be placed at the entered distance from the last point and in the selected direction.

**Width**

**Graphic** -
Move the mouse crosshairs to a point within the GDI Display and left-click the mouse. The width of the feature will be set equal to the length of the line that is displayed in the GDI Display.

**Value Entry** -
Type a value (in Coordinate units) on the GDI Prompt Line and press the Enter key. The width of the feature will be set to the entered value.

**Notes & Considerations**

None

**See Also**

Enter GDI Coordinates
Set A Feature’s Location

Summary

Describes the different ways to set a model features (node, User Graphic, User Text or vertex) location in the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and a GDI Command is running that requires the location of a model feature to be set.

Any Model Feature

Graphic -
Move the mouse crosshairs to a point in the GDI Display and left-click the mouse. The feature will be placed at the selected location.

Coordinate Entry -
Type a coordinate pair (X,Y) on the GDI Prompt Line and press the Enter key. The feature will be placed at the entered coordinates.

Entered Distance/Angle -
Type the “@” symbol, followed by a distance (in Coordinate units), followed by the “<” symbol, followed by a direction (in degrees clockwise from the Y-axis) on the GDI Prompt Line and press the Enter key. The To Node will be placed at the entered distance and angle from the From Node location.

Entered X-Y Distance -
Type the “@” symbol, followed by an X-distance (in Coordinate units), followed by a comma “,”, followed by a Y-distance (in Coordinate units) on the GDI Prompt Line and then press the Enter key. The To Node will be placed at the entered distance from the last point.

Node Specific

Default -
If a previous GDI Command created a new node, those coordinates will be displayed on the GDI Prompt Line. Right-click the mouse or press the Enter key to select this location as the From Node.
Entered Distance/Selected Angle -
Type the "@" symbol, followed by a distance (in Coordinate units), followed by the "<" symbol, followed by the question mark "?" symbol on the GDI Prompt Line and then press the Enter key. At the Pick A Point To Establish The Angle prompt, move the mouse crosshairs to a point in the GDI Display, and left-click the mouse. The To Node will be placed at the entered distance from the last point and in the selected direction.

Node Entry -
Type “N” (not case-sensitive) followed by the Name of a node on the GDI Prompt Line and press the Enter key. This will select the existing node as the From Node.

Node Selection -
If the Feature Snap is enabled, move the mouse crosshairs so that a node is within the snap target circle and left-click the mouse. If the Feature Snap is not enabled, move the mouse crosshairs near a node, hold down the Shift key and left-click the mouse. The selected node will be the From Node.

Text Specific

Automatic -
Type “A” (not case-sensitive) on the GDI Prompt Line and press the Enter key. This will set the text to its default location and end the command.

Notes & Considerations

None

See Also

Enter GDI Coordinates
Set The GDI Coordinate Units

Summary

Establish the Coordinate units for the GDI Display.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

- From the Utilities menu list, select the Set Defaults item.

- The Default Data Values screen is displayed.

  - On the Dimensional Units data tab, select a dimensional unit from the Coordinates list.

  - Either click the Apply Dimensional Units Only command button to apply the specified dimensional units to the model, click the Apply All Values command button to apply the values from all of the tabs to the model, or click the Close command button to return to the GDI Window.

Notes & Considerations

- The Coordinate units are saved to the model data. Creating a new model, or opening a different model, will change the Coordinate units to that model’s saved or default value.

- Click the Save As Default command button from the Graphic Settings screen to use the current Coordinate units as the default value when a new model is created. To access the screen, select the Settings item from the Graphics menu list.

- Changes to the Coordinate units do not change the scale of the model image. For example, if the Coordinate units are changed from Feet to Inches, a distance that was 12 Feet will now be 12 Inches without any change in the appearance of the model image. Use the Shift Model Coordinates command to rescale the model image contents.

- The Coordinate units are not the same as the Length units. The Coordinate units only affect distances as scaled or measured in the GDI Display. When a new pipe is added, the graphic length in Coordinate units is converted to its equivalent value in Length units to calculate the Hydraulic Length value. When entering relative distances during pipe entry, enter the value in Length units.
See Also

Shift The Model Coordinates
Use The Data Panel

Summary

View or change data associated with model features (including customers, nodes, pipes, User Graphic Images, User Graphic Lines, User Graphic Symbols, User Text, vertices) from the GDI Window.

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and at least one feature is present in the model.

- Left-click on a model feature. The Data Panel will be displayed to the right of the GDI Display. One or more of the following sections will be displayed in the Data Panel:

  - The top of the Data Panel always displays the *Record Number*, *Internal ID Number*, and any other identifying information. (All features)

  - The *Hydraulic Data Items* section contains values that will be used to compute a solution to the model. (Customers, Nodes, and Pipes)

  - The *Data Items* section contains values that control the appearance of non-hydraulic features in the GDI Display. (User Graphic Images, User Graphic Lines, User Graphic Symbols, and User Text)

  - The *Graphic Data Items* section contains values that control the appearance of hydraulic features in the GDI Display. (Customers, Nodes, and Pipes)

  - The *Text Display Items* section contains values that determine the appearance of the associated text. (Customers, Nodes, and Pipes)

  - The *Miscellaneous Data Values* section contains the *Facility Type* and *Edit Date* of the selected feature. (All features)

  - The *Attribute Data Values* section contains data from a linked database file, if one is present. If not, the *Link To Database* item will have a value of “No”. (Customers and Pipes)

  - The *Calculated Values* section contains values computed by GASWorkS. These items cannot be directly edited, but can be changed by editing the data values used to calculate them. (Customers, Nodes, and Pipes)

  - The *Actions* section contains a list of GDI Commands associated with the selected feature. Left-click on one of the commands to execute. (All features)
If changes have been made, click the Apply Data Values command button.

Notes & Considerations

- Select “Default from the list for the Symbol Color, Symbol Style, Symbol Size Style, or Text Rotation items to use the specified default values for those items. The default values for the Symbol Color are set from the Color Display Settings screen. The default values for the Symbol Style and Symbol Size are set from the Graphic Settings screen. The default values for the Text Rotation are set from the Text Display Settings screen.

- If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon to restore the original configuration. To access the option, select the Settings item from the Preferences submenu from the File menu list.

See Also

- Color Display Settings
- Edit Customer Data
- Edit Node Data
- Edit Pipe Data
- Edit A User Graphic Image
- Edit A User Graphic Line
- Edit A User Graphic Symbol
- Edit User Text
- Select A Feature
- Text Display Settings
- Undo The Last Data Or Graphic Change
Use The Mass Update Routine

Summary

A step-by-step guide to using the Mass Update routine. The example below will change the Symbol Style for all the customers that have a Unit Count greater than 1.

Example

The example assumes that GASWorkS has been started.

1) Open A Model

- From the File menu list, select the Open item.
  - The Model Selection screen is displayed. Use the Drives and Directories lists to navigate to the GASWorkS 10\Files directory. Select the distribution_demo.hdr model. Click the Continue command button.
  - Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls Toolbar.
  - Click the Zoom To Fit icon from the lower-left corner of the GDI Window.

2) Mass Update

- From the Edit menu list, select the Mass Update item. The Mass Update Specifications screen is displayed.
  - In the Value Setting section, set the following values:
    - Item Type = Customer Model Data
    - Set = Symbol Style
    - Equal To = Box - Hollow
  - In the Search Specification section, set the following values:
    - Apply Only To A Selection Set = Select
    - Item Type = Customer Model Data
    - Where = Unit Count
    - Is = > (Greater Than)
    - To = 1
Click the Update command button to proceed.

A message will be displayed stating that 5 records were updated. Click the OK command button to clear the message and return to the Mass Update Specifications screen.

Click the Close command button to return to the GDI Window.

Notes & Considerations

The meanings of the search operators are:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Definition</th>
<th>Applies To</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal To - The value of the Where item is an exact match of the specified To value</td>
<td>Numeric and String values</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not Equal To - The value of the Where item does not match the specified To value</td>
<td>Numeric and String values</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less Than - The value of the Where item is less than the specified To value</td>
<td>Numeric values</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater Than - The value of the Where item is greater than the specified To value</td>
<td>Numeric values</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less Than Or Equal To - The value of the Where item is less than or equal to the specified To value</td>
<td>Numeric values</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater Than Or Equal To - The value of the Where item is greater than or equal to the specified To value</td>
<td>Numeric values</td>
</tr>
<tr>
<td>Ends With</td>
<td>The value of the Where item ends with the specified To string</td>
<td>String values</td>
</tr>
<tr>
<td>Like</td>
<td>The value of the Where item contains the specified To string</td>
<td>String values</td>
</tr>
<tr>
<td>Max</td>
<td>The To number of features that have the highest values of the Where item</td>
<td>Numeric values</td>
</tr>
<tr>
<td>Min</td>
<td>The To number of features that have the lowest values of the Where item</td>
<td>Numeric values</td>
</tr>
<tr>
<td>Not Like</td>
<td>The value of the Where item does not contain the specified To string</td>
<td>String values</td>
</tr>
</tbody>
</table>
There are two methods to restore the model to the original configuration. Either click the *Restore* command button on the Mass Update Specifications screen, or if the *Allow Undo Of Data/Graphic Changes* preference settings option is enabled click the *Undo* icon to restore the original configuration. To access the option, select the *Settings* item from the *Preferences* submenu from the *File* menu list.

### See Also

- Edit Multiple Customers
- Edit Multiple Nodes
- Edit Multiple Pipes
- Edit Multiple User Graphic Lines
- Edit Multiple User Graphic Symbols
- Edit Multiple User Text
- Maximize The GDI Window
- Undo The Last Data Or Graphic Change
- Zoom The GDI Image
Use The Tool Palette

Summary

Add icons to the Tool Palette for another way to execute the associated GDI Commands.

Example

The example assumes that GASWorkS has been started, a model is open, and the GDI Window is displayed.

Add A GDI Command To The Tool Palette

From A GDI Toolbar (Example) -

- On the Graphic Construction Commands Toolbar, right-click the icon for Add Arc Pipe. The Tool Palette Menu will be displayed. Select the Add GDI Command To Tool Palette item.

- The icon will be displayed on the Tool Palette. The command can now be executed by left-clicking on the icon in the Tool Palette.

From The GDI Command List -

- Click on the GDI Command List icon so that the GDI Command List is displayed.

- In the list, left-click on a GDI Command to highlight the name. Right-click on the highlighted command to display the Tool Palette Menu. Select the Add Command To Tool Palette item.

- The icon will be displayed on the Tool Palette. The command can now be executed by left-clicking on the icon in the Tool Palette.

Display The Tool Palette

Click the Display Tool Palette icon from the upper-right corner of the GDI Window. The Tool Palette will be displayed in the lower-right corner of the GDI Window.

Note - If the Tool Palette is already displayed, clicking the Display Tool Palette icon will hide the Tool Palette. Click the icon again to display the Tool Palette.
Move A GDI Icon In The Tool Palette

Move the mouse cursor over the *Add Arc Pipe* icon on the Tool Palette. Click and hold the right mouse button to “select” the icon. While holding the right mouse button, move the mouse cursor to “drag” the icon to another position on the Tool Palette. Release the right mouse button to “snap” the icon into place.

Remove A GDI Icon From The Tool Palette

Right-click on the *Add Arc Pipe* icon on the Tool Palette. The Tool Palette Menu will be displayed. Select the *Remove Icon From Tool Palette* item. The icon will be removed.

Notes & Considerations

- The intent of the Tool Palette is to provide quick access to commonly used GDI Commands, based on a User’s selection.

- Commands that do not have an associated GDI Icon are assigned the default icon shown to the right. If tooltips are enabled, hovering the mouse cursor over an icon in the Tool Palette will display the command text.

- The number of GDI Commands that can be added to the Tool Palette is limited to the number that fits in the allotted space. If the Tool Palette is full, adding another command requires removing a command from the Tool Palette.

- Duplicate GDI Commands are not allowed on the Tool Palette. Attempting to add a command that is already on the Tool Palette will result in a message. Click the *OK* command button to clear the message.

- Adding a GDI Command to the Tool Palette when the Tool Palette is not visible will automatically display the Tool Palette in the lower-right corner.

- Icons on the Tool Palette can be arranged to suit the User’s preference. Consider placing the most commonly used icons in the same place, such as along the left edge of the Tool Palette. The lesser used commands might be better placed away from the most commonly used commands.

- The configuration of the Tool Palette is saved when GASWorkS is closed, and is not specific to a given model. This to allow a User to set up the Tool Palette once, then use that configuration across multiple models. The appearance of the Tool Palette, whether the Tool Palette is displayed or the GDI Command List is displayed, is saved with the model.

- To clear all GDI Icons from the Tool Palette, use the *Reset Tool Palette* command.
See Also

Display The Tool Palette
Reset The Tool Palette
Working With Shapefiles (SHP)

Notes & Considerations

- Shapefiles (SHP) are a type of exchange file used by a variety of GIS and AM/FM systems. A shapefile is actually a group of files with different content and extensions, all possessing the same base Filename. GASWorkS supports import, export, and viewing of shapefiles. A model can be created by importing an existing pipe file, or models may be exported to create shapefiles that can be viewed or further manipulated in a supporting third party application.

- The shapefile specification was developed by ESRI Inc. A technical description can be obtained from the ESRI website.

- The most basic shapefile set contains three individual files - the geographic data file (.shp), the attribute data file (.dbf), and the index file (.shx).

- The main “.shp” file will contain information about a single type of geographic entity - for example points, arcs, or polygons. The organization of the file records depends on the type of entity.

- The attribute data “.dbf” file is in dBase III format, and contains feature attributes for the records in the main file.

- The index “.shx” file contains information about the location of records within the main file.

- A basic GASWorkS model can be created by importing data from a shapefile containing arcs representing the pipes in the associated system. The Import routine will assign nodes at the beginning and end of the arc (pipe) segments found in the shapefile. The User can choose to have GASWorkS automatically assign data fields such as pipe size during the import, or can bring in the pipes and then manually set the fields later. More sophisticated models may be created by including customer features and isolation valves. Generally, node style shapefiles are not used.

- Once imported, the attribute data file can be linked to the GASWorkS model to allow non-model data to be viewed while working in the GDI Window. This is helpful for viewing items such as the customer address, pipe age, or cathodic protection information.

- The graphic contents of a shapefile can be displayed as a background to a GASWorkS model. Multiple files can be combined along with multiple image types.

- GASWorkS model data can be shared with outside applications supporting the shapefile format using its Export or Quick Export features.
See Also

Add A SHP Background Image
Export A SHP File - Customer, Node, Or Pipe
Import A SHP File - Customer
Import A SHP File - Pipe
Merge A SHP File - Service
Merge A SHP File - Valve
GeoMap Examples
General GeoMapping Information

Through its GeoMap functions, GASWorkS allows the use of geographic map services such as those provided by Google and Microsoft. The GeoMap functions allow roadway and satellite images from these services to be displayed as a background image to a GASWorkS model. The geolocating function allows a location to be found by address or geographic name. These functions can be helpful when building or maintaining a model.

You must have a continuous internet connection to have full use of the GeoMap functions. The displayed images are downloaded directly from the map service via an internet connection. The geolocation function requires internet access to the map service’s geolocating “engine”. The execution speed of the GeoMap functions will depend on the speed and quality of the internet connection being used.

The “map service” provides the images for display, and the engine for the geolocating service. The following services are supported:

Google Maps™
Microsoft Bing Maps™

In most cases, each map service uses different imagery of differing ages and resolution. For a specific area, one service may be more up-to-date than another. It may be necessary to use different services, in the same model, to get the coverage that you desire. Coverage may not be available for all areas.

Depending on the service selected, different features will be available for display including satellite imagery, roadways, or a combination of both.

Only one service may be used at a time.

To properly display a model over the GeoMap background image, the model must use the Web Mercator Projection (WMP). The WMP uses the World Coordinate System (WCS) values of Longitude and Latitude to identify locations. In the WMP, locations with a latitude further than about 85° north or south from the Equator are not supported.

In GASWorkS, the WMP is supported using the “Web L/L” dimensional unit. Location values must be entered in decimal degrees of Longitude (X) and Latitude (Y). Note that this coordinate entry order is reversed from the customary Latitude and Longitude convention. Generally, values to six decimals are required to accurately define a location.

If a model is using a plane coordinate system, it will need to be re-projected into the WCS before it can be used with the GeoMap functions. If the plane coordinate system is known, and an appropriate projection file is available, the model coordinates can be “re-projected” into WCS values using the Project Coordinates command. Once re-projected, it can be displayed using the Web L/L coordinate units.

See the User’s Manual for additional information on using and working with the GeoMap functions.
Attach A GeoMap Background To An Existing Model

Summary

A step-by-step guide to attaching a GeoMap background image to an existing model.

Example

The example assumes that GASWorkS has been started, and that an internet connection is active.

1) Open An Existing Model

- From the File menu list, select the Open item.
  - The Model Selection screen is displayed. Use the Drives and Directories lists to navigate to the directory containing the desired file - demo419_xy. Select the file. Click the Continue command button.
  - Note - If the GDI Window does not automatically display, select the View/Edit item from the Graphics menu list to display the GDI Window.
  - Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls Toolbar.

2) Check The Coordinate System

To overlay a model on a GeoMap background image, the model coordinates need to be in WCS values.

- Move the mouse cursor around the GDI Display Window. Note that the coordinate values displayed at the bottom of the screen are large numbers, which are not indicative of WCS Longitude and Latitude values. (Note - WCS values range from -180 to 180 for Longitude, and -90 to 90 for Latitude.) In this case, the coordinate values represent Colorado State Plane Coordinates for the Central Zone.

3) Re-Project The Model Coordinates To WCS Values

- From the GDI Command List, select the Project Coordinates command.
  - The Convert To Projected Coordinate System screen is displayed.
● From the Conversion list, select **Plane Coordinates To Longitude/Latitude**.

● From the File Type list, select **ESRI Projection (*.prj)**.

● Click the **Browse** command button.

  ● The File Selection screen is displayed. Use the **Drives** and **Directories** lists to navigate to the “support” folder for GASWorkS (usually c:\Program Files (x86)\GASWorkS 10\support). Select the **projections** folder. Select the **NAD 1983 StatePlane Colorado Central FIPS 0502 (US Feet).prj** file. Click the **Continue** command button.

  ● The Convert To Projected Coordinate System screen is displayed again. Click the **Continue** command button.

  ● A message will be displayed when the process is complete. Click the **OK** command button to close the message.

The model coordinates are now in WCS values. Move the mouse cursor around in the GDI Display and the coordinate values are now in decimal degrees. During the re-projection process the dimensional unit for the coordinate values was changed to Degrees L/L.

4) **Set The Coordinate Dimensional Units**

To use the GeoMap function we will need to set the coordinate units to Web L/L.

● From the **Utilities** menu list, select the **Set Defaults** item.

  ● The Default Settings screen is displayed. On the **Dimensional Units** data tab, select **Web L/L** from the **Coordinates** dimensional units list. Review the other settings and change as appropriate. When finished, click the **Close** command button to save the changes.

5) **Enable The GeoMap Function**

● Click the **GeoMap** icon from the bottom of the **GDI Toolbar** list.

  ● A message will be displayed. Carefully read the message. Click the **Yes** command button to continue.

  ● The **GeoMap** icon will change display style, and the GDI Image will be resized to the extents of the entire world.
6) Attach The GeoMap Background Image

- From the Graphics menu list, select the Background Settings item.
  - The Background Image Settings screen is displayed. Click the Attach New Image command button.
    - The Attachment File Type screen is displayed. Select Geographic Map Service from the list. Click the Continue command button.
  - The Background Image Settings screen is displayed again. From the Map Service list, select Google Map. From the Image Resolution list, select Better. From the Map Type list, select Combination Road Map & Satellite Image. Click the Apply command button to save the changes.
    - A message will be displayed stating certain conditions for use of the selected map service. Read the contents carefully. Click the Yes command button to accept the terms and display the GeoMap background image.
  - An image of the entire world will be displayed.

7) Zoom To The Model

- Click the Zoom To Fit icon to show the model extents. The piping in the model should now overlay on the GeoMap background image in their actual locations.

Notes & Considerations

- In this example, we overlaid an existing model on a GeoMap background image. This was possible because we were able to re-project the model coordinates to WCS values. This is not always possible, if the original coordinate system is not known, the model coordinates cannot be re-projected.

- A “projection” file is required to re-project the model coordinate values. Projection files are unique to each coordinate system and vary by geographic location. Often a projection file (.prj) is included in a shapefile set. If the model was originally built by importing data from a shapefile, the projection file associated with the original shapefile can be used to re-project the coordinates.

- When a model is overlaid on a GeoMap background image, newly entered pipe lengths will be calculated based on the image coordinates. Realize that the WMP tends to distort north-south distances for areas away from the Equator. Although not necessarily large, the further away, the more the distortion. Be sure to check your lengths to ensure that they are appropriate for the intended use.

- It may be beneficial to change the default display sizes and colors to make the data features (pipes, nodes,
etc) easier to see when overlaid on the GeoMap background image. Use the various display, graphic, and text settings to make changes as appropriate.

- A detailed description of the terms-of-use and privacy policy for the selected map service may be viewed by selecting the appropriate item from the Third Party Terms & Conditions submenu of the Help menu list. You must agree to the associated terms-of-use and privacy policy to use the GeoMap functions.

See Also

Graphically View A Model
Maximize The GDI Window
Project To Plane Coordinates
Project A Model
Turn The GeoMap Functions On
Zoom The GDI Image
Build A New Model Using A GeoMap Background

Summary

A step-by-step guide to attaching a GeoMap background image to a model to use as a base map or reference for building a new model.

Example

The example assumes that GASWorkS has been started, and that an internet connection is active.

1) Create The New Model

- From the File menu list, select the New item.
  - The Model Selection screen is displayed. Enter a name for the new GASWorkS 10 model. Click the Continue command button. Note - If using an existing model, a message may be displayed asking whether to overwrite the model. Click the Yes command button to proceed.

- Note - If the GDI Window does not automatically display, select the View/Edit item from the Graphics menu list to display the GDI Window.

- Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls Toolbar.

2) Enable The GeoMap Function

- Click the GeoMap icon from the bottom of the GDI Toolbar list.
  - A message will be displayed. Carefully read the message. Click the Yes command button to continue.

  - The GeoMap icon will change display style.
3) Set The Model Coordinate Units

- From the Utilities menu list, select the Set Defaults item.
  - The Default Data Values screen is displayed. On the Dimensional Units tab, select Web L/L from the Coordinates list. Review the other settings and change as appropriate. Click the Close command button to save the change and exit the screen.

4) Attach The GeoMap Background Image

- From the Graphics menu list, select the Background Settings item.
  - The Background Image Settings screen is displayed. Click the Attach New Image command button.
    - The Attachment File Type screen is displayed. Select Geographic Map Service from the list. Click the Continue command button.
  - The Background Image Settings screen is displayed again. From the Map Service list, select Google Map. From the Image Resolution list, select Better. From the Map Type list, select Combination Road Map & Satellite Image. Click the Apply command button to save the changes.
    - A message will be displayed stating certain conditions for use of the selected map service. Read the contents carefully. Click the Yes command button to accept the terms and display the GeoMap background image.
    - An image of the entire world will be displayed.

5) Build The Model

Use the various Pan and Zoom commands and functions to display the desired location. Use the various Construction and Edit commands to build the model.

Notes & Considerations

- The GeoMap Functions may also be enabled by typing GEOMAP on the GDI Command Line and pressing the Enter key.

- To find a geographic location by a place (town) name, a street address or geographic name may also be used. If using a street address, include the zip code, postal code, or city name and state.

- Generally, each map service uses different imagery for the same area. In this example, Google Map service
is used. To see the difference in imagery, use the Microsoft Bing Map service to display the location.

- When tracing over a GeoMap background image, pipe lengths will be calculated based on the image coordinates. Realize that the WMP tends to distort distances for areas away from the Equator. Although not necessarily large, the further away, the more the distortion. Be sure to check the lengths to ensure that they are appropriate for the intended use.

- A detailed description of the terms-of-use and privacy policy for the selected map service may be viewed by selecting the appropriate item from the Third Party Terms & Conditions submenu of the Help menu list. You must agree to the associated terms-of-use and privacy policy to use the GeoMap functions.

- If the background image does not display in the GDI Display, go to the Display Controls Toolbar and move the mouse cursor over the Display Background Image icon. If the option is “off”, left-click on the icon to turn it “on”.

See Also

Display A Background Image
Graphically View A Model
Maximize The GDI Window
Zoom The GDI Image
GLOSSARY
The following table describes some of the terms associated with the GASWorkS modeling environment.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-Point Pipe</td>
<td>A single pipe segment extending directly between the From Node and To Node.</td>
</tr>
<tr>
<td>Arc Pipe</td>
<td>A single pipe segment between the From Node and To Node curved around a fixed point with a specific radius.</td>
</tr>
<tr>
<td>Attribute Data</td>
<td>Refers to non-model data associated with customer, and pipe data. Non-model data values do not affect the calculation of the pressure and flow values in the system.</td>
</tr>
<tr>
<td>Branch Customer</td>
<td>A customer supplied from another customer’s service line. A branch customer is not attached to a main.</td>
</tr>
<tr>
<td>Change Log</td>
<td>Displays all of the model changes associated with the pipe features.</td>
</tr>
<tr>
<td>Color Legend</td>
<td>A key of the colors and associated ranges.</td>
</tr>
<tr>
<td>Color Panel</td>
<td>Displays the selected color. To change the displayed color, click in the color panel to display the Color screen.</td>
</tr>
<tr>
<td>Compressor</td>
<td>A hydraulic feature that simulates the presence of a compressor in the model by increasing the system pressure. The From Node represents the upstream (suction) side of the compressor and the To Node represents the downstream (discharge) side of the compressor. The compressor symbol will automatically display “facing” in the direction of gas flow.</td>
</tr>
<tr>
<td>CSV (Comma Separated Values) File</td>
<td>A data file that uses commas as a delimiter to mark the break point between data values.</td>
</tr>
<tr>
<td>Customer</td>
<td>A model feature that represents a natural gas consumer with a graphic symbol of the customer location and hydraulic data used in the solution. A customer that is assigned to a supply main will have a service line between the customer location and the tap location.</td>
</tr>
<tr>
<td>Customer Symbol</td>
<td>A graphic denoting a customer location.</td>
</tr>
<tr>
<td>DBF (dBase Format) File</td>
<td>A standard data file used by the dBase system as well as some GIS applications.</td>
</tr>
<tr>
<td>Design Factor</td>
<td>An adjustment factor to set the total system load to a specified value.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display Limit</td>
<td>A value that turns the display of the features “on” or “off” based on the zoom scale.</td>
</tr>
<tr>
<td>DXF (Drawing Exchange Format) File</td>
<td>A CAD file used by applications such as AutoCAD.</td>
</tr>
<tr>
<td>External Load</td>
<td>Represents all of the customer loads assigned to a node.</td>
</tr>
<tr>
<td>Facility Type</td>
<td>Like a layer in a CAD or GIS file, it is used to organize the model features into different groups by an attribute type.</td>
</tr>
<tr>
<td>Feature</td>
<td>Items which can be added to a model - customers, pipes, images, text.</td>
</tr>
<tr>
<td>Fitting</td>
<td>A model feature that represents a gas pipeline fitting.</td>
</tr>
<tr>
<td>From Node</td>
<td>The beginning node of a pipe feature.</td>
</tr>
<tr>
<td>GDI</td>
<td>An acronym (abbreviation) for the GASWorkS Graphic Data Interface.</td>
</tr>
<tr>
<td>GDI Command</td>
<td>Actions which can be used to manipulate the model.</td>
</tr>
<tr>
<td>GDI Command Line</td>
<td>A panel used to type a GDI Command abbreviation and display the coordinates of the mouse cursor.</td>
</tr>
<tr>
<td>GDI Command List</td>
<td>An alphabetical list of all of the GDI Commands.</td>
</tr>
<tr>
<td>GDI Display</td>
<td>The portion of the screen where the GDI Image is displayed and manipulated.</td>
</tr>
<tr>
<td>GDI Icon</td>
<td>An image associated with certain GDI Commands.</td>
</tr>
<tr>
<td>GDI Image</td>
<td>The part of the model that is currently being shown in the GDI Display.</td>
</tr>
<tr>
<td>GDI Prompt Line/List</td>
<td>A panel used to type or select information when running a GDI Command.</td>
</tr>
<tr>
<td>GDI Toolbars</td>
<td>A group of “fly-out” icons grouped together by GDI Command functionality.</td>
</tr>
<tr>
<td>Grid Intersection</td>
<td>Intersection points of the reference grid.</td>
</tr>
<tr>
<td>Grips</td>
<td>A symbol within a feature. When clicked, the feature can then be moved by that grip symbol.</td>
</tr>
<tr>
<td>Group</td>
<td>A set of pipe, User Graphics, and/or User Text features that can be moved and copied as one.</td>
</tr>
<tr>
<td>Hydraulic Type</td>
<td>Specifies the hydraulic element type - for example compressor, fitting, pipe, regulator, or valve.</td>
</tr>
<tr>
<td><strong>Term</strong></td>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Icon</td>
<td>A small simple image which represents a GDI Command or routine. Select the icon to execute the associated command or function. The Printer icon used by many of the Report routines is an example of an icon.</td>
</tr>
<tr>
<td>Isometric View</td>
<td>A display where three-dimensional objects are represented in two dimensions. X, Y, and Z coordinates are used.</td>
</tr>
<tr>
<td>KML (Keyhole Markup Language) File</td>
<td>The default file type for Google Earth, and can be created by other mapping software.</td>
</tr>
<tr>
<td>Marked View</td>
<td>Indicated by a cross-hatched area in the GDI Display.</td>
</tr>
<tr>
<td>Message</td>
<td>A simple form that provides a warning or message to the User. The box is cleared by clicking the OK command button, or choosing one of its options (if more than one command button is present).</td>
</tr>
<tr>
<td>Model</td>
<td>The header, node, pipe, and customer data that defines the system being modeled.</td>
</tr>
<tr>
<td>Mouse Crosshairs</td>
<td>When the mouse cursor changes to a “plus sign” indicator.</td>
</tr>
<tr>
<td>Mouse Cursor</td>
<td>Refers to the screen position indicator for the keyboard or the mouse.</td>
</tr>
<tr>
<td>Mouse Pointer</td>
<td>The cursor image which is controlled by movement of the pointing device.</td>
</tr>
<tr>
<td>Node</td>
<td>The end of a pipe or connection between multiple pipe ends.</td>
</tr>
<tr>
<td>Node Symbol</td>
<td>A graphic denoting a node location.</td>
</tr>
<tr>
<td>PD File</td>
<td>A text-based pipe data file.</td>
</tr>
<tr>
<td>Pipe</td>
<td>A model feature that serves as a graphic representation of a gas pipeline - typically a main, but can also be used for a service. Data associated with a pipe is used to calculate a steady-state solution to the model. A pipe also connects two nodes.</td>
</tr>
<tr>
<td>Pipe Symbol</td>
<td>A graphic denoting a pipe location.</td>
</tr>
<tr>
<td>Plan View</td>
<td>A display in two-dimensions. X and Y coordinates are used.</td>
</tr>
<tr>
<td>Polyl ine Pipe</td>
<td>A multi-segment pipe between the From Node and To Node where each intermediate segment ends at a vertex.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Regulator</td>
<td>A pipe feature that simulates the presence of a regulator in the model by lowering the pressure of the system. The From Node represents the upstream (inlet) side of the regulator and the To Node represents the downstream (outlet) side of the regulator. The regulator symbol will automatically display “facing” in the direction of gas flow.</td>
</tr>
<tr>
<td>SHP (Shapefile) File</td>
<td>Can be created by many GIS-AM/FM applications.</td>
</tr>
<tr>
<td>Size/Type Code</td>
<td>A GASWorkS abbreviation used to establish the link between the pipe data files and the Property Tables.</td>
</tr>
<tr>
<td>Snap Target</td>
<td>The product of the Feature Snap Ratio times the default Node Symbol Size. When the Feature Snap is enabled, a graphic circle will be displayed around the mouse crosshairs with a radius equal to the snap target. If the mouse is left-clicked and a node is within the snap target circle, the node will be selected. If a location is entered as a coordinate pair on the GDI Prompt Line, and a node is within the snap target of the coordinates, the node will be selected. These values can be changed from the Graphic Settings screen. To access the screen, select the Settings item from the Graphics menu list.</td>
</tr>
<tr>
<td>Supply Node</td>
<td>A node with a Total Load value greater than zero. Supply nodes represent points where gas flows into the system being modeled.</td>
</tr>
<tr>
<td>Symbol Legend</td>
<td>A key of the User Graphic Symbols.</td>
</tr>
<tr>
<td>To Node</td>
<td>The ending node of a pipe feature.</td>
</tr>
<tr>
<td>Tool Palette</td>
<td>A panel used to display frequently used GDI Icons.</td>
</tr>
<tr>
<td>Trunk Customer</td>
<td>A customer attached to a main, which then supplies another customer, known as a Branch Customer.</td>
</tr>
<tr>
<td>Unbroken Intersection</td>
<td>Nodes at the intersection of two or more pipes, where at least one of the pipes is not connected to the node. This can include overlaps and other graphic errors that will not be fixed by simply “breaking” the pipes.</td>
</tr>
<tr>
<td>User Graphics</td>
<td>A graphic image, line, or symbol feature input and defined by the User.</td>
</tr>
<tr>
<td>User Table</td>
<td>A User created spreadsheet or table style graphic.</td>
</tr>
<tr>
<td>User Text</td>
<td>Text features input and defined by the User.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Valve</td>
<td>A hydraulic feature that simulates the presence of a valve in the model by allowing the User to stop or limit the flow of gas. GASWorkS uses a separate equation to calculate the flow through a valve. A valve can also be modeled as a node or a fitting, but only a valve-type hydraulic feature can stop the flow of gas in a model.</td>
</tr>
<tr>
<td>Valve Node</td>
<td>A node that is designated as a valve used by the Trace routines.</td>
</tr>
<tr>
<td>Vertex</td>
<td>An intersection point between two adjacent segments of a polyline pipe.</td>
</tr>
<tr>
<td>Well</td>
<td>A model feature that simulates the presence of a wellhead and a gas gathering line in the model. The From Node represents the wellhead and the To Node represents the downstream pipe end. The well symbol will automatically display “facing” in the direction of gas flow.</td>
</tr>
<tr>
<td>XLS File</td>
<td>A spreadsheet file format.</td>
</tr>
<tr>
<td>XY File</td>
<td>Contains the coordinate data for the PD file.</td>
</tr>
</tbody>
</table>
# GASWorkSTM 10.0

## Index

**Table Of Contents**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-Point Pipe</td>
<td>577</td>
</tr>
<tr>
<td>Add</td>
<td>39</td>
</tr>
<tr>
<td>Segment</td>
<td>441</td>
</tr>
<tr>
<td>Add</td>
<td></td>
</tr>
<tr>
<td>2-Point Pipe</td>
<td>39</td>
</tr>
<tr>
<td>Arc Pipe</td>
<td>41</td>
</tr>
<tr>
<td>Background Image</td>
<td>495, 500, 504, 568, 572</td>
</tr>
<tr>
<td>Branch Customer</td>
<td>44</td>
</tr>
<tr>
<td>Compressor</td>
<td>46</td>
</tr>
<tr>
<td>Customer</td>
<td>49, 51, 53</td>
</tr>
<tr>
<td>Customer, Duplicate</td>
<td>55</td>
</tr>
<tr>
<td>Customer, Multiple</td>
<td>61, 63</td>
</tr>
<tr>
<td>Customer, Unassigned</td>
<td>77</td>
</tr>
<tr>
<td>Fitting</td>
<td>59</td>
</tr>
<tr>
<td>Group Feature</td>
<td>57</td>
</tr>
<tr>
<td>Polyline Pipe</td>
<td>65</td>
</tr>
<tr>
<td>Polyline Pipe Vertex</td>
<td>68</td>
</tr>
<tr>
<td>Polyline Service Customer</td>
<td>70</td>
</tr>
<tr>
<td>Regulator</td>
<td>72</td>
</tr>
<tr>
<td>Service Line Vertex</td>
<td>75</td>
</tr>
<tr>
<td>User Graphic Image</td>
<td>79</td>
</tr>
<tr>
<td>User Graphic Line</td>
<td>81</td>
</tr>
<tr>
<td>User Graphic Symbol</td>
<td>84</td>
</tr>
<tr>
<td>User Text</td>
<td>86, 91</td>
</tr>
<tr>
<td>User Text, Associated</td>
<td>88</td>
</tr>
<tr>
<td>Valve</td>
<td>94</td>
</tr>
<tr>
<td>Valve Node</td>
<td>97</td>
</tr>
<tr>
<td>Well</td>
<td>99</td>
</tr>
<tr>
<td>Angle</td>
<td></td>
</tr>
<tr>
<td>Measure</td>
<td>352</td>
</tr>
<tr>
<td>Arc Pipe</td>
<td>577</td>
</tr>
<tr>
<td>Add</td>
<td>41</td>
</tr>
<tr>
<td>Adjust</td>
<td>102</td>
</tr>
<tr>
<td>Convert To Polyline</td>
<td>146, 147</td>
</tr>
<tr>
<td>Segment</td>
<td>441</td>
</tr>
<tr>
<td>Associated User Text</td>
<td>88</td>
</tr>
<tr>
<td>Attribute Data</td>
<td>577</td>
</tr>
<tr>
<td>Background Image</td>
<td></td>
</tr>
<tr>
<td>BMP File</td>
<td>495</td>
</tr>
<tr>
<td>Display</td>
<td>206</td>
</tr>
<tr>
<td>DXF File</td>
<td>500</td>
</tr>
<tr>
<td>GeoMap</td>
<td>568, 572</td>
</tr>
<tr>
<td>JPG File</td>
<td>495</td>
</tr>
<tr>
<td>KML File</td>
<td>504</td>
</tr>
<tr>
<td>Move</td>
<td>358</td>
</tr>
</tbody>
</table>

Bradley B Bean PE

Revision - 003, Copyright 2020 All Rights Reserved.

585
GASWorkS™ 10.0

Index

Table Of Contents

Scale.......................................................... 439
SHP File....................................................... 504
TIF File........................................................ 495
Turn Off...................................................... 473
Branch Customer.......................................... 577
Add............................................................. 44
Create......................................................... 172
Branch Service Tap
Create................................................................. 172
Move.............................................................. 360
Calculate
Design Factor.................................................. 110
Flow Efficiency............................................... 112
Pressure Drop................................................ 108, 109
Change Log.................................................... 577
Clear............................................................. 121
Turn Off......................................................... 474
Turn On.......................................................... 475
View............................................................. 484
Clear
Change Log..................................................... 121
Customer Flag................................................... 117, 123
Customer Flag, Find........................................ 122
Customer Flag, Item.......................................... 124
DXF Find Flag.................................................. 125
Error Flag....................................................... 126
Flag................................................................ 118
GeoFind Flag..................................................... 127
Node Flag......................................................... 119, 129
Node Flag, Find.................................................. 128
Node Flag, Item............................................... 130
Pipe Flag.......................................................... 120, 132
Pipe Flag, Find................................................... 131
Pipe Flag, Item.................................................. 133
Supply Flag....................................................... 134
Unbroken Intersection Flag.............................. 135
User Text Find Flag.......................................... 136
Color Code
By Query........................................................ 511
By Range........................................................ 513
Color Display Settings Screen.......................... 139
Color Legend..................................................... 577
Display........................................................... 207
Text................................................................ 148
# Index

## Table Of Contents

- **CSV Table**
  - View .................................................. 486
- **Current View**
  - Mark ................................................... 324
  - Save ................................................... 436
- **Customer**
  - Add .................................................... 49, 51, 53, 61, 63
  - Branch ................................................ 44, 577
  - Copy ................................................... 151, 153
  - Delete .................................................. 181, 182, 409
  - Duplicate ............................................... 55
  - Edit ..................................................... 224, 226, 228
  - Find ..................................................... 263
  - Find, Address ......................................... 265
  - Find, Attribute ........................................ 267
  - Find, Internal ID Number ............................. 269
  - Find, Link ID Number ................................ 270
  - Find, Record Number .................................. 272
  - Flag ..................................................... 294
  - Flag, Clear ............................................. 117
  - Flag, Invalid Link ID Numbers ...................... 297
  - Flag, Item Value ....................................... 295
  - Flag, Redundant Link ID Numbers ................. 298
- **Copy**
  - Customer ............................................... 151, 153
  - Group Features ....................................... 155
  - Pipe ..................................................... 157
  - Saved View ............................................. 159
  - User Graphic Image ................................... 160
  - User Graphic Line ..................................... 162
  - User Graphic Symbol .................................. 164
  - User Graphics ......................................... 166
  - User Table .............................................. 167
  - User Text ............................................. 169, 171
- **CSV File**
  - Export .................................................. 27
  - Import ................................................... 5
- **Color Legend Text**
  - Create .................................................. 148
  - Delete ................................................... 180
  - Move ..................................................... 362
- **Color Panel** ........................................... 577
- **Compressor** ........................................... 577

---

Bradley B Bean PE  
**ENGINEERING & SOFTWARE**

Revision - 003, Copyright 2020 All Rights Reserved.

587
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid Coordinates</td>
<td>428</td>
</tr>
<tr>
<td>Move</td>
<td>363</td>
</tr>
<tr>
<td>Move, Reassign Main</td>
<td>365</td>
</tr>
<tr>
<td>Polyline Service, Add</td>
<td>70</td>
</tr>
<tr>
<td>Properties, Match</td>
<td>325, 327, 329</td>
</tr>
<tr>
<td>Purge</td>
<td>409</td>
</tr>
<tr>
<td>Reassign, Supply Main Number</td>
<td>418</td>
</tr>
<tr>
<td>Select</td>
<td>347</td>
</tr>
<tr>
<td>Service Tap, Move</td>
<td>389</td>
</tr>
<tr>
<td>Supply Main, Reassign</td>
<td>416</td>
</tr>
<tr>
<td>Symbol</td>
<td>209</td>
</tr>
<tr>
<td>Trunk</td>
<td>580</td>
</tr>
<tr>
<td>Unassigned</td>
<td>77</td>
</tr>
<tr>
<td>Customer Data</td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td>224, 226, 228</td>
</tr>
<tr>
<td>Customer Flag</td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td>117, 122-124</td>
</tr>
<tr>
<td>Customer Load</td>
<td></td>
</tr>
<tr>
<td>Multiply</td>
<td>399</td>
</tr>
<tr>
<td>Prorate</td>
<td>408</td>
</tr>
<tr>
<td>Customer Properties</td>
<td></td>
</tr>
<tr>
<td>Graphic, Match</td>
<td>325</td>
</tr>
<tr>
<td>Hydraulic, Match</td>
<td>327</td>
</tr>
<tr>
<td>Match</td>
<td>329</td>
</tr>
<tr>
<td>Customer Service Line</td>
<td></td>
</tr>
<tr>
<td>Assign</td>
<td>104</td>
</tr>
<tr>
<td>Customer Supply Main</td>
<td></td>
</tr>
<tr>
<td>Reassign</td>
<td>416</td>
</tr>
<tr>
<td>Customer Symbol</td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>577</td>
</tr>
<tr>
<td>Display</td>
<td>429</td>
</tr>
<tr>
<td>Customer Text</td>
<td></td>
</tr>
<tr>
<td>Move</td>
<td>367</td>
</tr>
<tr>
<td>Settings</td>
<td>467</td>
</tr>
<tr>
<td>Data Panel</td>
<td></td>
</tr>
<tr>
<td>Export</td>
<td></td>
</tr>
<tr>
<td>DBF File</td>
<td>577</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>Color Legend Text</td>
<td>180</td>
</tr>
<tr>
<td>Customer</td>
<td>181, 182, 409</td>
</tr>
<tr>
<td>Group Features</td>
<td>183</td>
</tr>
<tr>
<td>Marked View</td>
<td>184, 185</td>
</tr>
<tr>
<td>Node</td>
<td>186</td>
</tr>
<tr>
<td>Pipe</td>
<td>188</td>
</tr>
<tr>
<td>Pipe, Zero Length</td>
<td>205</td>
</tr>
</tbody>
</table>
## Table Of Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polylne Pipe Vertex</td>
<td>190</td>
</tr>
<tr>
<td>Saved View</td>
<td>192</td>
</tr>
<tr>
<td>Service Line Vertex</td>
<td>193</td>
</tr>
<tr>
<td>User Graphic Image</td>
<td>195</td>
</tr>
<tr>
<td>User Graphic Line</td>
<td>196</td>
</tr>
<tr>
<td>User Graphic Symbol</td>
<td>197</td>
</tr>
<tr>
<td>User Graphics</td>
<td>198</td>
</tr>
<tr>
<td>User Table</td>
<td>200</td>
</tr>
<tr>
<td>User Text</td>
<td>201, 202, 411</td>
</tr>
<tr>
<td>Valve Node</td>
<td>203, 204</td>
</tr>
<tr>
<td>Design Factor</td>
<td>577</td>
</tr>
<tr>
<td>Calculate</td>
<td>110</td>
</tr>
<tr>
<td>Display</td>
<td></td>
</tr>
<tr>
<td>Background Image</td>
<td>206</td>
</tr>
<tr>
<td>Color Legend</td>
<td>207</td>
</tr>
<tr>
<td>Customer Symbols</td>
<td>209</td>
</tr>
<tr>
<td>Flow Arrow</td>
<td>210</td>
</tr>
<tr>
<td>GDI Command List</td>
<td>518</td>
</tr>
<tr>
<td>Isometric View</td>
<td>212</td>
</tr>
<tr>
<td>Mouse Crosshairs</td>
<td>208</td>
</tr>
<tr>
<td>Node Symbols</td>
<td>213</td>
</tr>
<tr>
<td>Pipe Symbols</td>
<td>214</td>
</tr>
<tr>
<td>Plan View</td>
<td>215</td>
</tr>
<tr>
<td>Tool Palette</td>
<td>216</td>
</tr>
<tr>
<td>User Graphics</td>
<td>217</td>
</tr>
<tr>
<td>User Text</td>
<td>218</td>
</tr>
<tr>
<td>Display Limit</td>
<td>516, 578</td>
</tr>
<tr>
<td>Distance</td>
<td></td>
</tr>
<tr>
<td>Measure, Isometric View</td>
<td>355-357</td>
</tr>
<tr>
<td>Measure, Plan View</td>
<td>353</td>
</tr>
<tr>
<td>DXF File</td>
<td>578</td>
</tr>
<tr>
<td>Export</td>
<td>30</td>
</tr>
<tr>
<td>Import</td>
<td>7, 528</td>
</tr>
<tr>
<td>DXF Find Flag</td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td>125</td>
</tr>
<tr>
<td>DXF Layer</td>
<td></td>
</tr>
<tr>
<td>Convert Service Lines To Customers</td>
<td>150</td>
</tr>
<tr>
<td>Identify</td>
<td>223</td>
</tr>
<tr>
<td>Turn Off</td>
<td>477</td>
</tr>
<tr>
<td>DXF Text</td>
<td></td>
</tr>
<tr>
<td>Find</td>
<td>273</td>
</tr>
<tr>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Customer</td>
<td>224, 226</td>
</tr>
<tr>
<td>Customer, Multiple</td>
<td>228</td>
</tr>
<tr>
<td>Node</td>
<td>242</td>
</tr>
</tbody>
</table>
# GASWorkS™ 10.0

## Index

### Table Of Contents

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node, Multiple</td>
<td>230</td>
</tr>
<tr>
<td>Pipe</td>
<td>248</td>
</tr>
<tr>
<td>Pipe, Multiple</td>
<td>232</td>
</tr>
<tr>
<td>Polyl ine Pipe Vertex</td>
<td>251</td>
</tr>
<tr>
<td>User Graphic Image</td>
<td>253</td>
</tr>
<tr>
<td>User Graphic Image, Multiple</td>
<td>234</td>
</tr>
<tr>
<td>User Graphic Line</td>
<td>254</td>
</tr>
<tr>
<td>User Graphic Line, Multiple</td>
<td>236</td>
</tr>
<tr>
<td>User Graphic Symbol</td>
<td>255</td>
</tr>
<tr>
<td>User Graphic Symbol, Multiple</td>
<td>238</td>
</tr>
<tr>
<td>User Table</td>
<td>256</td>
</tr>
<tr>
<td>User Text</td>
<td>258</td>
</tr>
<tr>
<td>User Text, Multiple</td>
<td>240</td>
</tr>
</tbody>
</table>

### Facility Type

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>126</td>
</tr>
</tbody>
</table>

### Export

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSV File</td>
<td>27</td>
</tr>
<tr>
<td>DBF File</td>
<td>28</td>
</tr>
<tr>
<td>DXF File</td>
<td>30</td>
</tr>
<tr>
<td>GASWorkS Model</td>
<td>31</td>
</tr>
<tr>
<td>KML File</td>
<td>32</td>
</tr>
<tr>
<td>SHP File</td>
<td>33</td>
</tr>
<tr>
<td>Stoner PD/XY File</td>
<td>35</td>
</tr>
<tr>
<td>User Text</td>
<td>259</td>
</tr>
<tr>
<td>XLS File</td>
<td>36</td>
</tr>
</tbody>
</table>

### Feature Colors

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
<td>430</td>
</tr>
<tr>
<td>Save</td>
<td>437</td>
</tr>
</tbody>
</table>

### Feature Snap

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td>260</td>
</tr>
</tbody>
</table>

### Customer

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer</td>
<td>261, 263</td>
</tr>
<tr>
<td>Customer, Address</td>
<td>265</td>
</tr>
<tr>
<td>Customer, Attribute</td>
<td>267</td>
</tr>
<tr>
<td>Customer, Internal ID Number</td>
<td>269</td>
</tr>
<tr>
<td>Customer, Link ID Number</td>
<td>270</td>
</tr>
<tr>
<td>Customer, Record Number</td>
<td>272</td>
</tr>
<tr>
<td>DXF Text</td>
<td>261, 273</td>
</tr>
<tr>
<td>Feature</td>
<td>261</td>
</tr>
<tr>
<td>Component</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Geographic Location</td>
<td>275</td>
</tr>
<tr>
<td>Node</td>
<td>261, 277</td>
</tr>
<tr>
<td>Node, Name</td>
<td>279</td>
</tr>
<tr>
<td>Node, Record Number</td>
<td>281</td>
</tr>
<tr>
<td>Pipe</td>
<td>261, 282</td>
</tr>
<tr>
<td>Pipe, Address</td>
<td>284</td>
</tr>
<tr>
<td>Pipe, Attribute</td>
<td>286</td>
</tr>
<tr>
<td>Pipe, Internal ID Number</td>
<td>288</td>
</tr>
<tr>
<td>Pipe, Link ID Number</td>
<td>289</td>
</tr>
<tr>
<td>Pipe, Record Number</td>
<td>291</td>
</tr>
<tr>
<td>User Text</td>
<td>261, 292</td>
</tr>
<tr>
<td>Fitting</td>
<td>578</td>
</tr>
<tr>
<td>Add</td>
<td>59</td>
</tr>
<tr>
<td>Attach</td>
<td>507</td>
</tr>
<tr>
<td>Remove</td>
<td>423</td>
</tr>
<tr>
<td>Flag</td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td>118</td>
</tr>
<tr>
<td>Customer</td>
<td>294</td>
</tr>
<tr>
<td>Customer, Invalid Link ID Numbers</td>
<td>297</td>
</tr>
<tr>
<td>Customer, Item Value</td>
<td>295</td>
</tr>
<tr>
<td>Customer, Redundant Link ID Numbers</td>
<td>298</td>
</tr>
<tr>
<td>Customer, Unassigned</td>
<td>306</td>
</tr>
<tr>
<td>Node</td>
<td>299</td>
</tr>
<tr>
<td>Node, Item Value</td>
<td>300</td>
</tr>
<tr>
<td>Pipe</td>
<td>302</td>
</tr>
<tr>
<td>Pipe, Item Value</td>
<td>303</td>
</tr>
<tr>
<td>Supply Node</td>
<td>305</td>
</tr>
<tr>
<td>Unbroken Intersection</td>
<td>307</td>
</tr>
<tr>
<td>Flagged Intersection</td>
<td></td>
</tr>
<tr>
<td>Break</td>
<td>106</td>
</tr>
<tr>
<td>Flow Arrow</td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>210</td>
</tr>
<tr>
<td>Flow Efficiency</td>
<td></td>
</tr>
<tr>
<td>Calculate</td>
<td>112</td>
</tr>
<tr>
<td>From Node</td>
<td>578</td>
</tr>
<tr>
<td>GASWorkS Model</td>
<td>579</td>
</tr>
<tr>
<td>Compare</td>
<td>143</td>
</tr>
<tr>
<td>Export</td>
<td>31</td>
</tr>
<tr>
<td>Import</td>
<td>9</td>
</tr>
<tr>
<td>Regenerate Data</td>
<td>425</td>
</tr>
<tr>
<td>Solve</td>
<td>460</td>
</tr>
<tr>
<td>Solve, Quick</td>
<td>413</td>
</tr>
<tr>
<td>User Graphics, Copy</td>
<td>166</td>
</tr>
<tr>
<td>User Text, Copy</td>
<td>171</td>
</tr>
<tr>
<td>View</td>
<td>524</td>
</tr>
</tbody>
</table>
Table Of Contents

Index

GDI Command .......................................................... 578
  Cancel ................................................................. 115
  Execute .............................................................. 522
  Repeat ............................................................... 545
GDI Command Line .................................................... 523, 578
GDI Command List ..................................................... 522, 578
  Display ............................................................... 518
GDI Coordinates
  Enter ................................................................. 519
  Go To ............................................................... 310
  Unit ................................................................. 553
GDI Display ............................................................ 578
  Colors ............................................................... 139
  Display Limit ...................................................... 516
GDI Icon ............................................................... 578
GDI Image
  Display ............................................................. 546
  Increase Display Speed ........................................... 537
  Move ................................................................. 539
  Pan ................................................................. 402, 509
  Plot ................................................................. 403
  Repaint ............................................................ 427
  Zoom ............................................................... 488, 509
GDI Prompt Line ........................................................ 578
GDI Prompt List ........................................................ 578
GDI Toolbars .......................................................... 522, 578
GDI Window
  Close ............................................................... 137
  Maximize .......................................................... 351
  Open ............................................................... 524
  Resize ............................................................. 435
GeoFind Flag
  Clear ............................................................... 127
Geographic Location
  Find ............................................................... 275
GeoMap Functions ..................................................... 567
  Turn On .......................................................... 478
Graphic Data Interface ................................................ 578
  Snap ............................................................... 457
Grips .................................................................. 525, 578
Group ................................................................. 578
  Copy ................................................................. 155
  Create ............................................................. 174
  Delete ............................................................. 183

Revision - 003, Copyright 2020 All Rights Reserved.
### Index

#### Table Of Contents

- Dissolve .................................................. 219, 221
- Feature, Add .............................................. 57
- Highlight .................................................... 311
- ID ............................................................... 309
- Move .......................................................... 369
- Unhighlight .................................................. 480

Group Feature
- Add ............................................................ 57
- Dissolve ..................................................... 219
- Remove ...................................................... 424

Group ID ....................................................... 309

Highlight
- Group .......................................................... 311
- Pipe ............................................................. 312

Hydraulic Type .................................................. 578

Icon ............................................................... 579

Import ............................................................ 3
- CSV File ...................................................... 5
- DXF File ....................................................... 7, 528
- GASWorkS Model .......................................... 9
- KML File ...................................................... 11
- Property Table ............................................... 536
- SHP File, Customer ......................................... 13
- SHP File, Pipe ............................................... 15
- Stoner PD/XY File ........................................... 17

Insert
- Compressor .................................................. 313
- Regulator .................................................... 316
- Valve .......................................................... 319

Intersection Flag
- Set ............................................................. 444
- Unset .......................................................... 481

Isometric Coordinates
- Set To Flat .................................................. 443

Isometric View .................................................. 579
- Display ....................................................... 212
- Distance, Measure .......................................... 355-357

KML File .......................................................... 579
- Export ......................................................... 32
- Import ........................................................ 11

Marked View ................................................... 579
- Delete ......................................................... 184, 185

Mass Update .................................................... 557

Match
- Customer Properties ........................................ 329
<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>325</td>
<td>Customer, Graphic Properties</td>
</tr>
<tr>
<td>327</td>
<td>Customer, Hydraulic Properties</td>
</tr>
<tr>
<td>335</td>
<td>Node Properties</td>
</tr>
<tr>
<td>331</td>
<td>Node, Graphic Properties</td>
</tr>
<tr>
<td>333</td>
<td>Node, Hydraulic Properties</td>
</tr>
<tr>
<td>337</td>
<td>Pipe Facility</td>
</tr>
<tr>
<td>343</td>
<td>Pipe Properties</td>
</tr>
<tr>
<td>339</td>
<td>Pipe, Graphic Properties</td>
</tr>
<tr>
<td>341</td>
<td>Pipe, Hydraulic Properties</td>
</tr>
<tr>
<td>345</td>
<td>User Graphic Line Properties</td>
</tr>
<tr>
<td>347</td>
<td>User Graphic Symbol Properties</td>
</tr>
<tr>
<td>349</td>
<td>User Text Properties</td>
</tr>
<tr>
<td></td>
<td>Measure</td>
</tr>
<tr>
<td>352</td>
<td>Angle</td>
</tr>
<tr>
<td>355-357</td>
<td>Distance, Isometric View</td>
</tr>
<tr>
<td>353</td>
<td>Distance, Plan View</td>
</tr>
<tr>
<td>3</td>
<td>Merge</td>
</tr>
<tr>
<td>18</td>
<td>SHP File, Service</td>
</tr>
<tr>
<td>20</td>
<td>SHP File, Valve</td>
</tr>
<tr>
<td>579</td>
<td>Message</td>
</tr>
<tr>
<td>453</td>
<td>Model Coordinates</td>
</tr>
<tr>
<td>579</td>
<td>Shift</td>
</tr>
<tr>
<td>579</td>
<td>Mouse Crosshairs</td>
</tr>
<tr>
<td>579</td>
<td>Display</td>
</tr>
<tr>
<td>579</td>
<td>Mouse Cursor</td>
</tr>
<tr>
<td>579</td>
<td>Mouse Pointer</td>
</tr>
<tr>
<td>358</td>
<td>Move</td>
</tr>
<tr>
<td>360</td>
<td>Background Image</td>
</tr>
<tr>
<td>362</td>
<td>Branch Service Tap</td>
</tr>
<tr>
<td>363</td>
<td>Color Legend Text</td>
</tr>
<tr>
<td>367</td>
<td>Customer</td>
</tr>
<tr>
<td>367</td>
<td>Customer Text</td>
</tr>
<tr>
<td>365</td>
<td>Customer, Reassign Main</td>
</tr>
<tr>
<td>539</td>
<td>GDI Image</td>
</tr>
<tr>
<td>369</td>
<td>Group</td>
</tr>
<tr>
<td>371</td>
<td>Node</td>
</tr>
<tr>
<td>373</td>
<td>Node Text</td>
</tr>
<tr>
<td>375</td>
<td>Node Text, Multiple</td>
</tr>
<tr>
<td>377</td>
<td>Pipe</td>
</tr>
<tr>
<td>379</td>
<td>Pipe End</td>
</tr>
<tr>
<td>381</td>
<td>Pipe Text</td>
</tr>
<tr>
<td>383</td>
<td>Pipe Text, Multiple</td>
</tr>
<tr>
<td>385</td>
<td>Polyline Pipe Vertex</td>
</tr>
<tr>
<td>387</td>
<td>Service Line Vertex</td>
</tr>
<tr>
<td>389</td>
<td>Service Tap</td>
</tr>
</tbody>
</table>
## Table Of Contents

<table>
<thead>
<tr>
<th>Node</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>186, 322, 420</td>
</tr>
<tr>
<td>Edit</td>
<td>230, 242</td>
</tr>
<tr>
<td>External Load</td>
<td>244, 578</td>
</tr>
<tr>
<td>External Load, Fixed</td>
<td>246</td>
</tr>
<tr>
<td>Flag</td>
<td>277</td>
</tr>
<tr>
<td>Flag, Clear</td>
<td>279</td>
</tr>
<tr>
<td>Flag, Item Value</td>
<td>281</td>
</tr>
<tr>
<td>Move</td>
<td>299</td>
</tr>
<tr>
<td>Properties, Match</td>
<td>300</td>
</tr>
<tr>
<td>Reduce</td>
<td>311</td>
</tr>
<tr>
<td>Renumber</td>
<td>331, 333, 335</td>
</tr>
<tr>
<td>Select</td>
<td>342</td>
</tr>
<tr>
<td>Swap</td>
<td>346</td>
</tr>
<tr>
<td>Symbol</td>
<td>344</td>
</tr>
<tr>
<td>Valve Node</td>
<td>345</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Node Data</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>371</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Node Flag</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>119, 128-130</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Node Load</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiply</td>
<td>400</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Node Text</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move</td>
<td>373</td>
</tr>
<tr>
<td>Move, Multiple</td>
<td>375</td>
</tr>
<tr>
<td>Settings</td>
<td>467</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Orthogonal Coordinates</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orthogonal Plus Coordinates</td>
<td>446</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>External Load, Fixed</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>246</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Find</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Number</td>
<td>300</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Properties, Match</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match</td>
<td>331, 333, 335</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>119, 128-130</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>213</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Move, Multiple</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>375</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>467</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Orthogonal Coordinates</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orthogonal Plus Coordinates</td>
<td>447</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>213</td>
<td></td>
</tr>
</tbody>
</table>
Pipe Properties

Pipe Flag
Pipe Data
Pipe Customer Count
Pipe Combination Specifications Screen
Pipe End
Pipe Facility
Pipe Flag
Pipe Properties

GASWorkS™ 10.0
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match</td>
<td>343</td>
</tr>
<tr>
<td>Pipe Symbol</td>
<td>579</td>
</tr>
<tr>
<td>Color, Display</td>
<td>432</td>
</tr>
<tr>
<td>Pipe Text</td>
<td>214</td>
</tr>
<tr>
<td>Move</td>
<td>381</td>
</tr>
<tr>
<td>Move, Multiple, Settings</td>
<td>383</td>
</tr>
<tr>
<td>Plan View</td>
<td>579</td>
</tr>
<tr>
<td>Angle, Measure, Display</td>
<td>352</td>
</tr>
<tr>
<td>Distance, Measure, Display</td>
<td>215</td>
</tr>
<tr>
<td>Distance, Measure, Display</td>
<td>353</td>
</tr>
<tr>
<td>Plane Coordinates, Project</td>
<td>406, 540</td>
</tr>
<tr>
<td>Plot, GDI Image</td>
<td>403</td>
</tr>
<tr>
<td>Polyline Pipe, Add, Straighten, Vertex, Delete</td>
<td>579</td>
</tr>
<tr>
<td>Polyline Pipe Vertex, Add, Edit, Move</td>
<td>65, 462, 251, 190</td>
</tr>
<tr>
<td>Polyline Service Customer, Add</td>
<td>70</td>
</tr>
<tr>
<td>Pressure Drop, Linear, Squared, Calculate</td>
<td>108, 109</td>
</tr>
<tr>
<td>Property Table, Import</td>
<td>536</td>
</tr>
<tr>
<td>Purge, Customer, User Text</td>
<td>409, 411</td>
</tr>
<tr>
<td>Query Specifications Screen, Add</td>
<td>543</td>
</tr>
<tr>
<td>Quick Size</td>
<td>412</td>
</tr>
<tr>
<td>Redo</td>
<td>419</td>
</tr>
<tr>
<td>Regulator, Add, Insert</td>
<td>580, 72, 316</td>
</tr>
<tr>
<td>Remove, Fittings, Group Feature</td>
<td>423, 424</td>
</tr>
<tr>
<td>Route Profile</td>
<td>455</td>
</tr>
</tbody>
</table>
## Table Of Contents

**Save**
- GDI Image

**Saved View**
- Copy
- Delete

**Service Line Vertex**
- Add
- Delete
- Move

**Service Tap**
- Move

**SHP File**
- Export
- Import, Customer
- Import, Pipe
- Merge, Service
- Merge, Valve

**Size/Type Code**

**Snap**
- Feature
- Grid Intersection
- Pipe End
- Target

**Solve Model**
- Quick

**Stoner PD/XY File**
- Export
- Import

**Supply Flag**
- Clear

**Supply Main**
- Number, Reassign
- Reassign

**Supply Node**
- Flag

**Symbol Legend**
- Create

**Text Display Settings Screen**

**To Node**

**Tool Palette**
- Display
- Reset

**Trace**
- Quick
- Results
## Table Of Contents

**Index**

- Update Data ........................................ 471
- Trace Results
  - View ........................................... 487
- Unassigned Customer
  - Add ............................................ 77
  - Flag .......................................... 306
- Unbroken Intersection
  - Break .......................................... 106
  - Flag .......................................... 307
  - Flag, Clear ................................... 135
- Undo .................................................. 479
- User Graphic Image
  - Add ............................................. 79
  - Copy .......................................... 160
  - Delete ........................................ 195
  - Display ....................................... 217
  - Edit .......................................... 234, 253
  - Move .......................................... 391
- User Graphic Line
  - Add ............................................. 81
  - Copy .......................................... 162
  - Delete ........................................ 196
  - Display ....................................... 217
  - Edit .......................................... 236, 254
  - End, Move .................................... 394
  - Move .......................................... 392
  - Properties, Match ............................. 345
  - Size .......................................... 448
- User Graphic Symbol
  - Add ............................................. 84
  - Copy .......................................... 164
  - Delete ........................................ 197
  - Display ....................................... 217
  - Edit .......................................... 238, 255
  - Move .......................................... 396
  - Properties, Match ............................. 347
  - Size .......................................... 449
- User Graphics ........................................ 580
  - Copy .......................................... 166
  - Delete ........................................ 198
  - Display ....................................... 217
- User Table .......................................... 580
  - Copy .......................................... 167
  - Create ....................................... 178
  - Delete ........................................ 200

---

Bradley B Bean PE

Revision - 003, Copyright 2020 All Rights Reserved.
<table>
<thead>
<tr>
<th>Table Of Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>256</td>
</tr>
<tr>
<td>Move</td>
<td>397</td>
</tr>
<tr>
<td>User Text</td>
<td>580</td>
</tr>
<tr>
<td>Add</td>
<td>86, 91</td>
</tr>
<tr>
<td>Add, Quick</td>
<td>415</td>
</tr>
<tr>
<td>Associated</td>
<td>88</td>
</tr>
<tr>
<td>Copy</td>
<td>169, 171</td>
</tr>
<tr>
<td>Delete</td>
<td>201, 202, 411</td>
</tr>
<tr>
<td>Display</td>
<td>218</td>
</tr>
<tr>
<td>Edit</td>
<td>240, 258</td>
</tr>
<tr>
<td>Export</td>
<td>259</td>
</tr>
<tr>
<td>Find</td>
<td>292</td>
</tr>
<tr>
<td>Find Flag, Clear</td>
<td>136</td>
</tr>
<tr>
<td>Leader Line</td>
<td>91</td>
</tr>
<tr>
<td>Move</td>
<td>398</td>
</tr>
<tr>
<td>Properties, Match</td>
<td>349</td>
</tr>
<tr>
<td>Purge</td>
<td>411</td>
</tr>
<tr>
<td>Select</td>
<td>547, 548</td>
</tr>
<tr>
<td>Size</td>
<td>451</td>
</tr>
<tr>
<td>Valve</td>
<td>581</td>
</tr>
<tr>
<td>Add</td>
<td>94</td>
</tr>
<tr>
<td>Insert</td>
<td>319</td>
</tr>
<tr>
<td>Valve Node</td>
<td>581</td>
</tr>
<tr>
<td>Add</td>
<td>97</td>
</tr>
<tr>
<td>Delete</td>
<td>203, 204</td>
</tr>
<tr>
<td>Set</td>
<td>452</td>
</tr>
<tr>
<td>Unset</td>
<td>482</td>
</tr>
<tr>
<td>Vertex</td>
<td>581</td>
</tr>
<tr>
<td>Polylne Pipe, Add</td>
<td>68</td>
</tr>
<tr>
<td>Polylne Pipe, Delete</td>
<td>190</td>
</tr>
<tr>
<td>Polylne Pipe, Edit</td>
<td>251</td>
</tr>
<tr>
<td>Polylne Pipe, Move</td>
<td>385</td>
</tr>
<tr>
<td>Service Line, Add</td>
<td>75</td>
</tr>
<tr>
<td>Service Line, Delete</td>
<td>193</td>
</tr>
<tr>
<td>Service Line, Move</td>
<td>387</td>
</tr>
<tr>
<td>View</td>
<td></td>
</tr>
<tr>
<td>Change Log</td>
<td>484</td>
</tr>
<tr>
<td>CSV Table</td>
<td>486</td>
</tr>
<tr>
<td>Model</td>
<td>524</td>
</tr>
<tr>
<td>Trace Results</td>
<td>487</td>
</tr>
<tr>
<td>Well</td>
<td>581</td>
</tr>
<tr>
<td>Add</td>
<td>99</td>
</tr>
<tr>
<td>XLS File</td>
<td>581</td>
</tr>
<tr>
<td>Export</td>
<td>36</td>
</tr>
</tbody>
</table>
# GASWorkS™ 10.0

## Index

**Table Of Contents**

<table>
<thead>
<tr>
<th>XY Coordinates</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go To</td>
<td>310</td>
</tr>
<tr>
<td>Zoom</td>
<td>488, 509</td>
</tr>
<tr>
<td>Fit</td>
<td>488</td>
</tr>
<tr>
<td>In</td>
<td>488</td>
</tr>
<tr>
<td>Model</td>
<td>488</td>
</tr>
<tr>
<td>Next</td>
<td>489</td>
</tr>
<tr>
<td>Out</td>
<td>489</td>
</tr>
<tr>
<td>Previous</td>
<td>489</td>
</tr>
<tr>
<td>Saved View</td>
<td>489</td>
</tr>
<tr>
<td>Scale Factor</td>
<td>490</td>
</tr>
<tr>
<td>Window</td>
<td>490</td>
</tr>
</tbody>
</table>

Bradley B Bean PE

ENGINEERING & SOFTWARE

Revision - 003, Copyright 2020 All Rights Reserved.

601